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Содержание NX

ПРЕДИСЛОВИЕ
Вы держите в руках второе, специализированное, издание посвящённое системе автома-

тизированного проектирования NX. В сентябре 2009 года впервые в России вышла книга 
«NX для конструктора-машиностроителя», получившая широкое признание инженеров, кон-
структоров, учащихся, использующих программный пакет NX. Более 2000 тысяч экземпляров 
первого издания нашли своих читателей в России. Основанное на версии NX6 первое изда-
ние для многих инженеров стало первым шагом в освоении программного пакета NX. Сегодня 
текущая версия пакета – NX7.5.

В программном пакете NX 7.5 появилось много новых возможностей и улучшений, которые 
значительно повышают производительность разработки изделий. К улучшениям интегриро-
ванных CAD-приложений в NX относятся инструменты быстрого проектирования, например 
упрощенное создание эскизов, трансформирование с помощью синхронной технологии мо-
делей свободной формы и новые инструменты в оформлении документации, значительно по-
вышающие качество 2D проектирования. 

• Новые инструменты быстрого проектирования ускоряют создание и размещение 2D профи-
лей, автоматически накладывая ограничения и выявляя замысел создателя модели. В резуль-
тате время на создание модели сокращается до 50%. 

• Интеграция революционной синхронной технологии с моделированием тел свободной фор-
мы в NX преобразует процесс работы с моделями со сложной геометрией, включая импор-
тированные из других систем САПР. Пользователи могут создать простую призматическую 
или аналитически заданную форму, а с помощью соответствующих инструментов – сложные 
органические модели. 

• Нововведения в синхронной технологии включают улучшения в работе с массивами, сбор-
ками, тонкостенными оболочками, скруглениями, фасками, а также упрощенные методы по-
вторного использования геометрии, специализированные решения по созданию шаблонов 
изделий PTS (Product Template Studio). 

В новом издании затронуты следующие вопросы: это и моделирование сложных поверх-
ностей, моделирование в контексте с использованием модуля WAVE, создание деталей из 
листовых материалов. Отдельная глава книги посвящена прочностному анализу и практике 
использования модуля «Расширенной симуляции» NX. 

Данная книга описывает применение синхронной технологии для решения проектных за-
дач. Эта поистине революционная технология изменила представление о системах 3D-мо де-
ли рования. 

Книга «Практическое использование NX» подготовлена ведущими специалистами направ-
ления российского офиса Siemens PLM Software. Она адресована тем, кто имеет опыт проек-
тирования и моделирования в системах автоматизированного проектирования (САПР), а так-
же тем, кто только начинает их освоение. 

Книга сопровождается большим количеством примеров. Все модели, рассмотренные в кни-
ге, вы сможете найти на корпоративном сайте компании Siemens PLM Software по следующей 
ссылке: www.siemens.com/plm/ru/nx. 

Прежде чем начинать практическое изучение системы, скопируйте учебные файлы на 
жесткий диск вашего компьютера. Успешной работы!
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Глава 1. Интерфейс NX

Программный пакет NX представляет собой одну из самых популярных систем автомати-

зации задач разработки и производства изделий, используемой практически во всех отрас-

лях промышленности. Первая версия пакета NX, известного ещё как NX Unigraphics,  была 

выпущена в 2002 году, когда компания EDS PLM Solutions собрала на одной платформе ре-

шения пакетов Unigraphics и I-Deas. Как любая система САПР верхнего уровня, NX сочетает в 

себе функционал для решения задач конструирования и проектирования (CAD), инженерно-

го анализа (CAE) и подготовки производства (CAM). Этот функционал сгруппирован в прило-

жениях, объединённых на базе единого геометрического ядра Parasolid. Текущая версия NX 

7.5 выпущена для платформ Windows, Linux и MacOS. Так как разные операционные систе-

мы имеют свою реализацию отображения элементов интерфейса прикладных программ, то и 

в интерфейсе NX также имеются некоторые отличия в зависимости от платформы. Но общая 

логика работы системы и взаимодействия с пользователем не зависят от платформы, поэтому 

описание версии  NX для платформы Windows, используемой в этой книге, применимо и для 

других операционных систем. В этой главе предоставляется краткий обзор основных элемен-

тов интерфейса NX, на которых базируется вся работа пользователя в системе.

ЗАПУСК NX И ГЛАВНОЕ ОКНО

После инсталяции NX в списке программ Start > All Programs (Старт > Все программы) 

появится программная группа UGS NX 7.5 с набором ярлыков для запуска. Не будем оста-

навливаться сейчас на описании всех ярлыков, а щелчком мыши на ярлыке NX 7.5 запустим 

приложение.  Также во время инсталяции системы производится ассоциация файлов данных 

NX с расширением «prt» (и ряда других). Поэтому при двойном щелчке на файлах этого типа 

также будут произведёны запуск NX и загрузка соответствующего файла. После инициали-

зации приложения и проверки доступности ли-

цензии будет открыто главное окно системы. В 

случае с запуском по двойному щелчку на фай-

ле модели она будет загружена и отображена в 

графической области. Если же запуск был про-

изведён с помощью ярлыка, то вы можете соз-

дать новый файл модели или открыть существу-

ющий. Рассмотрим основные элементы главного окна приложения:

1 – заголовок окна, в котором помимо названия системы отображаются текущее приложе-

ние, имя рабочей детали и её состояние в случае изменения;

2 – строка главного меню, состав которой зависит от текущего активного приложения и 

роли; 

3 – панели инструментов, набор и состав которых также зависит от приложения и роли;

4 – панель выбора, которая содержит набор команд и опций, управляющих механизмом 

интерактивного выбора пользователя в процессе работы над моделью;

Рисунок 1.1 Запуск NX
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5 – строка статуса и подсказки, в которой отображаются контекстные подсказки для поль-

зователя и текущий статус выполнения операции;

6 – панель ресурсов, содержащая набор различных вкладок, каждая из которых отвеча-

ет за определённую функцию, например (рис. 1.2) вкладка Навигатор модели, отображаю-

щая дерево построения модели;

7 – кнопка переключения между стандартным и полноэкранным режимами;

8 – «рельс» крепления диалоговых окон. Этот элемент интерфейса предназначен для пози-

ционирования диалоговых окон команд, вызываемых пользователем;

9 – графическая область, в которой отображается моделируемая геометрия.

В данном случае NX работает в «классическом» режиме, характерном для всех Windows 

приложений. Существует ещё один режим – полноэкранный (рис. 1.3), переключаемый кноп-

кой (7).  Основное назначение данного режима – максимально расширить графическую об-

ласть и минимизировать количество отображаемых панелей инструментов и меню. Помимо 

кнопки (7), переключиться в полноэкранный режим можно, нажав Alt+Enter  или выбрав в 

строке главного меню команду View > Full Screen (Вид > Полный экран).

По сравнению со стандартным режимом, здесь нет множества панелей инструментов, 

строки главного меню и панели ресурсов – все они собраны в единый менеджер инстру-

ментов, который может отображаться как в расширенном, так и в сокращённом виде. Все 

остальные элементы интерфейса стандартного режима присутствуют. Полноэкранный режим 

подойдёт опытным пользователям, которые научились максимально использовать контекст-

Рисунок 1.2 Главное окно приложения
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ные меню команд, а также соответствующие клавиатурные сокращения. Все, что им нужно в 

этом случае, – максимально большое пространство, отображающие геометрию модели. Для 

менее опытных пользователей или для тех, кто любит пользоваться панелями инструментов, 

больше подойдёт стандартный режим.

ПРИЛОЖЕНИЯ
Как уже говорилось, набор панелей инструментов, их 

содержимое и состав главного меню зависят от текуще-

го активного приложения и роли. Приложением называ-

ется набор инструментов, решающих задачи определён-

ной области. Переключение между приложениями произ-

водится c помощью кнопки Start (Начало), либо исполь-

зуя соответствующую комбинацию клавиш. При наличии 

необходимой лицензии система запустит выбранное при-

ложение и отобразит набор инструментария, входящий в 

него. 

Некоторые приложения работают в сочетании с дру-

гими, некоторые работают поодиночке. Одним из ключе-

вых приложений является Gateway(Базовый модуль), 

оно само по себе не решает никаких задач проектирова-

ния, расчётов или производства, но работает как основа 

Рисунок 1.3 Полноэкранный режим

Рисунок 1.4 Приложения NX
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для других приложений и отвечает за операции взаимодействия с файловой системой, ото-

бражение геометрии и многое другое.

РОЛИ

Набор инструментов в рамках каждого приложения 

NX выражается в виде кнопочных инструментальных  па-

нелей и дополнительных элементов главного меню. Ред-

ко когда для решения какой-либо задачи в ход идут все 

возможные команды приложений, поэтому пользователи 

предпочитают отображать только часто используемые ко-

манды и убирать те, которые не нужны. Так, каждый поль-

зователь системы NX по мере освоения настраивает ин-

терфейс системы под себя. Для облегчения этого процес-

са в NX предусмотрен механизм ролей. Роль – это сохра-

нённое состояние интерфейса, в котором запоминаются 

набор отображаемых панелей и элементов меню, их со-

став и положение на экране. 

Для управления ролями в панели ресурсов существу-

ет вкладка Роли. В состав дистрибутива NX входит набор 

преднастроенных ролей, которые можно использовать в 

их изначальном виде, или  настроить на их основе свои 

роли. Для новых пользователей, которые только осваи-

вают систему, больше подойдёт роль Основы (Рекомен-

дуется) – будет отображён минимальный набор инстру-

ментальных панелей, каждая кнопка будет иметь назва-

ние под пиктограммой. Для более опытных пользователей 

более удобной может быть роль Расширенная с полным 

меню – количество отображаемых инструментов будет 

максимально, а кнопки будут иметь компактный вид без текста. 

ПАНЕЛИ ИНСТРУМЕНТОВ И ГЛАВНОЕ МЕНЮ

Инструментальные панели инструментов группируют команды по их функциональному на-

значению. Ряд панелей представлены только в определенных приложениях, как, например, 

панели простановки размеров в модуле Черчение (Drafting), другие панели присутствуют 

во всех приложениях, как, например, панель Вид (View) или Стандарт (Standard). Пользо-

ватель имеет возможность управлять как видимостью отдельных панелей на экране, так и их 

наполнением. Видимость панелей регулируется контекстным меню, появляющимся при нажа-

тии правой кнопки мыши на любой отображаемой панели или кнопке. 

Рисунок 1.5 Роли
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Практически все панели могут быть перемещены, прикреплены к другим краям графиче-

ской зоны или полностью откреплены. Для этого достаточно взять нужную панель за её ле-

вый край, обозначенный вертикальным рядом точек, и перетащить её. Перетаскивание в 

окрестностях её исходного положения будет перемещать панель относительно соседних па-

нелей, перетаскивание в графическую зону отсоединит панель полностью, а перетаскивание 

к какому-либо краю графической зоны прикрепит её к этому краю. Каждая кнопка инстру-

ментальной панели снабжена всплывающей подсказкой, которая появляется при наведении 

курсора мыши на кнопку.

Помимо инструментальных панелей, при работе исполь-

зуются общее главное меню приложения и большой набор 

контекстных меню, привязанных к конкретной команде или 

объекту. Главное меню приложения дублирует все команды 

инструментальных панелей,  большая часть которых содер-

жится в пунктах меню Вставить (Insert), Изменить (Edit) и 

Инструменты(Tools), а  также ряд дополнительных команд 

и опций. 

Контекстные меню существуют практически для всех объ-

ектов в NX и вызываются по нажатии правой кнопки мыши 

на этом объекте. При этом наполнение этих меню зависит 

от того, какой объект был использован для вызова. Так, на-

пример, щелчок правой кнопкой мыши на пустом простран-

стве графической зоны вызывает компактную панель выбора и меню, содержащее команды 

навигации и визуализации. А если вызвать контекстное меню, например. для ребра геометри-

ческого объекта, то оно будет содержать команды, которые могут быть применены к этому ре-

бру, такие как фаска и cкругление (рис.1.6). Это даёт возмож-

ность существенно ускорить работу при моделировании, так как  

большинство нужных команд находится всегда под рукой и нет 

необходимости их искать на инструментальных панелях. 

Ещё один механизм, полезный при работе над моделью, – на-

бор настраиваемых радиальных инструментальных панелей. Их 

можно отобразить, нажав одновременно Ctrl+Shift и одну из кно-

пок мыши. К каждой кнопке привязана своя панель (рис. 1.7). 

Меню отображается непосредственно возле курсора мыши, по-

этому имеет смысл поместить в эти радиальные панели наиболее 

часто используемые команды. 

Особенностью радиальных меню является то, что они зависят 

от текущего активного приложения, то есть их наполнение будет меняться в зависимости от 

того, в каком приложении работает пользователь.

Рисунок 1.6 Контекстное меню

Рисунок 1.7 Радиальное меню
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ПАНЕЛЬ РЕСУРСОВ 

Панель ресурсов представляет собой набор вкладок, содержащих навигаторы и палеты. 

Панель ресурсов в обычном режиме располагается по умолчанию по левой стороне окна 

приложения, а в полноэкранном режиме она является одной из вкладок менеджера инстру-

ментов. Наиболее часто используемые вкладки 

панели ресурсов:

1– навигатор сборки. Отображает структуру 

сборки и предоставляет инструменты в контекст-

ных меню для работы с компонентами сборок. 

Также в этом навигаторе производится работа с 

межмодельными связями WAVE;

2 – навигатор модели. Предоставляет доступ 

к истории построения модели и инструменты для 

работы с элементами построения;

3 – навигатор Базы знаний (Knowledge 

Fusion);

3 – библиотека данных повторного использо-

вания – интерфейс к библиотекам различных дан-

ных, которые могут быть классифицированы и ис-

пользованы в последующих разработках. Это мо-

гут быть стандартные изделия, типовые конструк-

тивные элементы, 2D блоки чертежей, шаблоны и 

многое другое;

4 – инструменты HD3D. Содержит функционал 

формирования визуальных отчетов и средств; 

5 – встроенный интернет – браузер. Как правило, используется для доступа к корпоратив-

ному сайту или документации NX;

6 – палета истории. Содержит ссылки, сгруппированные по дате на модели, которые за-

гружались в NX ранее;

7 – палета ролей. Содержит преднастроенные и пользовательские конфигурации (роли), 

управляющие компоновкой интерфейса.

Кроме базового набора навигаторов, отображенных по умолчанию в панели ресурсов, 

в зависимости от текущего активного приложения могут добавлять дополнительные вклад-

ки с навигаторами. В частности, это касается приложений Механическая и Электрическая 

маршрутизация.  

Помимо стандартных системных палет, есть возможность создавать свои, которые будут 

группировать какие-либо данные и обеспечивать быстрый доступ к этим данным. В большин-

стве случаев все объекты на палетах могуть быть использованы простым перетаскиванием в 

графическую область.

Рисунок 1.8 Панель ресурсов
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ДИАЛОГОВЫЕ ОКНА

Практически каждая команда во всех приложениях NX имеет диалоговое окно, через кото-

рое производится взаимодействие с пользователем. Диалоговое окно компонуется из функ-

циональных блоков, которые отвечают за определенный этап задания исходных данных для 

операции, выполняемой данным диалоговым 

окном, и кнопок ОК, Применить (Apply) и От-

мена (Cancel) (рис. 1.9) . 

По умолчанию позиционирование диалого-

вых окон определяется «рельсом» крепления, к 

которому привязывается диалог. Основное на-

значение «рельса» – задать определенное ме-

сто, в котором будут отображаться диалоги, 

хотя при желании пользователь может их откре-

плять и размещать их там, где удобно. С помо-

щью кнопки 4 диалог можно открепить от рельса 

и поместить на любое произвольное место экра-

на или закрепить свободный диалог на рельсе 

крепления. 

Для упрощения интерфейса и его унифика-

ции функциональные блоки диалогов повторя-

ются в различных командах. Например, если в 

диалоге команды вытягивания есть блок, отвеча-

ющий за указание направления вытягивания, то 

в любых других командах направление задает-

ся точно таким же блоком. 

Любая команда, как правило, имеет обяза-

тельные параметры, без которых она не может 

быть выполнена, и опциональные, которые мо-

дифицируют выполнение данной команды, но 

имеют некие значения, уже заданные по умол-

чанию.  Функциональные блоки, отвечающие за задание обязательных параметров, помече-

ны значком 1, а уже заданные параметры помечаются значком 2. Текущий блок, ожидающий 

ввода пользователя, помечается выделением оранжевого цвета.  

Как правило, все обязательные блоки в диалогах появляются в развёрнутом состоянии, 

другие же могут  быть как свёрнутом (3), так и в развёрнутом виде. Некоторые диалоговые 

окна содержат большое количество параметров, поэтому занимают достаточно  большое  

пространство, даже когда часть блоков находится в свёрнутом состоянии. В этом случае мож-

но воспользоваться кнопкой  (6), которая спрячет все свёрнутые блоки.  

NX запоминает состояние диалоговых окон – их положение на экране и состояние блоков, 

поэтому каждый раз диалог будет появляться в том же состоянии, в котором он был при по-

Рисунок 1.9 Диалоговые окна
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следнем его использовании, а именно при нажатии кнопок «ОК» или «Применить».

Команда не может быть выполнена, пока не будут заданы все обязательные параметры, и 

как следствие – кнопки выполнения ОК и Применить остаются деактивированными.  

Кнопки ОK и Применить отличаются тем, что при нажатии кнопки ОК (или средней кноп-

ки мыши) происходят выполнение команды и закрытие диалога, а при нажатии кнопки При-

менить (или средней кнопки мыши при нажатой клавиши Ctrl) происходит выполнение коман-

ды и диалог возвращается в исходное состояние для задания параметров следующего выпол-

нения этой команды.  Кнопка Отмена (или нажатие средней кнопки мыши при нажатой клави-

ше Alt) сбрасывает все заданные параметры и закрывает диалог. С помощью кнопки 5 можно 

сбросить все введеные и выбранные параметры в исходное состояние.

Отдельно стоит упомянуть блок предвари-

тельного просмотра результатов команды. Этот 

блок присутствует в диалогах большинства ко-

манд и расположен в самом низу окна. Он по-

зволяет вам просмотреть результат выполнения 

команды до того, как эта команда будет выпол-

нена и операция будет записана в историю по-

строения модели. Опция Просмотр (Preview), 

включённая по умолчанию, заставляет систе-

му показывать предварительный результат каж-

дый раз, когда пользователь меняет какие-либо 

параметры в диалоговом окне. Это достаточно 

удобно при варьировании параметрами в опе-

рациях, однако для больших и сложных моделей 

имеет смысл выключить эту опцию, так как в этом случае предпросмотр будет занимать дли-

тельное время. В этом случае при деактивации опции Просмотр можно в ручном режиме 

пользоваться кнопкой Показать результат (Show preview), когда необходимые параметры 

будут заданы.

Если функциональный блок предполагает ввод какой-либо геометрической информации 

или выбор объектов, то  он будет иметь кнопку-меню выбора объектов (9) и кнопку создания 

объекта (8). Кнопка  создания объекта позволяет  определить необходимый объект сразу из 

диалога команды, то есть не прерывая её выполнения.  Кнопка-меню выбора или предлагает 

различные варианты  объектов – например, координатные оси для выбора направления, или 

включает режим выбора объектов нужного типа – например, выбор кривых для операции 

вытягивания. Параметры, предполагающие некое числовое выражение,  как правило, могут 

вводиться непосредственно значением или ссылкой – это задается  специальной опцией (10). 

В качестве  ссылки могут быть измерение какого-либо объекта, расстояние до  объекта и т.д.   

Если параметр вводится как числовое значение, то  в большинстве диалогов пользователю 

пердоставляется выбор – ввести саму цифру в текстовое поле (11), задать выражение или 

формулу. Числовые параметры, имеющие явное выражение, как, например, расстояние, на 

которое надо вытянуть плоский профиль,  можно вводить непосредственно на геометрической 

Рисунок 1.10 Ввод значений
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модели с помощью специальных маркеров (рис. 1.10). 

ВЫБОР ОБЪЕКТОВ

Механизм выбора объектов является одним из ключевых для работы пользователя. Любое 

задание параметров команд сводится к назначению неких числовых параметров и выбору 

каких-либо объектов. Для управления логикой выбора и фильтрации выбираемых объектов 

NX предоставляет набор вспомогательных инструментов, реализованных в виде инструмен-

тальной панели и контекстных меню.

Инструментальная панель выбора всегда располагается в верхней части главного окна 

под всеми остальными включёнными панелями и непосредственно над графической областью 

(рис. 1.11). При этом пользователь может получить доступ к компактному виду панели выбо-

ра, нажав правую кнопку мыши непосредственно на графической области.

Панель выбора содержит блок фильтров выбора, блок управления множественного выбо-

ра и блок привязок. 

Фильтры выбора позволяют ограничить выбор по 

определённому признаку. Первый фильтр в виде выпа-

дающего списка (1) определяет, какой тип геометрии 

может быть выбран.  По умолчанию фильтр не установ-

лен, поэтому выбираются объекты всех типов, что не 

всегда удобно. Второй выпадающий список определяет 

контекст, в котором производится выбор (2) – в текущей 

детали, во всей сборке или в текущей детали и во всех 

входящих компонентах. Это наиболее часто используе-

мые фильтры выбора. Дополнительно в этом блоке представлены фильтры, работающие по 

другим признакам, такими как цвет, слой, наименование, атрибуты, а также ряд вспомога-

тельных инструментов, которые будут рассмотрены ниже. 

Выпадающий список (3), а также набор кнопок (4) определяют логику работы системы при 

Рисунок 1.11 Панель выбора

Рисунок 1.12 Приоритет выбора
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выборе множества объектов. Они устанавливают текущий режим выбирания объектов в за-

висимоти от некоторых геометрических условий. Так, например, режим выбора Связанные 

кривые (Connected Curves) заставляет систему выбирать все кривые, которые соединяются 

с кривой, выбранной пользователем. Совместное использование фильтров и режимов выбо-

ра дает существенный рост в производительности при работе в системе. 

Ещё один аспект механизма выбора объектов, который надо иметь в виду и использовать, 

– это приоритетность выбора. По умолчанию, если не применяется какой-либо фильтр выбо-

ра из списка (1), приоритетность выбора регулируется автоматически в зависимости от теку-

щего приложения. Пользователь может задавать приоритет через раздел главного меню Из-

менить > Выбор (Edit > Selection) или, что более эффективно, используя соответствующие 

клавиатурные сокращения (рис. 1.12)

Блок геометрических привязок на инструментальной панели Выбор позволяет выбирать и 

привязываться к точкам на объектах в зависимости от геометрических условий. 

В зависимости от текущих настроек фильтров при манипуляциях мышью в графической об-

ласти будут подсвечиваться какие-либо геометрические объекты. Это функция предваритель-

ного выбора. Так система показывает, какие объекты будут считаться выбранными, если поль-

зователь нажмёт кнопку мыши. 

Если задержать курсор мыши на каком-нибудь объекте, то в большинстве случаев через 

некоторое время (интервал задержки настраивается) вид курсора сменится на перекрестье с 

многоточием. Это означает, что возможен выбор из нескольких объектов. И если в этом ре-

жиме нажать курсор мыши, то появится список объектов, доступных для выбора, из которого 

надо выбрать необходимые.

УПРАВЛЕНИЕ
Управление в системе реализовано преимущественно на основе манипуляций с помощью 

мыши – как при навигации по геометрической модели, так и при выборе команд и вводе дан-

ных. Основные команды навигации имеют дублирование в виде команд на инструментальной 

панели Вид (View), но их использование неэффективно по сравнению с навигацией с помо-

щью мыши. Имеются три основных режима навигации:

• Вращение модели вокруг точки ( движение курсора при зажатой средней кнопки 

мыши);  

• Уменьшение / увеличение изображения (прокрутка колёсика мышки на средней кноп-

ке или движение курсора при зажатой средней кнопки и клавише Ctrl); 

• Перемещение по модели (движение курсора при зажатых средней и правой кнопках 

мыши или движение курсора при зажатой средней кнопке и клавише Shift).

Дополнительно к этому движение курсора мыши при зажатой средней кнопке вдоль лево-

го или правого края графической области будет вращать модель вокруг горизонтальной оси 

экрана. Если то же самое делать возле нижнего или верхнего края графической области, то 

вращение модели будет производиться вокруг вертикальной оси экрана и оси, перпендику-
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лярной плоскости экрана соответственно. Во всех трёх случаях курсор мыши будет менять 

свой вид. 

Вращение модели при нажатой средней кнопке мыши производится вокруг точки, которую 

можно задать, нажав клавиатурное сокращение Ctrl+F2 или выбрав соответствующий пункт 

контекстного меню, появляющегося при нажатии правой кнопки мыши в пустом месте графи-

ческой области. 

Если есть необходимость производить вращение вокруг 

координатной оси системы координат, то для этого необхо-

димо щелчком левой кнопки мыши по символу триады ко-

ординатных  осей в нижнем левом углу графической об-

ласти выбрать ось (рис. 1.13). После этого вращение при 

движении курсора мыши с зажатой средней кнопкой будет 

производиться только вокруг заданной оси. Для выхода из 

этого режима необходимо щёлкнуть правой кнопкой мыши 

на белом маркере – начале символов координатных осей 

триады. 

ОРГАНИЗАЦИЯ МОДЕЛИ
Доступ пользователя к файлам моделей, находящихся на файловой системе или в 

Teamcenter, осуществляется с помощью инструментальной панели Стандарт или раздела 

главного меню Файл, которые содержат команды, стандартные для Windows-приложения, 

команды по работе с файлами. Файлы моделей представляют собой унифицированную струк-

туру, которая может хранить в себе геометрические данные модели с историей построения, 

ссылки на другие модели (то есть являться сборкой) и вторичные данные, такие как листы чер-

тежа. Пространство модели условно разбито на видимое и невидимое подпространства, ко-

торые используются для скрытия и отображения объектов. Контекстные меню всех геометри-

ческих объектов, появляющиеся по нажатии правой кнопки мыши на объекте, содержат ко-

манду Скрыть (Hide), которая перемещает этот 

объект между подпространствами. Дополнительно 

в разделе главного меню Изменить > Показать и 

Скрыть (Edit > Show and Hide) имеется набор ко-

манд управления видимостью объектов (рис. 1.14).  

Также пространство модели разделено на 256 

слоев, собираемых в категории. В общем случае 

слои используются для группировки объектов по 

какому-либо признаку. Во время работы в систе-

ме какой-то один из слоёв является рабочим, и 

все создаваемые объекты попадают на этот слой. 

Вы можете управлять состоянием слоев, а также 

распределять геометрические объекты по ним че-

Рисунок 1.13 Вращение вокруг осей

Рисунок 1.14 Команды управления види-

мостью
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рез пункт главного меню Формат > Настройки слоя 

(Format > Layer Settings) или через соответствующую 

команду инструментальной панели Утилиты (Utilities). 

Каждый слои имеет состояние видимости и выбираемо-

сти, и только один слой в текущий момент времени мо-

жет быть рабочим. Состояние видимости слоя означает, 

что все объекты на этом слое будут отображены в графи-

ческой зоне, а состояние выбираемости позволяет вы-

бирать объекты на этих слоях.  

Продуманная группировка объектов по слоям и управ-

ление их состоянием позволяют существенно повысить 

качество и читаемость моделей.

В пространстве модели всегда присутствуют как минимум одна абсолютная и одна рабо-

чая система координат (РСК), которая по умолчания совпадает с абсолютной. Абсолютная 

система координат не отображается явно, но её ориентация показывается символом триады 

координатных осей в левом нижнем углу. Положение всех остальных СК в пространстве моде-

ли отсчитывается от нуля абсолютной системы. Все геометрические построения выполняются 

на базе одной из систем координат, но в большинстве случаев это бывает именно РСК. При 

необходимости вы можете вводить дополнительные системы координат и назначать их рабо-

чими, для этого вспользуйтесь командами главного меню Вставить > База/точка > Коорди-

натная СК (Insert > Base > Datum CS). А для манипуляций с существующими СК воспользуй-

тесь разделом главного меню Формат > РСК (Format > WCS) или производите изменения 

РСК динамически с помощью маркеров перемещения и вращения, появляющихся после двой-

ного щелчка мышью на РСК. 

Рисунок 1.15 Команды управления 

слоями
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ОСНОВНЫЕ ПОНЯТИЯ
Создаваемые геометрические тела в NX делятся на поверхности и твердые тела. Одним 

из подвидов твердого тела является модель детали из листового металла, для создания кото-

рой предлагается несколько специализированных приложений NX. Твердотельное моделиро-

вание представляет собой создание замкнутого геометрического объема, описывающего ге-

ометрию детали. Для этого используются примитивы, получаемые вытягиванием и вращени-

ем плоских контуров, конструктивные элементы и логические операции комбинирования тел. 

Явно выраженного модуля твердотельного моделирования в NX нет, так как для этого приме-

няются инструменты из разных приложений. В частности, твердые тела можно получать путем 

придания толщины поверхности созданной, в приложении Студия формы, или заполнением 

замкнутого контура из поверхностей.

Основная цель моделирования твердых тел – создать точное геометрическое представ-

ление проектируемой детали, которая будет основой для выпуска документации, проведе-

ния расчётов и написания программ ЧПУ. С точки зрения системы, геометрическое представ-

ление является результатом связанной последовательности операций, составляющих дерево 

построения модели. Работа пользователя сводится к добавлению операций в дерево построе-

ния, создающих те или иные конструктивные элементы или модифицирующие геометрию. Это 

справедливо для классического случая моделирования с историей построения. NX также под-

держивает моделирование без истории построения, о чем пойдет речь в отдельной главе. В 

данной главе будет дан обзор основных средств создания твердотельных моделей при моде-

лировании с историей построения. 

Для создания моделей вы можете использовать типовые конструктивные элементы или соз-

давать тела на базе двумерных контуров, а также комбинировать эти два способа. Эскизы яв-

ляются основой для всех тел, получаемых вращением или протягиванием вдоль траектории.

ЭСКИЗЫ
Эскизом считается именованная группа двумерных кривых, связанных геометрическими и 

размерными отношениями и расположенных на одной плоскости. Вы можете создавать эски-

зы на основе любого существующего плоского объекта, а также на кривой. В последнем слу-

чае в точке кривой, где будет привязан эскиз, система создаст плоскость, расположенную по 

нормали к кривой. Данный тип расположения эскизов используется для создания тел протяги-

ванием эскиза вдоль траектории.

Начиная с версии NX7.5 для создания эскиза предлагаются два набора инструментов 

– Эскиз в среде задач (Sketch in Task Environment) и инструментальная панель Прямой 

эскиз (Direct Sketch).  Первый представляет собой отдельный модуль, который запускается 

вызовом команды Вставить > Эскиз в среде задач и предназначен для редактирования эски-

зов, на которые ссылаются много конструктивных элементов. Прямой эскиз позволяет стро-

ить двумерные контуры непосредственно в текущем приложении NX и больше подходит для 

создания новых эскизов. Функционально эти два средства создания эскизов отличаются на 

три команды: Кривая пересечения (Intersection Curve), Точка пересечения (Intersection 
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Point) и Проецирование кривой (Projected Curve), которые отсутствуют в Прямом эскизе.

Для создания эскиза в среде задач вызовите соответствующую команду из главного меню 

и укажите плоскую поверхность размещения эскиза (рис. 2.1). Если эскиз должен распола-

гаться на кривой, то необходимо выбрать соответствующий подтип эскиза в выпадающем 

списке диалога. Обычно для задания исходных данных эскиза достаточно только указания 

плоскости. Но иногда бывает полезным (а в некоторых случаях обязательным) указать на-

правление оси Х и начало системы координат в опциях диалога Ориентация эскиза (Sketch 

Orientation) и Начало эскиза (Sketch Origin). После задания этих параметров или приня-

тия значений по умолчанию система координат эскиза расположится на плоскости и будет 

открыта среда создания эскиза с соответствующим инструментарием.

Прямой эскиз может также задаваться с помощью аналогичного диалога, для этого не-

обходимо нажать кнопку Эскиз (Sketch) на инструментальной панели Прямой эскиз. Но 

Рисунок 2.1. Создание эскиза в среде задач

Рисунок 2.2. Создание прямого эскиза
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можно, просто выбрав на этой панели команду рисования какого-либо двумерного объекта, 

и начать его рисовать на любой плоской грани тела или плоскости (рис. 2.2). В этом случае 

направление системы координат и её начало будут приняты по умолчанию.

Дальнейшая работа по созданию плоского контура одинакова для обоих инструментов 

создания эскизов. С помощью команд рисования геометрии на инструментальной панели 

Инструменты эскиза (Sketch Tools) рисуется геометрия, 

на которую потом накладываются размерные и геометри-

ческие ограничения (рис. 2.3). 

В момент рисования того или иного двумерного объекта 

система пытается автоматически определить, каким геоме-

трическим ограничениям он подчиняется, и накладывает эти 

ограничения. Этот режим регулируется кнопкой Создать 

контекстные ограничения (Create Inferred Constraints). 

Для ручного задания ограничений или для задания до-

полнительных ограничений необходимо воспользоваться 

кнопкой Ограничения (Constraints). При выборе гео-

метрии эскиза в диалоговом окне команды будут отобра-

жаться те ограничения, которые наложены на выбранную 

геометрию и которые можно наложить (рис. 2.4). В зависи-

мости от количества и типа выбранных объектов будут ото-

бражаться разные типы ограничений. Если придерживаться 

правильного подхода к проектированию, то все элементы 

эскиза должны быть связаны размерными и геометрически-

ми ограничениями – то есть эскиз должен быть полностью 

определенным и не иметь свободных степеней свобод. Это 

гарантирует предсказуемость и управляемость эскиза при 

Рисунок 2.3. Инструменты построения эскиза.

Рисунок 2.4. Задание геометриче-

ских условий
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изменениях геометрических элементов модели, на которые ссылается эскиз.

В версии NX7.5 был представлен механизм постоянного образмеривания, который ре-

гулируется одноименной кнопкой на панели Прямой эскиз. Этот механизм автоматически 

накладывает размерные ограничения на все создаваемые элементы эскиза, тем самым обе-

спечивая определенность эскиза. При этом создаваемые размерные ограничения являются 

вторичными. Это выражается в том, что автоматически сгенерированные размерные ограни-

чения удаляются при добавлении пользователем любого ограничения, которое с ними кон-

фликтует.  Таким образом, эскиз остается всегда определенным – вне зависимости от того, 

сколько ограничений было наложено пользователем. Очевидно, что автоматически добав-

ленные размеры не могут реализовывать задуманную логику изменений эскиза, поэтому не-

обходимо либо принять предложенные размеры, либо переопределить их в ручном режиме. 

Для принятия размерного ограничения, 

созданного системой, необходимо произ-

вести двойной щелчок левой кнопкой мыши 

на выбранном размере. В модели будет 

создан соответствующий параметр, значе-

ние которого будет связано со значением 

размера, – то есть размер станет таким, 

как если бы он был поставлен вручную.

При необходимости использования су-

ществующих ребер модели в эскизе их 

можно спроецировать на текущую пло-

скость эскиза с помощью команды Про-

ецирование кривой (Projected Curve). 

Также с помощью команды Кривая пере-

сечения (Intersection Curve) можно по-

лучить пересечение плоскости эскиза с 

выбранной гранью тела. Обе команды создают ассоциативные кривые, которые отслеживают 

состояние исходных геометрических элементов (рис. 2.5). 

После завершения построения геометрии эскиза и наложения размерных и геометриче-

ских ограничений необходимо нажать кнопку Закончить эскиз (Finish Sketch) для выхода из 

режима создания эскиза. Для редактирования существующего эскиза необходимо выбрать 

его двойным щелчком левой кнопки мыши в Навигаторе модели или графической области. 

Давайте на практическом примере рассмотрим построение простого эскиза:

• Запустите NX7.5 и с помощью команды главного меню Файл  > Новый (File > New) соз-

дайте новую модель.

• Вставьте рабочую систему координат в новую модель, воспользовавшись пунктом меню 

Вставить > База/Точка > Координатная СК (Insert > Datum/Point > Work CSYS). 

Она по умолчанию совпадет с абсолютной системой координат модели.

• Расположите новый эскиз в плоскости YZ, выбрав пункт главного меню Вставить > Эскиз 

Рисунок 2.5. Проецирование кривых
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в среде задач и указав соответству-

ющую плоскость. В диалоге создания 

эскиза примите все предложенные зна-

чения опций и нажмите ОК для перехо-

да в среду редактирования эскиза.

• С помощью команды Профиль по-

стройте контур примерно так, как это 

показано на рис. 2.6. Замыкая контур, 

сделайте перехлест прямых, чтобы они 

пересекались с некоторым запасом. 

Это необходимо для демонстрации 

функции выбора и обрезки. 

• С помощью инструментов Контекст-

ный размер и Ограничения задайте 

некоторые размеры и ограничения. 

Как правило, первое, что необходимо сделать при образмеривании,–это задать стацио-

нарные объекты, относительно которых будут располагаться другие элементы эскиза. Задать 

стационарный объект можно, сославшись на грань или ребро другого тела или привязавшись 

к осям системы координат. 

• Нажмите кнопку задания ограничений и выберите одну из вертикальных прямых, а затем ось 

Y. В диалоге команды будут отображены возможные геометрические ограничения. Выберите 

условия коллинеарности (рис. 2.7).

• То же самое проделайте с горизонтальной прямой и осью X. Таким же образом можно за-

давать положение какого-либо конца кривой или отрезка на оси системы координат или 

на другой кривой – при этом необходимо подвести курсор к 

концу отрезка и дождаться, пока загорится маркер точки.

• Задайте размеры относительно стационарных элементов.

• Полученный искусственно перехлест можно устранить в эскизе 

с помощью команд Создать угол или Быстрая обрезка на 

панели инструментов эскиза. Но на данном этапе можно его 

оставить и выйти из эскиза.

• Сохраните модель для продолжения работы с ней в следую-

щем разделе.

Рисунок 2.6. Создание эскиза

Рисунок 2.7. Условие колли-

неарности
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СОЗДАНИЕ ТЕЛ
Для созданий тела на основе эскиза необходимо воспользоваться одной из команд вытяги-

вания эскиза в заданном направлении или вращения вокруг оси. Наиболее часто используе-

мые их них–это команды Вытягивание (Extrude) и Вращение (Revolve), распложенные на 

инструментальной панели Элемент (Feature) или в разделе главного меню Вставить  > Эле-

менты проектирования (Insert > Feature). 

Рассмотрим команду Вытягивание (рис. 2.8). Для её работы необходимый минимальный 

набор исходных данных состоит из плоского контура или прямой и вектора направления, 

которые задаются соответственно в разделах диалога Сечение (Sections) и Направление 

(Direction). При этом возможно сразу из команды запустить редактор эскиза и нарисовать 

его с нуля. В этом случае эскиз будет считаться внутренним и не будет доступен в Навигато-

ре модели до тех пор, пока не будет сконвертирован во внешний. В качестве контура для вы-

тягивания могут выступать любые кривые, в том числе и ребра существующих тел. 

При выборе плоского контура направление по умолчанию определяется по нормали к пло-

скости контура, но при необходимости его можно переопределить, нажав кнопку Задать 

вектор (Specify Vector). В разделе Ограничения (Limits) задаются лимиты перемещения 

эскиза от плоскости его построения в обе стороны. Они могут задаваться как напрямую, ука-

занием величин, так и ссылкой, с помощью выбора одного из следующих значений опции:

До следующего (Until Next) – контур будет вытянут до пересечения с другим твердым те-

лом, встреченным в направлении вытягивания;

До выбранного (Until Selected) – контур будет вытянут до выбранной грани существу-

ющего тела или поверхности. Если вытянутый контур не полностью пересекает выбранную 

грань или поверхность, то по возможности будут использоваться смежные грани или поверх-

ности. Если такой возможности нет, то будет сгенерировано сообщение об ошибке;

До расширенного (Until Extended) – модификация опции До выбранного, которая по-

Рисунок 2.8. Диалог команды Вытягивание
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зволяет выбирать ограничивающие объекты, не полностью пересекающие протягиваемый 

контур. В этом случае система автоматически рассчитывает продолжение выбранной грани 

или поверхности и использует её для построения;

Через все (Through All) – протягивает контур в заданном направлении через все встре-

чающиеся тела;

В разделе диалога Булевы операции (Boolean) можно сразу задать тип логической опе-

рации, применяемой к телу, если в модели уже есть твердые тела. Среди возможных значений 

этой опции следует отметить значение Контекстный (Inferred). При этом значении система 

сама определяет подходящий тип операции, исходя из взаимного расположения создаваемо-

го тела и существующего. Такой вариант следует применять, когда не предполагается измене-

ния модели, которое может вызвать изменение взаимного 

расположения задействованных тел, иначе тип применяе-

мой логической операции может измениться.

Одновременно с вытягиванием контура можно задать 

дополнительные трансформации получаемого тела в раз-

делах Уклон (Draft) и Смещение (Offset) или воспользо-

ваться соответствующими командами после создания эле-

мента вытягивания.

Тип получаемого тела определяется в разделе диалога 

Настройки (Settings), но эта опция действует только в слу-

чае использования замкнутого контура, в противном слу-

чае получаемый элемент вытягивания будет представлять 

собой поверхность.

Команда Вращение по большинству параметров со-

впадает с командой Вытягивание, только ей необходимо 

указывать ось вращения и точку начала для получения тела Рисунок 2.10. Конструктивные эле-

менты

Рисунок 2.9. Дерево построения модели
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вращения проворотом на заданный угол выбранного эскиза. 

После получения первого тела в модели далее можно изменять его с помощью конструк-

тивных элементов или проводя операции логического сочетания с другими телами. Все опера-

ции будут добавляться согласно хронологии создания в дерево построения, отображаемое в 

Навигаторе модели (Part Navigator) (рис. 2.9).

Помимо операций получения тел вытягиванием или вращением эскиза, в разделе главного 

меню Вставить > Элементы проектирования предлагается набор предопределенных прими-

тивов и конструктивных элементов, комбинируя которые можно получить геометрию модели. 

Но в общем случае создание тел вытягиванием и вращением является более универсальным, 

так как позволяет задать любое сечение (рис. 2.10).

Продолжим работу с эскизом, созданным в предыдущем разделе.

• Вызовите команду Вытягивание и выберите сделанный эскиз. Возникнет сообщение об 

ошибке, так как эта команда может работать либо с замкнутым контуром, либо с открытым, 

но не работает в случае с перехлестом. Как уже говорилось, перехлест можно устранить со-

ответствующими инструментами эскиза, но можно пойти более простым путём.

• На панели выбора установите правило Связанные кривые и включите режим отслежива-

ния пересечений, нажав кнопку Остановка по пересечению. После этого укажите одну 

из кривых в замкнутом контуре эскиза. На этот раз эскиз будет воспринят, а лишние кривые 

будут проигнорированы (рис. 2.11).

• В разделе диалога Ограничения выберите Симметричное значение (Symmetric Values) 

в выпадающем списке Конец (End) и задайте какое-то числовое значение. При таком режиме 

задания пределов тело будет получаться путем вытягивания в обе стороны от плоскости эскиза. 

Рисунок 2.11. Вытягивание эскиза
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• Завершите построение эскиза нажатием кнопки ОК в диалоге.

Элемент вытягивания был построен на базе заранее созданного эскиза. Многие команды 

в NX, которые в качестве входных данных принимают плоские кривые или эскизы, позволяют 

создать его во время выполнения команды.

• Вызовите ещё раз команду Вытягивание и вместо выбора кривых нажмите кнопку создания 

эскиза в разделе Сечение и выберите ту же плоскость, где был расположен первый эскиз.

• С помощью команды Пересечение получите пересечение плоскости эскиза с двумя вну-

тренними гранями (рис. 2.12), а затем отрезком замкните контур, соединив конечные точки 

кривых, и завершите построение эскиза.

Рисунок 2.12. Прямые пересечения с плоскостью эскиза

Рисунок 2.13. Добавление тела
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• Задайте симметричное значение и в разделе Булевы операции убедитесь в том, что систе-

ма выбрала операцию объединения, после чего завершите построение тела (рис. 2.13).

• Откройте Навигатор модели. Выделите последний построенный элемент и в контекстном 

меню по правой кнопке мыши выберите пункт Сделать эскиз внутренним (Make Sketch 

Internal). Эскиз будет помещен внутри элемента вытягивания. Для обратной операции – соз-

дания независимого эскиза – необходимо воспользоваться пунктом контекстного меню на 

элементе Сделать эскиз внешним (Make Sketch External). 

• Сохраните модель и закройте её.

Таким образом, создавая тела на основе эскизов или используя стандартные контсруктив-

ные элементы, вы формируете геометрию модели. При создании модели в режиме моделиро-

вания с историей построения необходимо стараться сохранять читаемость истории построе-

ния и делать её максимально линейной. 

Практически все операции в дереве построения модели основываются на одном или не-

скольких предыдущих элементах, как явно, так и неявно. С одной стороны, это дает использо-

вать все преимущества параметризации, но с другой – непродуманная привязка элементов 

друг на друга могут испортить логику построения модели.

В общем случае при привязках рекомендуется отдавать предпочтение стационарным объ-

ектам или объектам вероятность изменения которых минимальна. Естественно это не должно 

быть в противоречии с задуманной логикой модели. 

При использовании каких-либо геометрических объектов предыдущих элементов построе-

ния желательно стараться ссылаться на ближайшие к текущей операции элементы. Это позво-

лит, как минимум, быстро отслеживать связь между изменением ссылочной геометрии и  по-

лучаемым результатом.

Также рекомендуется документировать модели.  В процессе построения появляется мно-

жество вспомогательных элементов, эскизов, кривых и прочих объектов, которые усложняют 

чтение модели, если они не организованы. Для организации можно использовать слои и ссы-

лочные наборы, размещая и группируя на них основные и вспомогательные геометрические 

элементы построения.

НАВИГАТОР МОДЕЛИ
Навигатор модели служит для отображения и навигации по элементам построения и пре-

доставляет ряд инструментов для работы с ними. Он может работать в режиме отображения 

хронологии, то есть отображает историю построения, и в режиме отображения тел в модели 

с их составляющими. 

Нажимая правую кнопку мыши на элементах построения, можно отображать контекстное меню 

со специфичными командами для данного типа элементов, но ряд команд одинаков для всех эле-

ментов. Рассмотрим основные команды контекстного меню, используемые при работе (рис. 2.14):

Изменить параметры (Edit Parameters) – открывает окно редактирования элемента или 

окно с параметрами элемента,  в зависимости от того, какой элемент был выбран. Особен-
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ностью этой команды является то, что она поддер-

живает множественный выбор – в этом случае будет 

открыто окно с параметрами всех выбранных элемен-

тов. 

Изменить с откатом (Edit with Rollback) – акти-

вирует режим редактирования выбранного элемента 

с откатом истории построения на момент создания 

данного элемента.

Подавить (Suppress) – деактивирует выбранный 

элемент в истории построения. Если этот элемент яв-

ляется родителем для других объектов в дереве по-

строения, то они также будут деактивированы.

Переставить перед/после (Reorder before/

after) – перемещает выбранный элемент в дереве по-

строения. Возможность переместить элемент опреде-

ляется его связями с соседними элементами. 

Группа элементов (Group) – открывает диалог 

задания группы элементов. Группы служат для умень-

шения дерева построения и создания логических бло-

ков, из которых состоит модель.

Замена (Replace) – открывает диалог перезада-

ния исходных данных для выбранного элемента.

Показать размеры (Show Dimensions) – отобра-

жает размерные линии, соответствующие значениям, 

заданным в момент создания элемента.

Сделать элемент текущим (Make Current Feature) – откатывает историю построения 

модели до выбранного элемента.

Все эти команды используются для внесения изменений в элемент модели и контроля 

процесса их прохождения по дереву построения. Обычно редактирование какого-то эле-

мента модели совершается путем двойного щелчка правой кнопкой мыши на элементе. 

Открывается диалоговое окно, соответствующее этому элементу, в котором можно про-

извести нужные изменения. Когда необходимо производить изменения в сложной детали 

или когда происходит сбой в прохождении изменения по дереву построения, то с помощью 

команд Изменить с откатом и Подавить можно локализовывать сложные участки дерева 

построения и проводить изменения шаг за шагом.

ВЫРАЖЕНИЯ
Выражения модели представляют собой набор всех параметров, созданных пользовате-

лем или операциями построения. Практически каждый создаваемый геометрический объект 

Рисунок 2.14. Контекстное меню элемен-

та построения модели
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является ассоциативным и параметрическим, все числовые параметры объектов попадают 

в выражения модели. С помощью диало-

га редактирования и задания выражений 

можно изменять текущие значения параме-

тров или связывать их формулами. Диалог 

открывается с помощью пункта главного 

меню Инструменты > Выражения (Tools 

> Expressions) (рис. 2.15). С помощью 

выпадающего списка можно фильтровать 

отображаемые параметры по типу. 

Так как наименование параметрам эле-

ментов система даёт автоматически, то в 

моделях достаточно трудно определить 

по имени параметра, к какому конкретно 

объекту он относится. Для этого в выпада-

ющем списке фильтра отображения используется значение Параметры объекта (Object 

Parameters), которое отобразит все параметры выбранного в графической области объекта. 

При связывании параметров с помощью формул можно ссылаться на параметры другой 

модели, что создаст параметрическую межмодельную связь. Для этого используется кнопка 

Создать ссылку между деталями. Создание такого рода связей будет обсуждаться в по-

следующих главах. 

Создание пользовательского параметра сводится к заданию его имени в соответствующем 

текстовом поле, выбора типа и задания числового значения или формулы. Рассмотрим на 

примере задание пользовательских параметров и их использование в модели:

• Запустите NX7.5 и откройте файл Expressions.prt из папки ch2.

• Выберите пункт главного меню Инструменты > Выражения для отображения диалога за-

дания выражений.

• Создайте новый параметр, введя в поле Имя (Name) значение Holes, выбрав тип Число 

(Number) и подтип Постоянный (Constant). В поле Формула (Formula) введите зна-

чение 8 и нажмите кнопку с зеленой галкой. Параметр будет создан, и теперь его можно 

использовать. 

• Закройте диалог выражений и с помощью команды главного меню Вставить > Ассоциа-

тивная копия > Элемент массива (Insert > Associative Copy > Instance Feature) вы-

зовите диалог определения массива.

• В появившемся диалоге выберите Круговой массив (Circular Array), в следующем диало-

ге выберите Простое отверстие.

• В открывшемся диалоге задания параметров в поле Число (Number) введите N, а в поле 

Угол (Angle) введите A=360/N – такая формулировка говорит о том, что значение опреде-

Рисунок 2.15. Диалог задания выражений
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ляется параметром А, вычисляемым по формуле 360/N. То есть это ещё один альтернатив-

ный способ создания пользовательских параметров из диалогов команд (рис. 2.16).

• Далее нажмите ОК и в новом диалоге нажмите Координатная ось (Datum Axis), а за-

тем укажите в графической области ось Z. Подтвердите создание массива и закройте диалог 

с отображением результатов. Будет создан массив элементов на основе заданных пользова-

тельских параметров.

Теперь, изменяя значение параметра N, мы можем управлять массивом отверстий. Для из-

менения параметра можно воспользоваться диалогом Выражения, но проще всего изменить 

параметры, созданные пользователем, развернув в Навигаторе модели группу Выраже-

ния пользователя. Выбрав параметр двойным щелчком, можно изменить его значение (рис. 

2.17).

С помощью параметров также можно управлять состоянием подавления отдельных элемен-

тов в модели. 

Рисунок 2.17. Отображение параметров в Навигаторе модели

Рисунок 2.16. Создание кругового массива объектов
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• Выберите в истории построения элемент Вы-

тягивания, формирующий паз в  централь-

ном отверстии. В главном меню выберите 

пункт Изменить > Элементы > Подавле-

ние по выражению (Edit > Feature > 

Suppress By Expression).

Откроется диалог создания переменных, от 

которых будет зависеть состояние подавления 

одного или нескольких конструктивных элемен-

тов в дереве построения. В данном случае у нас 

элемент только один, поэтому подойдут опции, 

заданные по умолчанию. В общем случае вы 

можете создать одну переменную на группу 

элементов или создать отдельную переменную 

на каждый элемент в группе. Это регулируется выпадающим списком Опция выражения 

(Expression Option).

• Нажмите Применить в диалоге и закройте его. Отобразите диалог задания выражений и 

отобразите все выражения в модели, выбрав значение Все (All) в выпадающем списке. 

• Найдите созданную переменную. Так как имя задает система, то она будет отображена 

последней в списке с характерным описанием, содержащим имя подавляемого элемента. 

Пока эта переменная имеет значение, отличное от нуля, элемент построения будет активен в 

модели, как только переменной будет присвоено значение ноль, элемент будет подавлен. 

Вы можете создать пользовательский параметр и связать значение переменной подавле-

ния с этим параметром. Тогда можно будет управлять состоянием подавления элемента из 

Навигатора модели.

Также можно задать условие, определяющее значение переменной подавления. 

• Выделите переменную подавления и в поле Формула впишите “if (N>10) (0) else (1)”, на-

жмите Применить в диалоге (рис. 2.18).

• Закройте диалог и, через Навигатор модели изменяя значение переменной N, посмотри-

те, как перестраивается модель.

• Сохраните модель и закройте её.

Таким образом вы можете управлять логикой построения модели с помощью условий и 

дополнительных функций, которые доступны в диалоге задания выражений. Кроме использо-

вания формул и чисел, вы также можете задавать значение параметру с помощью ассоциа-

тивного измерения.

Рисунок 2.18. Задание формулы
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 ПОВТОРНОЕ ИСПОЛЬЗОВАНИЕ
Повторное использование су-

ществующих наработок позволяет 

существенно оптимизировать и со-

кратить процесс создания моделей. 

Традиционно считается, что повторно 

использовать можно или целые моде-

ли, или специально сгруппированные 

элементы построения, называемые 

«пользовательскими элементами». В 

NX под данными для повторного ис-

пользования подразумевается лю-

бой геометрический объект, который 

может быть выделен, классифицирован и помещен в хранилище. Данным хранилищем являет-

ся Библиотека повторного использования (Reuse Library), доступная в виде навигатора 

на панели ресурсов. Она группирует геометрические объекты разного типа – от кривых и 

элементов геометрии до шаблонов моделей – и предоставляет доступ к ним. Для большинства 

объектов, сохранённых в библиотеке, можно использовать перетаскивание мышкой в графи-

ческую область для использования выбранного элемента. Особо эффективна библиотека, 

когда она отображает не локальное хранилище данных, а общедоступное, расположенное в 

PDM системе или в общей папке. 

Библиотека разбита на разделы, которые можно переопределить в Настройках по 

умолчанию, зайдя в раздел Базовый модуль > Библиотека повторного использования 

(Gateway > Reuse Library) (рис. 2.19). В базовой поставке NX идет некоторый набор де-

монстрационных объектов, которые можно применять для ознакомления с возможностями би-

блиотеки.

Рисунок 2.20. Вставка плоского контура из библиотеки

Рисунок 2.19. Настройки Библиотеки повторного ис-

пользования данных
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Продемонстрируем работу Библиотеки на примере:

• Запустите NX7.5 и откройте файл reuse.prt из папки ch2.

• На панели ресурсов переключитесь на вкладку Библиотека повторного использования 

и в верхнем иерархическом списке разверните узел 2D Section Library > Metric. Здесь со-

держатся примеры двухмерных контуров для библиотеки, которые представляют собой эски-

зы с наложенными размерными и геометрическими ограничениями.

• Выделите один из примеров и перетащите его на грань модели. Контур будет расположен на 

грани, и появится маркер динамического позиционирования, который можно использовать 

для примерного позиционирования контура на грани (рис. 2.20). 

• При нажатии ОК в диалоге позиционирования будут созданы размерные ограничения, 

определяющие позицию контура относительно системы координат.

Далее вы можете редактировать полученный контур как обычный эскиз и использовать его 

для получения тел.

Рассмотрим использование ещё одного типа объектов повторного использования. 

• В Библиотеке повторного использования разверните узел Reuse Examples > 

Standard Parts > ANSI Metric > Bolt > Hex Head . Это пример модели крепежа, который 

является частным случаем данных повторного использования. 

• Выделите пиктограмму болта и перетащите его на модель, наведя курсор мышки на цилин-

дрическую грань отверстия, когда она будет подсвечена, отпустите кнопку мышки. 

• Болт будет вставлен строго в отверстие, и будет подобран нужный диаметр болта, а в от-

крывшемся диалоге можно будет подобрать его длину (рис. 2.21).

Крепеж в данном случае демонстрирует возможности библиотеки, которые могут быть 

применены к любому другому объекту. 

Рисунок 2.21. Вставка крепежа из библиотеки
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СРАВНЕНИЕ МОДЕЛЕЙ
Иногда бывает необходимо сравнить две схожие модели или версии одной и той же моде-

ли, чтобы узнать, какие изменения были сделаны. Это можно сделать через истории построе-

ния, однако подобный способ не подходит, если состав дерева не изменился, но изменились 

параметры некоторых элементов. В таком случае необходимо воспользоваться средством ге-

ометрического анализа. Проведем анализ сравнения на примере двух моделей.

• Из папки ch2 откройте в NX модель PartA.prt и модель PartB.prt. Две модели подобны друг 

другу и на первый взгляд ничем не отличаются друг от друга.

• С помощью пункта главного меню Анализ > Сравнение моделей (Analysis > Model 

Compare) вызовите диалог команды сравнения.

• В разделе Отобразить (Display) диалога задается отображение одинаковых, измененных 

и уникальных граней и ребер в модели. Переключаясь между этими наборами, задайте же-

лаемый цвет отображения сравниваемых объектов.

Опция Выделите все тела каждой детали (Select all bodies in each part) определяет 

будут ли в анализе участвовать все тела в каждой модели или только выбранные. В нашем 

примере модели имеют по одному телу, поэтому эта опция игнорируется.

• Выделите курсором модель и, не закрывая диалог команды, переключитесь с помощью раз-

дела главного меню Окно (Window) на вторую модель и также её выделите. 

• После того как окно будет разделено на три части, где будут отображены каждая из моделей 

и их наложение друг на друга, нажмите кнопку Применить.

В результате анализа, согласно настройке, будут раскрашены ребра и грани, показываю-

щие различия между моделями (рис. 2.22).

Рисунок 2.22. Анализ различий между моделями
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СЕМЕЙСТВА ДЕТАЛЕЙ
Семейства деталей представляют собой набор подобных деталей, имеющих  одинаковую 

форму, но разные размеры, определяющие эту форму. Типовым примером семейства дета-

лей является крепеж, например болт, который имеет одинаковую форму, но может иметь де-

сятки возможных типоразмеров по длине и диаметру. В NX такого рода модели создаются на 

основе шаблона и таблицы, описывающей возможные размеры данного шаблона. Создадим 

семейство на базе существующего шаблона:

• Из папки ch2 откройте в NX файл partfamily.prt. 

Модель представляет собой листовое тело, управляемое тремя параметрами  H, L, W – со-

ответственно по высоте, длине и ширине (рис. 2.23). Эти параметры завязаны на размеры в 

эскизах и на операцию Вытягивания. Для создания семейства деталей не обязательно соз-

давать пользовательские параметры и завязывать их на параметры элементов построения – 

можно оперировать и ими напрямую. Но в этом случае придётся иметь дело с параметрами, 

названными системой, то есть без осмысленного имени. 

Будем в семействе управлять тремя параметрами габаритов модели и состоянием пода-

вления отверстия, расположенного в центре.

• С помощью команды главного меню Инструменты > Семейства деталей (Tools > Part 

Families) откройте диалог определения параметров семейства. 

• В данном диалоге необходимо выбрать параметры, которыми будет определяться семей-

ство. Тип параметров выбирается из выпадающего списка Доступные столбцы (Available 

Columns). Каждый параметр, добавленный в список Выбранные столбцы (Chosen 

Columns), будет добавлять столбец в электронной таблице.

• Добавьте параметры H, L, W из Выражений и добавьте Simple_Hole(4), выбрав в выпадаю-

щем списке значение Элементы (Features).

• В текстовом поле Каталог сохранения семейства (Part Save Directory) задайте путь 

Рисунок 2.23. Шаблон для семейства деталей
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к папке, где будут сохраняться созданные члены 

семейства (рис. 2.24).

• После этого нажмите кнопку Создать (Create).

Откроется электронная таблица, в которой будут 

созданы столбцы, соответствующие выбранным па-

раметрам, с единственной строчкой. содержащей те-

кущие значения параметров. Для формирования се-

мейства необходимо наполнить таблицу возможными 

значениями параметров. Также требуется заполнить 

столбцы OS_PART_NAME и DB_PART_NO. Эти столб-

цы определяют имя члена семейства для файловой си-

стемы и PDM системы соответственно.

В самом приложении Microsoft Excel появится до-

полнительное меню для управления семейством, со-

стоящее из следующих пунктов:

Проверка детали (Verify Part) – проверяет, мо-

жет ли выбранный член семейства быть создан с за-

данными параметрами.

Применить значения (Apply Values) – обновляет 

модель в соответствии с текущими значениями.

Обновить детали (Update Parts) – обновляет 

члены семейства. Если ни одной строки в таблице не 

выбрано, то обновляются все члены семейства. 

Создание детали (Create Parts) – создает мо-

дель с выбранными параметрами.

Сохранить семейство (Save Family) – сохраняет табличные значения параметров чле-

нов семейства в файл шаблона.

Отмена (Cancel) – возвращает управление в NX без сохранения данных в таблицы.

Все созданные члены семейства будут управлять-

ся через шаблон, поэтому все изменения геометрии 

должны производиться только в шаблоне, а потом об-

новляться в семействе. 

• Задайте значения параметров для нескольких 

членов семейства, заполнив все столбцы. В колон-

ке, соответствующей элементу отверстия для его 

подавления в каких-либо членах семейства, необ-

ходимо вписать значение NO (рис. 2.25).

• Проверьте, как NX отрабатывает значения из 

таблицы. Для этого выделите строчку одного из чле-

Рисунок 2.24. Диалог определения се-

мейства.

Рисунок 2.25. Задание параметров се-

мейства
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нов семейства и в дополнительном меню выберите пункт Применить значения. Вернитесь 

в окно NX и убедитесь в том, что модель перестроилась согласно новому значению.

Для генерации файлов моделей семейства выделите все или часть строк и в дополнитель-

ном меню выберите Создание детали. Созданные экземпляры семейства будут сохранены в 

папку, указанную в диалоге задания семейства.
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РАБОТА С ПОВЕРХНОСТЯМИ
Умение работать с поверхностями необходимо всем пользователям, работающим в CAD 

системах высшего уровня. Практически во всех отраслях промышленности встречаются де-

тали, для построения моделей которых необходимо прибегать к функционалу поверхностно-

го моделирования. Твердотельное моделирование позволяет строить 3D модель, комбинируя 

логическими операциями различные формы, полученные операциями протягивания и враще-

ния плоских контуров. Это дает возможность строить сравнительно  простые модели, но ког-

да возникает необходимость получить более сложные формы, приходится обращаться к по-

верхностному моделированию. 

Обычно при построении моделей реальных изделий приходится сочетать твердотельное 

моделирование и моделирование поверхностей. Но есть и ряд задач, которые решаются 

только в модуле моделирования поверхностей. Например, создание аэродинамических об-

водов летательного аппарата или моделирование корпусов изделий бытовой техники. Иногда 

построить твердотельную модель возможно только путём создания поверхностной оболочки 

заданной геометрической формы в модуле работы с поверхностями и дальнейшей обработки 

полученной поверхности в модуле твердотельного моделирования. Это характерно для задач 

из области промышленного дизайна.

В системе NX поверхность представляет собой тело нулевой толщины, имеющее две раз-

мерности. У пользователя есть возможность как получить твёрдое тело на основе поверхно-

сти, с помощью специальной команды задав толщину, так и производить обратные операции  

– получать поверхности на основе граней существующих твёрдых тел. 

Некоторые команды твердотельного моделирования также могут создавать и редактиро-

вать поверхности. В ряде случаев этого функционала достаточно для построения простых по-

верхностей, и нет необходимости прибегать к другим инструментам создания поверхностей.

Так, например, операции Вытягивания (Extrude) или Вращения (Revolve) при исполь-

Рисунок 3.1 Получение простых поверхностей
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зовании незамкнутого контура или включения соответствующей опции создадут не твёрдое 

тело, а поверхность (рис. 3.1). Также операции Обрезка тела (Trim Body) и Разделить тело 

(Split Body) могут принимать в качестве входных параметров не только плоскости и грани 

тел, но и поверхности.

В функционал системы NX входят два модуля, предназначенных для работы с поверхно-

стями. Один из них, модуль поверхностей свободной формы (Freeform Modeling),  входит в 

приложение Моделирование (Modeling) и представлен набором инструментальных пане-

лей и меню, содержащих команды построения и редактирования поверхностей. Второй мо-

дуль оформлен в виде отдельного приложения Студия формы (Shape Studio), которое не-

обходимо активировать через меню Начало > Все приложения > Студия формы (Start > 

Applications > Shape Studio). 

В данной главе мы сделаем акцент на функционале  первого модуля, так как он закрывает 

большую часть задач моделирования поверхностей в машиностроении, и в то же время осво-

ение возможностей этого модуля будет достаточным для начала использования модуля Сту-

дии формы. Функционал Студии формы является развитием средств моделирования по-

верхностей и предназначен для задач, где требуется получение эстетических поверхностей, 

применяемых в области промышленного дизайна и художественного моделирования. Многие 

функции Студии формы пересекаются с тем набором средств, которые есть в модуле Моде-

лирование, но при этом предоставляют большее количество опций, позволяющих более гиб-

ко управлять построением поверхностей. 

Естественно, любая операция по созданию и редактированию поверхностей, как и сами 

поверхности, описывается мощным математическим аппаратом, который NX реализует в 

своих алгоритмах. Но с точки зрения пользователя знание этой математики, как правило, не 

очень помогает при практической работе, поэтому мы не будем подробно останавливаться 

на математическом описании кривых и поверхностей и  больше сосредоточимся на практиче-

ском использовании функционала работы с поверхностями. 

БАЗОВЫЕ НАСТРОЙКИ
Для начала работы с поверхностями имеет смысл ознакомиться с некоторыми общими на-

стройками, которые так или иначе будут влиять на результат, получаемый при работе ко-

манд. Под общими настройками подразумеваются те наборы опций, которые применимы по 

умолчанию ко всем получаемым объектам в пределах данного файла модели. Ряд команд в 

своих диалоговых окнах предоставляют возможность пользователю изменить значения об-

щих настроек применительно к данному объекту.

Для получения доступа к общим настройкам в главном меню выберите пункт Настройки > 

Моделирование (Preferences > Modeling). В появившемся диалоге нас интересуют вклад-

ки Общий (General) и Поверхности свободной формы (Freeform). Первое, на что стоит 

обратить внимание, – это настройки точности моделирования на первой вкладке (рис. 3.2).

Линейный допуск (Distance Tolerance) контролирует максимально возможное расстоя-

ние между теоретической поверхностью, описанной математическим уравнением, и поверх-
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ностью, получаемой аппроксимацией при постро-

ении. Эта опция влияет на все команды, которые 

так или иначе имеют дело с аппроксимациями. 

Угловой допуск (Angle Tolerance) контроли-

рует максимально допустимое отклонение вектора 

нормали в каждой точке получаемой поверхности 

от вектора нормали в точке теоретической поверх-

ности. Опять же речь идёт о разнице между теоре-

тической поверхностью и аппроксимацией, полу-

чаемой при построении поверхности в NX. 

С практической точки зрения при работе с до-

пусками надо иметь в виду, что увеличение точно-

сти построения будет означать, что для операций 

построения и редактирования понадобится боль-

ше времени и машинных ресурсов, а именно па-

мяти. Дополнительно надо иметь в виду, что эти до-

пуски не являются независимыми с математиче-

ской точки зрения, поэтому возможны случаи, ког-

да при построении поверхности, даже когда полу-

чаемая поверхность будет удовлетворять линейно-

му допуску, система будет уточнять аппроксима-

цию, чтобы уложиться в угловой допуск. Это кос-

венно можно оценить по резко возросшему потре-

блению оперативной памяти, а также по увеличе-

нию размера файла модели. В таких случаях, если 

нет особых требований к угловому допуску, необ-

ходимо его увеличить.

Тип тела (Body Type) определяет результат работы некоторых команд, которые могут 

создавать как твердое тело, так и поверхность. 

У некоторых команд эта опция включена в диа-

логовый интерфейс, и её можно изменять непо-

средственно во время создания объекта.

Сетка линий (Grid Lines) определяет коли-

чество изопараметрических линий, отображае-

мых на поверхностях вдоль двух ортогональных 

направлений (рис. 3.3). Эти линии видны лишь 

в режиме отображения Статический каркас 

(Static Wireframe) и служат только для визуаль-

ного анализа получаемых поверхностей. Коли-

чество линий, задаваемых этими параметрами, 

Рисунок 3.2 Базовые настройки

Рисунок 3.3 Изопараметрические кривые
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никак не влияет на точность и гладкость поверхно-

сти. Для отображения изопараметрических линий 

на уже существующих объектах или для изменения 

количества отображаемых линий необходимо вос-

пользоваться командой главного меню Изменить 

> Отображаемый объект (Edit > Object Display).

На второй вкладке обратите внимание на на-

стройку Метод аппроксимации кривой (Curve 

Fir Method). Эта настройка применима в тех слу-

чаях, когда в операциях построения необходимо 

аппроксимировать сплайнами связанные цепочки 

кривых. Она определяет степень сплайна, которым 

будет произведена аппроксимация. Кубический 

сплайн – самый простой, как правило, при экспор-

те файлов моделей в CAD системы среднего уров-

ня имеет смысл выбирать это значение. Сплайн 5-й 

степени наиболее эффективно воспроизводит кри-

визну исходных кривых. Для более высоких степе-

ней необходимо использовать последнее значение 

настройки.

Ещё одна группа настроек, которые нас интери-

суют на этой вкладке, называется Дополнитель-

ные опции перестроения (Advanced Rebuild 

Options). Эти настройки применимы к нескольким 

командам построения поверхности, в диалогах ко-

торых есть опция перестроения поверхности. Если 

режим перестроения включён, то NX перестраивает исходные кривые, меняя их степень, что-

бы получить более высококачественную поверхность. Это полезно, когда исходные кривые, 

на базе которых строится поверхность, сильно отличаются по степени математического опи-

сания или имеют неоптимальное расположение управляющих точек. 

Также на этой вкладке есть настройка Результат создания свободной формы (Freefrom 

Construction Result). Эта настройка определяет, что будет создаваться при операциях по-

строения поверхностей, если получаемый геометрический объект или его часть будут плоски-

ми в пределах допусков точности. Значение Плоскость (Plane) будет заставлять систему соз-

давать простые геометрические объекты, то есть, другими словами, система будет использо-

вать упрощённое математическое описание объекта. Если вам важно сохранить изопараме-

трические кривые и более сложное математическое описание получаемого объекта, то сле-

дует выбрать опцию B-поверхность (B-surface).

Необходимо иметь в виду, что любое изменение общих настроек модели применимо ко 

всем операциям построения, произошедшим после изменения. Это значит, что изменив, на-

пример, параметры допусков, вы повлияете на объекты, созданные после изменения, в то 

Рисунок 3.4 Базовые настройки
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время как все объекты, созданные до момента изменения настроек, будут основываться на 

старых значениях опций. При необходимости изменения настроек для уже существующих на-

строек необходимо редактировать сами объекты.

При работе с командами построения и редактирования поверхностей вы часто будете 

сталкиваться с заданием условий сопряжений поверхностей G0–G1. Не вдаваясь в матема-

тические подробности описания поверхностей, условия G0–G3 можно описать так:

G0 – две поверхности (грани тела) имеют общую границу, то есть соединяются друг с дру-

гом;

G1 – две поверхности имеют общую границу, и для обеих поверхностей соблюдается усло-

вие касательности в каждой точке этой границы;

G2 – две поверхности имеют общую границу, и для обеих поверхностей соблюдается усло-

вие непрерывности по кривизне в каждой точки этой границы;

G3 – две поверхности имеют общую границу, и приращение кривизны для каждой точки 

границы одинаково для обеих поверхностей.

Давайте рассмотрим основные способы создания поверхностей, которые представлены в 

модуле поверхностей свободной формы.

ПОСТРОЕНИЕ ПОВЕРХНОСТИ ПО КРИВЫМ
Модуль моделирования поверхностей свободной формы предлагает два способа созда-

ния поверхностей по кривым. Первый способ предполагает построение через набор кривых, 

расположенных последовательно друг за другом. Второй способ предполагает наличие двух 

наборов кривых, расположенных во взаимно перпендикулярном направлении, то есть по-

верхность строится по сетке кривых. Давайте рассмо-

трим оба этих способа на примерах и основные оп-

ции соответствующих команд:

• Запустите NX7.5 и, зайдя в папку Examples/ch3, 

откройте файл surf1.prt.

• Активируйте инструментальную панель  Поверх-

ность (Surface), если она не отображена у вас на 

экране. Для этого нажмите правой кнопкой мыши 

на любой другой инструментальной панели и в по-

явившемся контекстном меню выберите пункт По-

верхность (Surface). 

Набор кнопок в инструментальной панели, изображённый на рис. 3.5, может отличаться 

от того, что вы видите у себя на экране, так как это определяется доступностью определён-

ных лицензий и применённой роли. Вы всегда может добавить или убрать кнопки с инструмен-

тальной панели через меню настройки панели, нажав на маркер выпадающего меню в самой 

правой части панели.

• В главном меню, выбрав пункт Настройки > Моделирование (Preferences > Modeling) 

Рисунок 3.5 Команды построения поверх-

ностей



47

NX Глава 3. Моделирование поверхностей

на вкладке Общий (General), задайте отображение сетки изопараметрических линий. Для 

этого примера достаточно будет задать количество линий по U и V направлениям, равным 

15.

• В инструментально меню Поверхность (Surface) нажмите кнопку По кривым (Through 

Curves) для вызова диалога построения поверхности по набору кривых (как альтернативу 

инструментальным панелям инструментов вы можете использовать главное меню приложе-

ния. Все команды создания объектов дублируются в пункте меню Вставить (Insert)).

Для построения поверхности по кривым вам необходимо задать минимум два набора кри-

вых, через которых будет проходить поверхность. Под набором понимается группа связан-

ных между собой кривых, формирующих одно сечение. В нашем случае мы хотим построить 

поверхность через два сечения образованными красными и зелеными кривыми, соединённы-

ми между собой. 

• Укажите первый набор кривых для задания первого сечения. Для этого в инструментальной 

панели выбора в выпадающем списке выберите правило Связанные кривые (Connected 

Curves) и укажите одну из красных кривых. Первый набор будет сформирован из трех свя-

занных кривых и добавлен в список. В диалоговом окне разверните элемент Список (List), 

находящийся в блоке диалога Сечения (Sections). 

• Теперь укажем второй набор кривых для задания второго сечения. Нажмите кнопку Доба-

вить новый набор (Add New Set) или в графической области нажмите среднюю кнопку 

мыши и выберите одну из зеленых кривых. В список будет добавлен ещё один  набор, фор-

мирующий второе сечение, и будет отображён предварительный вид получающейся поверх-

ности в соответствии с текущими настройками команды. 

В общем случае таких сечений может быть несколько, поэтому для задания очередного се-

чения всегда необходимо добавлять новый набор в список, иначе система будет считать вы-

Рисунок 3.6 Построение поверхности по кривым
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бираемые объекты одним набором, что приведёт к нежелательному результату.

• Переключитесь в режим отображения Статический каркас (Static Wireframe), чтобы ви-

деть изопараметрические линии поверхности. Для этого, не выходя из команды построения, 

нажмите правую кнопку мыши на графической области и держите её до появления радиаль-

ного меню, в котором нажмите соответствующую кнопку. Обратите внимание, что после ука-

зания наборов кривых на них появились стрелки, указывающие направление каждого на-

бора. Для правильного построения поверхности вам необходимо добиться одинакового на-

правления стрелок у каждого набора. Если направление будет отличаться, то возникнет пе-

рехлёст поверхности, который, как правило, является нежелательным. Для смены направле-

ния вы можете воспользоваться кнопкой Сменить направление (Reverse Direction) в ди-

алоге команды, выбрав  в списке соответствующий набор. Или  просто двойным щелчком ле-

вой кнопкой мыши на стрелке в графической зоне поменять её направление на обратное 

(рис. 3.6).

• Сверните блок диалога Непрерывность (Continuity), так как он пока нам не понадобит-

ся, а в блоке Настройки (Settings) выключите опцию Сохранённая форма (Preserve 

Shape). Затем в блоке Выравнивание (Alignment) поменяйте одноимённую опцию с Па-

раметр (Parametr) на Длина дуги (Arc Length). Обратите внимание, как меняется сет-

ка изопараметрических кривых. Когда используется опция Параметр, система фактически 

учитывает то, что сечение состоит из нескольких кривых. Каждая кривая одного сечения со-

единяется с соответствующей ей кривой в другом сечении. При этом разбиение интервалов 

при построении изопараметрических кривых производится на основе длины каждой кривой, 

входящей в сечение. В случае с опцией Длина дуги система считает, что сечения являются 

едиными кривыми и разбиение интервалов для построения изопараметрических кривых про-

изводится на основе длины всего сечения.  Какой из вариантов больше подходит для каждого 

конкретного случая, определяется, исходя из результата, который необходимо получить. 

• Ещё один часто используемый способ выравнивания сечений при построении поверхности. 

Рисунок 3.7 Выравнивание по точкам
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Это ручное сопоставление  точек на сечениях. Для этого выберите опцию выравнивания По 

точкам (By Points). Система отобразит те точки, которые в данный момент используются 

для выравнивания (рис. 3.7). По умолчанию исходное положение точек соответствует опции 

выравнивания Параметр, то есть сопоставляются точки стыковки кривых, из которых состо-

ят сечения. В режиме По точкам вы можете подвигать существующие точки, добавить допол-

нительные точки и удалить существующие. Для добавления точки необходимо просто щёл-

кнуть левой кнопкой мышки на одной из кривых, при этом будет добавлена и соответствую-

щая точка на другом сечении. Для удаления существующей точки необходимо вызывать кон-

текстное меню, нажав правую кнопку мыши на соответствующей точке. 

• Рассмотрим ещё один пример использования опции выравнивания По точкам, который бо-

лее наглядно покажет отличие этого способа от других.

• Откройте файл surf2.prt из папки Examples/ch3. В этой модели находятся два набора свя-

занных кривых, но при этом количество кривых в обоих наборах отличается. 

• С помощью команды По кривым постройте поверхность по этим двум наборам кривых ана-

логично предыдущему примеру. При построении убедитесь, что направления сечений, ука-

занные стрелкой, совпадают, а также что опция Сохранённая форма (Preserve Shape) в 

блоке Настройки (Settings) деактивирована. Обратите внимание, что при использовании 

опций выравнивания Длина дуги и Параметр результирующая поверхность искажается, и 

происходит скручивание отдельных частей поверхности (рис. 3.8). Это происходит из-за не-

соответствия сечений как по количеству составляющих кривых в них, так и по длинам. 

• Переключите опцию выравнивания на значение По точкам. Теперь вы можете выровнять по-

верхность, так как это больше подходит, исходя из желаемого результата. Возьмите точку А 

и перетащите её из положения 2 в положение 1, а точку Б - в положение 2. В результате бу-

дет получена поверхность без искривлений и скручивания (рис. 3.9).

Рисунок 3.8 Использование метода выравнивание Длина дуги
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Мы рассмотрели три наиболее часто встречающиеся опции выравнивания при построении 

поверхности, но команда построения поверхности содержит ещё несколько способов вырав-

нивания, о которых можно прочитать в справочной системе NX. Сейчас давайте на примере 

рассмотрим условия сопряжения поверхностей, которые задаются в блоке Непрерывность  

(Continuity) диалога команды построения поверхности По кривым.

• Откройте файл surf3.prt из папки Examples/ch3.

• В модели содержатся две поверхности, и нам необходимо построить третью поверхность, ко-

торая будет их соединять.

• Запустите команду построения поверхности По кривым и, выбрав в панели выбора прави-

ло Единственная кривая (Single Curve), задайте два набора кривых. Для этого выбери-

Рисунок 3.9 Использование метода выравнивание По точкам

Рисунок 3.10 Задание условий сопряжения
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те кромки двух поверхностей, расположенные ближе всего друг к другу, не забывая нажать 

среднюю кнопку мыши после выбора первой кромки. Мы получим два набора кривых, со-

стоящих каждый из одного элемента, и этого хватит для того, чтобы система построила пред-

варительный вид поверхности (рис. 3.10). Убедитесь в том, что оба набора имеют одинако-

вое направление, чтобы не было перехлеста. 

Обратите внимание на опции сопряжения в блоке Непрерывность. Сейчас условие со-

пряжения установлено в значение G0 (Позиция) (Position). Это означает, что построенная 

поверхность  стыкуется с исходными поверхностями в каждой точке общих границ. При этом 

никаких условий касательности или кривизны не соблюдается. 

• Поменяйте условие непрерывности на первой кромке на G1 (Касательность) (Tangent). 

Теперь системе необходимо указать, относительно какой поверхности надо соблюдать усло-

вие касательности. Укажите существующую смежную поверхность. Сделайте то же самое для 

второй кромки создаваемой поверхности (рис. 3.11). И нажмите кнопку ОК в диалоге.

Построенная поверхность теперь не образует изломов на границах с двумя другими по-

верхностями, которые она соединяет. Переключившись в режим отображения Статический 

каркас для отрисовки изопараметрических линий, вы можете более наглядно оценить пере-

ходы на границах стыковки поверхностей. 

• Переключитесь обратно в режим отображения Закраска с рёбрами (Shaded with 

Edges) и в главном меню выберите Анализ > Форма > Отражение (Analysis > Shape > 

Reflection). 

• В появившемся диалоге выберите Тип изображения – Прямой (Image type - Line 

images)  и включите режим Черно-белых линий (Black and White Lines). В выпадаю-

щем списке Ориентация прямой (Line Orientation) выберите значение Вертикальный 

(Vertical) и нажмите кнопку Применить (Apply). Как видно из полученного анализа по-

верхности на основе отражённого света, хоть и условие касательности соблюдается, есть 

нарушения кривизны (рис. 3.12).

Рисунок 3.11 Задание условий касательности на стыках
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• Нажмите кнопку Отмена (Cancel) в диалоге анализа  и двойным щелчком на построенной 

поверхности вызовите диалог команды По кривым для её редактирования. В блоке Непре-

рывность поменяйте значение опций сопряжения на G2 (Кривизна) (Curvature) для обе-

их границ. Поверхность будет перестроена, и анализ на основе отражённого света покажет, 

что теперь нет нарушений по кривизне на всех переходах (рис. 3.13).

Теперь давайте построим поверхность по сетке кривых. Как уже говорилось, этот способ 

предполагает наличие двух взаимно перпендикулярных групп  кривых, на основе которых бу-

дет производиться построение. При этом условие перпендикулярности не является строгим, 

то есть сетка кривых может быть сформирована из примерно перпендикулярных групп. Вели-

чина допуска на перпендикулярность будет определяться отклонениями получаемой поверх-

Рисунок 3.12 Анализ стыков с условием касательности

Рисунок 3.13 Анализ стыков с условием сохранения кривизны
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ности от заданных допусков точности. Пока результирующая поверхность при всех наложен-

ных на неё ограничениях будет соответствовать заданной точности, отклонение от перпенди-

кулярности между группами кривых, формирующих сетку, будет считаться приемлемым. 

Аналогично в рамках каждой группы все наборы (сечения) должны быть примерно парал-

лельными, но не должны пересекаться.  Также допускается отсутствие прямого пересечения 

между группами кривых, то есть они могут располагаться на некотором удалении друг от дру-

га. 

• Откройте файл surf4.prt из папки Examples/ch3.

• Модель содержит несколько кривых, которые можно разбить на две группы условно пересе-

кающихся сечений поверхности.

• На кнопочной инструментальной панели нажмите кнопку По сетке кривых (Through 

Curve Mesh).

Появившийся диалог команды практически совпадает с диалогом команды По кривым. 

Основное отличие, что в этом диалоге есть два списка для задания групп  кривых – первич-

ных и поперечных. 

• Задайте первичную группу кривых, для этого выберите  поочередно четыре синие кривые, 

нажимая среднюю кнопку мыши после каждой указанной кривой. Убедитесь в том, что стрел-

ки, указывающие направление  кривых, повёрнуты в одну сторону.

Как и в предыдущей команде, нажатие на среднюю кнопку мыши аналогично нажатию на 

кнопку Добавить новый набор (Add New Set) в диалоговом окне. В общем случае один на-

бор (или сечение) может состоять из нескольких соединённых кривых. А в случае если в один 

набор входят кривые, образующие замкнутый контур, то становится активной кнопка зада-

ния начальной кривой. Она позволяет перезадать начальную точку отсчета, от которой от-

кладываются интервалы между изопараметрическими линиями. В нашем примере для просто-

ты каждый набор состоит из одной кривой, поэтому мы эту кнопку не используем. Если вам 

необходимо поменять порядок кривых в списке, то воспользуйтесь стрелками в правой части 

Рисунок 3.14 Построение поверхности по сетке кривых
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списка. В случае если какая-либо кривая была добавлена в набор ошибочно, выделите этот 

набор в списке и в графической области укажите эту кривую, нажав клавишу Shift, затем ука-

жите правильную кривую.

• В качестве пятого набора укажите точку, в которой сходятся три зеленые линии. В данном 

случае точка является частным случаем кривой и одним из сечений для построения поверхно-

сти (рис. 3.14).

• В диалоговом окне команды переключитесь на блок ввода кривых поперечного каркаса, на-

жав кнопку Выберите кривую. Укажите поочередно три зеленые кривые, создавая новый 

набор каждый раз после указания кривой. Также убедитесь в том, что направления всех 

кривых совпадают.  

После выбора второй кривой система попытается построить поверхность на основе теку-

щих настроек и заданных наборов. Так как группы первичных и поперечных кривых не пере-

секаются явно и расстояние между ними превышает заданный допуск, то в информационное 

окно будет выведена информация об этом, а в графической области будут подсвечены места, 

Рисунок 3.15 Задание поперечных наборов сетки

Рисунок 3.16 Редактирования допуска построения поверхности
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где пересечение не попадает в допуск (рис. 3.15).

• В диалоговом окне раскройте блок Настройки (Settings) и увеличьте допуск на Пере-

сечение (Intersection) до 10. Поверхность будет построена, так как теперь максималь-

ное расстояние между наборами кривых двух групп находится в пределах допуска (рис. 

3.16). При этом у вас есть возможность определить, где будет лежать результирующая по-

верхность. Для этого раскройте блок Опции выходной поверхности (Output Surface 

Options). По умолчанию создаваемая поверхность, в случае когда группы не пересекают-

ся явно, расположена между наборами групп. Соответствующая  опция установлена в значе-

ние Обе (Both), то есть обе группы кривых определяют положение поверхности. Переклю-

чая эту опцию, вы можете указать, что поверхность также может лежать на наборах кривых 

первичной группы или на на наборах кривых поперечной группы. 

• Нажмите ОК в диалоге команды и сохраните модель.

ПОВЕРХНОСТИ ЗАМЕТАНИЯ
Поверхность заметания получается путём протягивания одного или нескольких сечений по 

заданной траектории. Это даёт возможность строить поверхности постоянного сечения или 

переходные поверхности между сечениями разной формы по заданной траектории.  В ин-

струментальной панели Поверхности присутствуют несколько команд создания поверхно-

стей заметания, которые отличаются опциями управления сечением вдоль траектории, в част-

ности его формой и ориентацией. Рассмотрим базовую команду создания поверхности за-

Рисунок 3.17 Создание поверхности заметания
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метания.

• Из папки Examples/ch3 откройте файл surf5.prt. Сейчас модель представляет собой одну 

кривую, которая будет служить направляющей, и два замкнутых сечения, которые мы протя-

нем вдоль этой направляющей.

• В инструментальной панели Поверхность (Surface) нажмите кнопку команды Заметание 

(Swept). 

• В блоке Настройки (Seeings) для опции Тип тела (Body type) установите значение По-

верхность (Sheet).

• В первом блоке нам необходимо задать наборы сечений. Логика указания кривых, входящих 

в набор, здесь такая же, как и в командах построения поверхностей по кривым и сеткам кри-

вых. Каждый набор представляет собой одно сечение, при этом в набор может входить не-

сколько соединенных кривых. При этом набор может быть как замкнутым, так и открытым. 

Укажите окружность как первый набор и, нажав среднюю кнопку мыши, добавьте второй на-

бор в список. 

• Во второй набор добавьте кривые второго сечения. Для этого в инструментальной панели вы-

бора установите правило Связанные кривые (Connected Curves) и укажите нижнюю го-

ризонтальную линию второго сечения. В данном случае мы намеренно допускаем ошибку, 

чтобы продемонстрировать работу кнопки перезадания начальной кривой (рис. 3.17). Убе-

дитесь в том, что направления сечений, указанные стрелками, совпадают. 

При этом в случае с замкнутыми сечениями стрелку лучше расценивать как направление 

Рисунок 3.18 Выравнивание поверхности заметания по точкам
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движения по или против часовой стрелки. Это поможет более правильно определить взаим-

ное направление, так как в большинстве случаев стрелки выходят из разных точек сечений.

• Переключитесь на блок выбора направляющих и, нажав в нем кнопку Выберите кривую 

(Select Curve), укажите траекторию для создания поверхности.

Этого будет достаточно, чтобы получить предварительный вид получаемой поверхности. 

Как видно из результата, мы получили перехлест поверхности. Это произошло от того, что 

начало кривой (окружности) не совпадает с началом первой кривой второго сечения. 

• В диалоге команды выделите в списке строчку, соответствующую второму сечению, и нажми-

те кнопку Задать начальную кривую (Specify Origin Curve). Начальной точкой сече-

ния считается точка, откуда выходит стрелка, указывающая направление. Укажите верхний 

горизонтальный отрезок. 

Поверхность перестроится в более правильный вид (рис. 3.18), но при более детальном 

рассмотрении видно, что при переходе от первого сечения ко второму по траектории проис-

ходит небольшое кручение. Это хорошо видно, если посмотреть на изопараметрические ли-

нии, включив стиль отображения Статический каркас. Кручение возникает из-за того, что 

начальные точки сечений все еще не совпадают. Перезадав начальную кривую второго се-

чения, мы исправили перехлест, но так как теперь начальной точкой является начало верх-

него горизонтального отрезка, в то время как правильной точкой является его середина, тог-

да на обоих сечениях стрелки направления будут выходить из одинаково расположенных то-

чек. Чтобы убрать кручение, нам необходимо изменить выравнивание сечений относительно 

друг друга. 

• В диалоге команды разверните блок Опции сечения (Section Options) и поменяйте зна-

чение опции Выравнивание (Alignment) с Параметр (Parameter) на По точкам (By 

Points). Обратите внимание, что верхней точке на первом сечении (окружности) соответ-

ствует точка на правом конце горизонтального отрезка. Переместите контрольные точки 

первого сечения так, чтобы они соответствовали квадрантам окружности, а точки второго се-

чения разместите в центре прямых отрезков, как показано на рис. 3.18. Для облегчения вы-

бора центральных точек и квадрантов окружности воспользуйтесь соответствующими режи-

мами привязки на инструментальной панели выбора.  

• Нажмите ОК в диалоге и сохраните модель.

Мы получили нормальную поверхность с плавными изопараметрическими линиями без 

кручения и перехлеста. Диалог построения поверхности заметания предоставляет дополни-

тельные возможности задания получаемой поверхности. Например, в блоке Опции сечения 

вы можете управлять ориентацией и масштабом сечения. В нашем примере оба их параметра 

постоянны, поэтом масштаб сечения не меняется, а плоскость сечения в каждой точке нор-

мальна к линии траектории. 

Рассмотрим ещё один пример построения поверхности заметания по одному сечению и 

двум направляющим.

• Из папки ch3 откройте файл surf7.prt. 

• Переключитесь в режим отображения Статический каркас, вызовите команду Замета-

ние  и в качестве сечения укажите синюю кривую. Далее  задайте две направляющие – зеле-
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ные кривые, добавляя каждую в отдельный набор. Этих исходных данных хватит для постро-

ения поверхности, но при необходимости можно задать дополнительно опорную кривую для 

задания ориентации плоскости сечения поверхности в каждой точки траектории. При задан-

ной опорной кривой поверхность будет построена так, что плоскость сечения в каждой точке 

траектории будет нормальна по отношению к этой кривой.  

• В блоке Опорная кривая нажмите на кнопку Выберите кривую и укажите на жёлтый 

сплайн в графической области.  Обратите внимание, как перестроится сетка изопараметри-

ческих кривых.  Задание опорной кривой в ряде случаев позволяет получить более регуляр-

ную поверхность и избежать нежелательных изломов кривизны (рис. 3.19).  

Вы также можете управлять изменением масштаба сечения вдоль направляющих. Но в от-

личие от  использования одной направляющей (в предыдущем примере), в случае двух на-

правляющих опция Масштаб в блоке Опции сечения содержит только два значения, кото-

рые определяют, будет ли масштаб сечения меняться пропорционально в обоих направлени-

ях или только в одном. Остальные настройки команды повторяют логику работы при исполь-

зовании одной направляющей кривой.

Как уже говорилось, использованная команда Заметание является базовой в семействе 

команд построения такого типа поверхностей. Более расширенные возможности построения 

поверхностей заметания доступны в командах Стилизованное заметание и Переменное 

заметание.  Первая команда входит в приложение Студия поверхности и имеет дополни-

тельные опции, позволяющие строить поверхности класса А. Команда Переменное заме-

тание позволяет строить поверхности на основе траектории и переменного сечения, кото-

рое имеет геометрические зависимости, меняющиеся по траектории. Частные случаи постро-

ения поверхностей заметания представлены командами Заметание вдоль направляющей 

и Труба. Первая команда позволяет построить поверхность или тело на основе траектории и 

Рисунок 3.19 Поверхность заметания по двум направляющим
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сечения. Все остальные опции настройки, которые имеются в команде Заметание, в данном 

случае опускаются. Команда Труба требует задания ещё меньшего количества обязательных 

параметров – траектории и внутренних и наружных диаметров кольца. Все семейство команд 

построения поверхностей заметания вы можете найти в главном меню в разделе Вставить > 

Заметание или на соответствующих инструментальных панелях.

ПОЛУЧЕНИЕ ТВЕРДЫХ ТЕЛ
В большинстве случаев конечной целью поверхностного моделирования является получе-

ние твердотельной модели на основе построенной поверхности. Существуют два способа 

получения твердого тела на основе поверхностей. Первый способ представляет собой при-

дание толщины заданной поверхности, реализуется командой Вставить > Смещение/мас-

штаб > Утолщение (рис. 3.20).

Такой способ позволяет создавать тело равной толщина на основе поверхности или груп-

пы соединенных поверхностей, формирующих открытый контур. Второй способ получения 

твердотельной модели на базе поверхностей заключается в создании тела на основе замкну-

Рисунок 3.20 Получение твёрдого тела утолщением

Рисунок 3.21 Получение твердого тела заливкой контура
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того контура поверхностей, которые определяют границы тела. Для этого используется ко-

манда Вставить > Комбинирование > Сшивка.  Эта команда служит для объединения не-

скольких поверхностей в одну, когда они имеют общие границы, но если исходные поверхно-

сти формируют замкнутый контур, то результатом работы команды будет твёрдое тело (рис. 

3.21).

ПРАКТИЧЕСКОЕ ИСПОЛЬЗОВАНИЕ
Давайте на практическом примере отработаем рассмотренные выше команды построе-

ния поверхностей и изучим некоторые другие. В сборке игрушечного вертолёта необходимо 

построить корпус, который пока представлен заготовкой в виде нескольких сплайнов (рис. 

3.22).

• Из папки Examples/ch3/Helicopter откройте файл Helicopter_Demo.prt. 

• После загрузки сборки вертолета двойным щелчком в Навигаторе сборки (Assembly 

Navigator) сделайте рабочей деталью компонент Body_Demo_rev5.

 Все построения мы будем производить в этой модели. Некоторые элементы корпуса уже 

были сделаны в виде поверхностей, и были нарисованы контуры корпуса в виде сплайнов, на 

которых отображены эпюры кривизны. 

• Построим половину сечения корпуса, которое затем протянем по направляющим для полу-

чения поверхности. Активируйте приложение Моделирование (Modeling) и в главном 

меню выберите пункт Вставить > Эскиз (Insert > Sketch). 

• Разместите эскиз по нормали к кривой. Для этого в выпадающем списке Тип (Type) вы-

берите значение По траектории (On Path) и укажите верхний сплайн контура корпуса. 

В блоке Расположение плоскости (Plane Location) установите опцию Положение 

(Location) в значение % Длины дуги (% Arc Length) и задайте процент, равный 20. Это 

Рисунок 3.22 Сборка вертолета
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разместит плоскость эскиза на расстоянии  20% длины сплайна от его начала. Ориентация 

плоскости (Plane Orientation) эскиза определяется одноименной опцией в следующем 

блоке диалога. Установите эту опцию в значение Нормально к пути (Normal to path). 

Осталось только указать направление горизонтали для создаваемого эскиза. Для этого 

нажмите в блоке Ориентация эскиза (Sketch Orientation) кнопку Выберите горизон-

Рисунок 3.23 Позиционирование эскиза

Рисунок 3.24 Построение прямоугольника
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тальное направление (Select Horizontal 

Reference) и укажите нижнюю кромку 

параллелепипеда, находящегося по центру 

вертолета (рис. 3.23), и нажмите кнопку ОК.

• Постройте прямоугольник по трем точкам, 

как показано на рис. 3.24. Начальный угол 

прямоугольника расположите в нуле систе-

мы координат эскиза, второй угол располо-

жите примерно на сплайне, формирующем 

нижнюю линию контура корпуса, и задайте 

ширину прямоугольника примерно равной 

половине высоты. Затем преобразуйте линии построенного прямоугольника во вспомога-

тельные. Для этого выделите все линии, нажмите и держите на одной из них правую кнопку 

мыши до появления радиального меню вокруг курсора мыши. В радиальном меню выберите 

правую нижнюю кнопку (рис. 3.25).

• Теперь необходимо построить сплайн, вписанный в прямоугольник. Вызовите команду Сплайн 

студии формы (Studio Spline) и укажите точки сплайна – угол прямоугольника, лежащий на 

верхнем сплайне контура корпуса, среднюю точку вертикальной линии прямоугольника и угол 

прямоугольника, лежащий на нижнем сплайне контура корпуса (рис. 3.26). Не закрывая диало-

гового окна построения сплайна, поочередно нажав правую кнопку мыши на заданных точках, 

Рисунок 3.25 Вспомогательные линии

Рисунок 3.26 Построение сплайна
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в контекстном меню задайте условие касательности сплайна Наследовать G1 (Infer G1).

• Завершите построение эскиза командой Закончить эскиз (Finish Sketch) и на инструмен-

тально панели Поверхность (Surface) нажмите на кнопку команды Стилизованное за-

метание (Styled Sweep). 

Команду создания поверхности заметания мы рассматривали ранее. Команда Стилизо-

ванное заметание работает по аналогичному алгоритму, но имеет расширенные опции по-

строения поверхности.  

• В диалоге команды выберите Тип (Type) построения 2 Направляющие (2 Guides), 

Рисунок 3.27 Построение поверхности заметания

Рисунок 3.28 Регулировка формы поверхности заметания
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сечением будет сплайн, построенный на предыдущем шаге, – укажите его в блоке Кри-

вые сечения (Section Curves).

•  Затем в блоке Направляющие кривые (Guide Curves) укажите верхний и нижний 

сплайны контура корпуса. В блоке Атрибуты заметания (Sweep Attributes) переключи-

те опцию Ориентация сечения (Section Orientation) на Сделать нормально (Make 

Normal) (рис. 3.27).

• Не закрывайте диалоговое окно команды и разверните блок Управление формой (Shape 

Control).  Выберите метод управления Частичное заметание (Partial Sweep). Теперь с 

помощью ползунков в диалоге или советующих маркеров в графической области отредакти-

руйте получаемую поверхность, как это показано на рис. 3.28. После этого нажмите ОК в 

диалоге построения поверхности.

• Выбрав нижнюю направляющую построенной поверхности, нажмите правую кнопку мыши, в 

контекстном меню выберите пункт Скрыть(Hide). 

• Теперь поменяем длину второго нижнего сплайна контура корпуса. Нам необходимо умень-

шить этот сплайн, чтобы в дальнейшем  построить переходную кривую между этим сплайном 

и кромкой построенной поверхности заметания. Для редактирования длины кривой (сплай-

на) включите инструментальную панель Изменить кривую (Edit Curve) и нажмите кнопку 

вызова команды Длина кривой (Curve Length). Вы также можете вызвать эту команду че-

рез главное меню, выбрав пункт Изменить > Кривая > Длина (Edit > Curve > Length). 

• Выберите нижний сплайн и передвиньте правый маркер конца кривой вдоль сплайна на 

40–50 мм влево. Убедитесь, что в блоке Настройки (Settings) включена опция Ассоциа-

тивно (Associative), и в выпадающем списке Исходные кривые (Input Curves) выбери-

те значение Скрыть (Hide). Это означает, что исходный сплайн будет скрыт, а вместо него 

Рисунок 3.29 Редактирование длины сплайна
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будет создан новый ассоциативно связанный (рис. 3.29). Если вам необходимо удалить ис-

ходную кривую, то следует выключить опцию Ассоциативно, но в нашем случае это не тре-

буется.

• Оптимизируйте вид эпюры анализа кривизны. Для этого нажмите правую кнопку мыши на 

эпюре анализа и в контекстном меню выберите пункт Анализ кривой (Curve Analysis). В 

появившемся диалоге в блоке Отображения анализа (Comb Range) с помощью ползун-

ков отрегулируйте отображения эпюры на кривой (рис. 3.30).

• Включите отображение инструментальной панели Кривая (Curve) и нажмите кнопку вызова 

Рисунок 3.30 Модификация отображения анализа кривизны

Рисунок 3.31 Создание соединительной кривой
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команды Соединительная кривая (Bridge Curve). В качестве начального объекта укажи-

те крайнюю правую точку нижнего сплайна, а в качестве второго объекта – крайнюю левую 

точку нижней кромки поверхности заметания. Затем, поочередно нажав на заданные точ-

ки правой кнопкой мыши, в контекстном меню выберите пункт Наследовать G2 (Infer G2). 

Это задаст условия сохранения кривизны в точках соединения кривых (рис. 3.31). Нажмите 

ОК в диалоге команды. 

• Скройте все эпюры кривизны и в инструментальной панели Кривая (Curve) нажмите кноп-

ку вызова команды Сплайн студии формы 

(Studio Spline).

• На инструментальной панели выбора включите 

режимы привязок Пересечение (Intersection) и 

Точка на грани (Point on Face). 

• Выберите в диалоге создания сплайна метод По 

точкам (Through Points) и в качестве первой 

точки укажите в графической области пересече-

ние сплайнов контуров корпуса. Вторую точку 

укажите на поверхности заметания ближе к левой 

кромке. Появится предварительное изображение 

получаемого сплайна, укажите на нем третью 

точку между первыми двумя, ближе к первой точке 

(рис. 3.32). 

• Не закрывая диалога построения сплайна, вы-

делите вторую точку, заданную на поверхности, и 

задайте её позицию с помощью параметров U и V или маркеров, как показано на рис. 3.33. 

Необходимо поместить точку на середину левой кромки поверхности заметания. 

• Выделите вторую точку сплайна и с помощью маркеров перемещения сдвиньте её вдоль оси 

XC примерно так, как изображено на рис. 3.34, и после этого завершите построение сплай-

на нажатием кнопки ОК.

Построим кривую на основе левой кромки поверхности заметания. Она нам понадобит-

Рисунок 3.32 Построение сплайна

Рисунок 3.33 Модификация параме-

тров точки сплайна
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ся в последующих операциях. Построить эту кривую можно несколькими способами. Самый 

очевидный – это воспользоваться командой из главного меню Вставить > Кривые из тел > 

Выделение (Insert > Curves from Bodies > Extract), но воспользуемся другим способом, ко-

торый иногда более гибок для построения кривых на основе кромок существующих объектов. 

• В инструментальной панели Кривая (Curve) нажмите кнопку вызова команды Кривая сме-

щения (Offset Curve) и в появившемся диалоге укажите Тип (Type) кривой – Расстояние 

(Distance), в графической области укажите левую кромку поверхности заметания. Рассто-

яние (Distance) смещения задайте равным нулю и нажмите ОК в диалоге. Будет построен 

сплайн, совпадающий с выбранной кромкой поверхности (рис. 3.35).

•  Теперь построим две простые поверхности вытягивания на основе двух сплайнов конту-

ра корпуса вертолета. Они нам будут нужны для задания условия сопряжения в следую-

щей операции. В инструментальной панели Элемент (Feature) нажмите кнопку вызова ко-

манды Вытягивание (Extrude) и, включив в панели выбора режимы Связанные кривые 

Рисунок 3.34 Ручное позиционирование точки сплайна

Рисунок 3.35 Построение поверхности вытягиванием
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(Connected Curves) и Остановка по пересечению (Stop at Intersection), выберите 

три сплайна, формирующие контур корпуса. В блоке Настройки (Settings) укажите Тип 

тела (Body type) Поверхность (Sheet).

•  Задайте расстояние вытягивания равным 10–15 мм и при необходимости воспользуйтесь 

кнопкой Сменить направление (Reverse Direction), чтобы поверхности вытягивались в 

сторону отрицательных значений по оси X (рис. 3.35).

• Закончите построение поверхностей нажатием кнопки ОК. 

• Построим половину корпуса вертолета, воспользовавшись знакомой командой По сетке 

кривых (Through Curve Mesh). Нажмите на соответствующую кнопку на инструменталь-

но панели Поверхность (Surface) и выберите кривые первичной группы. В первый набор 

добавьте кривую, полученную нулевым смещением кромки поверхности заметания, и, доба-

вив второй набор, укажите точку пересечения сплайнов контура каркаса или начальную точ-

Рисунок 3.36 Задание первичного набора 

Рисунок 3.37 Задание наборов кривых поперечных сечений 
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ку построенного сплайна. Воспользуйтесь соответствующими привязками из инструменталь-

ной панели выбора (рис. 3.36).

• Затем перейдите на блок задания поперечных кривых. Убедитесь в том, что на панели выбо-

ра активен режим Остановка по пресечению (Stop at Intersection), задайте первый на-

бор, состоящий из одного сплайна верхнего контура каркаса, второй набор – из построен-

ного нами сплайна и третий набор – из двух сплайнов нижнего контура каркаса. Убедитесь 

в том, что стрелки направления заданных наборов повернуты в одну сторону. На основе вве-

дённых данных система построит предварительное изображение получаемой поверхности. 

Нам осталось только задать граничные условия на границах новой поверхности (рис. 3.37). 

• Для задания граничных условий или условий сопряжения разверните блок Непрерыв-

ность (Continuity) в диалоге команды. Поменяйте условие сопряжения у первого и послед-

него поперечных наборов на G1 (Касательность) (Tangent) и в качестве ссылочных гра-

ней укажите верхнюю и нижнюю вытянутые поверхности соответственно.  В блоке Настрой-

ки (Settings) укажите в опции Тип тела (Body type), выберите значение Поверхность 

(Sheet) и завершите построение, нажав кнопку ОК в диалоге (рис. 3.37).

Рисунок 3.38 Создание зеркальной поверхности

Рисунок 3.39 Сшивка поверхностей
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• В главном меню выберите команду Вставить > Ассоциативная копия > Геометрия мас-

сива (Insert > Associative Copy > Instance Geometry). В появившемся диалоге выбе-

рите тип копирования Зеркало (Mirror), укажите построенную поверхность и поверх-

ность, полученную операцией заметания в блоке Геометрия для массива (Geometry to 

Instance), и в качестве плоскости в блоке Плоскость отражения (Mirror Plane) выбери-

те плоскость ZY рабочей системы координат. Нажмите кнопку ОК для получения зеркальной 

копии поверхностей (рис. 3.38).

• Выберите пункт главного меню Вставить > Комбинирование > Сшивка (Insert > 

Combine > Sew). Этой командой мы объединим все построенные поверхности. В появив-

шемся диалоге выберите в выпадающем списке Тип (Type) значение Поверхность (Sheet) 

Рисунок 3.40 Построение линии обрезки

Рисунок 3.41 Обрезание поверхности
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и далее укажите одну из поверхностей в блоке диалога Цель (Target), а оставшиеся три по-

верхности укажите в блоке Инструмент (Tool) и нажмите ОК (рис. 3.39).

• Сделаем скругление носовой части полученного корпуса. Для этого сначала обрежем 

острую часть и на её месте построим более гладкую поверхность. Вызовем команду постро-

ения сплайна и нарисуем линию обрезки, примерно как показано на рис. 3.40 . Для этого 

активируйте вид справа на модель и в опции команды построения сплайна Плоскость по-

строения (Drawing Plane) выберите значение Вид (View). 

• В главном меню выберите пункт Вставить > Обрезка > Обрезка поверхности (Insert 

Рисунок 3.42 Создание соединительной кривой

Рисунок 3.43 Создание N-сторонней поверхности 
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> Trim > Trimmed Sheet). В появившемся 

диалоге команды в качестве Цели (Target) 

укажите сшитую поверхность, в блоке Объ-

ект границы (Boundary Objects) выберите 

построенный сплайн, переключите опцию 

Направление проецирования (Projection 

Direction) на значение Вдоль вектора 

(Along Vector) и выберите синий символа 

вектора, соответствующий оси X. Убедитесь в 

том, что включена опция Проецирование в 

обе стороны (Project Both Side), и в блоке 

Область (Region), нажав кнопку Выбрать 

область (Select Region), проверьте, что 

будет обрезана именно носовая часть поверх-

ности корпуса. После этого нажмите кнопку 

ОК в диалоге (рис. 3.41).

• Скройте сплайн, построенный для обрезки, и с 

помощью команды Соединительная кривая 

(Bridge Curve) постройте соединение между 

крайними точками кромок поверхности, как 

показано на рис. 3.42. При построении, 

нажав правую кнопку на выбранные точки, 

убедитесь в том, что задано условие касательности (G2).

• На инструментальной панели Поверхность (Surface) нажмите кнопку вызова команды 

N–стороняя поверхность (N-sided Surface). В выпадающем списке Тип (Type) диалога 

команды выберите значение Обрезанная (Trimmed). В блоке Наружняя петля (Outer 

Рисунок 3.44 Создание N-сторонней поверх-

ности для заднего торца 

Рисунок 3.45 Объединение полученных тел 
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Loop) укажите кромки поверхности, по которой была сделана обрезка, в качестве Гра-

ней ограничения (Constraint Faces) укажите саму поверхность. Поменяйте значение оп-

ции UV Ориентация (UV Orientation) на Площадь (Area) и нажмите кнопку Выберите 

кривую (Select Curve) в разделе Внутренние кривые (Interior Curves). В инструмен-

тальной панели выбора установите правило Единственная кривая (Single Curve) и ука-

жите построенную соединительную кривую. Затем в блоке диалога Настройки (Settings) 

включите опцию Обрезка по границе (Trim to Boundary) и нажмите ОК для завершения 

построения поверхности (рис. 3.43).

• Повторите команду построения N–сторонней поверхности для заднего торца корпуса. В 

этот раз опции UV Ориентация задайте значение Опорная кривая (Spine), также вклю-

чите опцию Обрезка поверхности (Trim to Boundary) и в разделе диалога Управле-

ние центром (Center Control)  с помощью ползунка отрегулируйте выпуклость получае-

мой поверхности (рис. 3.44).

• Воспользуйтесь командой главного меню Вставить > Комбинирование > Сшивка (Insert 

> Combine > Sew), чтобы сшить вместе две построенные поверхности и поверхность корпу-

са.

• Затем с помощью  команды Вставить > Комбинирование > Объединение (Insert > 

Combine > Union) объедините полученную поверхность корпуса с поверхностями крыла и 

стабилизатора (рис. 3.45).

• Для придания более эстетического вида полученной поверхности корпуса осталось толь-

ко скруглить углы стыков. Для этого воспользуйтесь командой Вставить > Конструктив-

ный элемент > Скругление ребра или нажмите соответствующую кнопку на инструмен-

тальной панели Элемент. Выделите все ребра, которые были образованы стыковкой состав-

ляющих поверхностей, и, задав величину радиуса равной 1 мм, постройте скругление (рис. 

3.46).

Рисунок 3.46 Создание скругления  
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МОДЕЛИРОВАНИЕ В КОНТЕКСТЕ
Задача проектировать в контексте, то есть учитывая окружение разрабатываемой дета-

ли или узла, возникает довольно часто. Как при проектировании сложных изделий с плотной 

компоновкой, так и при создании модификаций существующих узлов, когда часть деталей 

остается прежней, а новые необходимо вписать в существующий контекст. Это, в свою оче-

редь, заставляет создавать 3D модели разрабатываемых узлов, опираясь на геометрию и па-

раметры уже существующих деталей и сборок, создавая межмодельные связи и управляя из-

менениями. 

Основной задачей конструктора при моделировании детали в контексте или при исполь-

зовании ссылок на геометрию других деталей вне контекста является правильное определе-

ние тех параметров и геометрических объектов, которые можно использовать как ссылки в 

своей модели.  В системе NX реализован достаточно мощный и гибкий механизм для работы 

с межмодельными связями, которые получил название WAVE. Этот механизм используется не 

только для создания модели с использованием геометрических ссылок на другие объекты, но 

и для реализации метода проектирования сверху вниз. В обоих случаях  WAVE представляет 

собой инструменты для создания и управления геометрическими и параметрическими связя-

ми, а также отслеживания их текущего состояния. Все остальное – определение ключевых па-

раметров, выбор определяющих геометрических объектов, определение последовательности 

проведения изменений – остаётся за пользователем.  

В данной главе мы на примерах рассмотрим функционал системы NX, предназначенный 

для работы в контексте изделия и для реализации подхода проектирования сверху–вниз.

СОЗДАНИЕ МЕЖМОДЕЛЬНЫХ СВЯЗЕЙ
Механизм WAVE позволяет создавать несколько типов межмодельных связей, отличаю-

щихся друг от друга тем, как они отслеживают изменения в исходных моделях. Использование 

Рисунок 4.1. Создание межмодельной связи
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связей правильного типа определяет, насколько поведение связанных моделей будет соот-

ветствовать ожиданиям. Давайте на примере простой детали создадим несколько типов свя-

зей и посмотрим на их поведение при изменениях.

• Запустите NX7.5 и откройте файл сборки Assy-links.prt из папки ch4/links.

• В сборке находится один компонент, который как-то спозиционирован относительно 

нуля системы координат сборки. Создадим новый компонент сборки и скопируем некото-

рые геометрические данные из первого компонента. В инструментальной панели Сбор-

ки (Assemblies) нажмите кнопку команды Создать новый компонент (Create New 

Component), в появившемся диалоге выберите шаблон детали и нажмите ОК. Двойным 

щелчком на новом компоненте сделайте его рабочей деталью. 

• На той же инструментальной панели нажмите кнопку Редактор геометрических свя-

зей WAVE (WAVE Geometry Linker) или воспользуйтесь пунктом главного меню Вста-

вить > Ассоциативная копия > Редактор геометрических связей WAVE (Insert > 

Associative Copy > WAVE Geometry Linker). Скопируем в новый компонент геометрию 

существующей детали, выбрав в появившемся диалоге тип геометрии Грань (Face) и указав 

на торцевую грань модели (рис. 4.1). 

• Нажмите в диалоге кнопку ОК, сделайте новый компонент сборки отображаемой деталью, 

нажав на нем в Навигаторе сборки (Assembly Navigator) правой кнопкой мыши и вы-

брав соответствующий пункт меню. Затем переключитесь в Навигатор модели (Model 

Navigator) и убедитесь, что в истории построения появился объект Связанная грань 

(Linked Face). Обратите внимание, что скопированная грань расположена относительно 

нуля системы координат модели так же, как эта грань расположена в исходной детали отно-

сительно нуля системы координат модели (рис. 4.2).

Сейчас мы создали позиционно зависимую связь между геометрией исходного компонен-

та и нашей моделью. Позиционно зависимые связи, создаваемые командой Редактор гео-

метрических связей WAVE, характеризуются тем, что они копируют исходную геометрию с 

Рисунок 4.2. Позиционно-зависимая связи
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учетом позиции родительской детали в сборке. Это означает, что не только геометрические 

изменения самой детали будут отражаться на скопированном объекте, но и изменение пози-

ции исходного компонента в контексте сборки будет менять позицию связанной геометрии в 

контексте модели. 

• Включите задержку обновления геометрических связей. Для этого в главном меню выберите 

пункт Инструменты > Обновить > Обновить связи между деталями > Задержка ге-

ометрии и выражений (Tools > Update > Interpart Update > Delay Geometry and 

Expressions). Это будет блокировать обновление связанной геометрии и выражений при 

их изменениях в исходных моделях до отмены этого режима или ручного обновления связей. 

Использование этой опции блокирует изменения для всех связей во всех загруженных моде-

лях. 

• Переключитесь в Навигатор сборки, вызовите контекстное меню по щелчку правой кнопки 

мыши на компоненте и выберите сборку в пункте меню Отобразить родителей (Display 

Parent).

Рисунок 4.3. Изменение исходного объекта

Рисунок 4.4. Создание позиционно-независимой связи
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• Двойным  щелчком мыши на компоненте сборки сделайте её рабочей деталью и, выбрав ис-

ходный компонент в Навигаторе сборки, нажмите правую кнопку мыши и выберите пункт 

меню Перемещение (Move). Затем с помощью маркеров переместите компонент в про-

извольном направлении (рис. 4.3). Скопированная грань осталась на месте, так как активен 

режим блокировки обновлений. Нажмите ОК в диалоге перемещения компонента.

• Активируйте  в Навигаторе сборки режим работы с WAVE связями. Для этого нажмите 

правую кнопку мыши в любом пустом месте навигатора (там, где нет компонентов сборки) и 

в контекстном меню выберите пункт Режим WAVE (WAVE Mode).

• Обновим связь между деталями. Для этого можно отключить режим блокировки обновлений, 

но мы воспользуемся альтернативным способом и обновим связь вручную. Выбрав в Нави-

гаторе сборки наш компонент 

в контекстном меню правой кноп-

кой мыши, выберите пункт WAVE 

> Обновить деталь (WAVE > 

Update Part). Скопированная 

грань сместится в новое положе-

ние исходной грани. 

• Создадим ещё одну копию этой же 

грани, но воспользуемся теперь 

другой командой. В Навигаторе 

сборки выберите исходный ком-

понент с моделью, то есть тот ком-

понент, геометрия которого долж-

на быть скопирована, и нажмите 

правую кнопку мыши. В появившемся меню выберите пункт WAVE > Копировать геоме-

трию в деталь (WAVE > Copy Geometry to Part). В диалоговом окне укажите наш новый 

компонент, то есть целевой компонент, куда геометрия будет скопирована, и нажмите ОК. 

В следующем диалоговом окне в выпадающем списке Фильтр (Filter) выберите значение 

Грань (Face) и в графической области укажите на торцевую грань модели, после чего на-

жмите ОК (рис. 4.4). В новом компоненте будет создана ещё одна копия грани, но в этот раз 

она будет создана в нуле системы координат модели. 

Это позиционно независимая связь. Они отслеживает изменения геометрии исходного 

объекта, но не учитывает положения компонента в сборке. Хотя в данном случае мы создали 

позиционно независимую связь между компонентами, входящими в одну сборку, на практике 

такого типа связи создаются между моделями напрямую, без использования общей сборки.

 

• Ещё раз операцией перемещения сместите исходный компонент в произвольном направле-

нии и двойным щелчком мыши на нем в Навигаторе сборки сделайте его рабочей дета-

лью. Откройте Навигатор модели и удалите из дерева построения последнюю операцию  

построения отверстия. Затем переключитесь обратно в Навигатор сборки, отобразите ро-

Рисунок 4.5. Связанные объекты до обновления
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дительскую сборку и сделайте её рабочей де-

талью. Так как режим задержки обновлений 

включен, то пока обе связи остаются необнов-

лёнными (рис. 4.5).

• Обновим связь, но на этот раз воспользуем-

ся командой главного меню Инструменты > 

Обновить > Обновить связи между де-

талями > Обновить всё (Tools > Update > 

Interpart Update > Update All). Эта коман-

да обновляет все межмодельные  сборочные 

связи, требующие актуализации во всех загру-

женных компонентах (рис. 4.6).

После завершения обновления обе скопиро-

ванные грани примут новое геометрическое представление, так как в исходной грани исчез-

ли отверстия. Но изменения позиции исходного компонента будут восприняты только гранью, 

скопированной с позиционно зависимой связью. Это ключевое различие между этими типа-

ми связей, которое надо учитывать при моделировании с использованием связанной геоме-

трии из других компонентов. 

Ещё один способ создания позиционно зависимой связи заключается в команде WAVE > 

Копировать геометрию в компонент (WAVE > Copy Geometry to Component) контекст-

ного меню в Навигаторе сборки. Для использования этой команды необходимо выбрать в 

Навигаторе сборки исходный компонент, вызвать эту команду и в открывшемся диалоге 

сначала выбрать геометрию, которую необходимо скопировать, а затем, переключившись 

на следующий шаг выбора, указать целевой компонент в Навигаторе сборки или графиче-

ской области (рис. 4.7).  

Ряд команд модуля Моделирование (Modeling) имеют возможность автоматически соз-

давать позиционно зависимые копии геометрии, которую они используют в качестве входных 

Рисунок 4.7. Создание позиционно-независимой связи через меню компонента

Рисунок 4.6. Связанные объекты после обнов-

ления
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данных, если эта геометрия находится в другом компоненте сборки. Продемонстрируем это 

на примере команды Вытягивание (Extrude). 

• Закройте сборку Assy-links.prt без сохранения и откройте её заново или воспользуй-

тесь командой главного меню Файл > Закрыть и открыть снова выбранные детали 

(Close and Reopen Selected Parts), включив опцию Деталь и компоненты (Part and 

Components).

• Добавьте новый компонент в сборку и сделайте его рабочей деталью.

• На инструментальной панели Элемент (Feature) нажмите кнопку Вытягивание (Extrude) 

или выберите пункт меню Вставить > Элемент проектирования > Вытягивание (Insert 

> Design Feature > Extrude).

• В инструментальной панели выбора в выпадающем списке Область выбора (Selection 

Scope) установите значение Вся сборка (Entire Assembly) – это позволит выбирать ге-

ометрию в других компонентах. И нажмите кнопку Создать связи между деталями 

(Create Inetrpart Link), чтобы включить режим автоматической привязки к геометрии дру-

гих компонентов. После этого выберите кромки торцевой грани детали исходного компонен-

та и нажмите ОК в диалоге. Переключитесь в Навигатор модели. Система автоматически 

создала объект, содержащий кривые с позиционно зависимой связью, и  использовала его 

для построения элемента вытягивания (рис. 4.8). 

Механизм создания ассоциативных межмодельных связей позволят отслеживать не толь-

ко положение скопированного элемента в контексте сборки, но и его состояние на момент 

создания ассоциативной копии. В предыдущих примерах скопированная грань при обнов-

лении приводилась к текущему состоянию грани в исходной модели. То есть все изменения в 

исходной модели, которые были сделаны после создания связанных копий, учитывались свя-

зью. Это не всегда бывает нужно, и в ряде случаев необходимо учитывать все изменения, ко-

торые происходят в исходной модели до момента создания ассоциативной копии, и игнори-

Рисунок 4.8. Автоматическое создание связи
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ровать то, что было сделано после. Это бывает актуально, когда скопированные геометриче-

ские объекты, использованные для построений в соседних компонентах, потом модифициру-

ются для моделирования обработки в сборке. Давайте создадим ассоциативную копию гра-

ни, которая будет учитывать её геометрическое состояние на момент создания копии.

• Ещё раз закройте сборку Assy-links.prt без сохранения и откройте её заново.

• Добавьте новый компонент в сборку и сделайте его рабочей деталью.

• Воспользуемся командой Редактор геометрических связей WAVE для создания пози-

ционно зависимой связи, как в первом примере, но на этот раз, выбрав грань, в диалоге 

включим опцию Фиксировать как текущее состояние в процессе построения (Fix at 

Current Timestamp) (рис. 4.9).

• Сделайте исходную модель рабочей деталью и, переключившись в Навигатор модели, 

внесем два изменения в дерево построения модели. Двойным щелчком на последнем элемен-

те построения Простое отверстие (Hole) перейдите в режим его редактирования и поме-

няйте диаметр с 12 мм на 18 мм. И сделайте фаску по контуру грани. Теперь в дереве по-

строения есть изменение, которое касается элемента, созданного до момента копирования 

грани, и один новый элемент построения, меняющий грань после того, как она была скопи-

рована (рис. 4.10). 

• Сделайте сборку рабочей деталью  и обновите новый компонент через пункт контекстного 

меню WAVE > Обновить деталь (WAVE > Update Part). В результате копия грани в це-

левом компоненте будет изменена, но изменение будет касаться только диаметра отверстий, 

в то время как появление фаски на исходной грани будет проигнорировано (рис. 4.11).

При использовании команд контекстного меню в Навигаторе сборки WAVE > Копиро-

вать геометрию в компонент и Копировать геометрию в деталь такого типа связи стро-

ятся при включении опции Порядок построения (At Timestamp) в диалоге создания связи. 

Мы рассмотрели основные команды создания ассоциативных межмодельных связей. Рас-

смотрим оставшиеся пункты контекстного меню WAVE в Навигаторе сборки:

Создание нового уровня (Create New Level) – команда создаёт новый компонент под 

Рисунок 4.9. Зависимость связи от времени создания
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текущей рабочей деталью, куда вставляет ассоциативную копию выбранных геометрических 

объектов  из рабочей детали. Эта команда применяется, когда надо «развалить» на несколь-

ко составных частей одну модель с сохранением ассоциативной связи между исходной моде-

лью и составными частями.

Копировать геометрию в новую деталь (Copy Geometry to New Part) – эта команда 

аналогична команде Копировать геометрию в деталь за исключением того, что копирова-

ние производится не в существующую модель, а в создаваемую новую. 

Копировать компонент как (Copy 

Component As) – команда пересохраня-

ет под новым именем компонент и сразу 

вставляет его в текущую рабочую деталь. 

Используется для создания подобных ком-

понентов, содержащих ассоциативные ге-

ометрические связи. 

Создание детали со связью (Create 

Linked Part) – создает новую модель, куда 

помещает ассоциативно связанное твер-

дое тело на основе выбранного ссылочно-

го набора текущей рабочей детали. 

Заморозить в сессии (Freeze in Ses si-

on) – блокирует все обновления межмодельных связей для выбранного компонента в текущей 

сессии NX.

Заморозить постоянно (Freeze Persistently) – блокирует все обновления межмодельных 

связей для выбранного компонента до отмены  блокировки. 

Разрешить состояние обновления (Resolve Update Status) – обновляет межмодельные 

связи для выбранного компонента, если активен режим задержки обновления геометрии и вы-

ражений.

Рисунок 4.10. Изменение исходного компонента

Рисунок 4.11. Обновление связи
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В зависимости от текущего статуса 

межмодельных связей в контекстном меню 

могут появляться пункты:

Разморозить (Unfreeze) – отменяет 

действие команд Заморозить в сессии и 

Заморозить постоянно.

Показать объекты, требующие об-

новления (Show Out of Date Objects) – 

отображает информационное окно с опи-

санием объектов, требующих обновления 

при действии команд Заморозить в сес-

сии или Заморозить постоянно.

Все использованные до сих пор коман-

ды создавали ассоциативные копии геоме-

трических объектов. Между тем в процессе 

проектирования часто возникает необходимость привязываться не только к геометрии другой 

модели, но и к каким-либо числовым параметрам и выражениям. Редактор выражений, вызы-

ваемый командой главного меню Инструменты > Выражения (Tools > Expression), предо-

ставляет возможность создавать и редактировать ссылки на параметры других моделей, за-

груженных в сессии (рис. 4.12). 

ПРОСМОТР И ОБНОВЛЕНИЕ СВЯЗЕЙ
Давайте на примере создания нового компонента в контексте сборки рассмотрим работу 

с параметрическими и геометрическими связями.

• Запустите NX, нажмите кнопку откры-

тия существующей модели и в диало-

ге нажмите кнопку Опции (Options) 

в левом нижнем углу. Нам необходимо 

установить опции загрузки сборки, что-

бы данные о межмодельных связях за-

гружались при открытии.

• Включите опцию Загрузка данных 

о связях между деталями (Load 

Interpart Data) и в выпадающем спи-

ске Загрузите родителей (Load 

Parents) выберите значение Все уров-

ни (All Levels), нажмите ОК в диалоге 

опций загрузки (рис. 4.13). 

Рисунок 4.12. Создание параметрических связей

Рисунок 4.13. Опции загрузки сборки
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Первая опция управляет, будут ли данные о межмодельных связях загружены одновремен-

но с моделями, а вторая определяет, для какого уровня сборки загружать данные о связях – 

только для первого или для всех.  Как правило, включение режима загрузки данных о связях 

необходимо, когда надо открыть сборку и провести изменения, вызванные модификацией ис-

ходных данных. Загрузка данных о связях повышает количество необходимой памяти для от-

крытия сборки, так как детали, содержащие ссылки на другие модели, начинают подгружать 

частично, и эти модели тоже, которые не всегда являются компонентами открываемой сборки. 

И более того, если не включен режим задержки обновления, то при открытии сборки с меж-

модельными связями будет производиться их обновление, что может занять достаточно дли-

тельное время при работе с большими сборками. Поэтому использовать опцию загрузки меж-

модельных связей надо по мере необходимости. Следует добавить, что это не единственный 

способ загрузить данные о связях. Практи-

чески все команды WAVE, отвечающие за 

просмотр и редактирование связей, опре-

деляют текущий статус загруженных моде-

лей, и если данные о связях не были загру-

жены, пользователю будет предложено их 

загрузить. В дополнение к этому существу-

ет возможность вручную загрузить дан-

ные о связях с помощью команды главного 

меню Сборки > WAVE >  Загрузить дан-

ные связей (Assemblies > WAVE > Load 

Interpart Data). В нашем примере сбор-

ка содержит всего несколько компонентов 

Рисунок 4.14. Команда вызова диаграммы связей

Рисунок 4.15. Диаграмма связей
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с межмодельными связями, поэтому мы загру-

зим данные о связях при её открытии.

• Выберите файл сборки Fan.prt из папки ch4/

Fan и нажмите ОК.  

• Сборка представляет собой три детали, ко-

торые связаны между собой геометрически-

ми ссылками. Существуют несколько возмож-

ностей просмотра межмодельных связей. Для 

отображения общей схемы ссылок между мо-

делями и их текущего статуса воспользуйтесь 

командой главного меню Сборки > WAVE 

>  WAVE Диаграмма текущей сборки 

(Assemblies > WAVE > WAVE Diagram of 

Current Assembly).

В меню присутствует ещё команда отобра-

жения диаграммы текущей сессии, и, как ясно 

из названия, различие этих двух команд в обла-

сти действия. В первом случае диаграмма меж-

модельных связей будет построена для текущей 

активной сборки, а во втором будут учтены все 

загруженные на данный момент модели. Если вы не видите в интерфейсе этих команд, то пе-

реключите роль интерфейса на Расширенные с полным меню (Advanced with full menus) 

или воспользуйтесь поиском команд, вызвав диалог  Помощь > Поиск команды (Help > 

Рисунок 4.16. Просмотр связнй между деталя-

ми

Рисунок 4.17. Создание геометрических связей
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Command Finder) (рис. 4.14). 

  Диаграмма связей представляет собой графическое изображение связей между компо-

нентами, которое показывает текущий статус связей, их тип и состояние соответствующих 

компонентов (рис. 4.15).  Для получения более детальной информации, а именно информа-

ции о том, какие именно объекты были использованы для создания межмодельных связей меж-

ду двумя компонентами, можно воспользоваться контекстным меню, щедкнув правой кнопкой 

мыши на схематичном изображении интересующего компонента. Команда Просмотр связей 

детали (Browse Part Links) выведет список ис-

пользованных геометрических объектов.

Ещё одно средство просмотра и редакти-

рования существующих межмодельных свя-

зей реализует команда главного меню Сбор-

ки > WAVE > Просмотр связей между де-

талями (Assemblies > WAVE > Interpart Link 

Browser). Диалог команды предоставляет де-

тальную информацию о связях во всех полно-

стью загруженных моделях, как геометриче-

ских, так и параметрических. Из этого же ди-

алога можно редактировать связи, переназна-

чая геометрические элементы (рис. 4.16).

Создадим модель вентилятора, вписанного в 

данную сборку, с использованием геометрии и параметров существующих компонентов.

• Закройте все диалоговые окна просмотра связей и, в Навигаторе сборки выбрав верхний 

узел, добавьте новый компонент с помощью кнопки Создать новый компонент в инстру-

ментальной панели Сборки или аналогичной командой в разделе главного меню Сборки > 

Компоненты (Assemblies > Components).

• Скройте компонент Grid, нажав на нем правой кнопкой мыши в Навигаторе сборки и вы-

брав пункт меню Показать и скрыть > Скрыть (Show and Hide > Hide). Он нам пока не 

Рисунок 4.18. Создание связей между параметрами

Рисунок 4.19. Созданные переменные
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понадобится. 

• Двойным щелчком в Навигаторе 

сборки на созданном компоненте сде-

лайте его рабочей деталью.

• Вызовите Редактор геометрических 

связей WAVE (WAVE Geometry 

Linker) и, убедившись, что опция Ассо-

циативно (Associative) включена, вы-

берите грани деталей Frame и Pin, как 

показано на рис. 4.17. 

Мы создали в новой модели три связи 

на геометрию других компонентов сборки, которую будем использовать для построения сво-

ей детали.

• Переключитесь в Навигатор модели 

и вызовите редактор выражений через 

меню Инструменты > Выражение 

(Tools > Expression) . Создайте пере-

менную PinRef и свяжите её с перемен-

ной PinLength из компонента сбор-

ки Pin. Для этого в редакторе выраже-

ний введите новой имя переменной в 

поле Имя (Name)  и нажмите кнопку 

Cоздать ссылки между деталями 

(Create Interpart Reference). 

• В появившемся диалоге выберите мо-

дель Pin.prt и нажмите OK. В следую-

щем диалоге укажите переменную Pin_

Length и нажмите ОК. В строке Фор-

мула (Formula) появится строчка свя-

зи с переменной другой модели. Завер-

шите создание связанной переменной 

нажатием кнопки Применить (Apply) 

(рис. 4.18).

• Не закрывая диалога Выраже-

ния, создайте аналогичным обра-

зом ещё одну переменную с именем 

BladesNumber,  связанную с перемен-

ной NumBlades, определенной в мо-

дели верхней сборки Fan_assy (рис. 

Рисунок 4.20. Создание элемента вытягивания

Рисунок 4.21. Проецирование кривой

Рисунок 4.22. Создание офсетной поверхности
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4.19), только в отличие от предыдущей пере-

менной во втором выпадающем списке, за-

дающем тип переменной, поменяйте зна-

чение с Длина (Length) на Постоянный 

(Constant). После чего закройте диалог ре-

дактирования выражений.

Таким образом, мы создали две связи на па-

раметры других моделей, которые будем ис-

пользовать в наших построениях.

• Создайте элемент Вытягивание (Extrude) 

на базе эскиза, расположенного на скопи-

рованной плоской грани компонента Frame. 

Эскиз должен представлять собой окруж-

ность диаметром 35–40мм с центром, распо-

ложенным на оси цилиндрической грани ком-

понента Pin (рис. 4.20). В параметрах опера-

ции вытягивания укажите первое  расстояние, 

равное 4 мм, чтобы обеспечить зазор между 

получаемым элементом вытягивания и скопи-

рованной гранью. А в качестве второго зна-

чения расстояния укажите значение, равное 

(PinRef–6) мм.

• На плоскости ZX системы координат модели 

постройте эскиз, состоящий из дуги или пря-

мой, примерно как это показано на рис. 4.21.

• С помощью команды главного меню Вста-

вить > Кривая по кривой > Проецирова-

ние (Insert > Curve from Curves > Project) 

спроецируйте построенный эскиз на грань 

тела вытягивания вдоль оси Y (рис. 4.21).

• На основе цилиндрической скопированной 

грани создайте офсетную поверхность на 

расстоянии 3 мм с помощью команды Вста-

вить > Смещение/Масштаб > Смеще-

ние поверхности (Insert > Offset/Scale > 

Offset Surface) (рис. 4.22).

• Постройте одну лопасть вентилятора. Соз-

дайте элемент Вытягивание на основе спро-

ецированной кривой вдоль оси Y, задав рас-

стояние вытягивания 50–70 мм (рис. 4.23).

Рисунок 4.23. Создание лопасти

Рисунок 4.24. Обрезка поверхности

Рисунок 4.25. Массив по окружности
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• Командой Вставить > Обрезка > Обрезка поверхности (Insert > Trim > Trimmed 

Sheet) обрежьте полученный элемент вытягивая офсетной поверхностью  (рис. 4.24).

• Используя команду Вставить > Смещение/Масштаб >  Утолщение (Insert > Offset/

Scale > Thicken) придайте толщину полученной поверхности, выбрав обрезанную поверх-

ность и задав величину смещения в 1 мм. Затем скройте все поверхности и кривые построе-

ния, переместив их на любой невидимый слой командой Формат > Переместить на слой 

(Format > Move to Layer), оставив 

только твердые тела. 

• Командой Вставить > Ассоциатив-

ная копия > Геометрия массива 

(Insert > Associative Copy > Instance 

Geometry) создайте круговой мас-

сив тел на основе полученного тела. Вы-

берите тип (Type) массива в выпада-

ющем списке – Вращение (Rotate), 

укажите вектор Z как ось вращения и 

задайте точку в центре окружности эле-

мента вытягивания. В поле ввода зна-

чения угла (Angle) введите формулу 

360/BladeNumber, а в поле Число ко-

пий (Number of Copies) введите зна-

чение BladeNumber. Система сразу 

подставит числовые значения и создаст 

соответствующие формулы в редакторе выражений. Нажмите ОК в диалоге построения мас-

сива (рис. 4.25). 

• Сохраните деталь и, переключившись в Навигатор сборки, отобразите родительскую 

Рисунок 4.26. Изменение параметров модели

Рисунок 4.27. Диаграмма связей
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сборку текущей модели. Сделайте сборку рабочей и, нажав правую кнопку на созданном 

компоненте Fan, выберите в контекстном меню WAVE > Заморозить постоянно (WAVE 

> Freeze Persistently) и сохраните сборку. Это изолируют компонент на случай изменения 

ссылочных данных. 

• Двойным щелчком в Навигаторе сборки на компоненте Frame сделайте его рабочей де-

талью и откройте диалог редактирования выражений. Найдите переменную W со значением 

120, которая определяет габариты корпуса вентилятора, и поменяйте её значение на 140 и 

нажмите кнопку Применить. Компоненты сборки перестроятся, за исключением модели са-

мого вентилятора, так как в данный момент межмодельные связи заморожены для изменений 

(рис. 4.26). 

• Сделайте сборку рабочей деталью и, открыв диалог редактирования выражений, поменяй-

те значение переменной NumBlades с 6 на 8. Затем просмотрите текущее состояние меж-

Рисунок 4.28. Информация о состоянии связей

Рисунок 4.29. Менеджер WAVE связей
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модельных связей с помощью команды  Сборки > WAVE > WAVE диаграмма текущей 

сборки (Assemblies > WAVE > WAVE Diagram of Current Assembly). 

Как видно из диаграммы, все связи компонентов, кроме модели вентилятора, находятся в 

актуальном состояния, а на схематичном представлении компонента вентилятора показаны 

значки статуса заморозки и наличия необновленных связей (рис. 4.27). На данный момент 

построенная модель вентилятора ссылается на геометрию двух других компонентов сборки – 

Frame и Pin, причем это позиционно зависимые связи, а также использует переменные из ком-

понента Pin и из самой родительской сборки Fan_Assy.

• Нажмите в диаграмме связей правую кнопку мыши на компоненте Fan и в контекстном меню 

выберите Просмотр связей детали (Browse Part Links), затем в появившемся диалоге 

выберите все связи (Select All Links) и нажмите кнопку Показать информацию о связях 

(Show Link Information). В появившемся информационном окне будут отображены все вы-

бранные связи с указанием элементов построения родительских моделей, геометрия кото-

рых была  использована для создания связи, a также тип геометрии, которая была скопиро-

вана, и текущий статус  этих связей (рис. 4.28).Обратите внимание, что отображаются толь-

ко данные по геометрическим связям. Закройте информационное окно и диаграмму связей 

сборки.

• С помощью команды Сборки > WAVE > Менеджер WAVE связей (Assemblies > WAVE 

> Associativity Manager) откройте ещё одно средство для просмотра и обновления связей. 

Менеджер WAVE связей дает возможность просмотреть, какие компоненты сборки в данный 

момент требуют обновления и какие конкретно элементы в этих компонентах не актуальны, а 

также разрешить состояние обновления или снять статус заморозки. В открывшемся диалоге 

в списке Требующие обновления замороженные детали (Out of Date Frozen Parts) 

Рисунок 4.29. Просмотр связей между деталями по объектам
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мы видим наш компонент вентилятора (рис. 4.29). Выделите его и нажмите кнопку Пока-

зать объекты, требующие обновления (Show Out of Date Objects). На этот раз в от-

крывшемся информационном окне будут отображены не только геометрические межмодель-

ные связи, требующие обновления, но и параметрическая связь. Закройте информационное 

окно и диалог менеджера связей без обновления. 

В большинстве случаев для проведения обновлений сборок, в которых есть заморожен-

ные связи или необновлённые связи при включенном режиме задержки изменений, впол-

не достаточно использовать диаграмму и менеджер связей. Но если возникает необходи-

мость более детально исследовать геометрические зависимости и управлять их состоянием, 

для этого больше подойдёт рассмотренный выше диалог Просмотр связей между деталями  

(Assemblies > WAVE > Interpart Link Browser) в разделе меню Сборки > WAVE.

• Откройте этот диалог и в разделе Связи для просмотра (Links to Investigate) выберите 

опцию Объекты (Objects). В этом режиме вы можете получить информацию о связях, соз-

данных на основе конкретного элемента дерева построения модели. Укажите в графической 

области на модель корпуса, и в диалоге появится информация о том, какой элемент постро-

ения был выбран и какие связи были созданы на основе геометрии этого элемента. Поми-

мо отображения имен компонентов, которые используют геометрию выбранного элемента, и 

основных данных о них, здесь можно видеть текущий статус связи в колонке Состояние свя-

зи (Link Status), Тип связи (Link Type) в одноимённой колонке, а также была ли исполь-

зована опция зависимости от порядка построения при создании связи  – в колонке Поря-

док построения (At timestamp) (рис. 4.29). В этом диалоге вы можете не только просма-

тривать, но и редактировать геометрические связи. Для этого при выборе какой-либо свя-

зи в правом нижнем углу активируются кнопки Изменить (Edit) и Разорвать связь (Break 

Link), которые позволяют соответственно переназначить исходный геометрический объект 

для связи или разорвать 

связь и сделать скопиро-

ванный геометрический 

элемент неассоциативным. 

• Переключите режим 

просмотра связей, выбрав 

в разделе Связи для про-

смотра опцию Элемен-

ты (Features). В этом ре-

жиме информация о связях 

предоставляется в более 

обобщенном виде и свя-

зи показываются на осно-

ве выбранного компонен-

та сборки, без детализации 
Рисунок 4.30. Просмотр связей между деталями по элементам
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до уровня элементов построения модели.  Выбирая интересующий компонент в диалоге или 

Навигаторе сборки, вы можете получить полный список всех связей, которые используют-

ся в данном компоненте (рис. 4.30). Последний режим отображения связей, определяемый 

опцией Детали (Parts), предоставляет самый простой режим отображения, который пока-

зывает только зависимости между компонентами без детализации по конкретным связанным 

геометрическим элементам.

• Закройте окно просмотра связей и обновите компонент Fan, нажав правой кнопкой мыши в 

Навигаторе сборки и выбрав пункт меню WAVE > Разморозить  (WAVE > Unfreeze).

• Связи будут обновлены, и модель перестроится, исходя из новых значений геометрических 

параметров и связанных переменных. Сохраните модель и закройте сборку. 

Управление состоянием межмодельных связей является ключевой составляющей процес-

са проведения изменений в макете изделия. В ряде случаев изменения исходных данных не 

должны влиять на связанные модели – например, когда исходные данные варьируются с точ-

ки зрения оптимизации и до получения окончательного результата принимают несколько про-

межуточных состояний. В таком случае постоянные перестроения связанных моделей будут 

нежелательны, поэтому состояние заморозки связей защищает модель от нежелательных по-

строений. Когда изменение исходных данных утверждено, то их можно учесть в связанных мо-

делях, разморозив соответствующие связи.

СОЗДАНИЕ ИНТЕРФЕЙСОВ ДЕТАЛЕЙ
При создании геометрических и параметрических связей имеет смысл привязываться к за-

ранее определённым элементам и переменным. То есть к таким объектам, которые будут ста-

бильны с точки зрения изменений, не будут вырождаться и которые можно будет легко отсле-

Рисунок 4.31. Определение интерфейса модели
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живать. До сих пор при создании геометрических свя-

зей мы могли выбирать любую геометрию родительской 

модели. Также и в случае с созданием параметрических 

связей мы могли выбирать любые переменные в исхо-

дных моделях. Это вполне работает, когда межмодель-

ные связи создаются в рамках сборки, которую разра-

батывает один человек. Когда возникает необходимость 

связи моделей, разрабатываемых разными участниками 

проекта, то появляется необходимость в договоренно-

сти относительно того, к каким объектам можно привя-

зываться и какие параметры можно использовать.  Если 

не оговорено, какие объекты могут быть использованы 

для привязки, то с большой долей вероятности будут воз-

никать проблемы обновления связей, вызванные удалением исходных геометрических эле-

ментов или параметров, на основе которых создавались эти связи.  Для того чтобы сделать 

поведение моделей при изменениях более предсказуемым и избежать таких проблем, необ-

ходимо использовать механизм интерфейсов геометрической модели, который реализован в 

NX. Под интерфейсом модели понимается набор геометрических объектов и выражений (пе-

ременных), которые модель предоставляет для создания межмодельных и сборочных связей. 

Другими словами, это те элементы геометрии модели, которые можно использовать для соз-

дания связей, и те переменные модели, на которые можно ссылаться. По умолчанию моде-

ли предоставляют доступ ко всем элементам геометрии и ко всем переменным, то есть интер-

фейс не определен. Давайте на примере простой модели определим интерфейс, который бу-

дет использован для создания межмодельных связей:

• Откройте файл сборки Assy-links.prt из папки ch4/Interface.

• В сборке находится один компонент, которому мы должны определить интерфейс. Двойным 

щелчком левой кнопки мыши на компоненте links_part сделайте его рабочей деталью и от-

кройте диалоговое окно определения интерфейса с помощью команды главного меню Ин-

струменты > Интерфейс изделия (Tools > Product Interface).

• Первый блок диалога предлагает выбрать геометрию. Укажите на торцевую грань и цилин-

дрические грани отверстий. Каждый раз при указании какой-либо геометрии в список диа-

логового окна будет  добавляться строчка, соответствующая выбранному элементу. Этот спи-

сок определяет набор элементов, из которых будет состоять интерфейс. При неправильном 

выборе элемента можно воспользоваться кнопкой Удалить из интерфейса (Remove from 

Interface) (рис. 4.31). Второй блок диалога предлагает выбрать выражения (переменные) из 

числа существующих, которые будут добавлены в список элементов, задающих интерфейс. 

Нажмите кнопку Выберите выражение (Select Expression) и в появившемся диалоге вы-

берите какие-нибудь переменные (рис. 4.32). 

После выбора геометрических объектов и переменных необходимо выбрать режим рабо-

Рисунок 4.32. Публикация выражений 

в интерфейс



95

NX Глава 4. Моделирование в контексте

ты интерфейса. Для этого необходимо воспользоваться выпадающим списком Связь меж-

ду деталями (Interpart Linking) в нижнем блоке диалогового окна.  Исходное значение 

этой опции – Разрешить выбор любой геометрии или выражения (Allow Selection of 

Any Geometry or Expression) – позволяет выбирать все объекты в модели. Второе значе-

ние – Разрешить использование объектов интерфейса (Encourage Usage of Interface 

Objects) – делает объекты, входящие в интерфейс, «рекомендательными» к использованию. 

Это означает, что пользователь всё ещё может привязываться к любой геометрии и выбирать 

любые переменные, но в случае если выбранные объекты не входят в интерфейс модели, си-

стема будет выдавать предупреждающее сообщение. И последняя опция, самая строгая – 

Ограничение выбора, чтобы связать объекты только с помощью интерфейса (Restrict 

Selection to Only Interface Objects) – заставит выбирать для привязок лишь ту геометрию и 

переменные, которые входят в список интерфейса. Второй выпадающий список Сопряжение 

сборки (Assembly Constraints) определяет аналогичное поведение элементов интерфейса 

при наложении сборочных связей в сборке, что также может быть полезным с точки зрения 

упорядочивания процесса создания сборок. 

• Установите опцию Связь между деталями в третье значение и выйдите из диалога, нажав 

кнопку ОК.

Рисунок 4.34. Создание связи с параметрами

Рисунок 4.33. Режим привязки к интерфейсным объектам
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• Двойным щелчком левой кнопки мыши в Навигаторе модели сделайте сборку рабочей де-

талью и создайте в ней новый компонент, который, в свою очередь, тоже сделайте рабочей 

деталью. 

• Вызовите Редактор геометрических связей WAVE и попробуйте выбирать грани, кото-

рые входят в интерфейс и которые не входят в него.  Подсвечиваться будут только те грани, 

которые входят в интерфейс, что означает возможность их выбора (рис. 4.33). 

• Нажмите ОК в диалоге создания связей и выберите в главном меню пункт Инструменты > 

Выражение. В диалоге введите имя новой переменной в поле Имя и нажмите кнопку соз-

дания ссылки между деталями, выберите деталь links_part для отображения списка доступ-

ных переменных. В списке будут отображены только те переменные, которые были добавле-

ны в список, определяющий интерфейс модели, все остальные переменные модели будут не-

доступны (рис. 4.34). Выберите любую доступную переменную и нажмите ОК, затем выйди-

те из диалога создания выражений. 

• Сделайте компонент сборки links_part рабочей деталью и откройте диалог определения ин-

терфейса. Помимо выбора объектов, определяющих интерфейс,  этот диалог предоставляет 

возможность узнать, какие модели ссылаются на объекты интерфейса. Для этого выберите в 

списке какой-нибудь объект и нажмите кнопку Где ссылается (Where Referenced). Будет 

открыто диалоговое окно с описанием всех межмодельных связей, созданных на базе вы-

бранного объекта (рис. 4.35).

•  Закройте диалоговые окна и закройте сборку.

На основе приведенного выше примера ясно видно, что использование интерфейсов на-

много упорядочивает процесс создания межмодельных связей. Естественно, существующий 

инструментарий просмотра и редактирования связей WAVE работает и без использования 

Рисунок 4.35. Отслеживание ссылок на объект интерфейса
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интерфейсов, но в таком случае повышается трудоемкость участников проекта, так как при 

возможности использовать любые объекты геометрии для создания связей становится значи-

тельно труднее их отслеживать и ими управлять.

МОДЕЛИРОВАНИЕ ОБРАБОТКИ В СБОРКЕ
Механизм создания межмодельных связей позволяет реализовать моделирование обра-

ботки деталей в сборке на основе создания на уровне сборки связанных представлений ком-

понентов, входящих в сборку. В функционале системы NX есть набор команд, которые реа-

лизуют некоторые операции обработки в сборке и без создания связей, например  такие как 

Вырез в сборке (Assembly Cut). Но использование межмодельных связей WAVE для подоб-

ных задач предлагает более универсальный подход. 

• Откройте сборку BracketAssy.prt из папки сh4/AssyLevel.

• Откройте Редактор геометрических связей WAVE, и выбрав в выпадающем списке 

Тип (Type) значение Тело (Body), выберите два компонента bracket и компонент plate (рис. 

4.36). 

Так как текущей рабочей деталью является сама сборка, то связанные тела будут добавле-

ны в компонент самой сборки. То есть мы на уровне сборки создали связанную геометрию из 

Рисунок 4.36. Создание связей на уровне сборки
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трех тел на основе компонентов входящих в сборку. Дальше можно работать с этими связан-

ными объектами, как если бы мы их сделали в рамках любого компонента сборки. 

• В Навигаторе сборки нажмите правую кнопку мыши на сборке и заморозьте её от изме-

нения, выбрав пункт контекстного меню WAVE > Заморозить постоянно,  и после этого 

сохраните сборку. Этим мы блокируем любые изменения в связанной геометрии, хранящей-

ся в головном компоненте самой сборки, вызванные изменениями компонентов. Но при этом 

ничто не мешает менять состав самой сборки. 

• В Навигаторе сборки выделите компоненты, которые мы использовали для создания свя-

Рисунок 4.37. Работа со связанными представлениями

Рисунок 4.38. Модификация исходных компонентов
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занных тел, и, нажав правую кнопку мыши на них, выберите в контекстном меню пункт За-

крыть > Деталь (Close > Part). Исходные компоненты будут выгружены из памяти, но свя-

занные тела останутся загруженными. Это одно из преимуществ использования межмодель-

ных связей для операций моделирования обработки сборки – не обязательно загружать ис-

ходные компоненты, чтобы работать со связанной геометрией. 

• Переключитесь в Навигатор модели и проделайте какие-нибудь операции над связанны-

ми телами. Например, объедините полученные тела командой Вставить > Комбинировать 

> Объединение (Insert > Combine > Unite)  и с помощью команды Вставить > Элемент 

проектирования > Вытягивание (Insert > Design Feature >Extrude) сделайте вырез, 

как показано на рисунке 4.37.

• В Навигаторе сборки выделите три выгруженных компонента и в контекстном меню пра-

вой кнопке мыши выберите пункт Открыть > Компонент (Open > Component). 

• Выберите компонент bracket и сделайте его отображаемой деталью. Операцией Переме-

стить грань (Move Face) сместите грани, показанные на рисунке 4.38. Сохраните модель 

и отобразите всю сборку.

• Сделайте сборку рабочей деталью и разморозьте межмодельные связи, созданные в сбор-

ке, с помощью команды контекстного меню правой кнопкой мыши на головном компоненте 

сборки  WAVE > Разморозить.

• Выгрузите компоненты bracket и plate и убедитесь, что связанное тело было перестроено в 

соответствии с новым представлением исходных компонентов.

• Сохраните и закройте полученную сборку.

Таким образом, мы создали связанное представление компонентов, входящих в сборку, 

создав ассоциативные связанные тела на уровне головной сборки, с которыми мы дальше мо-

жем работать инструментами моделирования, реализуя требуемую обработку компонентов 

в сборку как единого целого. При этом исходные компоненты остаются неизменными, но лю-

бые изменения исходных компонентов отражаются на связанных телах. 

ПРОЕКТИРОВАНИЕ СВЕРХУ-ВНИЗ
Механизм межмодельных связей используется для реализации концепции проектирования 

сверху вниз, когда проектирование ведется от общей компоновки изделия к детальной про-

работке узлов и деталей с промежуточным членением на составные части. Исторически си-

стемы САПР начинали с проектирования снизу верх, когда сначала делаются составные ча-

сти – детали, потом они собираются в подсборки, затем в сборки и таким образом форми-

руется состав изделия. Такой подход  весьма условно может называться проектированием и 

подходит для очень простых изделий. Когда деталь или узел проектируется в отрыве от обще-

го контекста, то высока вероятность появления ошибки, которая потом может быть выявлена 

только при сборке реального изделия. Поэтому при разработке сложных изделий более эф-

фективен подход проектирования снизу верх, когда изделие начинает увязываться с ранних 

стадий проектирования. 
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Когда мы проектируем новый узел, создавая его модель в контексте существующего из-

делия, мы сталкиваемся с частной реализацией проектирования сверху вниз, так как в этом 

случае большая часть изделия уже готова и декомпозирована, но тем не менее мы использу-

ем окружающие детали как входные данные. Это в большей мере применимо к  созданию мо-

дификаций существующих изделий. Когда речь идёт о проектировании изделия с другой ком-

поновкой, на основе других входных данных, хоть и с использованием какого-то количества 

существующих узлов и наработок, то тут более уместно говорить о проектировании сверху 

вниз, а не о моделировании в контексте. 

Проектирование сверху вниз в системе САПР начинается с создания  общей компоновки 

изделия. С точки зрения реализации в NX этот этап специфичен для каждого конкретного типа 

изделия, так как разные изделия описываются  по-разному. Например, в каких-то случаях 

компоновка может определяться внешними обводами изделия, на которые завязывается все 

остальное, а в других случаях внешние обводы не так важны, и большую роль играет взаим-

ная увязка составляющих блоков изделия.  Но во всех случаях на этапе определения общей 

компоновки важно максимально увязать составляющие компоненты друг с другом, несмотря 

на то что сами компоненты ещё не проработаны. 

Следующим этапом идет декомпозиция общей компоновки. Декомпозиция также весьма 

сильно зависит от специфики изделия, когда доходит до реализации в системе САПР. В не-

которых случаях имеет смысл разбивать изделия на составляющие согласно разбиению на 

системы и агрегаты, в иных случаях прибегают к группировке агрегатов и систем и разбива-

ют общую компоновку по зональному признаку. Количество уровней декомпозиции зависит 

Рисунок 4.39. Схема использования межмодельных связей 
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от сложности изделия и иногда бывает достаточно велико. В таких случаях особенно важно 

иметь механизм отслеживания и управления связями. 

После того как изделие разбито на конечные составляющие, которые можно отдавать в 

проработку исполнителям или подрядчикам, формируется пакет исходных данных, состоящий 

из геометрических и параметрических объектов, описывающих данный узел.

После детальной проработки составляющих они собираются обратно согласно схеме де-

композиции и формируют конечный состав изделия. Этот состав изделия используется для 

контроля сборки, проведения различного рода анализов, подготовки производства и выпу-

ска документации. На всех этапах процес-

са проектирования межмодельные связи 

играют большую роль. Именно за счет от-

слеживания связей и управляемого прове-

дения изменений возможно реализовать 

процесс параллельной разработки, ког-

да все участники основываются на еди-

ном источнике данных, видят и управляют 

их изменением и работают в едином кон-

тексте проектируемого изделия. Реализа-

ций процесса проектирования сверху вниз 

с использованием механизма межмодель-

ных связей WAVE может быть множество, 

и вряд ли найдётся какая-то одна универсальная, подходящая под любые изделия. Давайте 

рассмотрим общие подходы к проектированию сверху вниз на основе упрощенной сборки 

кривошипно-шатунного механизма.

• Откройте в NX файл base.prt из папки ch4/TopDown. Файл содержит 2D схему механизма 

с определенными геометрическими параметрами, которые вынесены в выражения модели 

(рис. 4.40). 

Эта схема будет управляющей при разработке сборки механизма, и все его составляю-

щие будут с ней связаны. В реальных проектах это может быть плоская схема компоновки из-

делия, трехмерная компоновка, разметка трасс и точек привязки агрегатов, обводы изделия 

с разбиением на зоны и так далее. И как правило, управляющая схема представляет собой 

не один файл модели, а сборку, в которую входят несколько связанных геометрическими свя-

зями уровней декомпозиции изделия. В нашем примере для простоты мы ограничимся одним 

уровнем.

После создания управляющей схемы и её декомпозиции каждый участник с помощью меж-

модельных связей копирует из неё необходимые объекты и параметры. Далее на основе этих 

объектов он создает свою модель (узел). 

• Создайте новый файл сборки и вставьте в него модель base.prt. Это фиктивная рабочая 

Рисунок 4.40. Управляющая схема изделия
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сборка, которая служит собирающим контейнером для всех исходных данных при построе-

нии модели. С помощью сборочных связей закрепите компонент base в начале системы ко-

ординат сборки.

• Создайте в рабочей сборке новый компонент Crank  и сделайте его рабочей деталью. Это 

будет компонент, в котором мы будем производить построения нашей модели.

• Вызовите Редактор геометрических связей WAVE и, установив в панели выбора пра-

вило Единственная кривая (Single Curve) и значение Сложная кривая в выпадающем 

списке Тип (Type), выберите по очереди три кривые, указанные на рисунке 4.41. После вы-

бора каждой кривой необходимо нажимать кнопку Применить (Apply) для создания связи.

• Сделайте сборку рабочей деталью и вставьте в неё модель Rod.prt . 

Это деталь, которая разрабатывается другим участником проекта и соединяется с нашей 

при помощи шарнира. Она может быть заимствована из другого проекта или может разра-

батываться с нуля, но в любом случае нам необходимо создать геометрическую связь с ней. 

Если эта деталь также создается в данный момент времени, необходимо  привязываться к су-

ществующей на данный момент геометрии. Как раз в этом случае использование механиз-

ма интерфейсов помогает создавать отслеживаемые связи. Поэтому необходимо привязать-

ся к той геометрии, которая была опубликована участником проекта, работающего над со-

седней деталью. Альтернативой интерфейсам в данном случае является создание дополни-

тельных объектов в управляющей схеме, которые будут описывать место стыка, и которые 

будут использоваться обоими участниками для создания своих деталей. Этот вариант имеет 

преимущество перед использованием интерфейсов в том, что не надо ждать, пока появится 

Рисунок 4.41. Создание связей с управляющей схемой
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какая-либо геометрия в сопряжённых моделях, но за это преимущество приходится платить 

углубленной детализацией управляющей схемы, что не всегда оправдано. 

• Сделайте компонент Crank рабочей деталью и ещё раз вызовите Редактор геометриче-

ских связей WAVE и скопируйте из компонента Rod две грани (рис. 4.42).

• Выделите компонент Crank в Навигаторе сборки  и в контекстном меню, открывающем-

ся по нажатии правой кнопки мыши, выберите пункт WAVE > Заморозить постоянно 

(WAVE > Freeze Persistently). 

Этим мы предотвратим нежелательные перестроения нашей модели, вызванные измене-

нием исходных данных.  Изменения могут быть сделаны в управляющей схеме модели, на-

пример в связи с новыми требованиями к изделию, а также изменениями в сопряженных де-

талях, которые более чем вероятны, так как эти модели тоже разрабатываются в данный мо-

мент. Несмотря на заморозку связи, необходимо, пользуясь таким инструментом, как WAVE 

диаграмма текущей сборки (WAVE Diagram of Current Assembly), периодически отсле-

Рисунок 4.42. Создание связей с другим компонентом

Рисунок 4.43. а) Построение тела вытягивания          б)Построение паза



104

Глава 4. Моделирование в контексте NX

живать изменения исходных данных и размораживать связь для обновления геометрических и 

параметрических данных, которые являются исходными для наших построений. Фактически, 

замораживая связь, мы не защищаемся от изменений, а делаем процесс изменений управля-

емым и предсказуемым. 

 

• Сделайте компонент Crank отображаемой деталью и, используя инструментарий модуля 

Моделирование, на базе скопированных связанных объектов постройте упрощенно ге-

ометрию модели. Способ построения модели в данном примере роли не играет, поэтому 

её можно строить любым способом, не забывая привязываться к скопированным объектам. 

Один из примерных вариантов построения может быть таким:

• на одной из скопированных граней нарисуем эскиз и на базе него создадим элемент Вы-

тягивание (Extrude). Для создания внутреннего контура (отверстия) была спроецирована 

кривая, которая является связанной кривой из схемы механизма. Внешний контур был нари-

сован без привязки к внешним объектам (рис. 4.43а);

• далее между двумя скопированными гранями было создано тело вычитания, которое сфор-

мировало паз в первом элементе Вытягивание (рис. 4.43б);

• следующим этапом операцией Вытягивание на базе другой скопированной из схемы кри-

вой был построен второй конец детали (рис. 4.44а);

• и последней операцией Вытягивание с операцией логического объединения тел было по-

строено тело, объединяющее оба конца детали в единое целое (рис. 4.43б).

• После окончания построений, выбрав пункт главного меню Формат > Ссылочные набо-

ры (Format > Reference Sets), откройте диалог управления ссылочными наборами и убе-

дитесь, что в набор MODEL входит только итоговое тело построения. Это необходимо для 

того, чтобы все участники проекта видели саму модель, а не промежуточные объекты постро-

ения (рис. 4.45). Также имеет смысл убрать все вспомогательные объекты на невидимый слой 

и определить интерфейс созданной модели. Сохраните модель.

• В Навигаторе модели отобразите родительскую сборку и сделайте её рабочей дета-

лью. Затем, нажав правую кнопку мыши на созданном компоненте, выберите пункт меню 

Рисунок 4.44. а) Построение второй части детали      б) Объединение тел
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WAVE > Создание детали со связью. В появившемся диалоге выберите ссылочный набор 

MODEL и нажмите кнопку Задать имя детали, введите имя CrankDet.prt, под которым соз-

данный компонент будет входить в состав изделия, и нажмите ОК в обоих диалогах. 

Этой операцией мы создали модель, связанную с нашей, в которую не входит история по-

строения, а входит только ассоциативно связанный результат. Тем самым мы помещаем в ма-

кет изделия лишь итоговую модель без промежуточных построений.

• Сохраните созданную модель.

• Откройте сборку CrankShaftAssy.prt. Это итоговая сборка изделия, куда все участни-

ки проекта вставляют законченные детали. С помощью кнопки Добавить компонент 

(Add component) на инструментальной панели Сборки (Assemblies) добавьте модель 

CrankDet.prt в сборку. Компонент будет вставлен сразу на место, согласно исходной схеме, 

но тем не менее его необходимо связать сборочными связями с сопряжёнными компонента-

ми. 

• Выбрав в главном меню пункт Сборки > WAVE > WAVE диаграмма текущей сессии, 

отобразите схему связей между компонентами (рис. 4.46). 

На схеме видно, что построенный компонент Crank ссылается на управляющую схему в 

компоненте base и на соседнюю деталь Rod и сам, в свою очередь, является ссылкой для свя-

занного компонента, который входит в состав изделия.

• Проведите изменение исходной схемы. Откройте компонент base и, зайдя в диалог опреде-

Рисунок 4.45. Создание ссылочного набора
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ления Выражений, поменяйте значение переменной L2 c 85 мм на 100 мм. Этой перемен-

ной определяется длина компонента Crank. Нажмите кнопку Применить и сохраните мо-

дель base.

• Переключитесь в сборку Crank_WCS и, выбрав компонент Crank в Навигаторе сборки, 

нажмите на нем правой кнопкой и выберите пункт меню Разморозить. Модель будет пе-

рестроена согласно новым исходным данным из управляющей схемы. После этого в том же 

контексте меню выберите пункт Заморозить постоянно, чтобы вернуть межмодельную 

связь в исходное состояние.

Мы обновили рабочую часть, теперь необходимо обновить результирующую часть, входя-

щую в состав макета изделия. 

• Переключитесь в сборку макета CrankShaftAssy и аналогичным образом сначала размо-

розьте, а после перестройки модели заморозьте связь. 

Мы рассмотрели принципиальную схему реализации подхода проектирования сверху вниз 

на базе упрощенной модели. За рамками остались вопросы оповещения участников проекта 

об изменениях схемы, управлении правами на составляющие схемы и итоговой сборке маке-

та изделия и другие вопросы, которые описываются методологией параллельной разработки 

и не имеют прямого отношения к межмодельным связям.  

При всей простоте механизма создания межмодельных связей неправильный выбор ссы-

лочной геометрии или излишняя перегрузка модели ссылками на внешние объекты могут при-

вести к достаточно неприятным последствиям, даже при незначительных изменениях.  Трудно 

вывести какие-то универсальные подходы к выбору геометрических объектов при создании 

связей как при моделировании в контексте, так и при проектировании сверху вниз. Тем не ме-

нее рекомендуется исходить из принципа разумной достаточности. Теоретически можно лю-

Рисунок 4.46. Диаграмма связей компонентов
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бое изделие сделать полностью параметризованным, увязать все его компоненты друг с дру-

гом и обеспечить перестроение всего макета изделия при изменениях, но на практике это да-

леко не всегда оправдано с точки зрения трудоемкости против получаемого результата, и что 

более важно – не всегда нужно. Для каких-то простых узлов и изделий это может быть оправ-

дано и достижимо, но когда речь идёт о сложных агрегатах, то тут необходимо искать баланс 

между затраченной трудоемкостью на грамотную увязку компонентов изделия и потенциаль-

ной экономией времени и ресурсов на проведение изменения. Уровень параметризации и ас-

социативности должен быть достаточен как с количественной, так и с качественной точки зре-

ния. Количество межмодельных связей в сборке изделия всегда является определяющим фак-

тором при проведении изменений. Особенно когда речь идёт об изделиях, над которыми ра-

ботают больше чем один человек. После определенного порога количества горизонтальных 

ссылок между компонентами, разрабатываемыми разными исполнителями, даже сборки про-

стых изделий перестают быть управляемыми.  Поэтому когда возникает необходимость в кол-

лективной работе над изделием и моделированием в контексте, необходимо заранее четко 

определить правила привязки, проведения изменений и контроля над связями. 

С качественной точки зрения следует создавать связи между моделями, исходя не толь-

ко из потребности перестроить одну модель в зависимости от изменения другой, но и учиты-

вая, как эти изменения будут влиять на процессы изготовления детали.  При создании ассо-

циативной связи с другой моделью необходимо четко понимать, какие изменения возможны 

и как они повлияют на «реалистичность» получаемого результата. Если изменение соседней 

модели приведет к такому изменению разрабатываемой модели, что её изготовление станет 

невозможным (из-за ограниченных возможностей производства, например), то ценность та-

кой, хоть и геометрически увязанной модели будет стремиться к нулю. В ряде случаев более 

оправданным бывает отказ от прямой связки моделей, чтобы при прохождении изменения по 

макету изделия можно было выявить потенциальные нарушения технологичности. Но при на-

личии четко определенных правил привязки и целостной управляющей схемы изделия меха-

низм WAVE связей позволяет качественно повысить уровень проектирования изделия с ис-

пользованием инструментария системы NX.
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РАБОТА С ЛИСТОВЫМ МЕТАЛЛОМ
В этой главе речь пойдёт о создании моделей деталей, получаемых гибкой и штамповкой. 

Процесс моделирования таких деталей специфичен тем, что  получаемые модели существу-

ют в двух состояниях – исходном и развёрнутом, а также тем, что толщина материала посто-

янна по всей модели. Поэтому функционал создания такого рода деталей был выделен из мо-

дуля Моделирование, так как многие операции в этом модуле создают элементы, не соче-

таемые с листовым металлом. 

С версии NX7.5 инструментарий моделирования деталей из листового металла в системе 

NX разделен на два модуля:

Листовой металл NX (NX Sheet Metal) – предназначен для решения задач общего ма-

шиностроения в области моделирования из листового металла. Ограничения этого модуля 

касаются возможностей работы с криволинейными ребрами для построения фланцев и ис-

пользования ссылочных поверхностей для создания элементов детали; 

Авиационный листовой металл (NX Aerospace Sheet Metal) – модуль, предназначен-

ный для задач моделирования деталей, специфичных для аэрокосмической отрасли. Он со-

держит инструментарий, позволяющий моделировать элементы моделей, не типичных для 

остальных отраслей, а также способный работать с элементами поверхностей при моделиро-

вании деталей.

Дополнительно в этих модулях доступен функционал модуля Расширенный листовой ме-

талл, который входил в состав приложений до версии  NX7.5.

В общем случае алгоритм создания моделей из листового металла достаточно прост.

– Создание основы – плоского элемента на базе эскиза или кривых.

– Построение фланца на базе рёбер основного элемента.

– Создание необходимых вырезов и подштамповок.

– Обработка стыков и углов.

– Получение развёрнутой формы модели и анализ технологичности при необходимости.

– Выпуск конструкторской документации.

Результатом работы в модуле листового металла является 3D модель детали, которая ис-

пользуется в составе макета изделия, а также ассоциативно связанная плоская развертка, 

по которой выпускается чертёж для изготовления детали. Так как построение модели и полу-

чение развертки ведутся с учетом физических свойств материала и характеристик оборудо-

вания для изготовления, то точность получаемой развертки целиком зависит от правильности 

задания необходимых параметров. Во время работы в модуле листового металла все пара-

метры материала берутся из общей библиотеки NX, поэтому для корректной работы и расчё-

та разверток деталей, получаемых штамповкой (с большими пластическими деформациями), 

необходимо обеспечить точность физических свойств материала.

НАСТРОЙКИ
Моделирование детали из листового металла начинается с назначения геометрических 

параметров материала листа и характеристик инструмента гибки. Данные параметры при-
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меняются по умолчанию ко всем операциям при построении модели, и обычно они неизмен-

ны для всей истории построения модели, хотя иногда может возникнуть необходимость откло-

ниться от заданных параметров для какой-то конкретной операции. 

При создании новой модели параметры материала и инструмента считываются из пользо-

вательских настроек, которые можно изменить, выбрав пункт главного меню Файл > Утили-

ты > Настройки по умолчанию (File > Utilities > Customer Defaults) и открыв вкладку Гло-

бальные параметры (Global Parameters) в разделе Листовой металл > Общие (Sheet 

Metal > General). Ключевыми параметрами здесь являются (рис. 5.1):

Толщина материала (Material Thickness) – толщина листа металла, используемого для 

создания детали;

Радиус сгиба (Bend Radius) – величина внутреннего радиуса сгиба при создании флан-

цев;

Коэффициент нейтрали (Neutral Factor) – коэффициент, определяющий положение 

нейтрального слоя. Положение слоя определяется величиной, равной произведению толщины 

материала и этого коэффициента, отложенной от внутренней поверхности сгиба. Коэффици-

ент можно задать напрямую, посчитать по формуле или взять из таблицы – что определяется 

соответствующим значением опции Метод определения сгиба (Bend Definition Method).

Также на этой вкладке задаются параметры вырезов (галтелей) в местах переходов сги-

бов – Глубина освобождения сгиба (Bend Relief Depth) и Ширина освобождения сги-

ба (Bend Relief Width)

Рисунок 5.1. Настройки по умолчанию для листового металла
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На второй вкладке этого раздела Стандарты материала (Material Standards) можно 

указать имя файла, в котором определены параметры материалов, сгибов и прочие необхо-

димые характеристики, чтобы не задавать их вручную. Пример такого файла, с описанием 

его формата, можно найти в папке установки NX, зайдя в подкаталог UGII\materials. 

Эти параметры, определяемые в Настройках по умолчанию, являются начальными при  

создании новой модели. При изменении каких-либо параметров они вступят в силу для новых 

моделей после перезапуска приложения. Те же самые параметры для текущей модели мож-

но изменить без перезапуска  приложения, выбрав пункт главного меню Настройки > Ли-

стовой металл NX (Preferences > NX Sheet Metal) (рис. 5.2). Значения параметров, задан-

ные в этом диалоге, будут иметь приоритет над теми, что были определены в Настройках по 

умолчанию. При этом файл модели запоминает значения параметров, выставленных в этом 

диалоге, поэтому каждый раз при открытии конкретной модели параметры  будут принимать 

значения, которые были заданы на момент её сохранения. 

Обратите внимание, что величины толщины материала, радиуса сгиба и коэффициента 

нейтрали в диалоге настроек имеют смысл, только когда включена опция Ввод значения 

(Value Entry) в разделе Ввод параметров (Parameter Entry) на вкладке Свойства дета-

ли (Part Properties). Если активна опция Выбор материала (Material Selection) или Выбор 

идентификатора инструмента (Tool ID Selection), значения этих параметров будут брать-

ся из файла с характеристиками материала или инструмента соответственно. 

Рисунок 5.2. Настройки модуля листового метала для модели
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СОЗДАНИЕ ПРОСТЕЙШЕЙ ДЕТАЛИ
Давайте для начала знакомства с модулем листового металла создадим простую деталь и 

посмотрим влияние заданных параметров материала.

• Запустите NX7.5, создайте новую модель и активируйте приложение Листовой металл 

NX, используя пункт меню Начало > Все приложения > Листовой металл > Листо-

вой металл NX (Start > All Application > Sheet Metal > NX Sheet Metal).  

• Для начала нам необходимо создать базовый элемент, который будет основой для последу-

ющих построений. В инструментальной панели Листовой металл (NX Sheet Metal) на-

жмите кнопку Эскиз в среде задач (Sketch in Task Environment) или воспользуйтесь 

пунктом меню Вставить > Эскиз в среде задач (Insert > Sketch in Task Environment) и 

постройте эскиз на плоскости XY, содержащий прямоугольник с размерами 100х250 мм. 

• Закончите построение эскиза (Finish Sketch) и на той же инструментальной панели нажми-

те кнопку База (Tab) или выберите пункт главного меню Вставить > Базовый элемент 

(Insert > Tab). Эта команда строит базовый элемент на основе плоского контура (эскиза). 

• Выберите построенный эскиз и обратите внимание, что величина толщины элемента уже за-

дана – был применен параметр материала,  назначенный в настройках (рис. 5.3). Вы може-

те переопределить назначенную толщину для данного элемента построения модели, нажав 

на значок формулы параметра Толщина (Thickness) и выбрав пункт меню Использовать 

локальное значение (Use Local Value). Это отвяжет параметры данного элемента от об-

щих настроек материала. Как уже говорилось, это бывает необходимо в очень редких случа-

ях, поэтому оставьте величину толщины неизменной и закончите построение базового эле-

мента нажатием кнопки ОК в диалоге. 

• Постройте фланец под прямым углом вдоль одной из длинных сторон прямоугольного базо-

вого элемента. На инструментальной панели Листовой металл нажмите кнопку Фланец 

(Flange) или воспользуйтесь пунктом главного меню Вставить > Сгиб > Фланец (Insert > 

Рисунок 5.3. Создание основания
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Bend > Flange). В качестве исходных данных укажите  ребро одной из длинных сторон пря-

моугольного элемента, убедитесь в том, что Опция ширины (Width Options) имеет значе-

ние Полное (Full), и задайте произвольное значение параметра Длина (Length). Угол по 

умолчанию назначен равным 90 градусов – поэтому его оставим неизменным. Вы также мо-

жете с помощью опции Измерение длины (Length Reference) задать точку отсчета этого 

размера и опцией Положение материала (Inset) указать положение получаемого флан-

ца относительно контура базового элемента. 

Обратите внимание, что, как и в случае с параметром толщины при построении базово-

го элемента, параметры Радиус сгиба (Bend Radius) и Коэффициент нейтрали (Neutral 

Factor) уже имеют значения, наследованные из настроек модели. 

• Нажмите ОК для завершения построения фланца (рис. 5.4).

• Аналогичным образом постройте ещё один фланец на противоположной стороне базового 

элемента,  только в этот раз выберите значение В центре (At Center) для параметра Оп-

ция ширины и задайте величину ширины меньше длины ребра, на котором строится фла-

нец. 

В случае если опция Положение материала имеет значение Материал снаружи 

(Material Inside) или Материал внутри (Material Outside), а опция Вырез на сгибе (Bend 

Relief) имеет значение, отличное от Нет (None), в местах начала фланца на базовом эле-

менте появятся вырезы. Параметры этих вырезов также наследуют значения, заданные в свой-

ствах модели (рис. 5.5). 

• Попробуйте поменять значение опций Положение материала и Вырез на сгибе и по-

смотрите, как это отражается на построении фланца. Затем нажмите ОК в диалоге.

• Откройте диалог определения выражений, выбрав пункт меню Инструменты > Выраже-

Рисунок 5.4. Создание фланца
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ние (Tools > Expression). 

• В выпадающем меню раздела Список выражений (Listed Expressions) поставьте фильтр 

отображения на значение Все (All). 

В списке появятся все переменные и формулы, заданные в модели. Обратите внимание, 

что значения основных параметров, которые были заданы в настройках, имеют соответству-

ющие переменные, а все размеры элементов построения модели связаны с этими переменны-

ми формулами. Поэтому при изменении параметров материала и радиуса гибки будут пере-

страиваться все элементы модели (рис. 5.6). 

•  Закройте диалог Выражения и, вы-

брав пункт главного меню Настройки 

> Листовой металл NX, откройте ди-

алог определения параметров листово-

го металла. Поменяйте значения толщи-

ны материала и радиуса сгиба, после 

чего нажмите ОК. Новые значения па-

раметров будут применены,  и модель 

будет перестроена.

• Сохраните модель и закройте её.

Мы рассмотрели на примере, как пара-

метры материала, заданные в настройках, 

используются при построении модели и как их изменение отражается на элементах построе-

ния. Теперь давайте более подробно рассмотрим основные конструктивные элементы, из ко-

торых строится модель детали из листового металла.

Рисунок 5.5. Фланец не полной ширины и галтели

Рисунок 5.6. Формулы параметров элементов
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ОСНОВНЫЕ ЭЛЕМЕНТЫ
Практически все элементы построения моделей в модуле Листового металла базируют-

ся на элементах, которые являются основами, то есть от которых начинается построение. 

В предыдущем примере мы использовали 

команду Базовый элемент (Tab) для соз-

дания такого основного элемента. Поми-

мо этой команды, основы создаются также 

командами Фланец по контуру (Contour 

Flange) и Фланец по двум сечениям 

(Lofted Flange). Все остальные элементы 

построения будут базироваться на одном 

из этих основных элементов. 

Команды создания основ могут созда-

вать два типа элементов – первичные и вто-

ричные. Первичные создаются, когда в мо-

дели ещё нет ни одного элемента построе-

ния и когда необходимо иметь два независимых основных элемента. Вторичные элементы соз-

даются для модификации существующих основных элементов, они сразу добавляются к ним и 

становятся единым целым (рис. 5.7).

Команда Фланец по контуру строит основной элемент, протягивая открытый эскиз или 

плоскую кривую по нормали и придавая толщину листа полученной поверхности. При этом 

если объекты  эскиза или кривые образуют острый угол, то в получаемом элементе будут сде-

ланы скругление радиусом, определенным в настройках моделирования. В остальном все па-

раметры этой команды соответствуют команде Фланец (рис. 5.8)

И последняя команда для построения основного элемента Фланец по двум сечениям 

(строит основной элемент, используя два открытых плоских эскиза, расположенных парал-

Рисунок 5.7. Добавление основание к существу-

ющему

Рисунок 5.8. Фланец по контуру
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лельно друг другу, или две кривые, между которыми протягивает поверхность и придает ей 

толщину. Преимущество этой команды в том, что могут использоваться сечения разной фор-

мы, что дает возможность строить комплексные переходные поверхности. При этом необхо-

димо обеспечить одинаковые положения начальных точек эскизов (кривых), чтобы избежать 

скручивания. Дополнительно к стандартным опциям фланцев в этой команде можно разбить 

поверхности сгиба на сегменты для упрощения получаемой геометрии (рис. 5.9). 

ПОСТРОЕНИЕ ФЛАНЦЕВ И СГИБОВ
Фланцы, или отбортовки, строятся по сторонам внешнего контура модели и требуют на-

личия в модели основного элемента. В качестве входных данных для построения какого-либо 

типа фланца необходимо предоставить кромку или базового элемента, или другого фланца. 

Мы на примере рассмотрели операцию построения простейшего фланца, но не рассмотрели 

Рисунок 5.9. Фланец по двум сечениям

Рисунок 5.10. Изменение контура фланца
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одну из ключевых опций этой команды. Давайте на примере рассмотрим расширенные воз-

можности команды Фланец (Flange) и использование команды Фланец по контуру для по-

строения отбортовки.

• Запустите NX и из папки ch5 откройте файл smd1.prt . В модели пока есть только один базо-

вый элемент.

• Нажмите кнопку команды Фланец, укажите одно из ребер основного элемента и разверни-

те блок диалога Сечение (Section).

• Кнопка Изменить эскиз (Edit Sketch) позволяет перезадать форму получаемого флан-

ца, которая по умолчанию является прямоугольником. Нажмите эту кнопку и модифицируй-

те контур получаемого фланца инструментами эскиза, соблюдая его целостность, после чего 

нажмите кнопку Закончить эскиз (рис. 5.10) и нажмите ОК в диалоге создания фланца. 

Он будет построен в соответствии с новым контуром. Такая возможность изменения фор-

мы фланца позволяет минимизировать дерево построения модели, так как нет необходимости 

прибегать к операциям обрезки, чтобы изменить форму фланца по умолчанию. 

• Теперь давайте опять рассмотрим команду Фланец по контуру (Contour Flange), но в 

этот раз не для создания базового элемента, а для создания фланца произвольного сечения 

вдоль ребра базового элемента. 

• Нажмите кнопку команды Фланец по контуру и в выпадающем списке Тип (Type) выбе-

рите значение Вторичный (Secondary).

• Нам необходимо создать сечение создаваемого фланца. Для этого в блоке диалога Сече-

ние (Section) нажмите кнопку Эскиз сечения (Sketch Section). Эскиз будет размещен на 

плоскости, нормальной к ребру, вдоль которого необходимо построить фланец, поэтому в 

диалоге Создание эскиза (Create Sketch) выберите ребро длинной стороны прямоуголь-

ного основания.

•  Опционально можно указать положение плоскости эскиза на выбранном ребре, задав про-

цент длины ребра, определяющего расстояние от начала ребра до точки пересечения ребра 

и плоскости. Также при необходимости укажите горизонтальное направление (рис. 5.11).

• Постройте инструментами эскиза сечение фланца, которое будет протянуто вдоль выбран-

Рисунок 5.11. Фланец по контуру
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ного ребра. Для корректной работы команды построения фланца необходимо, чтобы сече-

ние начиналось из точки пересечения ребра и плоскости построения эскиза. Если первый 

элемент построения, выходящий из этой точки, является дугой или сплайном, то в точке долж-

но соблюдаться условие касательности. Для соблюдения этих условий рекомендуется вос-

пользоваться командой построения пересечения грани тела и плоскости построения эскиза 

Кривая пересечения (Intersection Curve) (рис. 5.12). После построения сечения выйди-

те из эскиза, нажав кнопку Закончить эскиз (Finish Sketch).

• Завершите построение фланца, 

нажав кнопку ОК.  

Ещё одна команда построе-

ния фланца Завальцовка (Hem 

Flange), по сути, является частным 

случаем команды Фланец по кон-

туру  с несколькими предопреде-

лёнными контурами с настраивае-

мыми параметрами.

•  Вызовите команду Заваль-

цовка на инструментальной панели 

Листовой металл NX.

• Укажите одно из ребер суще-

ствующих фланцев или свободные ре-

бра основного элемента и  в выпадаю-

щем списке Тип выберите какое-либо значение.

• В зависимости от выбранного типа блок диалога Параметры скруглений (Bend 

Рисунок 5.12. Сечение фланца

Рисунок 5.13. Построение завальцовки
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Parameters)  отобразит параметры, характерные для данного типа завальцовки (рис. 5.13). 

• Нажмите ОК для завершения построения элемента.

Все рассмотренные фланцы строятся на базе прямых кромок основных элементов и опре-

деляются значениями высоты и угла наклона. Для создания более сложных фланцев, кото-

рые могут базироваться на основе криволинейных ребер и форма которых задается ссы-

лочной геометрией, необходимо использовать возможности модуля Авиационный листо-

вой металл. Альтернативой является использование команды Сложный фланец (Advanced 

Flange). 

• Откройте файл smd2.prt и из инструментальной панели вызовите команду Сложный фла-

нец (Advanced Flange).

• В выпадающем списке Тип (Type) выберите По значению (By Value) и укажите криволи-

нейную кромку основного элемента, задайте высоту фланца. Этот тип фланца по смыслу со-

впадает с операцией Фланец (Flange), за исключением того, что он может строиться на 

криволинейных кромках и его длина определяется двумя плоскостями, которыми он будет 

ограничен.

• Нажмите Применить в диалоге и, поменяв тип на значение По ссылке (To Reference), вы-

берите одну из кромок грани, прилегающей к поверхности, а в качестве ссылочной геоме-

трии (Reference Geometry) укажите саму поверхность. Такой тип построения создает фла-

нец, лежащий на ссылочной поверхности и ассоциативно с ней связанный (рис. 5.14).

Рисунок 5.14. Построение сложного фланца
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РАЗВЕРТКИ МОДЕЛЕЙ
Получение разверток модели из листового металла необходимо не только для оформле-

ния чертежей для производства детали, но и непосредственно для самого построения. В боль-

шинстве случаев операции обрезки и создания вырезов необходимо производить в развер-

нутом состоянии модели – как это и происходит в реальности. В функционале модуля рабо-

ты с листовым металлом есть несколько средств для создания развернутого состояния моде-

ли или отдельных её частей. 

В данном разделе речь пойдет о штатных средствах получения развернутого состояния мо-

дели, которые работают с моделями, созданными в модуле Листовой металл NX. Помимо 

этих средств, в функционале NX есть ещё ряд команд, предназначенных для получения раз-

верток с моделей, не созданных в этом модуле. Самая простая и часто используемая пара ко-

манд  для получения развернутого состояния части или всей модели – это команды Разверт-

ка (Unbend) и Согнуть снова (Rebend). Они используются во время построения модели, для 

получения плоского представления одного или нескольких фланцев с последующей их моди-

фикацией и возвращением в исходное состояние. 

•  Откройте файл smd4.prt из папки ch5.

• На инструментальной панели Листовой металл NX нажмите кнопку вызова команды Раз-

вертка (Unbend).

• Укажите грань, которую надо считать стационарной, – как правило, это грань основания, а 

затем укажите тот сгиб, который надо развернуть.

• Система сделает локальную развертку выбранного элемента, с которым можно дальше ра-

ботать инструментарием модуля (рис. 5.15).

• Для проведения обратной операции воспользуйтесь командой Согнуть снова (Rebend). 

Необходимо указать разогнутый сгиб для приведения его в исходное состояние. Опциональ-

Рисунок 5.15. Развертка сгиба фланца
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но можно задать стационарную грань, за счет этого можно изменять ориентацию модели, 

если выбирать грань, отличную от той, что была использована как стационарная в операции 

Развертка (рис. 5.16).

Эта пара команд работает со всеми типами фланцев и сгибов, за исключением Сложно-

го фланца (Advanced Flange) и фланцев, созданных в модуле Авиационный листовой ме-

талл. Для этих типов фланцев есть аналоги команд локальной развертки и свертки. 

Для получения развертки всей модели за одну операцию необходимо воспользоваться ко-

мандой Развертка тела (Flat Solid). Эта команда создает ассоциативно связанное плоское 

листовое тело, представляющее собой развертку модели. При этом сама операция постро-

ения развертки добавляется в историю построения модели и всегда является последней по 

времени. За счет этого изменения, которые вносятся в исходную модель после создания раз-

вертки, на ней тем не менее отражаются.  Рекомендуется использовать эту команду во время 

построения сложных моделей, для того чтобы контролировать корректность получаемого ре-

зультата. 

Следует отметить, что команда Развертка тела  имеет ограничение, отражающееся в 

том, что не все конструктивные элементы переносятся в развернутое состояние. Это касает-

ся большинства элементов построения, получаемых вытяжкой, и все они на развертке сохра-

няют свои исходные формы. 

• Вызовите команду Развертка тела (Flat Solid) с инструментальной панели.

• Укажите грань, которую надо считать стационарной. На плоскости этой грани будут развер-

нуты все остальные элементы модели. Как правило, используется грань основного элемента.

• Опционально можно указать набор кривых и точек, которые находятся на свернутом состоя-

нии модели, для того чтобы они тоже были перенесены на развертку. Установите в панели вы-

бора фильтр Точка (Point)  и выберите группу точек в центрах отверстий на модели. 

Рисунок 5.16. Свертка сгиба фланца
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• Нажмите ОК для завершения команды. Будет создано новое тело, представляющее собой 

развертку. Его можно переместить на какой-нибудь вспомогательный слой и периодически 

делать видимым для контроля получаемой модели (рис. 5.17).

• Проверим ассоциативность связанного представления развертки. Создайте на одной из кро-

мок свернутой модели фланец. В результате созданный элемент будет добавлен предпослед-

ним в дерево построения, а операция развертки сместится вниз и перестроится, исходя из 

текущего представления свернутой модели (рис. 5.18).

Развертка, полученная командой Развертка тела, может в ряде случаев служить основой 

для создания чертежа, но в силу описанных выше ограничений не все элементы построения 

модели будут на ней отображаться корректно. Альтернативой этой команде для выпуска до-

Рисунок 5.17. Создание тела развертки

Рисунок 5.18. Обновление тела развертки
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кументации является команда Шаблон развертки (Flat Pattern).

• Скройте тело развертки, полученное командой Развертка тела (Flat Body), и вызовите 

команду Шаблон развертки (Flat Pattern).

• Аналогично предыдущей команде получения развертки выберите грань, которая будет ста-

ционарной. Также при необходимости укажите кривые и точки, которые надо отобразить на 

развертке. Нажмите на ОК для завершения команды. 

• Будет создан набор кривых и аннотаций, описывающих развертку, вместо развернутого 

тела. Для отображения полученного результата необходимо переключить текущий вид моде-

ли на вид с именем FLAT-PATTERN-XX (где XX – номер элемента развертки в дереве построе-

ния модели). Все элементы, представляющие собой развертку, также помещаются в ссылоч-

ный набор FLAT-PATTERN-OBJECTS. Так же как и в случае с командой Развертка тела, по-

лученное представление развернутой модели ассоциативно и перестраивается в зависимо-

сти от текущего состояния модели. 

Формат аннотаций, которые наносятся на линии развертки, можно переопределить, от-

крыв пункт меню Файл > Утилиты > Настройки по умолчанию и зайдя в раздел Листовой 

метал > Шаблон развертки. 

ВЫРЕЗЫ
Теперь давайте рассмотрим на примере набор инструментов для создания вырезов и под-

штамповок  на основных элементах и фланцах.

В наборе инструментов создания вырезов модуля Листовой металл NX есть два средства 

для создания вырезов произвольной формы и несколько инструментов для создания специа-

лизированых вырезов и подштамповок.  Вырезы произвольной формы можно создавать с по-

мощью команд  Вытягивание (Extrude) и Вырез по нормали (Normal Cutout). Первая ко-

манда является штатной командой модуля Моделирование, которая создает на основе пло-

ского контура тело и вычитает его из целевого тела. 

Рисунок 5.19. Создание шаблона развертки
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• Откройте в NX файл smd7.prt  из папки ch5.

• Вызовите команду Вытягивание (Extrude), нажав кнопку на инструментальной панели Ли-

стовой металл NX.

• На  грани фланца, согнутого под острым углом, расположите новый эскиз и нарисуйте 

окружность, закончив эскиз, вытяните его внутрь модели на 10–15 мм (рис. 5.20). Нажав 

кнопку ОК, закончите построение выреза.

• Будет построен круговой вырез, который также будет существовать в развертке. Примене-

ние команды Вытягивание для создания вырезов имеет некоторые ограничения. 

Рисунок 5.20. Вырез произвольной формы Вытягиванием

Рисунок 5.21. Нарушение постоянства толщины



125

NX Глава 5 Работа с листовым металлом

• В дерево построения модели двойным щелчком на операции Вытягивание (Extrude) вой-

дите в режим её редактирования и поменяйте величину размера вытягивания так, чтобы оно 

проходило через все тело. 

В результате вырез должен появиться в двух стенках модели. Если в первой стенке получил-

ся нормальный вырез, то во второй стенке вырез нарушает требование к постоянной толщи-

не детали. Поэтому применять операцию Вытягивание к построению вырезов можно только 

в тех случаях, когда вычитаемое тело вытягивания будет строго нормально по отношению ко 

всем пересекаемым стенкам (рис. 5.21).

• Рассмотрим другую команду построения вырезов произвольной формы. В дереве модели вы-

делите последнюю операцию вытягивания и удалите её. 

• Вызовите команду Вырез по нормали (Normal Cutout), находящуюся на той же инстру-

ментальной панели. Так же как и в предыдущей операции, нарисуйте эскиз, содержащий 

окружности на наклонном фланце модели, и, завершив эскиз, вытяните его, выбрав значе-

ние Через все (Through All) в выпадающем списке Ограничение (Limits). 

• Будет построен вырез в двух гранях модели, но в этот раз в обеих стенках он будет сделан 

строго по нормали, несмотря на то что само, создающее вырез, подходит под углом ко вто-

рой стенке (рис. 5.22). 

• Обе команды создания вырезов произвольной формы можно применять и на развертках 

фланцев. Удалите из дерева построения последнюю операцию создания выреза по нормали 

и вызовите команду Развертка (Unbend) на инструментальной панели. 

• Выберите основную грань как стационарную и укажите сгиб фланца под острым углом, по-

сле чего нажмите ОК (рис. 5.23).

• На развернутой форме фланца постройте нормальный вырез, используя эскиз произволь-

Рисунок 5.22. Вырез по нормали
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ной формы. Затем воспользуйтесь командой Согнуть снова (Rebend), для  того чтобы вер-

нуть разогнутый фланец в исходное состояние. Для этого необходимо указать область сгиба 

фланца и нажать кнопку ОК в диалоге команды (рис. 5.24).

На практике рекомендуется делать вырезы уже после того, как построены все необходи-

мые фланцы, и максимально использовать возможность редактирования профиля в команде 

Фланец (Flange). Это упрощает дерево построения и делает его более стабильным.

Рисунок 5.23. Развертка грани

Рисунок 5.24. Вырез на развертке
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• Сохраните модель и закройте её. 

В дополнение к инструментам создания вырезов произвольной формы есть ряд средств для 

созданий элементов модели, которые обычно получаются при помощи штампов. Рассмотрим 

их на примере.

• Откройте модель smd8.prt из папки ch5. 

• В настройке слоев Формат > Настройки слоя (Format > Layer Settings) сделайте слой 

номер 7 видимым и выбираемым. На нем расположен эскиз, который будет использован ко-

мандой Вытяжка (Dimple). Эта команда на основе контура имитирует штамп, которым мо-

дель продавливается по направлению нормали к плоскости эскиза и строит глухое углубле-

ние на заданной стенке. 

• Нажмите кнопку вызова команды Вытяжка (Dimple) и, установив правило выбора Связан-

ные кривые (Connected Curves) на инструментальной панели выбора, выберите эскиз. В 

диалоге команды задайте величины Глубины (Depth) и Боковой угол (Side Angle) на-

клона стенок. 

• При необходимости задайте радиусы скругления «штампа» и «матрицы», которые будут 

определять радиусы получаемого элемента с учетом толщины листа, и нажмите ОК для за-

вершения построения (рис. 5.25).

Данный элемент построения  не учитывает эффекта утонения стенок, который неизбежно 

будет возникать при больших значениях глубины, поэтому его размеры должны определять-

ся, исходя из свойств материала, а также на основе анализа формуемости данной модели. 

Рисунок 5.25. Создание элемента Вытяжка
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Эскиз, использованный для построения элемента, является замкнутым, иначе он был бы прод-

лен до границ детали. Есть одно важное ограничение, касающееся использования операции 

Вытяжка – она не обрабатывается командой Развертка тела (Flat Solid), поэтому все эле-

менты, созданные операцией Вытяжка останутся в исходном состоянии на развернутом теле. 

При необходимости создать элемент типа Вытяжка, но с пробивкой, то есть без сохранения 

верхней грани конструктивного элемента, необходимо воспользоваться командой Вытяжка с 

пробивкой (Drawn Cutout).

Ещё одна команда, которая строит закрытый конструктивный элемент, предполагающий 

большие пластические деформации это команда Косынка (Gusset). Она используется для 

построения элементов ребер жесткости для подкрепления стенок фланцев. 

• Вызовите команду Косынка из инструментальной панели Листовой металл NX и укажите 

в качестве входных данных сгиб созданный на прямой кромке основания.

• У вас есть возможность использовать профиль по умолчанию для ребра жестокости – ему 

соответствует значение Автоматический профиль (Automatic Profile) в выпадающем 

списке Тип (Type) диалога или задать свой профиль, выбрав значение Определяемый 

пользователем профиль (User Defined Profile). В последнем случае необходимо по-

строить желаемое сечения в эскизе расположенным на плоскости нормальной к линии сгиба 

фланца.

• Выберите форму и задайте соответствующие параметры создаваемого элемента  в блоке ди-

алога Параметры (Parameters), после чего завершите построение, нажав кнопку ОК.

Использование команды Косынка, позволяет строить подкрепляющие ребра для мест 

сгибов. При необходимости создать ребра жесткости на основаниях или на плоских гранях 

фланцев, необходимо использовать команду  Ребро жесткости (Bead).

Рисунок 5.26. Создание ребер жесткости на фланцу
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• Сделайте слой 8 видимым и выбираемым и нажмите кнопку вызова команды Ребро жестко-

сти

• Выберите два отрезка на 8-м слое в качестве исходных данных. Выберите форму сечения в 

выпадающем списке Сечение (Cross Section) и метод изготовления в выпадающем  списке 

Конечное условие (End Condition). 

• В зависимости от выбранных значений этих двух опций будет предложен набор геометриче-

ских параметров определяющих параметры элемента.  После задания значений этих пара-

метров нажмите ОК для завершения построения (рис. 5.26). 

Элементы, созданные этой командой также не могут быть обработаны командой Разверт-

ка тела (Flat Solid), но, тем не менее, они обрабатываются командой Шаблон развертки 

(Flat Pattern).

Команда Ребро жесткости (Bead) совпадает с командой Вентиляционное отверстие 

(Louver) с точки зрения исходных данных для построения. Разница только в том, что послед-

няя команда, строит элемент, используемый в основном для забора или выброса воздуха в 

системах вентиляции.

Для построения подштамповки произвольной формы, необходимо воспользоваться коман-

дой Пробивка тела (Solid Punch). Она имитирует работу штампа, форма которого задает-

ся произвольным телом.

• Сделайте слой 9 видимым и выбираемым. На нем расположено тело, которое будет служить 

формой штампа.

Рисунок 5.27. Штамп произвольной формы
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• Вызовите диалог команды Пробивка тела (Solid Punch) нажав соответствующую кнопку 

на инструментальной панели.

• Выпадающий список Тип (Type) содержит два значения Пробивка (Punch) и Штамп 

(Die). Первое используется, когда задаваемое тело является штампом, а второе – когда оно 

является матрицей. Выберите значение Пробивка (Punch).

• Укажите основание модели в качестве Целевой грани (Target Face).

• Выберите тело на 9-м слое в качестве Тела инструмента (Tool Body).

• Так как тело-инструмент и исходная модель пересекают друг друга, то нет необходимости 

задавать их взаимное положение с помощью кнопок От СК (From CSYS) и К СК (To CSYS). 

Поэтому нажмите ОК для завершения построения (рис. 5.27).

РЕДАКТИРОВАНИЕ ЭЛЕМЕНТОВ ЛИСТОВЫХ ДЕТАЛЕЙ
В функционал модуля NX листовой металл входит набор средств для локального редак-

тирования существующих моделей и для обработки моделей без истории построения. В боль-

шинстве случаев, когда модель построена с помощью команда модуля, редактирование от-

дельных операций можно осуществлять, непосредственно изменяя их параметры в дереве 

построения модели. Но иногда необходимо изменить локально глобальные параметры для 

определенной операции, оставив нетронутыми остальные.  В частности, это касается радиу-

са сгиба и коэффициента нейтрали, которые задаются глобально для всей детали. 

Также нередко возникает необходимость создать модель детали из листового металла 

на базе существующей твердотельной модели или преобразовать импортированную мо-

Рисунок 5.28. Получение модели листовой детали из твердого тела
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дель из другой CAD системы. Для этих целей в модуле есть два инструмента – Листовой ме-

талл из тела (Sheetmetal from Solid) и Преобразовать в листовой металл (Convert to 

Sheetmetal). Рассмотрим на примере один из них, а также другие инструменты редактиро-

вания:

• Откройте в NX модель Solid.prt из папки ch5.

• Эта твердотельная модель не содержит истории построения, и нам необходимо получить на 

её основе аналогичную модель из листового металла. На панели инструментов NX Листо-

вой металл вызовите команду  Листовой металл из тела. 

• Для преобразования модели необходимо указать грани, которые будут формировать стенки 

листовой детали и места сгибов. Укажите две смежные грани, как показано на рис. 5.28. На 

пограничном ребре между гранями будет вставлен сгиб с параметрами, взятыми из настроек 

моделей (при необходимости их можно переопределить локально).

• Выберите одну из боковых граней, смежную с предыдущими двумя. При таком выборе воз-

никнет неоднозначность в определении места сгиба, так как возможны два варианта. Для 

того чтобы определить однозначно ребро, которое будет заменено на сгиб, в диалоге ко-

манды нажмите на кнопку Выбрать ребро сгиба (Select Bend Edge) и укажите одно из 

ребер между боковой гранью и двумя другими. Второе ребро в новой модели будет убрано 

– то есть по этому месту будет сделан разрыв. 

• Нажмите кнопку Выберите грани фланца (Select Web Face) и укажите вторую боковую 

грань. После этого для этой грани также укажите место создания сгиба, аналогично первой 

боковой грани (рис. 5.29). Затем завершите преобразования нажатием кнопки ОК в диало-

ге команды.

• Скройте исходное тело и убедитесь, что результирующая модель содержит выбранные грани 

Рисунок 5.29. Назначение места гиба
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и места сгиба расположены в назначенных местах. 

Когда необходимо создать модель из листового металла со сложной геометрией, то зача-

стую эффективнее использовать операцию преобразования твердотельной модели в модель 

из листового металла, вместо того чтобы изначально строить модель, комбинируя различные 

типы фланцев и вырезов. Но при этом необходимо учитывать то, что операция преобразова-

ния создает модель, используя исходное тело как внутренний контур, то есть толщина листа 

откладывается от исходных граней наружу. Поэтому при моделировании исходного тела не-

обходимо вводить поправку на предполагаемую толщину листа металла. 

Отредактируем полученную модель. После операции преобразования в дереве постро-

ения содержится всего лишь один элемент, представляющий модель из листового металла. 

Следовательно, редактировать отдельные элементы модели напрямую в истории построения 

не получится. Для такого случая, а также для локального изменения свойств материала и ра-

диуса сгиба необходимо использовать специализированные команды.

•  Измените радиусы сгибов, заданные по умолчанию. На инструментальной панели нажмите 

кнопку команды Изменить радиус сгиба (Resize Bend Radius) и укажите три грани сги-

ба, которые надо изменить (рис. 5.30). 

Тип модификации радиусов определяется выпадающим списком в начале диалога. Значе-

ние Фиксированная длина свертки (Fixed Folded Length) задает такой тип модификации 

радиуса сгиба, при котором общая длина сгиба и сопряженных стенок остаются постоянными 

для свернутого состояния детали. Второе значение задает постоянство длины сгиба и смеж-

ных стенок для развертки детали. 

• Выберите фиксацию длины развертки, увеличьте значение радиуса и укажите грань основа-

ния как неподвижную, после чего нажмите ОК для завершения команды.

Рисунок 5.30. Модификация радиусов фланцев
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Аналогичным образом работа-

ют команды Изменить угол сгиба 

(Resize Bend Angle) и Изменить 

коэффициент нейтрали (Resize 

Neutral Factor).  Изменение коэф-

фициента нейтрали влияет на точ-

ность создания развертки, поэтому 

видимых модификаций  исходного 

состояния модели не происходит.

• Поменяйте тип выреза на углах 

модели в местах, где пересека-

ются поверхности сгиба. Для это-

го воспользуйтесь командой За-

крытый угол (Closed Corner) 

на инструментальной панели Ли-

стовой металл NX.  

• Укажите две или более пересекающиеся поверхности сгиба в углу и в выпадающем списке 

Тип (Type) выберите подходящий вырез. В зависимости от выбранного типа будут отобра-

жены связанные с ним параметры, которые необходимо адаптировать. 

• Нажмите ОК для завершения команды (рис. 5.31). В случае когда необходимо модифициро-

вать угол стыка трех сгибов, необходимо воспользоваться командой Угол с тремя сгибами 

(Three Bend Corner).

Кроме изменения поверхностей сгибов и вырезов на углах, часто бывает необходимо мо-

дифицировать стенки фланцев, и не всегда это можно сделать только изменением угла накло-

на и высоты. Среди «семейства» команд по построению фланцев в инструментальной панели 

Рисунок 5.31. Модификация выреза на углах

Рисунок 5.32. Создание сгиба
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Листовой металл NX осталось две команды – Сгиб (Bend) и Ступенька (Jog), которые по 

сути не строят сам конструктивный элемент, а видоизменяют существующий. Рассмотрим эти 

команды на примере.

• Зайдите в настройки слоёв Формат > Настройки слоя и сделайте слой номер 7 видимым 

и выбираемым. На нем расположена прямая, лежащая на задней стеке модели. Используем 

эту прямую для создания сгиба.

• Вызовите команду Сгиб из инструментальной панели и в качестве входных данных укажите 

прямую на задней стенке 

• На вкладке Свойства сгиба (Bend Properties) задайте желаемые параметры и завершите 

построение нажатием кнопки ОК (рис. 5.32).

Обратите внимание, что построенный элемент и похож на то, что строит команда Фланец 

(Flange), но на самом деле это модификация фланца, так как в случае со сгибом отсутству-

ет возможность управлять длиной отогнутой части. Команда Ступенька по смыслу и задава-

емым параметрам практически совпадает со Сгибом, разница есть только в конфигурации 

получаемого элемента построения.

АНАЛИЗ ФОРМУЕМОСТИ И СЛОЖНЫЕ РАЗВЕРТКИ
Создание деталей из листового металла сопряжено с большими пластическими деформа-

циями, которые, в свою очередь, являются причиной ряда нежелательных явлений, искажа-

ющих геометрию детали. Так, например, при глубокой вытяжке металла происходит локаль-

ное утончение листа, а в некоторых случаях и возможно появление разрыва. Помимо это-

го, из-за возникающего эффекта пружинения конечная геометрия детали может существен-

но отличаться от расчетной. Для того чтобы максимально учесть эти негативные факторы, не-

обходимо использовать средства анализа, позволяющие оценить поведение модели при её 

изготовлении. Одно из таких средств реализовано в виде инструмента Анализ формуемо-

сти – одношаговый (Analyze Formability – One-step).  Этот инструмент использует сред-

ства конечно-элементого анализа для создания разверток сложных моделей, которые не мо-

гут быть сделаны средствами модуля Листовой металл NX. Помимо получения развертки, 

результатами работы инструмента является анализ напряженного состояния детали, утонче-

ния стенок и пружинения, возникающих при изготовлении детали.  Рассмотрим на примере 

детали работу команды Анализ формуемости.

• Из папки ch5 откройте в NX7.5 модель OneStep.prt. Деталь представляет собой листовое 

тело, без истории построения, полученное глубокой вытяжкой. 

• Для проведение анализа построим срединную поверхность между стенками модели. Это не 

является обязательным, но помогает повысить точность получаемого результата.  Выбери-

те пункт главного меню Вставить > Поверхность > Срединная поверхность  > Смеще-

ние (Insert > Surface > Midsurface > Offset). 

•  В появившемся диалоге в качестве первого шага укажите тело, которое необходимо обра-

ботать, а вторым шагом укажите плоскую грань модели. От этой грани будет откладывать-
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ся срединная поверхность на расстоянии в процентах от толщины, задаваемых параметром 

Положение срединной поверхности (Midsurface Position). Задайте этот параметр 

равным 50 и нажмите ОК в диалоге (рис. 5.33).

• Через пункт главного меню Анализ > Анализ формуемости – одношаговый (Analysis 

> Analyze Formability-One) вызовите диалог анализа. 

• В выпадающем списке Тип (Type) выберите значение Расширенная форма (Advanced 

Unform).

 Этот тип анализа самый полный из имеющихся в списке, оставшиеся два являются более 

Рисунок 5.34. Выбор граней для анализа

Рисунок 5.33. Создание срединной поврехности
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упрощенными с точки зрения количества задаваемых данных и получаемого результата. При 

выполнении анализа Полная форма (Entire Unform) производится расчет развертки всей 

модели, но не учитываются пружинение и ряд других факторов. Промежуточная форма 

(Intermediate Unform) анализа служит для частичной развертки модели, когда необходимо 

отработать этапы формирования детали.  

• В инструментальной панели выбора установите в выпадающем списке правил выбора значе-

ние Грани тела (Body Faces) и выберите одну из граней полученной срединной поверхно-

сти. 

• В блоке диалога задания граничных условий (Boundary Conditions) выберите тип ограни-

чения Кривая по кривой (Curve along curves) и укажите прямую кромку срединной по-

верхности. Эта кривая будет сохранять позицию при построении развернутой формы (рис. 

5.34).

• Разверните блок диалога Расширенные ограничения (Advanced Constraints) и в вы-

падающем списке Тип детали(Part Type) установите значение с переходом (With 

Addendum) – это означает наличие переходной поверхности у штампуемой детали. 

• Затем задайте прижимную поверхность. Для этого нажмите кнопку Область прижи-

ма (Binder Region),выберите на инструментальной панели правило выбора Одиночная 

грань (Single Face) и последовательно выберите все поверхности по внешнему периметру 

модели. 

Для окончательного задания условия прижима необходимо ввести величины давления и 

силы трения. Эти величины подбираются исходя их технологических соображений, и в данном 

примере оставим их значения по умолчанию.

Рисунок 5.35. Задание зажима
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• В блоке диалога Направление вытягивания (Draw Direction) укажите вектор вдоль оси 

Z – то есть в каком направлении штамп будет двигаться при получении детали из заготовки 

(рис. 5.35).

• В разделе Толщина (Thickness) введите значение толщины исходной детали, с которой де-

лалась срединная поверхность.

• В разделе Материалы выберите какой-нибудь металл (эти материалы берутся из библиоте-

ки материалов NX). 

Для просмотра и изменения параметров материала можно воспользоваться блоком диа-

лога Настройки (Settings). Это позволяет модифицировать свойства конкретного материа-

ла локально, не редактируя библиотеку материалов.

• Разверните блок Вычисления (Calculations). Здесь необходимо задать размер элемента 

сетки, на которую будет разбита исследуемая поверхность для проведения анализа. 

В данном случае можно принять значение, предложенное системой, но при работе над ре-

альными моделями надо подбирать это значение, исходя из критериев точности и времени 

расчета. Как и в любом другом конечно-элементном анализе, чем меньше размер элемента, 

тем точнее результат и тем дольше время расчета. С другой стороны, эта зависимость не ли-

нейная, поэтому надо задаваться какой-то разумной точностью, исходя из требований про-

изводства, и итеративно подбирать значение величины элемента. 

• Нажмите кнопку создания сетки (Mesh) и после разбиения нажмите кнопку Проверка 

качества сетки (Mesh Quality Check). 

Если проверка прошла успешно, то можно приступать к расчету. Если при проверке были 

выявлены какие-то проблемы, то необходимо их устранить, иначе результаты расчета будут 

некорректными. Исправить проблемы генерации сетки можно, изменив размер элемента сет-

Рисунок 5.36. Разбиение сетки
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ки в меньшую сторону или редактированием геометрии, а именно проблемного места (рис. 

5.36). 

• Для начала расчета нажмите кнопку запуска решателя Вычисление (Calculation). После 

окончания  расчета будет нарисован контур развернутой детали и загружены данные о на-

пряжениях, толщинах и пружинении.  

• С помощью кнопок управления результатами в блоке Отображение результатов (Results 

Display) просмотрите полученный результат расчета (рис. 5.37).

Кнопки имеют следующее функциональное назначение:

Показать толщину (Display Thickness) – показывает утончение стенок детали при штам-

повке.

Показать напряжение (Display Stress)  –  отображает напряжение, которое должно дей-

ствовать на заготовку для получения заданной формы.

Показать деформацию (Display Strain) – показывает относительную деформацию меж-

ду исходным состоянием и конечным.

Показать пружинение  (Display Springback) – отображает конечную форму модели с 

учетом эффекта пружинения.

Выходное фасетное тело пружинения (Output Springback Facet Body) – формиру-

ет фасетное тело, представляющее форму модели с пружинением, и сохраняет его в модели. 

Полученое тело даёт представление о том, какую форму примет деталь после снятия нагруз-

ки.  Это позволяет оценить, насколько надо скорректировать параметры модели, чтобы была 

получена желаемая форма с учетом эффекта пружинения.

Показать форму шаблона развертки (Display Flatten shape) – отображает конечно-

элементное представление развертки.

Создать профиль  (Create Profile) – создает в модели профиль (контур) развертки.

Отчет  (Report) – формирует отчет о результатах анализа на базе шаблона.

Проведенный анализ добавляется в дерево построения модели, и при сохранении все па-

раметры проведённого анализа будут также сохранены. Поэтому при каких-то изменени-

ях исходной геометрии модели можно открыть этот объект анализа и пересчитать конечно-

элементную сетку и результаты. Рассмотренный функционал расчета и анализа создания мо-

дели из листового металла позволяет учитывать в процессе проектирования технологические 

Рисунок 5.37. Результаты анализа
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и прочностные свойства материала, что дает возможность проектировать деталь, максималь-

но приближенную к тому, что будет получено в металле. 

ДОПОЛНИТЕЛЬНЫЕ ЭЛЕМЕНТЫ ПОСТРОЕНИЯ
Помимо рассмотренных команд построения и изменения элементов моделей из листово-

го металла, в модуле NX есть ряд команд  из модуля твердотельного моделирования, кото-

рые «совместимы» с листовым металлом. Это команды, представленные на инструментальной 

панели Элемент в модуле Листовой металл NX. Рассмотрим некоторые из них на примере.

• Откройте модель smd.9 из папки ch5 и активируйте приложение Листовой металл NX.

• Создадим ряд отверстий на фланцах. Нажмите кнопку Отверстие (Hole) на инструменталь-

ной панели Элемент (Feature) и, включив режим привязки к центрам окружностей и дуг на 

панели выбора, укажите две точки – центры скруглений углов фланцев (рис. 5.38).

• В выпадающем списке Тип (Type) выберите значение Общее отверстие (General Hole), 

для опции Направление отверстия (Hole Direction) выберите значение Нормаль  к 

грани (Normal To Face) и в разделе Форма и размеры (Form and Dimensions) уста-

новите Диаметр (Diameter) равным 5 мм. Остальные опции можно оставить по умолча-

нию. Завершите операцию, нажав кнопку ОК.

• С помощью команды Измерение расстояния (Measure Distance) из инструментальной 

панели Утилиты (Utilities) или раздела главного меню Анализ (Analysis) создайте ассо-

циативное измерение между центрами скруглений фланцев. Для этого вызовите команду из-

мерения, установите в выпадающем списке Тип значение Расстояние (Distance) и выбери-

те в графической области центры двух ребер скругления, лежащих на одной грани.

• Включите опцию Ассоциативно (Associative) в разделе Ассоциативное измерение и 

Рисунок 5.38. Создание отверстия
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проверка (Associative Measure and Checking) и нажмите ОК в диалоге команды. Изме-

рение будет добавлено в дерево построения, и в выражение модели будет добавлен соответ-

ствующий параметр (рис. 5.39).

• Откройте диалог определения выражений с помощью пункта главного меню Инструменты 

> Выражение (Tools > Expressions). В выпадающем списке Список выражений (Listed 

Expressions) выберите значение Измере-

ние (Measurements) и посмотрите имя соз-

данной переменной со значением измерения.

• В этом же диалоге создайте новую перемен-

ную, определяющую количество отверстий, 

с типом Число (Number) и подтипом По-

стоянный (Constant) со значением 8, после 

чего закройте диалог (рис. 5.40).

• На инструментальной панели Элемент на-

жмите кнопку вызова команды Массив эле-

ментов (Instance Feature). В появившемся 

диалоговом окне выберите Шаблон грани 

(Pattern Face).

• В следующем диалоге выберите в выпадающем списке тип Прямоугольный шаблон 

(Rectagular Pattern) и в графической области укажите на грань отверстия. Задайте на-

правление X вдоль фланца (X Direction), выбрав вектор X или соответствующее ребро.

• Далее в разделе Свойства шаблона (Pattern Properties) задайте расстояние по X между 

объектами массива равным переменной измерения, разделенной на (количество отверстий 

– 1), и количество отверстий по направлению X задайте равным созданной переменной. 

• Количество элементов по оси Y сделайте равным 1. И нажмите ОК для завершения построе-

ния массива (рис. 5.41).

• Создайте вырез по контуру, расположенному на основании модели. Нажмите на инстру-

Рисунок 5.39. Измерение

Рисунок 5.40. Выражения
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ментальной панели Листовой металл NX кнопку вызова команды Вырез по нормали 

(Normal Cutout) и укажите в качестве входных данных контур, оставив остальные опции со 

значением по умолчанию, нажмите ОК.

• Создадим зеркальную копию элемента выреза.  Для этого необходимо создать плоскость от-

ражения. На инструментальной панели Элемент нажмите кнопку создания  координатной 

плоскости (Datum Plane) и в диалоге выберите тип По кривой (On Curve). 

• Укажите одно из продольных ребер основания и введите значение 50 для опции % Длины 

дуги (%Arc Length), для того чтобы плоскость была расположена посередине. Убедитесь, 

что опция Направление (Direction) имеет значение Нормально к пути (Normal To 

path), и нажмите ОК в диалоге построения плоскости.

• На инструментальной панели нажмите кнопку Отражение элемента (Mirror Feature). В 

появившемся диалоге укажите грани элемента выреза и вторым шагом укажите созданную 

плоскость для отражения. И нажмите ОК для завершения построения.

Таким образом, мы создали несколько операций элементов построения, используя инстру-

ментарий модуля, применяя конструктивные элементы для листового металла в качестве ис-

ходных данных.

Рисунок 5.41. Массив объектов
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СИНХРОННАЯ ТЕХНОЛОГИЯ
Синхронная технология (СТ) является развитием средств прямого моделирования геоме-

трии, представленных в версиях NX5/NX6. Инструменты прямого моделирования дополни-

ли стандартные средства моделирования возможностью работы с топологией модели напря-

мую, игнорируя историю построения. СТ расширило возможности прямого моделирования, 

добавив механизмы «умного» выбора и распознавания конструктивных элементов без исто-

рии построения,а также введя функционал геометрических связей между элементами модели.

При работе в NX можно использовать два режима создания моделей:

С историей построения – традиционный способ моделирования в большинстве систем 

САПР, основанный на  упорядоченной последовательности конструктивных элементов, кото-

рые формируют геометрию модели. Любое изменение проходит от места его возникновения 

до конца истории построения. Этот режим используется в тех случаях, когда важно сохранять 

параметризацию и ассоциативные связи между моделями. Как правило, это характерно для 

этапа детальной проработки изделия.  

Без истории построения –  в этом случае история построения не создается и каждая новая 

команда моделирования оперирует геометрией напрямую. В силу отсутствия дерева постро-

ения нет никакой хронологической связи между конструктивными элементами, из которых 

состоит модель, поэтому любые модификации касаются напрямую определенного участка 

геометрии. Моделирование без истории чаще всего используется на этапах концептуальной 

отработки, когда отрабатываются различные вариан-

ты упрощенного геометрического представления мо-

дели. 

Переключение между режимами происходит при 

помощи контекстого меню в Навигаторе моде-

ли (рис. 6.1) или при применении соответствующих 

кнопок на инструментальной панели Синхронное 

моделирование (Synchronous Modeling). А сама 

возможность переключения в режим без истории 

определятеся опцией в настройках по умолчанию Разрешить изменения для режима моде-

лирования «Без истории» (History-Free) в разделе Моделирование > Общий (Modeling 

> General).

Переключение из режима с историей в режим без истории убирает зависимости элемен-

тов друг от друга. Дерево построения перестает существовать, но некоторые конструктивные 

элементы становятся локальными. Локальный элемент представляет собой конструктивный 

элемент без хронологических связей, изменяющий какую-то часть геометрии модели. 

При переключении из режима без истории в режим с историей локальные элементы пере-

стают существовать как управляемые объекты и результирующая геометрия модели перехо-

дит в виде одного или нескольких тел в начала истории построения модели.

Использовать инструменты СТ можно в обоих режимах, но некоторые из них работают 

только в режиме без истории. Также и стандартные средства моделирования работают в обо-

их режимах, но в режиме без истории большинство их них не отражаются в Навигаторе 

Рисунок 6.1. Режимы работы с историей
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модели, за исключением тех, которые создают локальные элементы.

Инструменты СТ имеют несколько областей применения:

Работа с импортированными данными. В этом случае традиционные инструменты модели-

рования предлагают весьма ограниченные возможности, так как они ориентированы на на-

личие дерева построения. Инструменты СТ дают возможность работать с моделями вне зави-

симости от того, в какой CAD  системе они были изначально сделаны. Это существенно повы-

шает возможности использования старых наработок, если они были сделаны в другой CAD 

системе, избавляя от необходимости перемоделирования.

Редактирование моделей с историей. Даже когда модель содержит историю построения, 

не всегда удаётся её быстро и легко редактировать. Во-первых, редактирование моделей с 

историей построения подразумевает прохождение обновлений по этой истории, что в случае 

со сложными моделями иногда занимает достаточно длительное время. Во-вторых, далеко не 

все модели имеют согласованную историю построения и могут перестраиваться при внесении 

изменений в любом месте истории. Чем сложнее модель, тем труднее заранее учесть все воз-

можные изменения и правильно строить связи между конструктивными элементами. Синхрон-

ная технология помогает решить обе эти проблемы. Редактирование модели с помощью этих 

инструментов не влияет на историю построения до момента редактирования, поэтому вы мо-

жете изменять геометрию модели без пересчёта всей логики построения. При этом если ак-

тивен режим построения с историей, все изменения, сделанные инструментами синхронной 

технологии, добавляются в дерево построения. 

Также применение инструментов СТ на моделях с историей характерно для направлений 

CAE и CAM. Для построения конечно-элементных сеток необходимо подготавливать геоме-

трию модели, убирая лишние элементы и упрощая сложную геометрию. Использование исто-

рии построения модели для таких целей очень неэффективно, так как расчетчик не является 

автором модели, поэтому ему тяжело разобраться во взаимосвязях конструктивных элемен-

тов. Поэтому инструменты, работающие с геометрией напрямую, в этом случае дают очевид-

ный выигрыш в трудоемкости при подготовке модели. То же самое можно сказать и про CAM 

с точки зрения создания оснастки по конструкторским моделям.

Моделирование деталей без истории построения. В ряде случаев бывает оправданным из-

начально моделировать деталь без истории построения. Это дает возможность проводить бы-

стрые изменения геометрии модели и не зависеть от хронологически связанной структуры 

элементов построения.

В данной главе на примерах будут рассмотрены инструменты синхронной технологии и 

особенности их использования. 

ПЕРЕМЕЩЕНИЕ И ПОВОРОТЫ ГРАНЕЙ
К функционалу перемещения и поворота граней условно можно отнести три команды: 

Переместить грань (Move Face), Грань вытягивания (Pull Face) и Смещение области 

(Offset Region). Отличие в работе этих команд заключается в том, как они перестраивают 

геометрию, сопряженную с той, которой оперируют. Самая функциональная команда из этой 
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группы по типам модификации геометрии – команда Переместить грань. Она перемещает 

одну или несколько граней и соответствующим образом адаптирует все сопряженные грани, 

что отличает её от команды Грань вытягивания, которая модифицирует только те грани, с 

которыми работает, а исходные сопряженные оставляет нетронутыми. Рассмотрим на приме-

ре работу команды Переместить грань:

• Запустите NX7.5 и откройте файл synch01.prt из папки ch6.

• Включите отображение инструментальной панели Синхронное моделирование 

(Synchronous Modeling) нажав правую кнопку мыши на какой-либо инструментальной па-

нели и выбрав в контекстном меню название нужной панели.

• Нажмите кнопку команды Переместить грань и выберите одну из внутренних граней от-

верстия. 

Обратите внимание, что в момент выбора грани возле курсора мыши загораются две 

кнопки с выпадающими списками (рис. 6.2). Первая кнопка – это контекстное представление 

выпадающего списка Правило грани, доступного на панели выбора. Этим правилом можно 

регулировать выбор смежных граней, что существенно упрощает выбор конструктивных эле-

ментов. Следует заметить, что эти правила работают вне зависимоти от режима построения.

Следующая кнопка предлагает выбрать опции поиска граней. Поиск граней также отвеча-

ет за расширение текущего выбора на основе геометрических признаков. Это выпадающее 

меню дублируется в диалоге команды в разделе Результаты (Results). 

Рассмотрим подробнее механизм поиска граней, так как он един для всех инструментов 

Рисунок 6.2. Команда Переместить грань
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синхронной технологии. В момент выбора какой-либо грани, если функция поиска граней 

включена, система автоматически подбирает по геометрическим критериям другие грани в 

текущей модели. Всего существуют семь возможных групп, куда попадут найденные грани:

Коаксиальные (Coaxial) – все цилиндрические грани, у которых ось совпадает в преде-

лах линейного допуска с осью выбранной цилиндрической грани.

Касательные (Tangent) – все грани, которые касательны последней выбранной грани.

Компланарные (Complanar) – все грани, лежащие в той же плоскости, что и выбранная 

последняя грань.

Компланарные оси (Complanr Axis) – все цилиндрические грани, у которых оси лежат в 

той же плоскости, что и ось последней выбранной цилиндрической грани.

Равные радиусы (Equal Radius) – все цилиндрические грани с радиусом, равным радиу-

сы последней выбранной цилиндрической грани.

Симметричные (Symmetric) – все грани, симметричные относительно выбранной плоско-

сти.

Смещение (Offset) – все грани, параллельные текущей, не являющиеся компланарными.

При этом система различает группы граней, близко расположенные к выбранной и уда-

ленные, которые помечаются соответствующей меткой.

Если какие-то грани в модели удовлетворяют геометрическому признаку одной из групп, 

то она отображается в разделе Результаты диалога команды. При наведении курсора мыши 

на группу в списке система подсветит на модели все грани, которые попали в это группу. Та-

ким образом можно значительно сократить объем выбора граней, используя группы. Надо 

иметь в виду, что Поиск граней работает на основе последней выбранной, то есть если по-

следовательно выбирать на модели грани, то группы при каждом новом выборе будут пере-

считываться. 

На вкладке Настройки (Settings) диалога команды есть ещё один список групп с допол-

нительным пунктом Использовать поиск граней(Use Face Finder). Этот пункт включает ме-

ханизм поиска граней, и при необходимости его можно здесь деактивировать. Это иногда 

необходимо при работе с большими сложными мо-

делями, когда поиск и группировка граней занимают 

длительное время. Остальные пункты данного списка, 

соответствующие группам, управляют автоматиче-

ским выбором. По умолчанию все они выключены, 

поэтому при выборе какой-либо грани система толь-

ко предлагает выбрать другие грани данной группы, 

отобразив её в списке Результаты. Если необходимо, 

чтобы система автоматически выбирала все грани из 

числа перечисленных выше групп, то необходимо их 

отметить в списке на вкладке Настройки. 

• В разделе Преобразованиеe (Transform) диа-

лога команды выберите в выпадающем списке 

Перемещение (Motion) значение Расстояние 
Рисунок 6.3. Перемещение граней
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(Distance), а в выпадающем меню За-

дать вектор (Distance Vector) выберите 

значение Контекстный вектор (Inferred 

Vector) и укажите одну из вертикальных 

граней. Используя появившийся маркер-

стрелку задания величины перемещения 

или текстовое поле Расстояние (Distance) 

передвиньте выбранную грань в любом из 

возможных направлений. Как видно, при вы-

боре единичной грани соседние грани оста-

ются на месте, и результат перемещения 

нарушает конструкцию детали (рис. 6.3). 

• Выберите в списке Результаты группы 

Коаксиальный и Коаксиальный (Far). Система выберет грани соответствующей группы 

и переместит их на заданное расстояние. На этот раз результат перемещения будет соответ-

ствовать ожидаемому (рис. 6.4). Попробуйте выбирать в списке Результаты другие группы 

и посмотреть, как они влияют на выбор граней.

Рассмотрим образование группы, куда попадают грани, симметричные выбранной. 

• С помощью пункта главного меню Вставить > База/Точка > Координатная СК (Insert > 

Datum/Point > Datum CSYS) создайте ещё одну локальную систему координат и располо-

жиете её начало в центре ребра, как показано на рис. 6.5, ось Z направьте вдоль ребра и 

ось Y – перпендикулярно ребру.

• Щелчком правой кнопки мыши на созданной системе координат откройте контекстное меню 

и выберите Установить РСК по координатной СК (Set WCS to Datum CSYS). Этим мы 

установим рабочую систему координат по вновь созданной локальной системе.

• Вызовите команду Грань перемещения и 

укажите боковую грань с отверстием. Обратите 

внимание, что в списке Результаты есть только 

группа Смещение, позволяющая выбрать бли-

жайшую параллельную грань. 

• В  диалоге команды переключитесь на вкладку 

Ссылка (Reference). В выпадающем списке вы-

берите значение РСК – рабочая деталь (WCS 

- Work Part) и переключитесь обратно на вклад-

ку Результаты. На этот раз в списке появилась 

группа Симметрично. 

• Включите эту группу,и при выборе других 

граней эта группа будет заново пересчитываться 

Рисунок 6.4. Использование Поиска граней

Рисунок 6.5. Задание системы координат
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и предлагать выбрать соответствующие 

симметричные грани (рис. 6.6). 

Группа симметричных граней стала до-

ступна, так как была задана система коор-

динат, относительно плоскостей которых 

и производится поиск симметричных гра-

ней. Помимо рабочей системы координат, 

можно использовать и абсолютную, если 

модель соответствующим образом рас-

положена. При работе в контексте сбор-

ки можно использовать рабочие и абсо-

лютные системы координат рабочей или 

отображаемой детали. И если никакая из 

всех существующих систем координат не подходит, выбрав в выпадающем списке значение 

Новая СК (New CSYS), можно определить дополнительную систему координат из диалога 

команды.

Как уже стало понятно, выпадающий список Перемещение в диалоге команды опреде-

ляет вид трансформации над выбранными гранями. Мы воспользовались самым простым – 

перемещением вдоль заданного вектора. Другие возможные трансформации из этого списка:

Угол (Angle) – перемещает выбранные грани вращением вокруг заданной оси.

Расстояние-угол (Distance-Angle) – комбинация трансформаций перемещения и угла 

поворота. Требует задания вектора направления перемещения и оси вращения с точкой на-

чала.

Расстояние между точками (Distance between Points) – перемещает выбранные грани 

вдоль заданного вектора на расстояние, равное расстоянию между проекциями двух выбран-

ных точек на вектор.

От точки к точке (Point to Point) – данная трансформация аналогична предыдущей, но в 

этом случае вектор перемещения задается вектором, соединяющим точки. 

Радиальное расстояние (Radial Distance) – смещает выбранные грани на заданное рас-

стояние по радиальному направлению между центром и выбранной точкой.

Вращать по трем точкам (Rotate by Three Points) – вращает выбранные грани вокруг 

задаваемого вектора, определяющего направление оси и установленного в первую выбран-

ной точку, на угол, равный углу между первой точкой и двумя следующими выбранными.

Выровнять ось по вектору (Align Axis to Vector) – перемещает выбранные грани вокруг 

задаваемой точки относительно разницы их положения между исходным вектором и целевым.

СК в СК (CSYS to CSYS) – трансформирует выбранные грани из одной системы координат 

в другую .

Динамика (Dynamic) – позволяет перемещать выбранные грани динамически, используя 

маркеры перемещения и вращения символа системы координат. Этот режим перемещения 

доступен только в режиме без истории построения.

Дельта XYZ (Delta XYZ) – перемещает выбранные грани на заданные приращения от-

Рисунок 6.6. Поиск симметричных граней
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носительно исходного положения в направления 

координатных осей выбранной системы коорди-

нат.

При работе в контексте сборки команда пе-

ремещения граней позволяет модифицировать 

не только геометрию рабочей детали, но и дру-

гих компонентов сборки. Это дает возможность 

изменять сопряженные грани соединяющихся 

элементов только одной операцией трансфор-

мации. Необходимым условием для работы в 

контексте сборки данной команды является ре-

жим моделирования без истории для модели 

сборки и всех её компонентов.

Откройте файл sync_assy.prt из папки ch6. Сборка состоит из двух компонентов, которые 

соединены сборочными связями.

• Двойным щелчком в Навигаторе сборки сделайте один из компонентов рабочей деталью 

и убедитесь в том, что активен режим моделирования без истории.

• Вызовите команду Переместить грань и выберите грань одного из отверстий, а затем, 

установив Вся сборка в выпадающем списке на панели выбора, выберите грань отверстия 

другой детали (рис. 6.7).

• Далее определите вектор направления по вертикали и задайте величину перемещения, по-

сле чего нажмите Применить.

Грани в обоих компонентах будут перемещены на одинаковое расстояние.

Теперь рассмотрим команду Грань вытягивания, которая является частным случаем ко-

манды Переместить грань для трансформаций перемещения и отличается от неё влиянием 

на смежные грани.

• Откройте файл synch02.prt из папки ch6.

Рисунок 6.8. Разница между командами Переместить грань и Грань вытягивания

Рисунок 6.7. Перемещение граней в контек-

сте сборки
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• С помощью команды Переместить грань вытя-

ните верхнюю плоскую грань на некоторое рас-

стояние и посмотрите на полученный результат. 

Помимо перемещения выбранной грани, команда 

продлила смежные существующие грани с сохране-

нием касательности.

• Отмените модификацию, сделанную командой 

Переместить грань, удалив из дерева построе-

ния последний элемент, и вызовите команду Грань 

вытягивания. Укажите ту же самую грань и в 

выпадающем списке задания вектора перемеще-

ния выберите перемещение вдоль оси Z, задайте 

некоторое расстояние и нажмите Применить.

• На этот раз при перемещении грани были созданы 

новые смежные грани, но исходные остались 

нетронутыми (рис. 6.8).

Это основное различие в работе двух первых команд перемещения граней.

Последняя команда, реализующая функцию трансформации набора граней, которую не-

обходимо рассмотреть, – команда Смещение грани. Эта команда является расширением 

команды Переместить грань, которая позволяет линейно перемещать несколько граней по 

направлению их нормалей на заданное расстояние.

• Откройте файл synch03.prt из папки ch6 и на инструментальной панели СТ вызовите коман-

ду Грань смещения.

• Выделите последовательно боковые грани модели и задайте перемещение, после чего на-

жмите применить (рис. 6.9).

Каждая грань переместится параллельно самой себе, и при этом каждая из них будет адап-

тирована так, что не образуется разрыва. Данная команда также позволяет  пользоваться по-

иском граней по геометрическому признаку и задавать справочную систему координат для 

определения плоскостей симметрии.

УДАЛЕНИЕ И СОЗДАНИЕ ГРАНЕЙ
Команда удаления граней является одной из основных при упрощении моделей и при 

исправлении дефектов конвертации данных из другой CAD системы. Она позволяет уда-

лять единичные грани или группу, а также цилиндрические грани с заданным размером 

радиуса. Создание новых граней, то есть по сути создание новых элементов геометрии, 

производится стандартным функционалом моделирования, вне зависимости от режима 

работы с историей. Но, как уже упоминалось, некоторые элементы построения имеют 

Рисунок 6.9. Команда Грань смещения
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• свойства переходить между режимами работы с историей. Рассмотрим на примере ко-

манду удаления граней, а также создание конструктивных элементов с сохранением 

истории построения и без неё.

• Откройте файл synch02.prt из папки ch6. Это деталь без истории построения, где модель 

представлена одним телом. 

• Вызовите из инструментальной панели СТ команду Удалить грань (Delete Face) и укажите 

одну из граней скругления внутри кармана, и открыв появившуюся кнопку задания правила 

выбора, укажите пункт Связанные грани сгиба (Connected Blend Faces) (рис. 6.10). 

Рисунок 6.11. Удаление отверстий по размеру диаметра

Рисунок 6.10. Удаление граней
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• Будут выбраны все грани скругления по контуру, несмотря на то что конструктивный элемент, 

создавший это скругление, уже в истории построения явно не присутствует. Нажмите кнопку 

Применить для удаления выбранных граней.

• Выберите и удалите все грани, представляющие фаски на четырёх отверстиях. На этот раз 

подходящего правила выбора нет, поэтому грани необходимо выбрать вручную. 

• В выпадающем списке Тип (Type) диалога команды удаления граней выберите значение От-

верстие (Hole). В этом режиме команда удаления будет действовать только на цилиндриче-

ские замкнутые грани. Вы можете вручную выбрать грани отверстий для удаления или офиль-

тровать по размеру. В первом случае достаточно выбрать рамкой всё тело, и будут выбраны 

только отверстия (рис. 6.11).

• Включите опцию Выберите отверстия по размеру (Select Holes by Size) и задайте раз-

мер отверстия меньшим или равным 26 мм. Затем рамкой выберите все тело модели или 

укажите одно из меньших отверстий. В результате будут выбраны те отверстия, которые удо-

влетворяют заданному условию. Нажмите кнопку Применить для завершения удаления и 

закройте диалог.

Если сейчас посмотреть в Навигатор модели, то там будут все операции удаления гра-

ней, которые были применены к модели. В режиме работы с историей все инструменты син-

хронной технологии записываюся в историю построения.

• С помощью команд Скругление ребра (Edge Blend) и Отверстие (Hole) модуля Моде-

лирование добавьте соответствующие конструктивные элементы, восстановив её исходное 

состояние (это также можно сделать деактивацией операций удаления граней, но в данном 

случае необходимо добавить стандартные команды моделирования в историю). А затем пе-

реключитесь в режим моделирования без истории построения (рис. 6.12).

Теперь в Навигаторе модели другая картина. Операции удаления грани исчезли, так как 

они имели временную зависимость, но операции создания скругления и отверстия остались. 

Рисунок 6.12. Добавление элементов в режиме с историей построения
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Однако теперь они представляют собой локальные элементы, которые не имеют какой-либо 

хронологической зависимости, но тем не менее хранят свои параметры. Таким свойством об-

ладают несколько команд Моделирования, которые могут конвертироваться из конструк-

тивных элементов построения модели в локальные. Здесь важно понимать, что эти элемен-

ты независимы друг от друга, то есть режим моделирования без истории не исключает нали-

чия самих элементов построения, но исключает временную ассоциативную зависимость меж-

ду ними.

КОМАНДЫ ЗАДАНИЯ ОТНОШЕНИЙ
Помимо прямых методов трансформации геометрии, инструменты синхронной техноло-

гии позволяют модифицировать элементы моделей на основе геометрических условий и за-

данных размеров. Рассмотрим группу команд, отвечающих за задание относительных усло-

вий между гранями.

• Откройте файл synch04.prt из папки ch6.

• На инструментальной панели СТ разверните кнопку-список Отношение (Relate). Здесь 

представлены следующие команды:

Сделать компланарным (Make Complanar) – перемещает выбранную грань до уровня 

выбранной стационарной грани и делает её компланарной. При этом можно задать дополни-

тельные грани, которые получат смещение на ту же величину, что и первая грань.

Сделать коаксиальным (Make Coaxial) – делает выбранную цилиндрическую грань со-

осной выбранной стационарной цилиндрической грани или какой-либо оси. 

Сделать касательным (Make Tangent) – делает грань касательной к выбранной стаци-

онарной и опционально перемещает дополни-

тельные грани.

Сделать симметричным (Make Symmetric) 

– задает симметрию между выбранной гранью и 

стационарной, используя плоскость симметрии.

Сделать параллельным (Make Parallel) – 

делает выбранную грань параллельной стацио-

нарной.

Сделать перпендикулярным (Make 

Perpendicular) – делает выбранную грань пер-

пендикулярной стационарной.

Зафиксировать (Make Fixed) – фиксирует 

грань и блокирует её от всех возможных транс-

формаций.

Сделать смещение (Make Offset) – смеща-

ет выбранную грань на заданное расстояние от 

стационарной грани. Рисунок 6.13. Условие компланарности
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Показать грань отношения (Show Related 

Faces) – показывает грани с отношениями фик-

сации и размерными связями.

Все эти команды трансформации, кроме ко-

манды фиксации и просмотра отношений, по-

мимо перемещения грани, могут перемещать 

дополнительную группу граней относительно их 

исходного положения, в направлении и на вели-

чину перемещения исходной грани.

• Вызовите команду Сделать компланарным 

и укажите верхнюю плоскую грань для пере-

мещения, в качестве стационарной укажи-

те горизонтальную плоскость. А в разделе 

Группа перемещения (Motion Group) вы-

берите две цилиндрические грани отверстия 

и две грани, образующие фаски, и нажмите 

Применить. Исходная грань станет ком-

планарной выбранной плоскости, а грани, 

заданные в Группе перемещения, сместятся на ту же величину расстояния, что и исходная 

грань (рис. 6.13).

• Вызовите команду Сделать симметричным и укажите отверстие в вертикальной стенке, 

которое ближе к середине. Укажите существующую плоскость для определения симметрии и 

укажите второе отверстие как стационарную грань, затем нажмите кнопку Применить (рис. 

6.14). 

Обратите внимание, что в Группе перемещения выбраны два объекта, хотя указывался 

только один. Система автоматически добавила грань фаски отверстия, чтобы не нарушить 

топологию модели перемещения одной цилиндрической грани. 

Все остальные команды трансформации этой группы работают аналогичным образом и 

доступны в обоих режимах моделирования. Исключение из этой группы составляют команды 

фиксации и просмотра отношений граней, которые работают только в режиме без истории 

построения.

• Командой Зафиксировать пометьте одну из граней отверстия и затем попытайтесь к ней 

применить команду Переместить грань. Будет выдано сообщение о нарушении геометри-

ческих условий, и операция не будет применена.

 Таким образом вы можете фиксировать отдельные элементы геометрии, чтобы они оста-

вались независимыми от любых изменений смежных граней. Для определения, какие грани в 

модели зафиксированы, и для снятия этого ограничения воспользуйтесь командой Показать 

грань отношения.

Рисунок 6.14. Условие симметричности
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УПРАВЛЯЮЩИЕ РАЗМЕРЫ
Дополнительно к возможности задания гео-

метрических условий вы можете задавать линей-

ные, угловые и радиальные размеры с привяз-

кой к набору граней, которые будут управляться 

этими размерами. Такого рода зависимости за-

даются соответственно командами Линейный 

размер (Linear Dimension), Угловой размер 

(Angular Dimension) и Радиальный размер 

(Radial Dimension) на инструментальной пане-

ли СТ.

• Откройте файл sync05.prt из папки ch6.

• Вызовите команду Линейный размер и 

задайте размер ширины детали по верхней 

грани. При наведении курсора на края мо-

дели в местах скруглений будут подсвечены 

фиктивные линии пересечения смежных граней. Их можно использовать для привязки разме-

ра. Первый указанный объект определяет стационарную часть, а второй – ту часть, которая 

будет перемещаться (рис. 6.15). 

• В разделе Грань для перемещения  на вкладке Результаты выберите группу Смещение 

и расположите размер. После этого с помощью маркера перемещения или числового поля 

в диалоге произведите изменение размера. Обратите внимание, что этот размер был до-

бавлен в историю построения и его можно 

редактировать. 

• Ещё одним линейным размером задайте рас-

стояние между центрами отверстий двух бо-

бышек и в качестве Граней перемещения 

выберите всю вертикальную стенку с двумя 

бобышками (рис. 6.16). Альтернативой за-

данию расстояния перемещения может быть 

привязка размера к объекту. Для создания 

привязки необходимо нажать правую кнопку 

мыши на маркере перемещения размера.

• Вызовите команду Угловой размер. Задай-

те размер между верхней гранью и боковой 

наклонной. После расположения размера 

включите группу Смещение, чтобы выбрать 

обратную сторону стенки. Измените размер 

Рисунок 6.15. Линейный размер

Рисунок 6.16. Линейный размер на группу
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и посмотрите, как модель перестроится (рис. 6.17). 

Угловые размеры, как и линейные, также мож-

но ставить на ребра, выбирая при этом набор 

граней для перемещения.

 Таким же образом, как и предыдущие типы 

размеров, попробуйте проставить радиальные 

размеры на цилиндрические грани и изменять их.

Инструменты управляющих размеров можно 

использовать не только для прямого управления 

положением геометрических элементов или их 

формой. Размеры также можно использовать для 

накладывания геометрических условий на ка-

кую-либо грань тела, чтобы сохранить её форму 

и размеры при изменении сопряженных граней. 

Этот подход по смыслу совпадает с наложением 

размеров в эскизе. Рассмотрим работу линейного 

размера в режиме геометрического ограничения.

• Откройте файл sync06.prt из папки ch6.

• Запустите команду Переместить грань и выберите верхнюю грань одной из «лапок», 

включите в разделе Поиск граней опцию Смещение, чтобы выбрать противоположную 

грань «лапки».

• Начните перемещать выбранные грани вниз. Обратите внимание, что по мере смещения 

Рисунок 6.18. Вырождение граней Рисунок 6.19. Фиксация размера

Рисунок 6.17. Угловой размер
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граней от их исходного состояния начинает меняться и высота граней, что не является же-

лательным изменением. Отмените операцию перемещения и вызовите команду Линейный 

размер (рис. 6.18). 

• Поставьте размер между фантомной линией пересечения плоскости грани и наклонной стен-

ки (она появится, если навести курсор мыши в эту область) и крайним ребром грани. Полу-

чится управляющий размер, которым можно регулировать высоту «лапки». Не меняя значе-

ния размера, откройте раздел диалога Настройки (Settings) и включите опцию Блокиро-

вать размер (Lock Dimension). Эта опция заставит размер сохранять начальное значение 

при любых изменениях геометрии модели (рис. 6.19).

• Нажмите ОК в диалоге создания размера и опять повторите операцию перемещения граней 

«лапки». На этот раз вне зависимости от перемещения высота будет сохраняться равной за-

данному размеру.

РЕДАКТИРОВАНИЕ СЕЧЕНИЙ
Ещё один способ редактирования тел без 

истории построения предлагает команда Изме-

нение сечения (Cross Section Edit). Она позво-

ляет редактировать части тел, полученные вытя-

гиванием или вращением какого-либо плоского 

профиля, путем редактирования динамического 

сечения, которое создается при редактирова-

нии. 

• Откройте файл sync07.prt из папки ch6.

• С помощью команды главного меню Вста-

вить > База/Точка > Координатная 

плоскость (Insert > Datum/Point > Datum) 

создайте плоскость, находящуюся строго 

между двумя боковыми торцами модели. Для 

этого в диалоге создания воспользуйтесь 

подтипом Средняя линия (Bisector) (рис. 

6.20).

• Убедитесь, что модель находится в режиме 

построения без истории, и на инструменталь-

ной панели СТ вызовите команду Измене-

ние сечения. Укажите созданную плоскость 

для создания динамического сечения и выбе-

рите одно из продольных ребер для указания 

Рисунок 6.20. Создание плоскости

Рисунок 6.21. Редактирование сечения
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направления оси Х эскиза.

• Будет создано пересечение плоскости и граней, и полученный контур будет загружен в при-

ложение редактирования эскиза. Передвигая составляющие эскиза, измените геометрию мо-

дели (рис. 6.21).

Модель будет перестраиваться каждый раз при изменении линий контура, и при выходе 

из среды эскиза контур будет удален. При редактировании эскиза вы можете использовать 

размеры и геометрические ограничения, но в некоторых случаях это может вызывать раз-

рыв контура, что приведет к ошибке перестроения тела. Вы не можете удалять существую-

щие кривые контура, а также при создании дополнительных кривых в пределах динамиче-

ского сечения они не будут учитываться. При создании сечения система автоматически на-

следует ряд геометрических ограничений, таких как параллельность и перпендикулярность 

на основе взаимного расположения исходных граней, которые можно удалять и добавлять.
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ОБЩИЕ КОНЦЕПЦИИ
 Моделирование и анализ сборочных единиц является одной из важных составляющих 

процесса проектирования в системе САПР. На этом этапе все созданные разными участника-

ми модели деталей собираются и увязываются в общий состав изделия. Для решения задач, 

связанных с созданием сборок и работой с ними, в NX предлагаются два модуля – Сборки и 

Расширенные сборки, объединенные под одним приложением. 

Модуль Сборки содержит основной инструментарий по созданию сборок, позициониро-

ванию компонентов и наложению сборочных связей. А модуль Расширенные сборки, пред-

ставленный в виде дополнительных инструментальных панелей, предлагает средства анализа 

массы, созданияе последовательностей сборки и разборки и многое другое. В этой главе об-

зорно будут рассмотрены процесс создания сборок и инструменты по работе с ними.

Сборка в NX представляет собой файл модели, содержащий ссылки на другие модели, ко-

торые являются компонентами сборки. В общем случае любая модель технически может вы-

ступать сборкой, и также любая модель сборки может хранить в себе не только ссылки на 

компоненты, но и свою собственную геометрию.  

Каждый компонент, входящий в сборку, несет информацию не только о геометрии модели, 

на которую он ссылается, но и дополнительную информацию, такую как слой расположения 

компонента, цвет отображения, матрицу позиционирования данного экземпляра компонента 

и отображаемый ссылочный набор. 

Ссылочным набором называется определенный набор геометрических объектов, которые 

применяются для представления компонента в сборке. Механизм ссылочных наборов исполь-

зуется для фильтрации содержимого модели в целях предоставления только тех геометриче-

ских элементов, которые необходимы для той или иной задачи. Это помогает снизить потреб-

ность в ресурсах памяти и видеокарты при работе со сборками, так как дает возможность не 

загружать все содержимое моделей, а только необходимую часть. В общем случае  модель 

может содержать в себе несколько ссылочных наборов – как системных, так и пользователь-

ских. Каждый компонент сборки также содержит ссылку на файл модели, поэтому изменения 

этой модели отражаются на всех вхождениях компонента сборки. При этом одинаковые ком-

поненты могут иметь свои уникальные атрибуты,  отличающие одно вхождение от другого. 

Загрузка компонентов сборки – их состояния, используемые версии, а также как они ото-

бражаются на экране – определяется опциями загрузки, которые определяются во время от-

крытия сборки или предопределяются для конкретной сборки в виде файла с опциями.

ЗАГРУЗКА И ОТОБРАЖЕНИЕ СБОРОК
Рассмотрим на примере механизм загрузки сборок и управление отображением компо-

нентов.

• Запустите NX7.5 и выберите пункт главного меню Файл > Открыть (File > Open). В папке 

с примерами перейдите в директорию ch7/impeller и выберите файл impeller_asm.prt, после 

чего нажмите кнопку Опции (Options) в диалоге выбора файла.
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Откроется диалоговое окно задания опций загруз-

ки сборки (рис. 7.1). Первый раздел диалога Версии 

детали (Part Versions) определяет место, откуда бу-

дут загружаться компоненты сборок. Возможны три 

значения:

Как сохранено (As Saved) – компоненты будут 

искаться в тех местах, где они были при последнем 

сохранении файла сборки.

Из каталога (From Folder) – компоненты будут 

браться из каталога, где находится файл сборки.

Из каталогов поиска (From Search Folders) – 

поиск входящих компонентов будет вестись по задан-

ным каталогам поиска.

Опция Загрузка (Load) в следующем разделе 

определяет, как будет грузиться сборка, и имеет сле-

дующие значения:

Все компоненты (All Components) – будут загру-

жены все компоненты, входящие в сборку, за исклю-

чением тех, которые представлены пустым ссылочным 

набором.

Только структура (Structure Only) – загружает-

ся только структура всех уровней сборки без загруз-

ки компонентов. Используется для выборочной руч-

ной загрузки какого-то набора компонентов.

Как сохранено (As Saved) – сборка открывается 

с тем же состояниям входящих компонентов, которое 

было на момент сохранения.

Пересчитать последнюю группу компонент 

(Re-evaluate Last Component Group) – открывает 

сборку, загружая ту группу компонент, которая использовалась на момент сохранения.

Выбрать группу компонент (Specify Component Group) – позволяет выбрать группу 

компонент, которую необходимо загрузить.

При загрузке каждого файла компонента NX считывает не весь файл, а только необходи-

мую часть, исходя из текущих настроек. Это регулируется опциями Использовать частич-

ную загрузку (Use Partial Loading) и Загрузка данных о связях между деталями (Load 

Interpart Data). Первая опция включена по умолчанию и определяет, что загружаться будет 

минимально необходимый объем данных. Вторая опция, будучи включенной, отменяет дей-

ствие первой для компонентов, в которых есть межмодельные связи. Как уже говорилось  в 

предыдущих главах, для отслеживания состояния и управления изменениями связей между 

моделями необходимо загружать компонент полностью.  

Следующий набор опций расположен в разделе Режим загрузки (Load Behavior):

Рисунок 7.1. Опции загрузки сборок
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Разрешить замену (Allow Replacement) – включение этой опции будет заставлять сбор-

ку загружать первый найденный компонент с правильным именем, даже если он не соответ-

ствует исходному компоненту. 

Создавать отсутствующие компоненты семейства (Generate Missing Part Family 

Members) – разрешает создавать члены семейства деталей, если они не были найдены в ка-

талогах загрузки при наличии родительской детали.

Отмена загрузки по ошибке (Cancel Load on Failure) – включает остановку процесса 

загрузки сборки при ошибке загрузки какого-либо компонента.

Список Ссылочные наборы (Reference Sets) определяет приоритет загрузки ссылочных 

наборов компонентов. Система ищет первый ссылочный набор в списке в компоненте, и если 

находит, то загружает его, если нет, то ведется поиск следующего, и так далее.  Если в ком-

понентах существует пользовательский ссылочный набор, то его тоже можно добавить в спи-

сок, воспользовавшись текстовым полем Добавить ссылочный набор (Add Reference Set).

Любая создаваемая модель в NX имеет два предопределенных ссылочных набора – Пу-

стой и Вся деталь. Пустой ссылочный набор не содержит никакой геометрии и представляет 

собой только вхождение компонента в структуре сборки. Ссылочный набор Вся деталь, на-

оборот, содержит все объекты, созданные в данной модели. Вдобавок к этим ссылочным на-

борам в настройках по умолчанию задается создание ссылочного набора MODEL, куда ав-

томатически добавляются все твердотельные и листовые тела, создаваемые в процессе мо-

делирования. Как правило, именно этот ссылочный набор является основным при работе со 

сборками, так как он содержит геометрическое представление готовой модели. Данный на-

бор относится к категории наборов, поддерживаемых системой, то есть NX в зависимости от 

настройки сам управляет содержимым этого набора, что не исключает его редактирование 

пользователем.

До версии NX7.5 ещё одним автоматически создаваемым ссылочным набором было легко-

весное представление твердых тел модели, которое сохранялось в ссылочном наборе FACET. 

Это позволяло загружать в сборках не точную геометрию деталей, а облегченное представ-

ление в формате JT, что давало существенный выигрыш в потребляемой памяти. При этом 

большая часть инструментария по работе со сборками могла работать именно с таким пред-

ставлением модели, а когда была необходима точная геометрия, то пользователь переклю-

чал отображаемый ссылочный набор. 

В версии NX7.5 был представлен новый механизм работы с легковесным представлением. 

Теперь при сохранении модели система автоматически проверяет все системные и пользова-

тельские ссылочные наборы и при наличии в них твердых или листовых тел создает облегчен-

ное представление для каждого ссылочного набора. И  это представление не отображается 

явно среди ссылочных наборов, а вместо этого была добавлена возможность переключения 

режима отображения текущего ссылочного набора между точным и облегченным. При откры-

тии файлов старых версий NX7.5 удаляет ссылочный набор FACET и генерирует неявное об-

легченное представление для модели. 

Также изменился механизм работы с облегченным представлением. Раньше пользователю 

приходилось переключаться между фасетным и точным представлениями геометрии, так как 



163

NX Глава 7. Работа со сборками

не все команды работают с фасетным представлением. В текущей версии при использовании 

легковесного представления компонентов система сама определяет в зависимости от исполь-

зуемой команды, надо ли загружать точное представление. Если это необходимо, то произ-

водится загрузка точной геометрии, выполняется операция и затем обратно загружается лег-

ковесное представление. 

Раздел Опции восстановления закладок (Bookmark Restore Option) отвечает за па-

раметры загрузки сборок, если пользователь использовал закладки. Закладка позволяет со-

хранить заданное состояние компонентов сборки и открыть в следующий раз сборку в этом 

состоянии. Это особенно удобно при работе с большими сборками, когда требуется неко-

торое время для настройки рабочей зоны. Опция Детали для загрузки (Parts To Load) вы-

бирает, какие компоненты будут загружены, а опции Восстановить полностью загружен-

ное состояние (Restore Fully Loaded State) и Восстановить ссылочные наборы (Restore 

Reference Sets) определяют, будут ли загружаться компоненты соответственно в том состоя-

нии и с тем ссылочным набором, которые были актуальны в момент создания закладки.

Текущие выставленные опции загрузки можно сделать опциями по умолчанию, или можно 

восстановить предыдущие опции, заданные как значения по умолчанию, при помощи соот-

ветствующих кнопок в разделе Сохраненные опции загрузки (Saved Load Options).

• В диалоге задания опций 

разверните раздел Ссы-

лочные наборы. Здесь, 

помимо стандартных набо-

ров Пустой (Empty) и Вся 

деталь (Entire Part), при-

сутствуют Использовать 

Model (Use Model) и Как 

сохранено (As Saved).  

Последняя опция загрузит 

те ссылочные наборы ком-

понентов, которые были ак-

тивны в момент сохране-

ния сборки. А значение Ис-

пользовать Model озна-

чает, что система будет ис-

кать ссылочный набор 

MODEL, который упоми-

нался ранее, или его ана-

лог. 

Дело в том, что имя этого ссылочного набора является настраиваемым, поэтому однознач-

но задать в этом списке имя не всегда возможно. Вы можете переопределить имя ссылочно-

го набора, открыв Настройки по умолчанию и зайдя в раздел Сборки > Стандартное ме-

сто > Ссылочные наборы (Assemblies > Site Standards > Reference Sets) (рис. 7.2).  Здесь 

Рисунок 7.2. Настройки ссылочных наборов
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же вы можете определить, какие объекты попадают в данный ссылочный набор, выбрав соот-

ветствующую опцию в разделе Содержание (Contents). Ещё один набор из категории под-

держиваемых системой может быть активирован путем задания какого-нибудь имени в поле 

Упрощенный ссылочный набор (Simplified Reference Set). В него будет помещаться ге-

ометрия, созданная командой Обертка сборки для упрощенного представления подсбо-

рок. Также здесь в поле Дополнительные ссылочные наборы модели (Additional Model 

Reference Sets) можно через пробел ввести имена наборов, которые будут создаваться для 

моделей.  Эти наборы будут уже поддерживаемыми пользователем.

• Сделайте значение Использовать MODEL (Use Model) первым в списке загружаемых 

наборов, включите опцию Облегченное представление и закройте диалог опций за-

грузки, а затем нажмите ОК в диалоге выбора файла. Будет загружена сборка со все-

ми входящими в неё компонентами. Структура сборки и атрибуты компонентов отобра-

жаются в Навигаторе сборки (рис. 7.3).

• Нажмите правую кнопку мыши на пустом месте Навигатора сборки и в контекстном меню 

выберите пункт Столбцы > Конфигурация (Columns > Configure). В этом диалоге зада-

ются отображаемые параметры компонентов и их порядок. Выберите параметры Представ-

ление (Representation), Ссылочный набор (Reference Set) и Положение (Position) и 

с помощью стрелок сдвиньте их наверх, чтобы соответствующие столбцы сместились влево. 

• В данном диалоге также можно вывести пользовательский атрибут, присвоенный компонен-

там, задав его имя в поле Атрибут и нажав кнопку Создать. Тогда в появившемся столбце 

будут отображаться значения атрибута с таким именем для каждого компонента. Нажмите 

кнопку Применить и закройте диалог.

Обратите внимание, что, как и было указано в опциях загрузки, для всех компонентов был 

загружен ссылочный набор MODEL или его эквивалент, так как не во всех моделях этот на-

Рисунок 7.3. Отображение сборки
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бор имел данное имя. Так же как и было ука-

зано, было загружено легковесное представле-

ние компонентов, о чем говорит пиктограмма в 

виде пера в колонке Представление. Колонка 

Положение показывает статус позиционирова-

ния компонента, который зависит от наложен-

ных сборочных связей, ограничивающих степе-

ни свободы компонента. 

Переключение между представлениями и 

ссылочными наборами производится через кон-

текстное меню компонента в Навигаторе сбор-

ки или в графической области. В последнем слу-

чае для получения контекстного меню компонен-

та необходимо выбрать значения фильтра выбо-

ра «Компонент», иначе будет выбираться геоме-

трия компонента. 

• Выделите один из компонентов в Навигато-

ре сборки и нажмите правую кнопку мыши. 

В разделе Ссылочный набор переключи-

те текущий ссылочный набор на Пустой, а потом на Вся деталь. Обратите внимание, как 

изменяется представление компонента в графической области. Так же выбирая пункты кон-

текстного меню Показать точное представление (Show Exact) и Показать облегчен-

ное представление (Show Lightweight), поменяйте состояние загрузки для компонентов 

(рис. 7.4).  

Рассмотрим подробнее задание ссылочных наборов. 

Рисунок 7.4. Смена ссылочных наборов

Рисунок 7.5. Выделение геометрии
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• Выберите компонент 014_shaft_

load и, открыв контекстное меню, 

выберите пункт Сделать ото-

бражаемой деталью (Make 

Displayed Part). Деталь откроет-

ся отдельно от всей сборки в но-

вом окне.

• С помощью команды главно-

го меню Вставить >  Кривые 

из тел > Выделение (Insert > 

Curve From Bodies > Extract) 

вызовите диалог команды выделе-

ния кривых из тел. В диалоге на-

жмите кнопку Кривые из ребер 

(Edge Curves) и в следующем ди-

алоге нажмите кнопку Все в теле 

(All of Solids). После этого ука-

жите твердое тело и нажмите ОК два раза и закройте диалог (рис. 7.5). 

• Откройте диалог задания ссылочных наборов, выбрав пункт главного меню Формат > Ссы-

лочные наборы (Format > Reference Set). В модели определены три ссылочных набора. 

Добавим ещё один, который будет содержать только контур модели. 

• В поле Имя ссылочного набора введите КОНТУР (или любое другое), затем, установив 

фильтр выбора по типу в значение «Кривая», нажмите кнопку Выбрать объект и рамкой 

выделите твердое тело и выделенные кривые (рис. 7.6).

• В результате в созданный ссылоч-

ный набор будут добавлены все 

кривые. Закройте диалог и сохра-

ните модель.

• В Навигаторе сборки выбери-

те имя компонента и, открыв кон-

текстное меню по правой кноп-

ке, выберите пункт Отобразить 

родителей (Display Parents), 

а затем выберите файл  головной сборки. После того как отобразится вся структура сборки, 

двойным щелчком на верхнем узле сделайте сборку рабочей деталью.

• Выделите в структуре сборки модифицированный компонент 014_shaft_load и поменяйте 

ему текущий ссылочный набор на Контур. Будет отображена группа кривых, заданных для 

этого ссылочного набора (рис. 7.7).

Рисунок 7.6. Создание ссылочного набора

Рисунок 7.7. Применение нового ссылочного набора
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Таким образом можно создавать ссылочные набо-

ры для представления компонент в сборке.

Как уже было сказано, Навигатор модели яв-

ляется основным средством для работы со структу-

рой сборки. Работа осуществляется с помощью кон-

текстного меню и инструментальной панели Сборки 

(Assemblies), а также пункта главного меню в разде-

ле Сборки.

Рассмотрим часто используемые пункты контекст-

ного меню в Навигаторе сборки (рис. 7.8):

Упаковать (Pack) – команда позволяет сокра-

тить отображаемую структуру сборки путем сверты-

вания нескольких вхождений одного компонента в 

одну строчку. Для упаковки выберите одно из вхож-

дений повторяющегося компонента и воспользуй-

тесь этой командой. Обратная команда Распаковать 

(Unpack) возвращает структуру в исходное состоя-

ние.

WAVE – раздел, содержащий команды управле-

ния межмодельными связями.

Группы компонент (Component Group) – позволяет создавать именованные группы ком-

понент. Группы могут создаваться по списку или по близости к выбранному компоненту. Этот 

функционал используется для формирования контекста работы над определенным участком 

сборки и для разбиения состава сборки по какому-либо признаку.  Сформированные груп-

пы потом можно использовать в опциях загрузки, для открытия только тех компонентов, кото-

рые входят в выбранную группу.

Сделать рабочей деталью (Make Work Part) – делает компонент рабочей деталью, 

оставляя отображение остальной сборки.

Сделать отображаемой деталью (Make Displayed Part) – делает выбранный компо-

нент одновременно рабочей и отображаемой деталью.

Отобразить родителей (Display Parent) – отображает выбранный родительский узел.

Закрыть (Close) – закрывает выбранный компонент, выгружая его из памяти.

Заменить компонент (Replace Component) – открывает диалог замены выбранного ком-

понента на другой компонент.

Сопряжения сборки (Assembly Constraints) – открывает диалог задания сборочных свя-

зей компонента.

Перемещение (Move) – открывает диалог перемещения компонента с помощью динами-

ческих осей или с использованием точного метода.

Подавления (Suppression) – управляет режимом подавления компонента в контексте 

данной сборки.

Свойства (Properties) – отображает диалоговое окно задания свойств компонентов, в 

Рисунок 7.8. Контекстное меню компо-

нента
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частности веса компонента и атрибутов. 

Отобразить степени свободы (Show Degree of Freedom) –  отображает на компоненте 

графический символ, показывающий оставшиеся степени свободы компонента. Для выключе-

ния отображения этого символа воспользуйтесь пунктом главного меню Вид > Операция > 

Регенерировать рабочий (View > Operation > Regenerate Work).

  СОЗДАНИЕ СБОРКИ
Создание сборок сводится к добавлению компонентов на какой-либо уровень сборки с по-

следующим его позиционированием и заданием относительных сборочных связей. Как уже 

говорилось, по умолчанию любая модель может содержать ссылки на другие модели, то есть 

являться сборкой. Для изменения этого поведения конкретной модели необходимо пометить 

её как деталь – то есть модель, которая не может содержать ссылки на другие компоненты. 

Для этого следует воспользоваться пунктом главного меню Файл > Утилиты > Режим дета-

ли (File > Utilities > Enforced Piece Part).

Добавление компонентов в сборку производится при помощи команды Добавить компо-

нент (Add Component), расположенной на инструментальной панели Сборки, или с помо-

щью пункта главного меню Сборки > Компоненты > Добавить компонент (Assemblies > 

Components > Add Component). В диалоге команды необходимо выбрать компонент из чис-

ла загруженных или открыть существующую модель с диска (рис. 7.9). Далее следует выбрать 

способ позиционирования:

Начало абсолютной системы координат – компонент будут помещен в ноль абсолют-

ной системы координат.

Выберите начало – будет предложено задать положение вставляемого компонента.

По связям – позиционирование компонента будет вестись согласно накладываемым сбо-

Рисунок 7.9. Вставка компонента в сборку
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рочным связям, для чего будет открыт диалог их  опре-

деления (которые можно задать и после вставки ком-

понента).

Перемещение – компонент будет вставлен в ука-

занную первоначальную точку, а затем будет открыт 

диалог задания перемещения.

При вставке и позиционировании компонентов 

надо иметь в виду, что за точку вставки компонента 

принимается ноль абсолютной системы координат 

модели, а ориентация компонента определяется на-

правлением осей этой системы координат.

После вставки компонента его необходимо связать 

геометрическими связями с другими компонентами 

или зафиксировать как стационарный. Для этого ис-

пользуется команда Сопряжения сборки (Assembly 

Constraints), вызываемая на инструментальной пане-

ли Сборки или из контекстного меню компонента в 

Навигаторе сборки. Задание геометрических усло-

вий или сопряжений заключается в выборе типа со-

пряжения и последующем выборе геометрических 

элементов компонентов. Помимо этого, диалог зада-

ния сопряжений содержит несколько важных опций (рис. 7.10):

Расположения (Arrangement) – позволяет применить задаваемое сопряжение в рамках 

определенного расположения сборки.

Динамическое позиционирование (Dynamic Positioning) – опция определяет, будет ли 

компонент перемещаться сразу же при применении сопряжения. Если опция деактивирована, 

то сопряжение становится отложенным, и его необходимо активировать вручную.

Ассоциативно (Associative) – данная опция определя-

ет, будут ли сопряжения сохраняться в сборке. Если опция 

включена, то все созданные сопряжения будут добавлять-

ся в соответствующий узел в Навигаторе сборки, а если 

нет, то компонент будет перемещаться, так как этого тре-

бует условие сопряжения, но оно само не будет запоми-

наться. То есть, другим словами, в этом случае механизм 

задания сопряжений используется для «умного» перемеще-

ния компонентов.

Обычно задание сопряжений сборки начинается с вы-

бора стационарного компонента, а затем последователь-

но к этому компоненту присоединяются другие составляю-

щие сборки. Несмотря на то что существует много вари-

антов создания сопряжений между двумя компонентами, 
Рисунок 7.11. Концентричность

Рисунок 7.10. Сопряжения сборки
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рекомендуется использовать те типы сопряжений и ту по-

следовательность, которые свойственны реальному физи-

ческому объекту. В диалоге создания сопряжений доступны 

следующие типы связей:

Концентричность (Concentric) – накладывает ограни-

чение концентричности на две цилиндрические или эллип-

тические ребра граней (рис. 7.11). В результате примене-

ния данного типа связей центры выбранных граней будут 

совмещены, а сами грани расположены в одной плоско-

сти. На работу этого типа связи влияет опция Считать кри-

вые окружности в пределах допуска (Accept Tolerant 

Curves) в настройках по умолчанию, расположенная в 

разделе Сборки > Позиционирование > Решатель 

(Assemblies > Positioning > Solver). Если эта опция вклю-

чена, то все грани с кривизной в пределах линейного до-

пуска считаются окружностями. Для заданий ограничения 

концентричности необходимо выбрать 

Выравнивание по касанию (Touch Align) – позицио-

нирует два компонента относительно друг друга, выравни-

вая выбранные объекты. Существуют несколько подтипов 

данного ограничения:

Касание (Touch) – выравнивает компоненты так, что 

нормали выбранных поверхностей (граней) будут направ-

лены в противоположные стороны.

Выравнивание (Aligh) – выравнивание производится 

на основе одинакового направления нормали выбранных 

поверхностей.

Предпочтительное касание (Prefer Touch) – если 

возможно применить и Касание, и Выравнивание, то бу-

дет выбираться первое.

Вывод центра/оси (Infer Center/Axis) – при выборе 

цилиндрических граней или круглых граней будут учиты-

ваться соответственно их оси и центры.

Расстояние (Distance) – позиционирует два компонен-

та на величину указанного минимального расстояния (рис. 

7.12).

Угол (Angle) – задает угол между двумя объектами, ко-

торые могут быть гранью или ребром тела (рис. 7.13). Эта 

связь имеет два подтипа, выбираемых в диалоговом окне:

3D Угол (3D Angle) – определяет угол между двумя объ-

ектами без вспомогательной оси. В этом случае необходи-

Рисунок 7.12. Расстояние

Рисунок 7.13. Угол

Рисунок 7.14. Центр
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мо выбрать только два объекта и задать угол между ними.

Угол ориентации (Orient Angle) – определяет угол между двумя объектами с использова-

нием вспомогательной оси. При использовании этого подтипа необходимо сначала указать 

ось, а затем два объекта для задания угла между ними.

Фиксация (Fix) – фиксирует компонент по всем степеням свободы.

Параллельность (Paralell) – задает условие параллельности между двумя выбранными 

объектами, которые могут быть гранями и ребрами.

Перпендикулярный (Perpendicular) – задает условие перпендикулярности между двумя 

выбранными объектами, которые могут быть гранями и ребрами.

Совмещение (Fit) – совмещает две цилиндрические грани одного радиуса. Если радиус 

какого-либо из совмещенных компонентов впоследствии изменится, то ограничение автома-

тически станет неработоспособным. Этот тип ограничения используется в основном для рас-

становки крепежа в отверстия.

Соединение (Bonds) – создает жесткое соединение между выбранными компонентами. 

Любое перемещение одного из соединенных компонентов приводит к перемещению других, 

если нет иных ограничений. Соединение может быть создано между компонентами сборки 

или между компонентами и геометрическими телами на уровне сборки.

Центр (Center) – задает условие центровки одного из двух объектов между двумя други-

ми объектами или двух объектов относительно одного (рис. 7.14). Условие сопряжения име-

ет несколько подтипов:

1 в 2 – центрирует первый выбранный объект между двумя следующими выбранными объ-

ектами;

2 в 1 – центрирует два первых выбранных объекта относительно третьего выбранного объ-

екта;

2 в 2 – центрирует два первых выбранных объекта относительно двух следующих выбран-

ных объектов.

В случае выбора первых двух подтипов с помощью опции Осевая геометрия (Axial 

Geometry) можно задавать, что будет являться определяющим при выборе цилиндрических 

граней – сами грани или их оси.

РАСПОЛОЖЕНИЯ СБОРКИ
Часто бывает необходимо показать сборку в нескольких вариантах положения компонен-

тов, её составляющих. Особенно это актуально для различного рода механизмов. Для этих 

целей в модуле работы со сборками используется механизм запомненных расположений 

компонент. Задание нового расположения компоненты делается следующими шагами:

• В Навигаторе сборки в контекстном меню на узле сборки выбрать пункт Расположения 

> Изменить (Arrangements > Edit). Также можно воспользоваться пунктом главного меню 

Сборки > Расположения (Assemblies > Arrangements).

• Изначально существует только одно расположение – текущее положение компонентов 
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сборки относительно друг друга. Для задания ещё одного варианта конфигурации сборки 

необходимо нажать кнопку Новое расположение (New Arrangement) и задать имя для 

новой конфигурации. 

• Сделав активным созданное расположение двойным щелчком левой кнопки мыши или кноп-

кой Использовать (Use), затем закрыть диалог (рис. 7.15).

• С помощью команды Перемещение расставить компоненты в новые положения. При этом в 

диалоге команды перемещения опция Расположения должна иметь значение Применить 

к расположению – это будет означать, что операции перемещения будут запомнены в те-

кущем активном расположении (рис. 7.16). 

• Сохранить сборку.

Теперь в контекстном меню сборки в разделе Расположения будут доступны оба вариан-

Рисунок 7.15. Задание нового расположения

Рисунок 7.16. Позиционирование компонентов
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та положений компонентов, и, выбирая один из них, можно получать соответствующую кон-

фигурацию. Одно из расположений помечено в диалоге меткой «По умолчанию», будет опре-

делять позиции компонентов при загрузке сборки. При необходимости можно его заменить, 

нажав кнопку Установить по умолчанию. 

Запомненные расположения можно использовать при создании чертежей – если сборка 

содержит два и более расположений, то в диалоге создания чертежных видов будет отобра-

жена опция выбора расположения, которое будет отображено на виде.

Помимо этого, с помощью расположений можно управлять не только положением компо-

нентов, но и их состоянием в сборке. Для этого необходимо выделить компонент в Навигато-

ре сборки и в контекстном меню выбрать команду Подавление. Данная команда может по-

давлять, то есть выгружать, компонент из состава сборки при применении какого-то располо-

жения или по выражению (рис. 7.17). В диалоге команды необходимо для существующих рас-

положений выбрать значение опции Состояние.

Здесь надо уточнить, что механизм расположений и возможности подавления компонентов 

сборки в привязке к расположениям не является альтернативой опциям и вариантам в систе-

ме PDM, используемой для управления составом изделия. Вышеописанные средства управля-

ют именно геометрической конфигурацией конкретной сборки, но не подходят для управле-

ния её составом.

АНАЛИЗ ЗАЗОРОВ
Анализ зазоров и пересечений сборки является одним из ключевых этапов при проекти-

ровании. Такого рода анализ проверяет наличие пересечений между компонентами, которые 

в реальном изделии могут вызвать проблемы с собираемостью. Анализ пересечений и зазо-

ров в NX может проводиться как в интерактивном, так и в фоновом режимах. Фоновый режим 

особенно полезен, когда необходимо проверять большие сборки. Его можно запускать по но-

чам, проверяя сборку всего разрабатываемого изделия на периодической основе, чтобы воз-

никающие пересечения как можно раньше обнаруживались и исправлялись. 

Рисунок 7.17. Подавление компонентов
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Интерактивный режим больше подходит для анализа сравнительно небольших сборок, ко-

торый занимает непродолжительное время. Результаты анализа делятся на четыре категории:

Условное пересечение (Soft Interference) – факт такого пересечения означает, что ми-

нимальное расстояние между компонентами   меньше или равно заданному зазору.

Касание (Touching Interference) – компоненты касаются, но не пересекают друг друга. 

Как правило, это не является критичным пересечением.

Настоящее пересечение (Hard Interference) – имеется явное столкновение компонен-

тов с пересечением геометрии. 

Пересечение содержания (Containment Interference) – пересечение, вызванное тем, 

что один компонент полностью находится внутри другого.

Для проведения анализа необходимо задать набор компонентов, для которых будет про-

веден анализ. Задание набора производится с помощью команды главного меню Анализ >  

Анализ зазоров в сборке > Набор компонентов > Набор (Analysis > Assembly Clearance 

> Clearance Set > New) или с помощью кнопки Зазоры в сборке (Assembly Clearance) ин-

струментальной панели Активный макет (Active Mockup). 

В окне задания свойств нового набора необходимо задать имя – под этим именем в детали 

будут храниться и исходные данные для анализа, и результаты (рис. 7.18). 

Далее необходимо в одном или двух списках задать проверяемые объекты. Для простых 

сборок достаточно будет одного списка в выпадающем меню. Первый список – надо выбрать 

одно из значений, определяющих область анализа. Самый простой способ задания списка – 

это выбрать значение Все видимые объекты (All visible objects), но на практике лучше ста-

раться разбивать сборку на зоны и проверять их последовательно. Ещё один ключевой пара-

метр набора – это тип анализа. Возможны три типа проведения анализа:

Рисунок 7.18. Задание набора компонентов для анализа
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Основанный на фасетах (Facet Based) – самый простой и быстрый тип анализа, но наи-

менее точный из всех. Перед началом анализа все тела компонентов аппроксимируются фа-

сетами, которые потом и используются для анализа. После окончания анализа соответству-

ющие фасетные тела удаляются. В силу того что аппроксимация делается с небольшой точно-

стью (для более быстрого анализа), этот тип служит для определения явных врезаний компо-

нентов друг в друга и не очень подходит для анализа касаний и небольших зазоров.

Использование тел где возможно (Use Solids Where Available) – для анализа исполь-

зуется геометрия твердых тел, но только в тех случаях, когда два проверяемых смежных ком-

понента имеют текущий ссылочный набор, содержащий твердые тела. Если один из них за-

гружен в фасетном представлении, то для второго создается фасет, и выполняется анализ на 

основе фасетов. Использование тел по возможности является самым оптимальным по соот-

ношению времени и точности результатов, если сборка загружена так, что все компоненты, 

подлежащие анализу, имеют текущий ссылочный набор с точной геометрией. 

Использование тел (Use solids) – самый точный вид анализа на базе точной геометрии 

твердых тел. В то же время это самый медленный способ поиска пересечений, требующий 

значительного количества оперативной памяти. Во время анализа все компоненты, загружен-

ные в фасетном представлении, по возможности подгружают точную геометрию. Если у ком-

понента нет точной геометрии, что используется фасетное представление с предупреждени-

ем.

Если общего задания области недостаточно, то необходимо переключиться на вклад-

ку Расширенные диалога задания набора для анализа. С помощью расширенных средств 

определения набора компонентов на этой вкладке можно задать игнорируемые компоненты, 

указать конкретные пары для анализа, а также обнулить результаты предыдущего анализа. 

Дополнительно можно включить режим создания геометрии пересечения (не рекоменду-

ется для больших сборок), включив соответствующую опцию на вкладке Геометрия пересе-

чения (Interference Geometry). Все объемы, получаемые пересечением твердых тел компо-

нентов, будут выделены и помещены на заданный слой. Эта опция чаще всего используется 

при применении анализа на базе фасетного представления, так как при просмотре получен-

Рисунок 7.19. Результаты анализа
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ных тел пересечения можно оценить примерно среднюю погрешность анализа и исследовать 

только те объемы, которые из неё выбиваются.

После определения набора компонентов или тел можно запустить анализ с помощью кноп-

ки Выполнить анализ (Run Analysis) на вспомогательной инструментальной панели, с по-

мощью команды главного меню Анализ > Анализ зазоров в сборке > Выполнить анализ. 

Как только расчет интерференция и зазоров будет окончен, появится окно с результатами, 

где будут представлены найденные нарушения, сгруппированные по типу (рис. 7.19). Выби-

рая строчку в списке результатов с помощью контекстного меню, можно детально исследо-

вать каждый найденный случай интерференции или нарушение минимального зазора. 

УПРОЩЕНИЕ СБОРКИ
При работе с большими сборками часто бывает необходимо минимизировать количество 

отображаемых компонентов и снизить объем потребляемой оперативной памяти. NX, исполь-

зуя частичную загрузку файлов моделей и механизм работы с легковесным представлением,  

существенно увеличивает объем данных, с которым пользователь может работать. Но иногда 

этого бывает недостаточно, и в таких случаях возникает необходимость временно упрощать 

отдельные элементы сборки. Это позволяет, с одной стороны, уменьшить детализацию и сни-

зить потребление ресурсов, а с другой – помогает не терять понимание о  габаритах сборки 

и отдельных её узлов. Для таких задач в модуле Сборки есть несколько средств. 

Первое из них – это команда Обертка сборки (Warp Assembly), вызываемая из раздела 

главного меню Сборки > Дополнительные (Assemblies > Advanced). Данная команда на осно-

ве выбранных компонентов создает твердое тело, представляющее собой набор плоских гра-

ней, ограничивающих внешний контур выбранных объектов. Тело создается в текущей рабочей 

детали, поэтому, как правило, эта команда применяется для подсборок, в которых создается от-

Рисунок 7.20. Обертка сборки
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дельный ссылочный набор, содержащий твердое тело обертки компонентов подсборок (рис. 

7.20). 

Таким образом, у пользователя появляется возможность переключения между габаритным 

телом узла и его детальным представлением из всех составляющих компонентов. При созда-

нии тела обертки в диалоге команды имеется возможность управления точностью получаемо-

го габаритного объема путем задания плоскостей, определяющих места изломов аппрокси-

мирующих граней.

Следующее средство упрощения представления компонентов сборок – это команда Внеш-

няя связь, которую можно найти в том же разделе. Данная команда создает связанное точ-

ное представление из граней, представляющих внешний контур компонентов. То есть резуль-

татом является точная геометрическая форма выбранных узлов, которая ассоциативна с ис-

ходными компонентами.  В качестве исходных данных необходимо указать твердые тела ком-

понентов и грани, которые считаются внешними. Грани можно указывать вручную или вос-

пользоваться одним из двух автоматических методов определения, задав соответствующие 

параметры. После этого в дерево построения текущей рабочей детали будет помещен набор 

связанных граней, которые могут представлять исходные компоненты в рамках вышестоящей 

сборки (рис. 7.21). 

Ещё один инструмент, используемый для создания облегченных представлений, представ-

ляет собой пошаговый мастер, вызываемый командной главного меню Сборки > Дополни-

тельные > Упрощение сборки. Данный мастер из выбранных компонентов создает одно 

легковесное тело с возможностью сохранения или удаления внутренних граней. Из всех спо-

собов упрощения сборок этот является самым точным с точки зрения точности получаемого 

представления.

Рисунок 7.21. Внешняя свзяь
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Данная глава посвящена обзору модуля NX Расширенная симуляция (NX Advanced 

Simulation) для проведения инженерного анализа в рамках работы с единой средой проек-

тирования NX. Использование численных методов при проектировании различных конструк-

ций и машин продиктовано необходимостью постоянного повышения надежности и качества 

изделий, а также возможностью использовать новые современные материалы, учитывать 

сложные условия работы современных конструкций при необходимости повышения их кон-

курентоспособности и надежности. Максимальный эффект от использования технологий чис-

ленного инженерного анализа достигается при их использовании начиная с самых ранних 

стадий проектирования. При этом снижаются стоимость изделия, вероятность возникновения 

рисков и срок выпуска изделия на рынок. Исследования механического поведения трехмер-

ных конструкций можно проводить с помощью экспериментального подхода. Этот способ по-

зволяет оценивать поведение конструкции при воздействии на нее различных внешних фак-

торов. Однако он является довольно дорогостоящим, требует больших временных затрат, 

а иногда не может быть применим. В настоящее время в процессе разработки высокотехно-

логичной конкурентоспособной продукции ведущие фирмы мира используют конечно-эле-

ментное (КЭ) моделирование, пытаясь заменить дорогостоящий натурный эксперимент более 

дешевым вычислительным экспериментом. КЭ-моделирование позволяет оценить поведение 

трехмерных конструкций под воздействием различных внешних факторов. Современный уро-

вень компьютерной техники дает возможность решать сложные задачи на мощных рабочих 

станциях в течение нескольких часов. Следует также отметить, что при проведении реальных 

экспериментов, как правило, информацию можно получать лишь в десятках или сотнях точек, 

при численном моделировании таких точек может быть несколько сотен тысяч, а при необхо-

димости их число может достигать и миллиона.

Эта глава содержит описание возможностей системы NX Расширенная симуляция, ос-

новные принципы и этапы выполнения численного инженерного анализа. Основная аудито-

рия, к которой обращена данная глава, – это конструкторы и начинающие инженеры, кото-

рые впервые открывают для себя систему численного инженерного анализа на базе метода 

конечных элементов (МКЭ). Для первого знакомства с NX Расширенная симуляция вам бу-

дет достаточно данной главы, но уже с первых шагов рекомендуем обращаться к литературе, 

посвященной МКЭ, а также к документации NX.

Большинство функций и операций, о которых пойдет речь в данной главе, доступны в NX 

Расширенная симуляция версии 5 и выше. Однако главу можно также использовать и при 

работе с NX 4, учитывая тот факт, что функционал предыдущих версий может быть менее 

обширным, а интерфейс – отличаться на уровне иконок, меню и т.д. Данная глава позволит 

получить ответы на первые практические вопросы, которые возникают при работе с приложе-

нием для численного анализа. 

Обычно инженер-конструктор для предварительной оценки прочности/работоспособно-

сти конструкции применяет инженерные подходы, которые в основном состоят из представ-

ления конструкции в виде простых узлов и элементов, для которых существуют аналитические 

оценки поиска напряженно-деформированного состояния. К таким оценкам можно отнести 

использование простейших формул для поиска напряжений в балках при их растяжении, из-
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гибе или кручении, поиска относительного удлинения, моментов инерции, сил реакции и т.д. 

Инженер-конструктор вынужден работать с большим количеством специализированной лите-

ратуры для поиска необходимых выражений и законов. С началом использования систем чис-

ленного анализа всё меняется. Инженер обретает возможность моделировать конструкции и 

машины любой сложности с любой степенью детализации. У него появляется инструмент для 

анализа реального распределения напряжений и деформаций в конструкции. Многие в дан-

ный момент подумали о том, что использование таких систем конструкторами практически не 

реализуемо из-за необходимости дополнительно повышать квалификацию для использования 

специализированного программного обеспечения. Теперь это не так. С появлением приложе-

ния NX Расширенная симуляция на базе промышленного решателя NX Nastran (и других 

решателей компании Siemens PLM Software) всё меняется. Инженер получает возможность 

работать с различными приложениями, оставаясь в единой привычной для себя среде про-

ектирования NX. Причем масштабируемость модуля NX Расширенная симуляция позволит 

решать как самые простые, так и сложнейшие задачи из различных областей механики.

КОНЕЧНО-ЭЛЕМЕНТНОЕ МОДЕЛИРОВАНИЕ
По своему характеру метод конечных элементов относится к вариационно-разностным ме-

тодам и имеет в своей основе представление исходной области со сложной формой границ 

совокупностью достаточно простых подобластей (конечных элементов). Представление ис-

следуемой области совокупностью подобластей имеет смысл дискретизации континуальной 

задачи с заменой реальной области тела с бесконечно большим числом степеней свобо-

ды приближенно-эквивалентным телом с большим, но конечным числом степеней свободы. 

Последующий вывод разрешающих уравнений для совокупности конечных элементов из ва-

риационных принципов механики определяет вариационный характер метода. Именно ука-

занными двумя факторами определяется эффективность метода при решении сложных задач 

механики.

Выделим основные шаги выполнения инженерного анализа с помощью метода конечных 

элементов (рис. 8.1): 

• создание идеализированной модели, этот этап соответствует переходу от реальной физиче-

ской модели к измененной (упрощенной) математической модели. Однако математические 

модели имеют бесконечное число степеней свободы, что влечет за собой практическую не-

реализуемость решения задачи на сложной модели;

• создание дискретной модели, что соответствует ограничению числа степеней свободы, то есть 

происходит дискретизация идеализированной модели;

• решение системы разрешающих уравнений, которые соответствуют выбранному типу анализа.

Необходимо учитывать, что каждый этап численного моделирования вносит ту или иную 

погрешность в результат расчета. Особое внимание вы должны уделять двум этапам: идеали-

зации – на этом этапе осуществляется переход к математической модели, что может внести 

существенную погрешность или даже кардинальную ошибку в результат; дискретизации – 
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на этом этапе необходимо проверять сходимость численного решения к верному, причем 

при увеличении числа степеней свободы до бесконечного ошибка дискретизации стремится 

к нулю. 

Всегда следует помнить, что КЭ анализ – это компромисс (или баланс) опыта самого инже-

нера, требуемой точности результата, мощности вычислительной техники, времени расчета, 

времени разработки КЭ расчетной модели и прочее.

ВОЗМОЖНОСТИ NX РАСШИРЕННАЯ СИМУЛЯЦИЯ
NX Расширенная симуляция – это многофункциональный модуль конечно-элементного 

моделирования с широкими возможностями визуализации результатов моделирования пове-

дения конструкций, он содержит все возможности, которые необходимы любому CAE специ-

алисту, и поддерживает широкий диапазон инженерных анализов. Данный модуль имеет все 

необходимые инструменты пре- и постпроцессинга для создания, изменения сложной геоме-

трии и расчетной модели. NX Расширенная симуляция обеспечивает полную ассоциатив-

ность расчетных моделей с CAD моделями, что позволяет специалисту быстро вносить изме-

нения в конструкцию и соответственно в расчетную модель.

Отличительной особенностью NX Расширенная симуляция является возможность, оста-

ваясь в одной и той же среде моделирования NX, использовать для решения различные 

ведущие промышленные решатели, такие как NX Nastran, MSC Nastran, ANSYS, LS-Dyna 

и ABAQUS. При этом необходимо задать только тип используемого решателя, а система, 

в свою очередь, автоматически представляет все модели, типы элементов, свойства, параме-

тры, условия сопряжения и опции решения, используя терминологию или «язык» выбранного 

решателя и типа анализа (рис. 8.3). 

NX Расширенная симуляция, являясь одной из ведущих систем численного инженерного 

анализа, предлагает набор инструментов и функций для выполнения численного анализа лю-

Рисунок 8.1. Схема выполнения инженерного анализа
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бой степени сложности – начиная от простейших оценочных расчетов до выполнения анализа 

сложнейших процессов (таких как краш-тесты, технологические задачи, задачи связанного 

тепломассопереноса и т.д.). Интуитивная структура данных и параметров расчетной модели 

в виде нехронологического дерева с возможностью доступа ко всем параметрам как из ос-

новного меню и из дерева модели, так и через графическую область экрана позволяет ов-

ладеть системой пользователю с любым уровнем предварительной подготовки в кратчайшие 

сроки.

На этапе перехода от физической модели к математической NX Расширенная симуляция, 

обладая набором специализированных инструментов, позволяет адаптировать конструктор-

скую CAD геометрию для выполнения КЭ анализа. Например, специалисты-расчетчики без 

Рисунок 8.2. Общий вид NX Расширенная симуляция
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обращения к конструктору могут упростить модель, удалив мелкие геометрические элементы, 

погасив отверстия, скругления, создав срединные поверхности, осуществив булевы операции 

и операции деления тел для улучшения качества расчетной сетки.

Одной из особенностей работы в NX Расширенная симуляция с математической рас-

четной моделью является разделение расчетной и КЭ модели, поэтому всегда активна только 

одна модель, что существенно экономит компьютерные ресурсы. Такой принцип легко позво-

ляет для одной КЭ модели выполнять несколько анализов разных типов.

При моделировании в NX Расширенная симуляция происходит автоматическая органи-

зация расчетной модели по логическим признакам, например элементы КЭ модели разделя-

ются по типам, и образуются так называемые коллекторы в дереве КЭ модели.

NX Расширенная симуляция создает КЭ модели высокого класса с экономией количе-

ства элементов и дает возможность использовать полный набор существующих типов конеч-

ных элементов (0D, 1D, 2D и 3D) при больших возможностях контроля КЭ разбиения. Для 

повышения качества КЭ модели с учетом особенностей топологии геометрии  используются 

специализированные инструменты для исправления проблемных зон геометрии. Одним из 

основных достоинств  NX Расширенная симуляция является автоматическое отслеживание 

внесенных в геометрию и КЭ модель изменений с автоматическим обновлением расчетной 

модели до актуального состояния.

NX Расширенная симуляция позволяет проводить большой круг типов численного ана-

лиза. Это и линейный/нелинейный анализ прочности, анализ динамического поведения 

конструкции, анализ состояния изделия в условиях действия нелинейных быстро протека-

ющих процессов, тепловой анализ, анализ течения жидкости и газа и т.д. При переходе 

в NX Расширенная симуляция и создании расчетной модели первое, что необходимо за-

дать, – это решатель и тип анализа (рис. 8.4), который будет выполнен для текущей модели 

Рисунок 8.3. «Язык» выбранных решателей
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(и в соответствии с которой система автоматически настроит интерфейс и «язык» команд и 

функций).

Основные типы анализа, доступные в решателе NX Nastran: линейный статический анализ 

(SOL 101), анализ собственных частот и форм свободных колебаний (SOL 103), анализ от-

клика на воздействия, зависящие от времени или частоты (SOL 103), анализ потери устой-

чивости конструкций (SOL 105), базовый нелинейный анализ (SOL 106), анализ переходных 

процессов (SOL 129), анализ теплопереноса (SOL 153), нелинейный анализ на базе неявных 

схем интегрирования (SOL 601), нелинейный динамический анализ на базе явных схем инте-

грирования (SOL 701), оптимизационный анализ (SOL 200). Кроме этого, при выборе типа 

решателя доступны дополнительные варианты: 

• NX тепловой/поток (NX Thermal/Flow) – эти решатели позволяют выполнить анализ тепло-

передачи и анализ динамики жидкости и газов (CFD). Вы можете использовать эти два реша-

теля независимо или совместно для получения результатов как теплового анализа, гидро/

газодинамического анализа, так и результатов связанного анализа тепломассопереноса.

• Тепловой анализ космических аппаратов (NX Space Systems Thermal) – это промышлен-

но ориентированный решатель для теплового анализа космических аппаратов и орбиталь-

ных/межорбитальных систем.

• Тепловой анализ электронных систем (NX Electronic Systems Cooling) –  это промышлен-

но ориентированный решатель для анализа систем охлаждения. Он включает в себя анализ 

Рисунок 8.4. Типы решателей и анализов решателя NX Nastran
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теплопереноса и вычислительную гидро/газодинамику (CFD) для комплексного исследования 

систем отвода тепла.

• LS-Dyna – возможность записать расчетную модель в виде входного файла для системы чис-

ленного анализа LS-Dyna.

СТРУКТУРА И ЭТАПЫ СОЗДАНИЯ РАСЧЕТНОЙ МОДЕЛИ
Для решения той или иной задачи с помощью NX Расширенная симуляция необходима 

геометрическая модель, которую обычно предоставляет конструктор. Для решения задач де-

формируемого твердого тела в NX Расширенная симуляция используется метод конечных 

элементов, для этого геометрическая модель предварительно разбивается на дискретные об-

ласти, так называемые конечные элементы, таким образом создается конечно-элементная 

модель. При этом для выполнения любого КЭ анализа конструкции необходимо четко пони-

мать физику рассматриваемого процесса, программный продукт использует только данные, 

введенные пользователем, и внутренние решатели. В случае некорректно поставленной поль-

зователем задачи полученное решение будет неточным, а то и неправильным. 

Процедуру выполнения инженерного расчета конструкций методом конечных элементов 

в NX Расширенная симуляция условно можно разбить на несколько этапов, (рис. 8.5), ниже 

приведем их краткое описание. При этом создаются файлы, которые содержат определенные 

типы данных расчетной модели. Для эффективной работы в NX Расширенная симуляция 

вам необходимо различать, какие данные хранятся в определенном файле и какой файл дол-

жен быть активным при создании и работе с расчетной моделью.

Рисунок 8.5. Этапы создания расчетной модели
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1. Создание идеализированной геометрической модели (Master Part/ 

Idealize Part) 
Для эффективного применения КЭ метода должна быть построена корректная максимально 

простая геометрическая модель, для этого необходимо провести идеализацию исходной геоме-

трии (Master Part – мастер-модели). Рекомендуется исключить все элементы, которые приводят к 

усложнению модели (технологические отверстия, скругления, фаски), но не оказывают влияния 

на ожидаемые результаты выполняемого расчета. Если в исходной геометрии присутствуют ви-

димые поверхностные дефекты, то следует перестроить соответствующие геометрические эле-

менты, для этого в NX Расширенная симуляция предназначены разнообразные инструменты.  

Выполнение идеализации геометрии (то есть изменение или упрощение) реализуется без 

изменения мастер-модели. Система автоматически создает идеализированную модель, кото-

рой соответствует файл «имя_fem_i.prt», когда вы создаете файл FEM или файл симуляции SIM.

2. Создание КЭ модели (FEM Part)
Большое значение имеет качество КЭ модели (сетки). Если сетка будет низкого качества 

(большие элементы, вырожденная форма элементов), то можно не получить сходимость при 

решении либо не получить верный результат. Но при этом высокая степень дискретизации мо-

дели должна быть оправдана целью. Помимо построения непосредственно КЭ модели, зада-

ются физические свойства модели, такие как свойства материалов и параметры оболочечных 

и стержневых элементов.  Для КЭ модели создается файл «имя_fem.fem».

Вся геометрия в созданном файле FEM является полигональной. Когда вы создаете КЭ 

сетку, пользуясь указанием специализированных правил для генератора сетки, любое дей-

ствие производится на полигональной геометрии, а не на идеализированной модели, при 

этом файл FEM ассоциативен с идеализированной геометрией.

NX Расширенная симуляция дает возможность проводить численное моделирование не 

только для отдельных конструкций, но и для нескольких деталей, объединенных в единую сбор-

ку. В этом случае структура расчетной модели немного отличается от расчетной. Для создания 

конечно-элементной модели сборки создаются КЭ модели каждой из деталей, затем создается 

КЭ модель сборки «Assembly FEM Part», где все КЭ модели деталей объединяются в сборку. 

Для дальнейшего использования в расчете КЭ модели сборки необходимо наложить условия 

связи между конечными элементами сборочных компонент. Стоить отметить, что позициониро-

вание КЭ моделей деталей относительно друг друга в сборке происходит автоматически в со-

ответствии с исходной CAD сборкой, в случае же отсутствия исходной сборки существуют спе-

циальные инструменты в рамках «Assembly FEM Part» для позиционирования деталей вручную.

3. Создание расчетной модели (Simulation Part)
Для разработанной КЭ модели определяются условия нагружения, граничные и начальные 

условия, условия возможного контактного взаимодействия, один или несколько типов анали-

за и опции решателя. Данный этап является самым важным, поскольку он непосредственно 

влияет на полученные результаты.

Созданный файл симуляции «имя_sim.sim» содержит все параметры и свойства поведения 

конструкции, расчетных случаев, настройки решателя, такие как тип решения, шаг решения, 
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объекты симуляции (контактные граничные условия и т.д.), нагрузки, ограничения, физиче-

ские свойства, созданные при перезаписи физических свойств. Вы можете создать несколько 

файлов симуляции SIM, ассоциированных с одним файлом FEM.

4. Численное решение задачи (Solution)
Во время процесса расчета обычно происходит так называемый мониторинг хода реше-

ния, для выявления проблем с решением на раннем этапе необходимо следить за сходимо-

стью решателя, за сходимостью контактного алгоритма, за нелинейной или нестационарной 

историей решения. 

5. Анализ полученных результатов (Results)
В случае получения корректных и удовлетворяющих критериям пользователя результатов 

они анализируются, строятся необходимые графики и распределения, составляется отчет. 

В другом случае возможен возврат к одному из предыдущих этапов для корректировки ре-

зультатов путем изменения либо опций решения, либо КЭ модели, либо геометрической гео-

метрии.  При этом система автоматически реализует ассоциативную связь между геометри-

ческой и расчетной моделями и корректно изменяет расчетную сетку, переносит нагрузки и 

т.д. Это позволяет значительно сократить время на повторное построение расчетной модели 

после проведения изменений в исходной модели.

Приведем общую структуру типичной расчетной модели в NX Расширенная симуляция 

(рис. 8.6).

Рисунок 8.6. Структура и управление расчетной моделью
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ПРЕИМУЩЕСТВА СТРУКТУРИРОВАННОЙ 

РАСЧЕТНОЙ МОДЕЛИ
Существует несколько преимуществ от управления CAE данными в структуре расчетной 

модели NX Расширенная симуляция. Расширение .sim и .fem файлов может использоваться 

PLM-системой управления данными и процессами моделирования. NX поддерживает двойной 

щелчок мышью и перетаскивание .sim и .fem файлов при работе в системе Windows.

Открытие мастер-геометрии является опциональным, что приводит к использованию мень-

шего объема оперативной памяти и позволяет системе работать быстрее. Наглядная логиче-

ская структура позволяет легче ориентироваться при работе со сложными моделями. Повтор-

ное использование файла расчетной сетки FEM может значительно повысить эффективность 

использования ресурсов дискового пространства. Однако перед структурированием расчет-

ной модели, как уже упоминалось, конструктор должен четко представлять описываемую за-

дачу, тип анализа, условия работы конструкции.

Модуль NX Расширенная симуляция является гибкой настраиваемой средой численно-

го моделирования и допускает различные последовательности операций для достижения той 

или иной цели. В зависимости от стоящей перед инженером задачи и персональных настроек 

пользователь может самостоятельно определить удобную для себя последовательность дей-

ствий для достижения конечного результата. Две основные последовательности, однако, дают 

возможность выполнить большую часть расчетных случаев.

В рекомендуемой для большинства моделей последовательности действий необходимо 

явно задать материал, физические свойства и свойства сетки в коллекторах КЭ сетки до ге-

нерации самой сетки. Коллектор КЭ сетки – это элемент дерева расчетной модели, содержа-

щий информацию о типе, свойствах и параметрах расчетной КЭ сетки. Эта явная последова-

тельность действий полезна для построения сложных моделей, которые содержат несколько 

тел, материалов и КЭ сеток. Такая последовательность действий обеспечивает прозрачность 

свойств модели и снижает риск возникновения ошибки моделирования или расчета.

Для простых конструкций с одним твердым или поверхностным телом из одного материала 

можно использовать автоматизированную последовательность действий. Эта последователь-

ность позволяет быстро создать файлы расчетной сетки и КЭ модели FEM и SIM со всеми 

необходимыми коллекторами в автоматическом режиме. Также в этом случае происходит 

наследование свойств объектов из геометрической CAD-модели или используются значения 

свойств и параметров по умолчанию.

Множественность моделей и решений
NX Расширенная симуляция позволяет создавать множественные файлы FEM для одной 

детали. Например, можно создать крупную («грубую») сетку и более мелкую сетку с высокой 

степенью детализации конструкции одновременно.

Чтобы связать новый файл FEM с существующей идеализированной деталью, в меню Но-

вый FEM (New FEM) необходимо выбрать флажок Ассоциативно с деталью (Associate to 

Master Part) и выбрать идеализированную деталь из списка открытых деталей, или нажать 

Открыть (Open Part) и открыть идеализированную деталь. Чтобы связать новый файл FEM 
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с новой идеализированной деталью, в меню Новый FEM (New FEM)  необходимо выбрать 

флажок Ассоциативно с деталью (Associate to Master Part) и выбрать мастер-деталь из 

списка открытых деталей. Для создания новой идеализированной геометрии установите фла-

жок Создать идеализированную деталь (Create Idealized Part). После нажатия клавиши 

OK программа создает новую идеализированную деталь, основанную на мастер-модели.

Модуль NX Расширенная симуляция позволяет создавать несколько решений в одном 

файле симуляции. В этом случае NX допускает повторное использование заданных гранич-

ных условий путем простого перетаскивания мышью во вновь созданный расчетный случай.

При использовании такой методики все расчетные случаи будут использовать одни и те же 

свойства материалов и физические свойства объектов. Работая с множественными файлами 

симуляции, вы можете создать набор файлов симуляции для одного файла расчетной сетки 

FEM. Это эффективный способ проведения различных видов численного анализа в рамках 

работы с одним проектом. Повторное использование файла FEM может значительно сокра-

тить использование компьютерных ресурсов. Кроме того, повторное использование FEM-

файла возможно при анализе различных условий нагружения детали.

При создании файла симуляции вы можете перезаписать физико-механические свойств 

элементов конструкции. Перезаписывание свойств в файле SIM позволит вам изменить зна-

чения выбранных материалов, физических свойств или атрибутов элементов без внесения 

соответствующих изменений в расчетную сетку (в файл FEM). Когда вы рассчитываете мо-

дель, которая содержит перезаписанные физико-механические характеристики конструкции, 

система использует значения, которые заданы на уровне файла SIM, вместо исходных значе-

ний. К примеру, это позволяет за меньшее время исследовать применение различных матери-

алов в одной FEM-модели без создания дублирующихся на дисковом пространстве файлов. 

Также можно использовать перезаписывание свойств для быстрого анализа применимости 

различных толщин элементов при работе с поверхностными моделями.

ОБЗОР ОСНОВНЫХ МЕНЮ И КОМАНД
В NX Расширенная симуляция использование всех доступных команд возможно разными 

способами:

• через главное меню;

• через основную панель инструментов Расширенная симуляция (Advanced Simulation);

• через дерево модели (нажатие правой клавиши мыши) в окне Навигатор симуляции 

(Simulation Navigator);

• через графическое окно (нажатие правой клавиши мыши);

• через ту или иную панель инструментов, команды которых разделены по смысловому значению. 

Поскольку панель инструментов Расширенная симуляция (Advanced Simulation) содер-

жит почти все команды для работы в модуле NX Расширенная симуляция, то дальнейшее 

описание меню команд проводится лишь для этой панели. В зависимости от активной ча-

сти модели: идеализированной или конечно-элементной или модели симуляции – вид панели 
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инструментов Расширенная симуляция (Advanced Simulation) меняется. При дальнейшем 

описании некоторых команд используется решатель NX Nastran.

ИДЕАЛИЗАЦИЯ ГЕОМЕТРИИ 
Идеализация геометрии является процессом удаления или подавления элементов в моде-

ли, предшествующим созданию расчетной сетки. В целом вы можете также  использовать 

команды идеализации геометрии для создания дополнительных элементов и модификации 

существующих. Система выполняет все операции идеализации на ассоциативной копии ма-

стер-модели (идеализированной геометрии).

В NX Расширенная симуляция существуют два основных способа и соответствующие на-

боры инструментов для обработки геометрии.

1. Использование синхронной технологии 
NX имеет специальные инструменты «синхронного моделирования», в том числе и в модуле 

NX Расширенная симуляция для быстрого внесения изменений в любую исходную геоме-

трическую модель конструкции независимо от ее формата. Данная технология разработа-

на на основе геометрического ядра Parasolid и набора интегрированных модулей D-Cubed. 

Синхронная технология позволяет реализовывать поэлементное создание и редактирование 

модели без истории построения. Происходит синхронизация существующих геометрических 

элементов, взаимосвязей между элементами с историей построения, характера изменений 

и параметров связей. Таким образом, данный подход позволяет использовать геометрию не 

только общепринятых CAD систем, но и нейтрального формата. Весь инструментарий син-

хронного моделирования может в равной степени применяться к моделям с историей созда-

ния или импортированным из других CAD систем и форматов. На рис. 8.7 представлена со-

ответствующая панель Синхронное моделирование (Synchronous Modeling), поскольку 

инструменты синхронного моделирования подробно описаны в другой главе данной книги, то 

опустим описание команд.

Рисунок 8.7. Команды панели Синхронное моделирование (Synchronous Modeling)

2. Идеализация геометрии
В рамках модуля NX Расширенная симуляция для быстрого упрощения и изменения рас-

четной области (геометрии) существует набор инструментов (рис. 8.8), который позволяет: 

• напрямую удалять геометрические элементы, созданные в NX CAD модели;

• удалять скругления, фаски и отверстия  вручную для любой геометрии с  заданным признаком 

(например, радиус);
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• добавлять, изменять или удалять геометрические 

объекты (например, грани, ребра) по заданным 

правилам;

• различными способами создавать и сшивать сре-

динные поверхности тел для моделирования тонко-

стенных элементов, при этом значения толщин могут 

определяться автоматически на основе исходных 

твердых тел;

• делить на части геометрическую модель конструкции различными способами с использова-

нием удобных и эффективных средств, что помогает создавать структурированные КЭ сетки.

СОЗДАНИЕ РАСЧЕТНОЙ СЕТКИ
Построение КЭ расчетной сетки является этапом, на котором производится дискретиза-

ция математической модели, то есть разбиение непрерывной геометрической структуры на 

конечные элементы. Каждый элемент является математическим представлением дискретной 

части описываемой структуры и имеет заданную функцию интерполяции.

Создание конечно-элементной сетки – один из наиболее важных и критичных этапов в 

процессе численного инженерного анализа, и точность результатов напрямую зависит от ка-

чества создаваемой сетки.

Возможности по созданию КЭ сетки в модуле NX Расширенная симуляция позволяют 

пользователю автоматически создавать:

• 0D-элементы в выбранных точках;

• 1D-стержневые элементы на ребрах, линиях;

• 2D-оболочечные элементы на гранях и поверхностях;

• 3D-твердотельные элементы в объемах.

Система хранит все части расчетной КЭ сетки и их параметры, такие как материал, тол-

щины, сечения (атрибуты элементов), в файле FEM. Для построения КЭ сетки может исполь-

зоваться геометрия, созданная в других модулях NX, а также импортированная из других 

CAD-приложений.

На рис. 8.9 представлена соответ-

ствующая панель Расширенная си-

муляция (Advanced Simulation), она 

состоит из команд для работы с мате-

риалами, коллекторами, с сетками, для 

исправления полигональной геометрии 

и прочего.

Остановимся на основных командах.

Рисунок 8.8. Команды панели 

Расширенная симуляция 

(Advanced Simulation), идеализация

Рисунок 8.9. Команды панели Расширенная 

симуляция (Advanced Simulation), КЭ модель
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1. Материалы
Назначить материалы (Assign Materials) позволяет 

назначать материалы телам из списка материалов, кото-

рые находятся либо во встроенной библиотеке NX, которая 

содержит свойства стандартных материалов (в том числе и 

температурно-зависимые), либо в созданной пользователем.

Управление материалами (Manage Materials) дает возможность редактировать суще-

ствующие материалы или создавать новые изотропные, ортотропные, анизотропные, жид-

костные, гиперупругие и т.п. материалы.

Управление библиотекой материалов (Manage Library Materials) позволяет редакти-

ровать существующую библиотеку материалов или создавать новую.

2. Физические свойства и коллекторы
Физические свойства (Physical Properties) – создание, из-

менение и удаление таблиц физических свойств, которые ис-

пользуются при создании конечных элементов.

Коллектор сеток (Mesh Collector) – создание коллектора 

сеток в зависимости от размерности элементов,  типов и определение физических свойств.

Объекты моделирования (Modeling Objects) – создание различных параметров моде-

лирования в зависимости от выполняемого типа анализа.

3. 1D соединения
1D соединение (1D Connection) – создание одномерных 

конечных элементов, таких как: стержневой элемент (CROD, 

CONROD), балочный элемент (CBAR, CBEAM), упруго-демп-

ферная связь (CBUSH), демпфер узел–узел (CDAMP), элемент 

вязкого демпфирования (CVISC), пружина узел–узел (CELAS), 

элемент зазора (CGAP), элемент связи (RBE3), абсолютно 

жесткий стержень (RBAR), абсолютно жесткая связь (RBE2), 

технический элемент (PLOTRL) и др. Создание возможно как 

через узлы/элементы, так и через геометрические объекты.

Болтовое соединение (Bolt Connection) – создание на-

бора одномерных элементов для корректного моделирования 

болтового соединения, при этом тело болта обычно моделиру-

ется стержневым элементом, а взаимодействие шляпки/гайки с конструкцией – элементами 

связи (RBE2, RBE3). 

Условия сопряжения сетки (Mesh Mating Condition) – задание условий для создания: 

непрерывной сетки на границе разделения тел, разрывной сетки на границе разделения тел 

с одинаковым местоположением узлов и разрывной сетки между телами с условиями связи на 

перемещения. 

Точечная сварка (Spot Weld) – создание одномерных элементов, которые соединяют 

один набор точек с другим набором, например для создания заклепочных соединений.
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Контактная сетка (Contact Mesh) и Контактная сетка по поверхности (Surface 

Contact) – автоматизированное создание контактных элементов зазора (CGAP) между гео-

метрическими объектами.

Соединение CFAST/CWELD (CFAST/CWELD Connection) – моделирование точечной 

сварки конечными элементами CFAST или CWELD.

4. Создание конечно-элементных сеток
3D тетраэдральная сетка (3D Tetrahedral) – созда-

ние сетки с помощью тетраэдральных CTETRA4, CTETRA10 

и пирамидальных конечных элементов от 5 до 13 узлов 

(CPYRAM).

3D сетка из поверхностной (Solid From Shell Mesh) – 

создание 3D тетраэдральной сетки в замкнутой области, 

границы которой разбиты на 2D треугольные конечные эле-

менты.

3D гексаэдральная сетка (3D Swept Mesh) – создание 

структурированной 3D гексаэдральной сетки с помощью эле-

ментов CHEXA8 и CHEXA20.

2D сетка (2D Mesh) – создание сетки с помощью 2D эле-

ментов: четырехугольные поверхностные элементы (CQUAD4, 

CQUAD8, CQUADR), треугольные поверхностные элемен-

ты (CTRIA3, CTRIA6, CTRIAR), осесимметричные элементы 

(CQUADX4, CQUADX8, CTRAX3, CTRAX6), элементы для мо-

делирования 2D-трещин (CRAC2D) и др.

2D регулярная сетка (2D Mapped Mesh) – создание полностью регулярной поверхност-

ной сетки с помощью 2D элементов.

2D зависимая сетка (2D Dependent) – создание мастер-сетки на одной грани с привяз-

кой к ней сетки другой грани, при этом если мастер-сетка меняется, то автоматически меня-

ется зависимая сетка.

Локальное пересоздание сетки 2D (2D Local Remesh) – измельчение с заданным раз-

мером элемента поверхностной сетки вокруг выбранного объекта.

Поверхностный слой (Surface Coat) – создание оболочечных элементов на основе гра-

ней 3D элементов.   

1D сетка (1D Mesh) – создание одномерных конечных элементов на основе кривых и 

ребер.

Сечение 1D элементов (1D Element Section) – создание поперечных сечений в Менед-

жере сечений для стержневых элементов. 

0D сетка (0D Mesh) – создание 0D элементов: упруго-демпферная связь узел–основание 

(CBUSH), пружина узел–основание (CELAS), демпфер узел–основание (CDAMP), элемент со-

средоточенной массы (CMASS, CONM) и др. 

Параметры сетки (Mesh Control) – локальное управление размером или количеством 

элементов на выбранных гранях или ребрах.
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5. Инструменты абстракции геометрии
Иногда CAD геометрия содержит излишнюю детализацию, 

в которой нет необходимости при моделировании. При работе 

с КЭ моделью можно подправлять полигональную геометрию, не 

переходя в идеализированную модель, для улучшения и контро-

ля КЭ сетки.  Специальные инструменты позволяют удалять вы-

рожденные грани и экстремальные поверхности (так называемое 

лечение геометрии), делить и объединять грани и ребра, сшивать 

ребра и заполнять зазоры, восстанавливать недостающие грани. 

Результат данных команд не вносит изменений в идеализирован-

ную геометрическую модель. Важнейшим фактором при работе 

с инструментами редактирования геометрии является способ-

ность препроцессора NX Расширенная симуляция автоматиче-

ски обнаруживать все внесенные изменения  и обновлять конеч-

но-элементную модель. При этом  нагрузки, граничные условия и 

другие опции моделирования сохраняются.

Автоисправление геометрии (Auto Heal Geometry) – автоматическое обнаружение и 

исправление проблемных зон полигональной геометрии.

Разделить ребро (Split Edge) и Разделить грань (Split Face) – деление ребер и граней 

на части.

Объединить ребра (Merge Edge) и Объединить грани (Merge Face) – объединение 

ребер относительно выбранной точки и граней относительно общего ребра.

Сшить ребра (Stitch Edge) – сшивка ребро–ребро, ребро–грань с удалением возможных 

зазоров. Команда эффективна при работе со срединными поверхностями.

Расшить ребра (Unstitch Edge) – обратная операция Сшить ребра (Stitch Edge), но без 

восстановления зазора.

Удалить ребро (Collapse Edge) – удаляет небольшие ребра, заменяя их точкой.

Восстановить грани (Face Repair) – восстанавливает недостающие грани или удаляет 

проблемные.

Сброс (Reset) – удаляет все выполненные команды абстракции для выбранных объектов.

Круговой отпечаток (Circular Imprint) – создание круговой области вокруг выбранного 

кругового ребра или точки.

Грань из сетки (Face from Mesh) – создание полигональной геометрии на основе вы-

бранных граней конечных элементов.

6. Другие инструменты
Ассоциативные данные сетки (Mesh Associated) – 

задание различных свойств для 0D, 1D и 2D сеток. 

Показать только (Show Only) – отображение только 

выбранной геометрии и связанных с ней объектов моде-

лирования.
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Показать смежные (Show Adjacent) – отображение смежных граней относительно вы-

бранных граней или ребер.

Проверка конечно-элементной модели (Finite Element Model Check) – проверка соз-

данной кончено-элементной модели на форму элементов и на наличие двойных узлов, про-

верка нормалей оболочечных  элементов, проверка ориентации материалов элементов и 

прочего.

Следует упомянуть, что для работы с конечно-элементной сеткой существуют дополнитель-

ные инструменты, которые позволяют непосредственно создавать новые узлы и элементы, ме-

нять существующие узлы и элементы, удалять узлы и элементы, разбивать на части элементы, 

менять физические свойства отдельных элементов, смотреть соответствующую информацию и 

многое другое. На рис. 8.10 и 8.11 представлены соответствующие панели для работы с объ-

ектами конечно-элементной модели.

Рисунок 8.10 Команды панели Операции с узлом (Node Operations)

Рисунок 8.11. Команды панели Операции с элементами (Element Operations)

ПОДГОТОВКА К РЕШЕНИЮ
Для окончательного создания расчетной модели Навигатор симуляции предоставляет 

инструменты, которые позволяют создавать, изменять и отображать граничные условия и ус-

ловия сопряжения объектов численной модели. Также для задания граничных условий и нагру-

зок вы можете воспользоваться панелью инструментов Расширенная симуляция (Advanced 

Simulation). В данной главе ограничимся командами, которые соответствуют задачам меха-

ники деформируемого твердого тела. 
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Все параметры и опции при задании граничных условий интерактивны и активируются 

в соответствии с выбранным решателем и типом решения. Создавать граничные условия мож-

но как до, так и после создания решения. Если вы создаете сначала решение, то нагруз-

ки, граничные условия и т.д. сохраняются в Навигаторе симуляции (Simulation Navigator) 

в соответствующих контейнерах: Контейнер нагрузки (Load Container), Контейнер огра-

ничений (Constraint Container) и Контейнер объектов симуляции (Simulation Object 

Container). Создаваемые объекты также сохраняются в соответствующих контейнерах ак-

тивного решения. Если вы создаете сначала нагрузки, ограничения и т.д., они сохраняются 

в контейнерах в Навигаторе симуляции. Затем их можно перетащить с помощью мышки 

в созданные расчетные случаи.

Граничные условия могут быть приложены к геометрическим объектам (ребрам, граням, 

вершинам, точкам) и объектам КЭ модели (узлам, элементам, граням и ребрам элементов). 

В частности, граничные условия, приложенные к элементам КЭ модели, незаменимы в слу-

чае работы с импортированными сетками без основной геометрии. Для задания значения 

граничного условия вы можете использовать постоянные величины, выражения NX или поля. 

Поля позволяют определить, как значение меняется в зависимости от времени, температуры, 

частоты или в пространстве.

После подготовки КЭ расчетной модели в препроцессоре NX Расширенная симуляция 

(NX Advanced Simulation) выполняется расчет задачи в решателе NX Nastran или другой си-

стеме численного анализа. При запуске расчета из препроцессора программа создает вход-

ной файл NX Nastran для выбранного типа решения и затем обрабатывает его в решателе 

(проводит численное решение системы дифференциальных уравнений). Для запуска расче-

та необходимо в Навигаторе симуляции (Simulation Navigator) нажать правой клавишей 

мыши на решении и выбрать Решение… (Solve…) или на панели Расширенная симуляция 

(Advanced Simulation) выбрать команду Решение (Solve).

На рис. 8.12 представлена соответствующая панель Расширенная симуляция (Advanced 

Simulation), она состоит из команд для работы с нагрузками, ограничениями,  объектами мо-

делирования и симуляции. 

Рисунок 8.12. Команды панели Расширенная симуляция 

(Advanced Simulation), файл симуляции

Команды Физические свойства (Physical Properties), Объекты моделирования (Mo-

deling Objects), Ассоциативные данные сетки (Mesh Associated), Показать только 
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(Show Only), Показать смежные (Show Adjacent), Проверка конечно-элементной мо-

дели (Finite Element Model Check) такие же, как и для КЭ модели. 

Остановимся на командах, которые относятся непосредственно к файлу симуляции.

1. Объекты симуляции
Область симуляции (Simulation Region) – создание регионов из граней 

или ребер с дополнительными контактными опциями для использования их 

при создании объектов симуляции.

Тип объекта симуляции (Simulation Object Type) – создание таких объ-

ектов, как контактное взаимодействие типа поверхность–поверхность, условия склеивания 

типа поверхность–поверхность и ребро–поверхность; задание условий для использования 

«смерть/рождение» элементов, задание начального распределения температур для нестаци-

онарной задачи теплопроводности.

2. Тип нагрузки
Сила (Force), Момент (Moment), Давление (Pressure), Сила 

тяжести (Gravity) – создание соответствующих условий нагруже-

ния для геометрических и конечно-элементных объектов. Обычно 

задаются тип приложения, объект, величина нагрузки, вектор на-

правления действия и метод распределения.

Давление смятия (Bearing) – задание давления на цилиндрическую 

грань или круговое ребро, причем оно меняется по гармоническому 

или параболическому закону в зависимости от угла раствора.

Крутящий момент (Torque) – моделирование крутящего момен-

та путем приложения касательных усилий на выбранную цилиндри-

ческую грань, при этом нагрузка эквивалентна заданному значению 

крутящего момента.

Гидростатическое давление (Hydrostatic Pressure) – задание 

переменного по высоте давления от жидкости при указанных гравитационной константе и 

плотности жидкости. 

Центробежное давление (Centrifugal Pressure) – задание центробежного давления, 

возникающего при вращении тела с учетом жидкости.

Центробежная нагрузка (Centrifugal) – приложение центробежной нагрузки, которая 

возникает от вращения тела, задаются угловая скорость и ускорение.

Температурная нагрузка (Temperature Load) – задание известного распределения тем-

пературы в объекте для дальнейшего учета температурных деформаций. 

Предварительная затяжка болта (Bolt Pre-Load) – задание усилия затяга болтовых со-

единений, применяется только к CBAR или CBEAM стержневым конечным элементам.

3. Тип ограничения
Ограничение, задаваемое пользователем (User Defined Constraint) – обобщенное 

задание условий на степени свободы: выбирается объект, для каждой из шести степеней сво-

боды ставится условие в соответствии с выбранной системой координат. 



198

Глава 8. Введение в NX Advanced Simulation NX

Вынуждающее перемещение (Enforced Displace ment 
Constraint) – задание значения перемещения для выбранных 
степеней свободы указанного объекта.

Заделка (Fixed Constraint), Пространственный шарнир 
(Fixed Translation Constraint), Ограничение вращения (Fixed 
Rotation Constraint) –  соответственно закрепляются все шесть 
степеней свободы, закрепляются только три трансляционные, за-
крепляются только три поворотные для выбранных объектов.

Простое опирание (Simply Supported Constraint) – задание 
условия простого опирания, определяется вектор для закрепления, 
степени свободы по остальным направлениям свободны.

Ограничение закрепления (Pinned Constraint) – для вы-
бранной цилиндрической грани закрепляются все степени сво-
боды, кроме окружных перемещений.

Цилиндрический шарнир (Cylindrical Constraint) – для вы-
бранной цилиндрической грани создается локальная цилиндри-
ческая система координат, относительно которой выбираются условия закрепления.

Ползун (Slider Constraint) – определяется вектор, вдоль которого степень свободы сво-
бодна, остальные степени свободы закреплены.

Роликовое закрепление (Roller Constraint) – выбирается вектор, относительно которо-
го трансляционная и поворотные степени свободы свободны, остальные закреплены.

Условие симметрии (Symmetric Constraint), Условие асимметрии (Anti-Symmetric 
Constraint) – постановка условий симметрии, асимметрии соответственно.

Автоматическая связь (Automatic Coupling), Определить соединение вручную (Ma-
nu al Coupling) – задание условий связи на степени свободы между узлами в автоматическом 
и ручном режимах соответственно.

4. Запуск на решение задачи и создание отчета
Решение (Solve) – запуск активного решения для разработанной расчетной модели на 

расчет в соответствии с выбранным решателем и типом анализа.
Создание отчета (Create Report) – генерация отчета, содержащего ос-

новную информацию о расчетной модели, при этом в дереве модели появля-
ется соответствующая вкладка.

ПРОСМОТР РЕЗУЛЬТАТОВ
После выполнения решения в выбранном решателе необходимо провести анализ получен-

ных результатов и дать оценку конструкции. Для перехода в режим постпроцессора NX Рас-
ширенная симуляция (NX Advanced Simulation)  необходимо на панели ресурсов выбрать 
Навигатор постпроцессора (Post Processing Navigator) или в окне Навигатор симуляции 
(Simulation Navigator) дважды нажать на закладку Результаты (Results). Используя Нави-
гатор постпроцессора (Post Processing Navigator), вы можете просматривать и управлять 
разными наборами результатов:
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• выводить анимации, динамическую плоскость сечения, динамические изоповерхности;

• осуществлять контроль над выходными данными с гибким выбором результатов для вывода 

в файл;

• одновременно просматривать результаты в разных графических окнах;

• создавать аннотации в графическом окне;

• экспортировать в файлы разных форматов (JT, PNG, JPEG, GIF, TIFF, BMP, анимированый GIF);

• строить графики и выводить данные результатов в текстовые таблицы для дальнейших манипу-

ляций с ними;

• генерировать отчет в HTML формате.

Кроме этого, можно переходить между несколькими наборами данных, включая импорти-

рованные результаты из различных систем КЭ анализа (Nastran, Abaqus, Ansys, I-deas).

Каждый открытый файл симуляции представлен узлом верхнего уровня в Навигаторе 

постпроцессора (Post Processing Navigator). Этот узел выступает в роли контейнера для 

решений. Управляя моделями, которые содержат несколько результатов, вы можете быстро 

определить, какие результаты какому решению принадлежат. С помощью нажатия правой 

клавиши мыши на узле решения вы можете загрузить и выгрузить результаты, а также соз-

дать определенный по умолчанию вид постпроцессора загруженных результатов. Для ото-

бражения любого из полученных результатов необходимо в Навигаторе постпроцессора 

(Post Processing Navigator) раскрыть узел решения и двойным щелчком мыши вывести ре-

зультаты в графическую область NX (рис. 8.13). Отображение созданных путей и графиков 

Рисунок 8.13. Общий вид Навигатора постпроцессора 

(Post Processing Navigator)
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Изменить вид (Edit Post View) – команда, отвечающая за вызов диалогового окна Вид 

постпроцессора (Post View) (рис. 8.15). Данное окно имеет все доступные в постпроцессо-

ре инструменты для отображения и визуализа-

ции результатов в графическом окне. Диалого-

вое окно имеет четыре вкладки:

• Отобразить (Display) – настройки отобра-

жения результатов для модели, такие как вид 

отображения (непрерывный, маркеры, сече-

ния, изоповерхности и т.д.), настройка дефор-

мированного состояния, выбор результатов 

для отображения.

• Легенда (Legend) – настройки отображения 

в графическом окне цветовой палитры и заго-

ловка.

• Ребра & грани (Edges & Faces) – настройки 

отображения свободных границ модели и гра-

ниц элементов.

• Аннотация (Annotation) – настройки ото-

бражения для маркеров минимального и мак-

симального значений.

Установить результат (Set Result) – коман-

да, отвечающая за вид отображения резуль-

Рисунок 8.14. Панель инструментов Постпроцессор (Post Processing)

также доступно в узле решения. Импортированные наборы результатов доступны под узлом 

Импортированные результаты (Imported Results) в Навигаторе постпроцессора (Post 

Processing Navigator).

Основные операции и команды меню Постпроцессор (Post Processing) для управления 

видом отображаемых результатов, видом модели в режиме постпроцессинга, а также для ко-

личественной оценки полученных данных представлены ниже.

Рисунок 8.15. Диалоговое окно 

Вид постпроцессора (Post View)
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тата (рис. 8.16), данную команду можно вызвать 

и через команду Изменить вид (Edit Post View) 

(вкладка Отобразить (Display), кнопка Результат…

(Result…)). Она позволяет выбрать вид результата, 

определить параметры осреднения результатов по 

узлам, систему координат, единицы измерения и т.д.

Вид сечения (Cross-Section View) – вызов диа-

логового окна для настройки вывода результатов 

для 1D стержневых элементов, а именно результатов 

в сечениях.

Идентификация (Identify) – снятие числовых зна-

чений результатов в выбранных узлах и элементах, их 

просмотр в текстовом виде или табличном, экспорти-

рование в отдельный файл.

Манипулирование результатами (Results Ma ni-

pulation) – выполнение операций с разными резуль-

татами и создание новых на основе существующих.

Удалить скрытые грани (Backface Culling) – ко-

манда для улучшения визуального вывода результа-

тов для оболочечных элементов.

Маркер вкл./выкл. (Marker On/Off) – включение и выключение маркера в графическом 

окне, указывающего на наибольшее и наименьшее значение текущего результата.

Перемещение маркера (Marker Drag) – включение режима динамического перемеще-

ния маркеров с помощью мыши.

Предыдущий режим/Итерация (Previous Mode/Iteration), Следующий режим/Ите-

рация (Next Mode/Iteration) – переключение между режимами или итерациями для ото-

бражения выбранного результата конкретной итерации.

Анимация (Animation) и кнопки управления анимацией – создание и настройка аними-

рованного состояния для текущего результата, сохранение анимированного файла.

Для построения графиков и работы с ними существуют отдельные инструменты и команды.

Более подробную информацию по работе с модулем NX Расширенная симуляция (NX 

Advanced Simulation) смотрите в справочной информации к NX.

Ниже приведем пример линейного статического анализа и анализа свободных колебаний 

пропеллера. 

ПРИМЕР. СТАТИЧЕСКИЙ РАСЧЕТ МОДЕЛИ ПРОПЕЛЛЕРА, 

АНАЛИЗ СВОБОДНЫХ КОЛЕБАНИЙ 
В данном примере рассмотрим модель пропеллера, на лопасти которого действует дав-

ление от окружающей среды, составляющее 6000 Па, также учтем центробежные усилия, 

возникающие от вращения пропеллера со скоростью 1200 об/мин. Будут выполнены ста-

Рисунок 8.16. Диалоговое окно 

Установить результат (Set Result)
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тический и модальный анализы. Для демонстрации возможностей NX CAE разработаем КЭ 

модель, состоящую из гексаэдральных и тетраэдральных 3D конечных элементов.

Проведение инженерного анализа будет состоять из нескольких этапов:

1. Открытие и создание новых файлов модели.

2. Идеализация модели.

3. Создание конечно-элементной модели.

4. Задание нагрузок и граничных условий.

5. Выполнение статического анализа.

6. Просмотр результатов статического анализа.

7. Выполнение модального анализа. 

8. Просмотр  модального анализа. 

В предложенном примере для вызова почти всех команд используются панели инструмен-

тов, команды которых разделены по смысловому значению. Для вызова указанной панели 

(если она не отображена) следует в любом месте, кроме графического окна, нажать правой 

кнопкой мыши, затем в появившемся списке доступных панелей выбрать наименование не-

обходимой панели для ее отображения. Все панели инструментов, которые необходимы для 

работы с NX Расширенная симуляция, находятся в нижней части списка панелей.

1. Открытие CAD модели и создание новых файлов модели
1.1. Запустите NX 7.5 и откройте файл Propeller_CAE.prt, перейдите в модуль NX Расши-

ренная симуляция/NX Advanced Simulation (Начало > Расширенная симуляция, Start > 

Advanced Simulation).

Сделайте все настройки диалоговых окон «по умол-

чанию», выберите через главное меню: Настройки 

> Интерфейс пользователя > Общий > Сбросить 

настройки меню (Preferences > User Interface > 

General > Reset Dialog Box Settings), нажмите OK, 

как показано на рис. 8.17.

1.2. Нажмите правую клавишу мыши на модели в 

Навигаторе симуляции (Simulation Navigator) или 

окне Вид файла симуляции (Simulation File View) 

(рис. 8.18). Выберите Новая конечно-элементная 

модель и симуляция (New FEM and Simulation) для 

создания КЭ и расчетной моделей. Появилось диало-

говое окно создания FEM файла, убедитесь, что в ка-

честве Решателя (Solver) у вас выбран NX Nastran, 

нажмите ОК. Появилось новое диалоговое окно 

создания SIM файла, убедитесь, что в окне Реше-

ние (Solution) выбран Тип решения (Solution Type) 

«SESTATIC 101 – Одно ограничение», нажмите ОК.

Таким образом, мы на основе исходной CAD мо-

дели создали идеализированную модель, FE модель и Рисунок 8.17
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Рисунок 8.18
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модель симуляции с соответствующими файлами. В окне Вид файла симуляции (Simulation 

File View) отображены названия четырех файлов модели, а поскольку на данный момент ак-

тивен файл симуляции, то именно он выделен синим цветом (рис. 8.19). Обратите внимание, 

что дерево модели файла симуляции наполнилось пустыми контейнерами, которые мы запол-

ним при создании полноценной расчетной модели.

Рисунок 8.19

2. Идеализация модели
Для упрощения геометрической модели мы проведем ее идеализацию, удалив небольшие 

отверстия. Для создания гексаэдральной сетки части конструкции выполним операции по раз-

делению тела.  

2.1. Двойным нажатием левой клавиши мыши на файл Propeller_CAE_fem1_i в окне Вид 

файла симуляции (Simulation File View) переходим к идеализированной модели, при этом 

появляется окно предупреждения о том, что если необходимо выполнять какие-либо опера-

ции с геометрией, то следует сделать ассоциативную копию геометрической модели. Нижи-

маем OK.
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Рисунок 8.20

2.3. Для разделения тела на несколько тел выполните команду Разрезать тело (Split Bo-

dy) (панель инструментов Подготовка модели (Model Preparation)), выберите тело, в ди-

алоговом окне выберите Опции инструмента (Tool option)  – Вытягивание (Extrude), 

в секции диалогового окна Инструмент (Tool) в качестве сечения (Section) выберите кри-

вую (круговое ребро), как показано на рис. 8.21. В качестве вектора, вдоль которого про-

исходит вытягивание выбранной кривой, автоматически выбрана осевая линия ребра. 

В секции диалогового окна Настройки симуляции (Simulation Settings) включите опцию Соз-

дать условия сопряжения сетки (Create Mesh Mating Conditions), это означает, что при соз-

дании КЭ сетки на границе разделения тел она будет непрерывна (общие узлы). Нажмите OK.

Для рассматриваемого тела выполните команду Перенос (Promote) (панель инструмен-

тов Расширенная симуляция (Advanced Simulation)) для создания ассоциативной копии.

2.2. Для удаления отверстий выполните команду Идеализировать модель (Idealize Geo-

metry) (панель инструментов Подготовка модели (Model Preparation)), выберите тело, 

в диалоговом окне включите опцию Отверстия (Holes). В выбранном теле подсветились все 

отверстия, диаметр которых меньше заданного (рис. 8.20). Нажмите OK.
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Рисунок 8.21

На этом этапе мы завершили идеализацию геометрии и переходим к созданию конечно-

элементной модели.

3. Создание конечно-элементной модели
На данном шаге необходимо получить конечно-элементную модель. Перед созданием КЭ 

сетки объединим некоторые грани полигональной геометрии для генерации качественной сет-

ки. Для этого воспользуемся инструментами абстракции.

3.1. Двойным нажатием левой клавиши мыши на файл Propeller_CAE_fem1 в окне Вид 

файла симуляции (Simulation File View) откройте КЭ модель.

3.2. Для объединения граней выполните команду Объединить грани (Merge Face) (па-

нель инструментов Очистка модели (Model Cleanup)), для объединения граней выбирайте 

общие ребра. В результате вы должны «удалить» по одному ребру (оранжевый цвет) каждой 

лопасти (рис. 8.22), после объединения обязательно нажмите OK. 
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Рисунок 8.22

Теперь модель готова к построению КЭ сетки, причем для внутренних тел будут использо-
ваться гексаэдральные элементы, а для остальной части конструкции – тетраэдральные ко-
нечные элементы.

3.3. Выполните команду 3D гексаэдральная сетка (3D Swept Mesh) (панель инструмен-
тов Конечно-элементная модель (Finite Element Model)), укажите (рис. 8.23): 

• Тип (Type) – Наследованное множество тел построения (Multi Body-Infer Target);

• Выбрать исходную грань (Select Source Face) – выберите по одной торцевой грани каждо-
го внутреннего тела;

• Тип/Type (Свойства элемента/Element Properties) – CHEXA(20);

• Исходный размер элемента (Source Element Size) – 3 мм.

Нажмите OK.
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3.3. Для создания сетки для остальных частей конструкции выполните команду 3D тетра-

эдральная сетка (3D Tetrahedral) (панель инструментов Конечно-элементная модель 

(Finite Element Model)), укажите (рис. 8.24): 

• Выберите тела (Select Bodies) – выберите не разбитое на элементы тело;

• Тип/Type (Свойства элемента/Element Properties) – CTETRA(10);

• Размер элемента  (Element Size) – 3 мм (в случае маломощного компьютера допускается 

задать 5 мм);

• опция Переход с элементами пирамиды (Transition with Pyramid Elements) должна быть 

включена для создания пирамидальных элементов, чтобы осуществлялся корректный переход 

от гексаэдральных к тетраэдраэдральным элементам;

• Автоматическое создание/Automatic creation (Коллектор назначения/Destination Col-

lec tor) – убедитесь, что опция выключена.

Рисунок 8.23
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Нажмите OK.

Заметим, что на границе разделения тел созданная сетка является связанной, так как во 

время разделения тела в рамках идеализированной модели мы поставили условие сопря-

жения тел. Это же условие мы могли поставить и в рамках конечно-элементной модели (па-

нель инструментов Подготовка модели (Model Preparation) – Условия сопряжения сетки 

(Mesh Mating Conditions)). 

3.4. Обратите внимание, что в окне Навигатор симуляции (Simulation Navigator) в де-

реве модели (раскройте все контейнеры), помимо указаний на используемые тела (контейнер 

Полигональная геометрия/Polygon Geometry), появился 3D коллектор Solid (1), который 

является таблицей физических свойств. В свою очередь, он имеет два набора гексаэдральных 

элементов (3d_mesh(1) и 3d_mesh(2)), набор тетраэдральных элементов (3d_mesh(3)) и на-

бор переходных пирамидальных элементов (3d_Pyramid_transition(1)).  Также модель содер-

жит коллектор соединений Коллекция MMC (MMC Collector), что соответствует условиям 

сопряжения сетки (рис. 8.25).

Рисунок 8.24
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Рисунок 8.25

Рисунок 8.26 Рисунок 8.27

Для завершения создания конечно-элементной модели зададим материал – сталь. В окне 

Навигатор симуляции  нажмите правой клавишей мыши на коллекторе Solid(1) и выберите 

Изменить (Edit). В диалоговом окне Коллектор сеток (Mesh Collector) измените имя коллек-

тора на Сталь (рис. 8.26), после чего нажмите на Изменить выбранные (Modify Selected) 

(напротив Свойства тела (Solid Property)). В новом окне изменения физических свойств 

PSOLID (рис. 8.27) нажмите на Выберите материал (Choose Material) (напротив Материал 

(Material)).
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В появившемся окне Список материалов (Material List) выберите материал Steel 

(рис. 8.28). Нажмите OK во всех диалоговых окнах.

3.5. Конечно-элементная модель готова для задания нагрузок, ограничений и запуска на 

расчет. На данном этапе стоит сохранить модель, для этого в окне Навигаторе симуляции 

(Simulation Navigator) нажмите правой клавиши мыши на Propeller_CAE_fem1 в окне Вид 

файла симуляции (Si mulation File View) и выберите Сохранить (Save). 

4. Задание нагрузок и граничных условий
На данном шаге необходимо задать граничные условия и нагрузки, в качестве опций ре-

шателя NX Nastran включить итеративный решатель и запустить на расчет.

4.1. Двойным нажатием левой клавиши мыши на файл симуляции Propeller_CAE_sim1 в ок-

не Вид файла симуляции (Simulation File View) откройте расчетную модель.

4.2. Для создания условия ограничения на степени свободы конструкции выполните ко-

манду Цилиндрический шарнир (Cylindrical Constraint) (панель инструментов Расширен-

ная симуляция (Advanced Simulation), инструменты Тип ограничения (Constraint Type)). 

В диалоговом окне укажите (рис. 8.29): 

Рисунок 8.28
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Рисунок 8.29

• Выбрать объект (Select Object) – две внутренние цилиндрические грани;

• в качестве Компонент (Components) – Осевое вращение (Axial Rotation) и Осевое по-

вышение (Axial Growth) фиксированы, а Радиальное увеличение (Radial Growth) – сво-

бодное.

Нажмите OK.

Это означает, что для всех узлов, лежащих на выбранных гранях, свободны только ради-

альные степени свободы (перемещения) в цилиндрической системе координат граней.

4.3. Приложите давление от окружающей среды на лопасти, для этого из выпадающего 

меню Тип нагрузки (Load Type) (панель инструментов Расширенная симуляция (Advanced 

Simulation)) выберите команду Давление (Pressure). В диалоговом окне укажите (рис. 8.30): 

• Выбрать объект (Select Object) – три грани лопастей, как показано на рис. 8.30;

• Давление (Pressure)  – 60 000 Па (убедитесь в правильности задания единицы измерения).
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Нажмите OK.

4.4. Приложите центробежную нагрузку, для этого из выпадающего меню Тип нагруз-

ки (Load Type) (панель инструментов Расширенная симуляция (Advanced Simulation)) 

выберите команду Центробежная нагрузка (Centrifugal). В диалоговом окне укажите 

(рис. 8.31): 

• Задать вектор (Specify Vector) – из выпадающего меню укажите вектор вдоль ZC;

• Задать точку (Specify Point) – выберите на модели центральную точку указанного кругового 

ребра; 

• Угловая скорость (Angular Velocity)  – 12 000 об/мин (убедитесь в правильности задания 

единицы измерения).

Нажмите OK.

Рисунок 8.30
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5. Выполнение статического анализа
5.1. В дереве модели окна Навигатор симуляции (Simulation Navigator) отображены 

контейнеры нагрузок и ограничений, если вы их раскроете, то увидите заданные вами объек-

ты. Также в дереве модели  вкладка Solution 1 соответствует выбранному анализу.  Для того 

чтобы установить опции и параметры решения задачи, нажмите правой клавишей мыши на 

Solution 1, выберите Изменить (Edit). Появится диалоговое окно Решение (Solution), изме-

ните имя решения на Static, на вкладке Общий (General) установите опцию Итерационный 

решатель (Element Iterative Solver) (рис. 8.32). Нажмите OK. 

5.2. Расчетная модель готова для запуска на расчет. Сохраните модель, для этого в ок не 

Навигаторе симуляции (Simulation Navigator) нажмите правой клавиши мыши на Propeller_

CAE_sim1 в окне Вид файла симуляции (Simulation File View) и выберите Сохранить (Save). 

5.3. Для запуска созданной расчетной модели на решение нажмите правой клавишей 

мыши на Static и выберите Решить… (Solve…). Нажмите OK.

Рисунок 8.31
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5.4. После завершения работы решателя NX Nastran (решение может занять до 15 мин) 

закройте все новые окна.

6. Просмотр результатов статического анализа
6.1. В дереве модели окна Навигатор симуляции (Simulation Navigator) нажмите двой-

ным щелчком левой клавиши мыши на Results, и вы автоматически  перейдете на вкладку На-

вигатор постпроцессора (Post Processing Navigator) с закруженными результатами.  Для 

просмотра результатов раскройте вкладку Static, выберите интересующую вас величину, 

например эквивалентное напряжение по Мизесу (Напряжение  – По элементам/узлам, 

Von-Mises, Stress – Element-Nodal, Von-Mises) и нажмите двойным щелчком левой клавиши 

мыши. 

6.2. Для редактирования вида отображения результатов  выберите команду Установить 

результат (Set Result)  (панель инструментов Постпроцессор (PostProcessing)). В диалого-

вом окне укажите (рис. 8.33):

• Nodal Combination – установите Average для плавного отображения усредненных по узлам 

результатов;

• Единицы (Units) – выберите МПа.

Нажмите OK.

Рисунок 8.32
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6.3. Для того чтобы скрыть границы конечных элементов,  выберите команду Изменить вид 

постпроцессора (Edit Post View)  (панель инструментов Постпроцессор (Post Processing)). 

В диалоговом окне Вид постпроцессора (Post View) выберите вкладку Ребра & грани 

(Edges & Faces) и для Первичное отображение отображения (Primary Display) – Ребра 

(Edges) укажите Нет (None) (рис. 8.34). Нажмите OK.

6.4.  Для быстрого отображения минимального и максимального значений выбранной ве-

личины в панели инструментов Постпроцессор (Post Processing) нажмите на команду Мар-

кер вкл/выкл (Marker On/Off) (рис. 8.35).

6.5. Для того чтобы вернуться к модели, в панели инструментов Управление компонов-

кой (Layout Manager) нажмите на Возврат к модели (Return to Model).

Рисунок 8.33
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7. Выполнение модального анализа 
7.1. Чтобы выполнить модальный анализ для вычисления собственных частот и форм свободных 

колебаний созданной расчетной модели, необходимо создать новое решение. Для этого в окне 

Навигатор симуляции (Simulation Navigator) нажмите правой клавишей мыши на Propeller_

CAE_sim1.sim (первая строчка в дереве модели) и выберите Новое решение (New Solution). 

В появившемся диалоговом окне (рис. 8.36) в качестве Типа решения (Solution Type) из выпада-

ющего списка укажите SEMODES 103. Измените имя решения на Modal. Нажмите OK.

Рисунок 8.35

Рисунок 8.34
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Рисунок 8.36

В появившемся диалоговом окне Шаг реше-

ния (Solution Step) убедитесь, что выбран метод 

Lanczos (метод «Блок Ланцоша» для извлечения 

собственных значений спектральной задачи). При 

желании вы имеете возможность изменить опции 

решения задачи, им соответствует набор пара-

метров Real Eigenvalue – Lanczos1 (рис. 8.37), 

который включает в себя диапазон значений 

собственных частот, количество форм и способ 

их нормировки. В данном случае оставляем все 

параметры без изменений, по умолчанию будут 

найдены первые 10 форм свободных колебаний. 

Нажмите OK. Рисунок 8.37
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7.2. В дереве модели окна Навигатор симуляции (Simulation Navigator) появилась 

вкладка Modal, которая соответствует только что созданному решению. Для задания гра-

ничных условий задачи о нахождении частот и форм колебаний раскройте Контейнер огра-

ничения (Constraint Container) в дереве модели и перетащите Cylindrical(1) удержанием 

левой клавиши мыши на вкладку Constraints созданного решения Modal (рис. 8.38).

Рисунок 8.38

7.3. Расчетная модель готова для запуска на расчет. Сохраните модель, для этого в ок-

не Навигаторе симуляции (Simulation Navigator) нажмите правой клавишей мыши на 

Propeller_CAE_sim1 в окне Вид файла симуляции (Simulation File View) и выберите Со-

хранить (Save). 

7.4. Для запуска на решение нажмите правой клавишей мыши на Modal и выберите Ре-

шить…(Solve…). Нажмите OK.

7.5. После завершения работы решателя NX Nastran (решение может занять до 20 мин) 

закройте все новые окна.

8. Просмотр результатов модального анализа 
8.1. В дереве модели окна Навигатор симуляции (Simulation Navigator) нажмите двой-

ным щелчком левой клавиши мыши на Results, и вы автоматически  перейдете на вкладку На-
вигатор постпроцессора (Post Processing Navigator) с загруженными результатами.  Для 
просмотра результатов частотного анализа раскройте вкладку Modal, выберите интересую-
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щую вас частоту, например первую (Режим 1/Mode 1), раскройте вкладку и нажмите двой-
ным щелчком левой клавиши мыши на Перемещение – По узлам (Displacement – Nodal), в 
графическом окне отобразится деформированное состояние, соответствующее первой фор-
ме свободных колебаний. Следует помнить, что выведенное на экран распределение суммар-
ных перемещений определено с точностью до множителя.

8.2. Для того чтобы скрыть границы конечных элементов,  выберите команду Изменить вид 
постпроцессора (Edit Post View)  (панель инструментов Постпроцессор (Post Processing)). 
В диалоговом окне Вид постпроцессора (Post View) выберите вкладку Ребра & грани 
(Edges & Faces) и для Первичное отображениеотображения (Primary Display) – Ребра 
(Edges)  укажите Нет (None). Нажмите OK.

8.3. Обычно для наглядного просмотра собственных форм на определенных частотах вы-
водят анимированное состояние. Для этого в  панели инструментов Постпроцессор (Post 
Processing) выберите команду Анимация (Animation). В диалоговом окне (рис. 8.39) уста-
новите следующие настройки:

Рисунок 8.39
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• Анимация (Animate) – Результат (Result);

• Стиль (Style) – Модальный (Modal);

• Число кадров (Number of Frames) – 10;

• выберите опцию Полный цикл (Full-cycle).

Нажмите OK.

8.4. Когда вы закончите обрабатывать результаты, для закрытия расчетной модели выбе-

рите через главное меню: Файл > Закрыть > Все детали (File > Close > All Parts).
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ЧЕРТЕЖИ
Чертежи являются классическим документом, описывающим разрабатываемое изделие, 

будь то детали или сборка. Современные системы САПР, помимо модулей создания трехмер-

ного представления изделия, предлагают и инструментарий по созданию чертежей на осно-

ве созданных моделей деталей и узлов. В системе NX этот инструментарий реализован в 

виде модуля Черчение (Drafting), который закрывает задачи формирования ассоциативных 

двухмерных чертежей на основе трехмерных представлений деталей и сборок. 

В версии NX7.5 было представлено дополнительное приложение NX Быстрое черчение 

(NX Power Drafting), которое запускается от-

дельным ярлыком и представляет собой базовый 

модуль NX в сочетании с модулем Черчение и 

добавочным модулем расширения функционала 

работы с чертежами (рис. 9.1). Это приложение 

решает только задачи создания чертежей, как 

на основе 3D моделей, сделанных в основной 

системе NX7.5, так и без них. Использование 

отдельного приложения для работы с чертежами 

позволяет разделить рабочие места на те, ко-

торые используются для проектирования, и те, 

которые служат для выпуска конструкторской 

документации. Это помогает снизить стоимость владения системой САПР, так как использо-

вание полного рабочего места NX только для выпуска чертежей не всегда оправдано.

Одно из преимуществ систем САПР высшего уровня заключается в возможности постро-

ения сквозной цепочки проектирования, часть из которой состоит из ассоциативно связан-

ных 3D моделей и двухмерных чертежей. Важным условием для создания сквозной цепочки 

является первичность трехмерной модели изделия перед чертежом. То есть первоисточником 

информации о геометрии и опционально о требованиях к изготовлению и размерах должна 

быть модель, а чертеж должен являться вторичным и представлять собой отчет по модели с не-

обходимой дополняющей информацией. Это подразумевает в первую очередь то, что любые, 

даже самые незначительные изменения размеров должны в первую очередь производиться 

на модели и потом обновляться на чертеже. Любое изменение представления чертежного 

вида или исправление размера, сделанного в рамках чертежа, автоматически делает модель 

неактуальной, что разрывает цепочку. Изменение чертежа без соответствующих изменений 

в модели приводит к тому, что изготовленная деталь не будет соответствовать той модели, 

которая была использована в сборках, что чревато проблемами с собираемостью, а также 

к тому, что при последующих изменениях придётся оперировать с моделью, которая не соот-

ветствует изготовленной детали. 

Чертеж модели может существовать в двух видах – в файле самой модели, содержащей 

исходную геометрию, с которой делается чертеж, или же в виде отдельного файла с ссылкой 

на исходную 3D модель (концепция мастер-модели). Несмотря на то что первый вариант ка-

жется удобней, второй способ является  более предпочтительным с точки зрения процесса 

Рисунок 9.1. NX Power Drafting



224

Глава 9. Чертежи и PMI NX

разработки. Когда 3D модели и чертеж хранятся в рамках одного файла, достаточно трудно 

обеспечить независимый выпуск этих двух объектов, а также независимое проведение изме-

нений. Ведь далеко не все изменения на чертеже, в частности изменения в технических тре-

бованиях на поле чертежа, требуют изменений в геометрии модели. Дополнительное ограни-

чение, возникающее при использовании одного файла для модели и чертежа, проявляется в 

невозможности разделить работы между несколькими участниками по созданию 3D модели и 

формированию чертежей с них. 

Для создания чертежа в файле модели достаточно просто с помощью меню Начало > Все 

приложения > Черчение (Start > All Apllications > Drafting) активировать чертежный мо-

дуль при текущей открытой 3D модели детали или сборки. В файл модели будет добавлен лист 

чертежа, и будет предложено создать базовый вид из текущей модели.

Для создания чертежа в отдельном файле необходимо создать новый файл с помощью 

команды главного меню Файл > Новый (File > New) или соответствующей кнопки инструмен-

тальной панели и в появившемся диалоге выбрать вкладку с шаблонами (форматками) чер-

тежей. Затем выбрать подходящий 

размер и, убедившись, что в поле Де-

таль для создания чертежа (Part to 

create a drawing of) выбрана имен-

но та модель, для которой должен 

быть сделан чертеж, нажать ОК (рис. 

9.2). В этом случае будет создан но-

вый файл, ссылающийся на исходную 

модель, в котором на базе выбран-

ного шаблона будет подготовлен 

первый лист, и запустится команда 

создания нового вида. При исполь-

зовании мастер-модели для создания 

чертежа создается псевдосборка, в 

которой родителем является компо-

нент чертежа, а компонентами – мо-

дели, с которых делается чертеж.

Рассмотрим обзорно  создание 

основных типов чертежных видов и их свойства.

ЧЕРТЕЖНЫЕ ВИДЫ
Создание чертежа начинается с получения одного или нескольких базовых видов, кото-

рые служат основой для создания других типов чертежных видов. Команда запуска создания 

базового вида запускается автоматически при создании нового чертежа. Это регулирует-

ся опцией Автоматически начать создание вида (Automatically Start View Creation) на 

Рисунок 9.2. Создание нового файла чертежа
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вкладке Чертеж (Drawing) раздела Черчение > Общие (Drafting > General) в настройках 

по умолчанию. Если команда не запускается автоматически или необходимо создать ещё 

один базовый вид, воспользуйтесь кнопкой Базовый вид (Base View) на инструментальной 

панели Чертеж или пунктом главного меню Вставить > Вид > Базовый (Insert > View > Base).

Базовый вид создается на основе какого-либо вида модели, который необходимо выбрать 

в диалоге создания базового вида в выпадающем списке Использовать вид модели (Model 

View to Use). В большинстве случаев этого будет достаточно, чтобы получить желаемый про-

екционный вид (рис. 9.3). Если необходимо создать вид, отличный с точки зрения ориентации 

от всех видов модели, то можно воспользоваться кнопкой Инструмент ориентации вида 

(Orient View Tool). С его помощью можно динамически позиционировать модель для созда-

ния необходимого ракурса или воспользоваться возможностью точного позиционирования, 

выбрав нормаль и вектор оси Х. 

Как уже говорилось, по умолчанию чертеж создается на базе текущей активной модели, 

но при создании базового вида в разделе диалога Деталь (Part) можно выбрать другую 

модель из числа загруженных или открыть другую. Так как базовых видов в пределах одного 

чертежа может быть несколько, это даёт возможность показывать несколько разных моделей 

(или представлений модели) на одном листе чертежа. 

Если чертеж создается для сборки, то при создании проекции по умолчанию будут учи-

тываться все компоненты сборки. Этим можно управлять с помощью раздела Настройки 

(Settings) диалога создания вида. В данном разделе предлагаются два списка для создания 

Скрытых компонентов (Hidden Components) и Нерассекаемых (Non-Sectioned). С по-

мощью соответствующих кнопок Выбрать объект (Select object) можно добавить опреде-

лённый компонент сборки в тот или иной список. Компоненты, попавшие в первый список, не 

будут отображены на создаваемом виде, а компоненты, попавшие во второй список, будут 

Рисунок 9.3. Создание базового вида
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отображены, но не будут рассекаться на всех видах сечения, созданных на основе текущего 

базового вида. Для корректной работы данных списков рекомендуется при выборе объектов 

ставить значение Компонент в фильтре выбора по типу (рис. 9.4).

В этом же разделе диалога находится кнопка Стиль вида (View Style), которая открывает 

диалог настроек изображения вида.  Завершается построение базового вида выбором мас-

штаба  в разделе Масштаб (Scale) и позиционированием его на плоскости листа. Для бо-

лее точного позиционирования можно воспользоваться опциями настройки в разделе Нача-

ло вида (View Origin).

После создания базового вида становятся активными команды создания других видов и ав-

томатически запускается команда создания проекционного вида. Это поведение также регу-

лируется опцией в настройках по умолчанию, и в случае с большими сборками это бывает не 

всегда удобно, так как предварительный просмотр проекции может занять достаточно долгое 

время. Для того чтобы деактивировать автоматическое создание проекционного вида без пе-

резагрузки системы (что необходимо в случае изменения настроек по умолчанию), откройте 

диалог настройки модуля Черчение с помощью пункта главного меню Настройки > Черче-

ние (Preferences > Drafting) и на вкладке Общий (General) выключите опцию Автозапуск 

команды «Вид проекции» (Automatically Start Projected View Command). 

Также это можно сделать при создании первого базового вида, когда создаётся новый 

чертеж. При позиционировании базового вида, нажав правую кнопку мыши, необходимо 

в открывшемся меню выключить опцию Автозапуск вида проекции (Automatically Start 

Projected View). 

Для создания проекционного вида воспользуйтесь командой Вид проекции (Projected 

View) на инструментальной панели Черчение или командой главного меню Вставить > Вид 

Рисунок 9.4. Изменение свойств компонент.
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> Проекция (Insert > View > Projected). Также команда создания этого и других типов ви-

дов доступна в контекстном меню базового вида, отображаемого по щелчку правой кнопкой 

мыши на границе вида. 

Проекционный вид создается на базе существующего базового, и если на листе несколько 

базовых видов, то необходимо указать, с какого вида следует создавать проекцию в разделе 

Родительский вид (Parent View) диалога команды. Далее нужно выбрать направление про-

ецирования – за это отвечает раздел диалога Линия расположения сечения (Hinge Line). 

Изначально стоит режим контекстного определения вектора проецирования, поэтому в зави-

симости от расположения курсора мыши по отношению к главному виду будет определяться 

вектор проецирования. Чтобы задать вручную направление проецирования, выберите в вы-

падающем списке Опция вектора (Vector Option) значение Заданный (Defined) и укажи-

те на листе вектор проецирования. Для инверсии направления проецирования активируйте 

опцию Сменить направление проекции (Reverse Projected Direction). Оставшаяся опция 

Ассоциативно (Associative) связывает направление проецирования с ближайшей парал-

лельной плоской гранью модели. Другие разделы диалога полностью идентичны диалогу ко-

манды создания базового вида (рис. 9.5).

 

Следующий тип видов, которые необходимо рассмотреть, – это виды с разрезами. В моду-

ле Черчение входят несколько вариаций этой команды, которые отличаются конфигурацией 

линии разреза и способом её задания. Рассмотрим базовую команду создания простых и 

ступенчатых разрезов. Разрез (или сечение) можно создать, выделив границу родительского 

вида и вызвав контекстное меню, в котором необходимо выбрать пункт Добавить вид сече-

ния (Add Section View). Альтернативой будет вызов команды Вид сечения (Section View) 

на инструментальной панели Черчение или выбор пункта главного меню Вставить > Вид > 

Сечение (Insert > View > Section). При использовании последних двух способов в качестве 

первого шага следует указать родительский вид, с которого надо делать вид с разрезом, по-

Рисунок 9.5. Создание проекционного вида.
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этому использование контекстных команд более оптимально. 

После указания родительского вида будет открыта панель команды создания вида, и сле-

дующим шагом необходимо указать расположение линии разреза на родительском виде, для 

этого можно пользоваться геометрическими привязками на панели выбора. Расположение 

указывается в два этапа, сначала задается точка – центр вращения линии, а затем выби-

рается ориентация линии вокруг выбранной точки. За этот этап отвечает раздел панели ко-

манды Линия расположения сечения (Hinge Line). По умолчанию выбирается контекстное 

определение ориентаций, поэтому она определяется положением курсора мыши относитель-

но точки вращения. Для точного задания ориентации необходимо нажать среднюю кнопку 

Задать ось разворота (Define Hinge Line) и, выбрав один из вариантов в появившемся 

выпадающем списке, определить ориентацию (рис. 9.7). 

При контекстном определении позиционирования, чтобы 

зафиксировать ориентацию, необходимо нажать правую 

кнопку мыши и в контекстном меню выбрать Фиксация вы-

равнивания (Lock Alignment). 

Далее следует щелчком правой кнопкой мыши располо-

жить вид с разрезом в выбранном месте (рис. 9.6). Перед 

этим можно с помощью команды Инструмент сечения 

вида (Section View Tool) в разделе Просмотр (Preview) 

отобразить плоскость разреза на модели. 

Рисунок 9.6. Вид с разрезом.

Рисунок 9.7. Ориентация линии 

разреза
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В случае создания ломаного разреза последовательность действий должна быть следую-

щей. После выбора родительского вида и задания точки вращения необходимо с помощью 

команды контекстного меню Фиксация выравнивания зафиксировать желаемую  ориен-

тацию и затем, заново вызвав контекстное меню, выбрать пункт Добавить сегмент (Add 

Segment), после чего спозиционировать новый сегмент линии на исходном виде. После 

окончания добавления и позиционирования сегментов нужно в контекстном меню выбрать 

пункт Расположить вид (Place View) и далее действовать аналогично созданию прямой 

линии разреза (рис. 9.8). Вместо пользования контекстным меню можно воспользоваться 

аналогичными командами в разделах Линия сечения и Расположить вид в той же после-

довательности.  

После создания вида с разрезом моди-

фикация линии разреза и её ориентации 

осуществляется по двойному щелчку левой 

кнопки мыши на линии сечения. В появив-

шемся диалоге необходимо выбрать жела-

емый вид модификации и в графической 

области переопределить линию разреза 

(рис. 9.9).

Команды Вид половинчатого сечения 

(Half Section View) и Вид ломаного сече-

ния (Revolved Section View) совпадают с 

базовой командой Вид сечения (Section 

View), за исключением этапа здания рас-

положения линии сечения. В первом слу-

чае после задания точки вращения необ-

ходимо задать ширину разреза, а затем 

определить ориентацию. В случае с ломаным сечением после задания точки вращения необ-

ходимо указать ориентацию каждой из двух половин линии разреза.

Ещё один часто используемый тип видов – это выносной вид, показывающий часть основ-

ного вида в более крупном масштабе. Для построения этого вида нажмите кнопку Выносной 

Рисунок 9.8. Создание ступенчатого разреза

Рисунок 9.9. Модификация линии разреза
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вид (Detail View) на панели инструментов Черчение или воспользуйтесь контекстным меню 

по щелчку правой кнопкой мыши на границе исходного вида, выбрав пункт Добавить вынос-

ной вид (Add Detail View). Далее в выпадающем списке Тип (Type) следует выбрать форму 

области, на основе которой будет создан вид. Чаще всего это окружность. Затем необходимо 

на исходном виде указать положение и размер этой области. В частности, для окружности 

нужно указать центр и радиус (рис. 9.10). Родительский вид будет назначен автоматически 

в зависимости от того, где будет нарисована область. Остальные параметры создаваемо-

го вида являются аналогичными другим типам видов, кроме опции Метка (Label) в разделе 

Обозначения вида (Label on Parent), которая определяет тип метки на обозначении вы-

носного вида.

Полученный вид можно настроить с помощью пун-

ктов контекстного меню Стиль (Style) и Изменить обо-

значения вида (Edit View Label), появляющегося при 

нажатии правой кнопки мыши на метке или выносной 

линии области. Первый пункт меню открывает диалог  

настройки выносной линии и текстовой метки, обозна-

чающих область на исходном виде, а второй отвечает за 

настройку метки выносного вида.

Выносной вид является полностью ассоциативным с 

исходным видом, причем не только в контексте измене-

ния геометрии на исходном виде, но и в случае, когда 

на исходном виде производятся изменения в рамках чертежа. То есть любые геометрические 

объекты, появившиеся в области выноски на исходном виде, будут переноситься на сам вы-

носной вид. При создании выносного вида он становится дочерним по отношению к исход-

ному виду, что отражается в Навигаторе модели. Если это необходимо, то выносной вид 

можно сделать независимым видом. Для этого надо в контекстном меню по нажатии правой 

Рисунок 9.10. Выносной вид

Рисунок 9.11. Настройка стиля вынос-

ного вида
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кнопки мыши на границе вида или на его имени в Навигаторе модели выбрать пункт Пре-

образовать в независимый местный вид (Convert to Independent Detail). 

Последний тип чертежных видов, который необходимо рассмотреть, – это вид с разры-

вом, предназначенный для уменьшения размера вида в том случае, когда он делается на 

основе длинномерного объекта. Для создания такого вида нажмите кнопку Вид с разрывом 

(Brocken View) на инструментальной панели Черчение или воспользуйтесь пунктом меню 

Вставить > Вид > Разрыв (Insert > View > Brocken). После этого будет предложено выбрать 

вид (если их несколько на листе), и будет включен режим редактирования вида. 

Для задания разрыва необходимо определить части вида, которые останутся на экране. 

Для определения новой части нажмите в диалоговом окне определения вида кнопку Доба-

вить область разрыва (Add Break Region) и, выбрав в выпадающем списке Тип кривой 

(Curve Type) вид линии разрыва, нарисуйте замкнутый контур, ограничивающий область 

вида, которая останется видимой (рис. 9.12). После того как будет построена последняя ли-

ния, замыкающая контур, необходимо указать точку привязки области и нажать кнопку При-

менить в диалоге. Область будет создана и запомнена.  

Аналогичным образом следует создать вторую область на противоположном конце вида и 

после окончания построения закрыть диалог. Вид будет урезан, и на чертеже останутся толь-

ко две области, ограниченные нарисованным контуром. В общем случае таких областей мо-

жет быть несколько. При необходимости добавить или отредактировать имеющиеся  области 

в виде с разрывом необходимо заново нажать кнопку создания данного типа вида и выбрать 

существующий вид с разрывом или, выделив вид в Навигаторе модели, в контекстном меню 

по правой кнопке мыши выбрать пункт меню Расширить (Expand).

Рисунок 9.12. Разорванный вид
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Каждый созданный вид является ассоциативно связанным с исходной геометрией модели, 

на основе которой он создавался. Это касается обоих подходов к созданию чертежей, как 

для мастер-модели, так и для случая, когда один файл несет в себе и чертеж, и модель. При 

изменении геометрии модели соответствующие виды перестают быть актуальными, о чем сиг-

нализирует значок в виде часов возле имени вида в Навигаторе модели. В этом случае необ-

ходимо провести обновление всего листа или выборочного вида, выделив объект, требующий 

обновления, в Навигаторе модели и нажав в контекстном меню пункт Обновить (Update).

 Также можно включить режим автоматического 

обновления чертежных видов при изменении исход-

ной геометрии модели. Для этого необходимо от-

крыть диалог настроек чертежа, выбрав пункт меню 

Настройки > Черчение (Preferences > Drafting), 

на вкладке Вид (View) выключить опцию Задержка 

обновления вида (Delay View Update) (рис. 9.13). 

Надо учитывать, что при работе со сложными моде-

лями и большими сборками обновление видов может 

занимать достаточно продолжительное время, и в 

этом случае режим автоматического обновления бу-

дет неудачным выбором, так как виды будут обнов-

ляться при любом изменении исходной геометрии. В 

таких случаях намного эффективнее обновлять виды 

вручную, после того как все модификации геометрии 

будут закончены.

СВОЙСТВА ВИДОВ
Во всех диалогах команд создания разных типов видов встречаются настройки стиля ото-

бражения вида. Их можно модифицировать во время создания видов, но в большинстве слу-

чаев удобней работать с ними после того, как виды уже созданы. Давайте на примере рас-

смотрим некоторые наиболее часто используемые настройки.

• Запустите NX7.5 и откройте файл сборки chopper.prt из папки ch9/Chopper.

• Создайте новый чертеж на базе шаблона формата А1. Выберите в главном меню пункт 

Файл > Новый, переключитесь на вкладку Чертеж и выберите соответствующий шаблон.

• После открытия модуля Черчение запустится команда создания главного вида, в диалоге 

команды выберите вид модели FRONT для создания вида, оставив все остальные опции ко-

манды по умолчанию, расположите вид на листе щелчком мыши.

Отредактируйте границу построенного вида. Если граница вида не отображается явно, 

а только подсвечивается при наведении на неё курсора мыши, необходимо включить ото-

бражение границ видов. Для этого в главном меню, выбрав пункт Настройки > Черчение, 

выберите вкладку Вид и включите опцию Отобразить границы (Display Borders).

Рисунок 9.13. Обновление видов
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• Выделите прямоугольную границу вида и, нажав на ней правой кнопкой мыши, откройте кон-

текстное меню вида. Выберите пункт Вид активного эскиза (Active Sketch View).  Этим мы 

переведем вид в режим редактирования, при котором все нарисованные элементы эскиза бу-

дут ассоциативно связаны с этим видом. С помощью команд на панели Инструменты эскиза 

нарисуйте незамкнутую кривую, которая будет определять новые границы вида (рис. 9.14).

• Нажмите кнопку Закончить эскиз (Finish Sketch) и, заново открыв контекстное меню вида, 

выберите пункт Граница вида (View Boundary), откройте диалог переопределения гра-

ниц. В выпадающем списке выберите значение  По линии разрыва (Break Line/Detail) и 

последовательно выберите нарисованные кривые, после чего нажмите кнопку Применить 

и закройте диалог. Граница будет переопределена в соответствии с новым контуром. Таким 

образом вы можете управлять границами видов с помощью произвольных объектов.

• Ещё раз вызовите диалог определения границ вида и, выбрав в выпадающем списке значе-

ние Автоматически прямоугольником (Automatic Rectangle), восстановите исходные 

границы.

• Вызовите контекстное меню вида и выберите пункт меню  Стиль (Style). 

Настроим отображение видимых и невидимых линий, которые управляются параметрами, 

расположенными на вкладках Видимые линии (Visible Lines) и Невидимые линии (Hidden 

Lines) соответственно.

• На вкладе Видимые линии задайте цвет, тип и толщину отображаемых линий контура мо-

дели и переключитесь на вкладку невидимых линий.

На этой вкладке опции имеют следующее значение (рис. 9.15):

Рисунок 9.14. Изменение границ вида



234

Глава 9. Чертежи и PMI NX

Невидимая линия (Hidden Line) – включает режим независимой настройки отображения 

невидимых линий. Будучи выключенной, эта опция заставит вид отображать невидимые линии 

также, как и видимые. Когда эта опция включена, то аналогично видимым линиям можно управ-

лять цветом, типом и толщиной отображаемых невидимых линий с помощью трех выпадающих 

списков, расположенных ниже. Для того чтобы невидимые линии были отображены, необхо-

димо во втором выпадающем списке, определяющем тип, изменить значение по умолчанию.

Только ссылочные ребра (Referenced Edges Only) – включение этой опции будет опре-

делять отображение тех невидимых линий, на которые ссылаются размерные линии и анно-

тации.

Ребра, скрытые ребрами (Edges Hidden by Edges) – данная опция определяет, будут ли 

отображаться ребра, изображение которых наложилось на другие ребра. 

Пересечение тел (Interfering Solids) – опция включает режим отображения линий пере-

сечения тел как невидимых.

Самоскрывающий (Self-Hidden) – определяет, будут ли отображаться невидимые линии, 

скрытые самим телом детали. Иначе невидимыми считаются линии, скрытые другим телом.

Включить кривые модели (Include Model Curves) – включает отображение простран-

ственных кривых и кривых эскиза как невидимых.

Малые элементы (Small Features) – данная опция регулирует отображение мелких эле-

ментов чертежного вида. По умолчанию эта опция выключена и отображаются все геометриче-

ские объекты вида. Если опция имеет значение Упрощение (Simplify) или Скрыть (Hide), то 

все элементы с размером меньше заданного будут соответственно упрощаться или скрываться.

• Включите отображение невидимых линий и нажмите кнопку Применить в диалоге. Затем 

переключитесь на вкладку Закраска (Shading). 

Рисунок 9.15. Настройки стиля вида
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Вкладка Закраска управляет режимом наложения цвета на изображение видов. По умол-

чанию опция Стиль закраски(Rendering Style) имеет значение Каркасная модель. При 

таком значении закраски не происходит.

• Поменяйте значение опции на Полная закраска (Fully Shaded) и нажмите Применить. 

Компоненты, отображенные на виде, будут закрашены согласно цветам исходных компонен-

тов (рис. 9.17).

• Верните обратно значение опции на Каркасная модель и переключитесь на вкладку Ли-

нии плавного перехода (Smooth Edges). Опции этой вкладки отвечают за отображе-

ние на видах линий плавного перехода граней с явными ребрами. Выключите опцию Ли-

нии плавного перехода и нажмите кнопку Применить для отображения результата (рис. 

9.16).

Похожая опция расположена на вкладке Виртуальные пересечения (Virtual 

Intersections). Она регулирует отображение виртуальных линий пересечения граней, кото-

рых нет в модели.

• Закройте окно настроек стиля и с помощью команды Вид проекции создайте проекцион-

ный вид справа от базового с настройками по умолчанию.

• Откройте диалог настроек стиля для созданного вида и перейдите на вкладку Общий 

(General). Рассмотрим опции этой вкладки:

Силуэтные линии (Silhouettes) – включает отображение силуэтных линий на виде. Если 

эта опция выключена, то проецируются только линии ребер на модели.

Автоматическое обновление (Automatic Update) – определяет, будет ли вид автомати-

чески обновляться при изменении исходной модели. Ранее была рассмотрена настройка за-

держки обновления видов при изменении модели. Эта настройка действует глобально на все 

виды чертежа. Данная же опция позволяет индивидуально управлять режимом обновления для 

каждого вида. 

Метка масштаба (Scale Label) – выводит обозначение масштаба над видом.

Рисунок 9.16. Вид модели без линий перехода Рисунок 9.17. Режим закраски
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Ссылка (Reference) – делает текущий вид ссылочным. Это означает, что над этим видом 

нельзя будет производить какие-либо операции и геометрия проекций не будет отображать-

ся. Но  при этом изображение этого вида будет выводиться при печати. Данная опция исполь-

зуется при работе с чертежами больших сборок, когда надо минимизировать потребляемые 

ресурсы при рабоче с чертежом. В таком случае эта опция позволяет отключать часть видов, 

над которыми не ведется работа в данный момент времени.

Точка привязки (Anchor Point) – создает точку привязки, используемую при перемеще-

нии и позиционировании вида.

Проверить состояние границы (Check Boundary Status) – включает отслеживание из-

менений на границах вида.

Сетка UV (UV Grid) – включает отображение изопараметрических кривых на виде, если 

они были отображены на исходных объектах.

Название вида (View Label) – включает отображение имени вида.

Угол (Angle) – задает угол наклона вида относительно горизонтали листа.

Масштаб (Scale) – определяет масштаб изображения вида.

Задание наборов отображения в виде (Define Render Sets in View) – это кнопка от-

крывает диалог задания наборов визуализации для данного вида. Используется, когда не-

обходимо назначить индивидуальные свойства отображения отдельным компонентам сбор-

ки или телам в модели.

Выражение (Expression) – позволяет связать величину масштаба вида с параметром, за-

данным в выражениях модели.

Выделение ребра (Extracted Edges) – включает альтернативный механизм отображения 

геометрии видов. По умолчанию эта опция выключена и изображается напрямую геометрия 

модели. Если эта опция имеет значение Ассоциативно, то на виде изображаются видимые 

ребра, которые ассоциативно связаны с исходной моделью. Это позволяет работать с чер-

тежными видами без загрузки исходной модели, а также сокращает время, необходимое для 

отображения чертежных видов для больших сборок.

Исходный цвет каркасного вида (Wireframe Color Source) – данная опция определя-

ет, откуда наследуется цвет спроецированных на вид линий.

Идентификатор изображения (Display Identifier) – управляет отображением иденти-

фикатора вида.

• Выключите на вкладке опцию отображения силуэтных линий и нажмите Применить. Посмо-

трите, как изменилось изображение проекционного вида. Также поэкспериментируйте с из-

менением значений других опций и отследите, как это отражается на виде. После этого на-

жмите кнопку Загрузить по умолчанию (Load Defaults), которая вернет исходные зна-

чения опций для данной вкладки, и нажмите Применить.

• С помощью команды Вид сечения создайте новый вид на основе базового вида, располо-

жив линию разреза ближе к правому краю исходного вида. И затем двойным щелчком по 

границе нового вида откройте диалоговое окно настройки стиля. Виды с разрезами также 

управляются параметрами на вкладках, которые были рассмотрены ранее, но есть некото-
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рые параметры применимые только для них. Откройте вкладку Сечение (Section). 

На ней представлены следующие параметры (рис. 9.18):
Фон (Background) – опция управляет отображением элементов модели, находящихся за 

плоскостью сечения вида.
Передний план (Foreground) – управляет отображением элементов модели, находящих-

ся перед плоскостью сечения вида.
Линии сгиба (Bend Lines) – данная опция включает отображение изломов линии разреза 

в случае сложного ступенчатого разреза.
Сечение листовых тел (Section Sheet Bodies) – включает создание сечений для поверх-

ностей, если они есть в модели. По умолчанию эта опция выключена, поэтому сечение фор-
мируется только на базе твердых тел.

Штриховка (Crosshatch) – включает отображение штриховки на рассечённых компонен-
тах сборки или телах модели.

Отображение невидимых линий (Hidden Line Hatching) – определяет, будут ли учиты-
ваться невидимые линии при отрисовке штриховки.

Штриховка сборки (Assembly Crosshatching) – опция меняет режим отрисовки штри-
ховки  так, что смежные компоненты сборки штрихуются в противоположных направлениях.

Ограничение штриховки +/– 45 градусов (Restrict Crosshatch to +/– 45 degrees) – 
данная опция фиксирует углы наклона линий штриховки.

Допуск на штриховку (Crosshatch Adjacency Tolerance) – эта опция работает при 
включенной опции Штриховки сборки и определяет допуск на расстояние между смежными 
компонентами, когда угол наклона линий штриховки меняется на обратный.

Отобразить выбранную прямую (Display Section Line) – опция управляет отображени-
ем линии сечения на исходном виде.

• Изменяя вышеописанные опции для вида сечения и нажимая кнопку Применить, просмо-

трите, как они влияют на его отображение. Затем закройте окно стиля. 

Изменение параметров на вкладках диалога Стиль влияет на отображение вида в целом, 

Рисунок 9.18. Настройки стиля вида с разрезом
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но иногда необходимо управлять отображением какого-либо компонента в пределах вида, 

при этом не влияя на другие компоненты. Для этих целей предлагается использовать функци-

онал наборов визуализаций, который дает возможность определить индивидуальные харак-

теристики отображения для тел и применять их к заданным видам.

• Вызовите диалог настроек чертежа, выбрав пункт главного меню Настройки > Черчение, 

и, переключившись на вкладку Вид, нажмите кнопку Задние наборов визуализации 

(Define Render Sets). Откроется окно задания наборов визуализации, в котором необхо-

димо задать параметры отображения для выбранных тел (рис. 9.19).

• Нажмите кнопку Выберите твердые тела (Select Solids) и, установив фильтр выбора в 

значение Твердое тело, укажите один из компонентов сборки на основном виде, после 

чего нажмите ОК в диалоге выбора. Затем в текстовом поле Текущий набор (Current 

Set) задайте имя набора визуализации и нажмите кнопку Создать.

• В нижней части диалога, исполь-

зуя кнопки Невидимые линии 

и Видимые линии, установите 

параметры отображения для этих 

типов линий. После чего нажмите 

кнопку Применить. Таким об-

разом мы сформировали име-

нованный набор визуализации, 

который состоит из выбранных 

тел и  связанных параметров 

отображения. Закройте диалог 

и двойным щелчком на границе 

Рисунок 9.19. Создание набора визуализации

Рисунок 9.20. Применение набора визуализации к виду
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главного вида (или любого другого) откройте диалог настройки стиля вида.

• На вкладке Общий нажмите кнопку Задание наборов отображения в виде (Define 

Render Sets in View). Откроется диалог задания активных наборов визуализации для вы-

бранного вида. В нижнем списке диалога отображаются все созданные наборы визуализа-

ции для текущего чертежа, а верхний список отображает те из них, которые были применены 

к текущему виду. 

• Выберите созданный набор визуализации и нажмите кнопку Добавить. При наличии несколь-

ких наборов визуализации можно управлять их наложением друг на друга, меняя порядок 

следования в верхнем списке с помощью кнопок Вверх (Move Up) и Вниз (Move Down). На-

жмите ОК и в диалоге настройки стиля вида нажмите кнопку Применить (рис. 9.20). 

Настройки отображения, заданные для выбранного компонента, применятся к текущему 

виду, и при этом остальные компоненты будут отображаться согласно общим настройкам 

вида.

РАЗМЕРЫ И АННОТАЦИИ
Для завершения оформления чертежа, помимо создания проекционных видов, разрезов 

и сечений, необходимо нанести размеры, допуски и другие аннотации в соответствии с чер-

тежным стандартом, описывающим требования к изготовлению и контролю детали. Модуль 

Черчение предлагает набор инструментов для решения этой задачи, которые позволяют об-

размеривать и аннотировать виды, полученные проекциями трехмерных моделей. В дистри-

бутиве NX поставляется шесть преднастроенных стандартов оформления чертежей, которые 

определяют характеристики отображения получаемых размеров и аннотаций. Рассмотрим 

механизм управления настройками чертежа с точки зрения соответствия стандартам.

Чертежный стандарт представляет 

собой набор настроек отображения 

различных типов чертежных объектов, 

которые регламентируются стандар-

том. Текущий стандарт, используемый 

для оформления чертежа, опреде-

ляется значением опции Стандар-

ты чертежа (Drafting Standard) на 

вкладке Стандарт (Standard) в раз-

деле Черчение > Общие (Drafting 

> General) настроек по умолчанию. 

Выбрав соответствующий стандарт, 

вы можете использовать его (после 

перезагрузки системы) или изменить 

под свои требования (рис. 9.21). 

Чертежные стандарты, поставляе-
Рисунок 9.21. Чертежный стандарт.
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мые с системой, не могут быть изменены. Поэтому любой пользовательский стандарт, соз-

данный на базе одного из существующих, должен быть пересохранен под другим именем и 

выбран текущим для использования.

Часть параметров, определяющих отображение размеров и аннотаций, также может 

определяться настройками шаблона чертежа, выбираемого в диалоге создания нового фай-

ла. Это регулируется опцией Настройки чертежа (Drawing Settings) на вкладке Чертеж 

(Drawing) в том же разделе настроек по умолчанию. Опция имеет два значения:

Использовать настройки из шаблона чертежа (Use Settings from Drawing Template) 

– настройки чертежного стандарта будут браться из файла шаблона нового чертежа.

Использовать настройки по умолчанию (Use Settings from Standard) – в этом случае 

настройки, сохраненные в шаблоне нового чертежа, будут игнорироваться, и вместо них бу-

дут применяться настройки выбранного текущего чертежного стандарта.

Здесь следует отметить, что выбор текущего чертежного стандарта начинает действовать 

только после перезагрузки системы и только для новых чертежей, в том случае, если вышео-

писанная опция регламентирует использование настроек чертежного стандарта. Но при этом 

уже созданные чертежи будут использовать настройки шаблона или предыдущего стандар-

та, которые были приоритетны на момент их создания. То есть опция задания текущего стан-

дарта и опция, определяющая источник настроек стандарта, не повлияет на ранее создан-

ные чертежи. 

Если возникает необходимость изменить настройки чертежного стандарта для существую-

щего чертежа, то следует воспользоваться командой главного меню Инструменты > Стан-

дарт чертежа (Tools > Drafting Standard) и выбрать нужный стандарт. После этого настрой-

ки оформления размеров и аннотаций будут перезаписаны для текущего чертежа и все новые 

размеры и аннотации, создаваемые в этом чертеже, будут базироваться на новых настрой-

ках. Рассмотрим процесс простановки основных типов размеров и аннотаций и управление 

их параметрами.

• Откройте чертеж DimensionsDrw.prt из папки ch9. На чертеже создано несколько видов, на 

которые необходимо нанести размеры и аннотации.

Для простановки размеров используются команды на инструментальной панели Размеры 

(Dimensions). Вы можете выбрать режим автоматического определения типа размера, нажав 

кнопку Контекстный размер (Inferred Dimension), или воспользоваться командой проста-

новки размера заданного типа. При использовании контекстного определения типа размера 

система сама будет определять, какой тип подходит больше, исходя из выбранных геометри-

ческих объектов. Не будем разбирать простановку каждого типа размера, а рассмотрим об-

щие параметры управления размерами.

• Выберите на панели инструментов команду Контекстный размер и проставьте горизон-

тальный линейный размер, как показано на рисунке, выбрав две прямые на проекции. 

Во время простановки размера активируется панель настройки параметров размера, ко-

торая состоит из опций (рис. 9.22):

Значение (Value ) – определяет форму отображения значения размера и количество зна-
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ков после запятой.

Допуск (Tolerance) – задает величины допусков и их разрядность.

Текст (Text) – открывает редактор текста для добавления текстовых надписей к значению 

размера. Эта опция не позволяет вручную изменять значение самого размера.

Настройки (Settings) – открывает окно настройки стиля отображения размеров. Настрой-

ки стиля определяют, как отображаются  элементы размерных линий, а также параметры тек-

ста, используемого для отображения значения, допуска и добавленного текста.

Запуск (Driving) – делает размер управляющим для геометрии, которую он образмери-

вает. Этот режим работает только для геометрии, нарисованной в контексте чертёжного вида 

посредством инструментов эскиза. 

Стек (Stacking) – включает режим стыковки размера с существующими размерами.

Выравнивание (Alignment) – включает режим выравнивания размерной линии.

Практически все эти опции присутствуют при простановке всех типов размеров, а отлича-

ющиеся параметры, как правило, находятся в диалоговом окне настройке стиля (рис. 9.23). 

При простановке размеров панель управления с вышеперечисленными опциями дублируется 

в контекстном меню, вызываемом правой кнопкой мыши во время позиционирования размер-

ной линии. В большинстве случаев такой 

способ задания параметров получаемого 

размера более удобен, чем панель.

• Расположите горизонтальный размер 

щелчком мыши, нажмите на инструмен-

тальной панели кнопку команды Размер 

радиуса (Radius Dimension) и нанесите 

размер на одну из дуг или окружностей, 

а затем закройте панель команды. Чтобы 

получить доступ к параметрам отображе-

ния нанесенного размера, выделите его и, 

Рисунок 9.22. Простановка размера

Рисунок 9.23. Настройки стиля размера
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нажав правую кнопку, в контекстном меню выберите пункт Стиль. Обратите внимание, что 

в открывшемся диалоге, помимо стандартных вкладок с общими для всех размеров пара-

метрами, появилась вкладка Радиус (Radius). На ней собраны параметры, которые спец-

ифичны только для данного типа размерных линий (рис. 9.24). 

Аналогичным образом наносятся и аннотации разных типов, такие как символы базы и до-

пуски формы и расположения (рис. 9.25). Так же как и в случае с размерами, параметры их 

отображения управляются диалоговым окном Стиль контекстного меню или соответствующей 

кнопкой в диалоге построения. Рассмотрим простановку этих типов аннотаций в следующем 

разделе.

Перейдите на вид сечения и нанесите размер диаметра на одну из окружностей, так чтобы 

значение было расположено в зоне штриховки. Для редактирования параметров штриховки 

двойным щелчком на линиях штриховки откройте диалог параметров. В этом диалоге вы мо-

Рисунок 9.24. Стиль размера разиуса

Рисунок 9.25. Простановка аннотаций
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жете задать тип штриховых линий и соответствующие параметры, а также определить зоны, 

свободные от штриховки в тех местах, где расположены размеры. Для этого в разделе диа-

лога Аннотация для исключения (Annotation to Exclude) нажмите кнопку Выберите ан-

нотацию (Choose Annotation) и укажите размер, расположенный в зоне штриховки, после 

чего нажмите ОК (рис. 9.26). 

В данном случае штриховка была создана автоматически при формировании вида с раз-

резом. Если вам необходимо вручную заштриховать какие-то области, то воспользуйтесь ко-

мандой Штриховка (Crosshatch) на инструментальной панели Аннотация. Но в общем слу-

чае не рекомендуется создавать искусственные зоны штриховки, которые не соответствуют 

реальному положению разрезанных тел. 

АННОТИРОВАНИЕ 3D МОДЕЛЕЙ (PMI)
Модуль Черчение предлагает инструментарий для классического способа создания кон-

структорской документации, когда на основе готовой 3D модели создаются чертежные виды, 

которые затем образмериваются и аннотируются. Альтернативой данному способу явля-

ется  нанесение размеров, допусков и  других аннотаций непосредственно на геометрию 

3D модели, реализованное в модуле NX Технические условия (Product Manufacturing 

Information) (рис. 9.27).  Этот способ находит все большее применение  в промышленности, 

так как является более наглядным и удобным, и современная редакция ЕСКД допускает ис-

пользование 3D модели как документа, описывающего изделие при наличии в ней требова-

ний для изготовления и контроля. 

При этом надо отметить, что аннотирование моделей в 3D не отрицает наличия чертежа, 

Рисунок 9.26. Редактирование параметров штриховки
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так как при необходимости выпустить класси-

ческий чертеж на основе аннотированной 3D 

модели все размеры и аннотации наследуются 

на чертежные виды. Аннотированная 3D модель 

может заменить чертеж, при готовности всех 

остальных этапов проектирования и производ-

ства работать с такими моделями, но даже при 

наличии чертежа как документа использование 

аннотированных 3D моделей даёт значительные 

преимущества с точки зрения сокращения сро-

ков подготовки к производству. Модель может 

содержать в себе всю информацию, которую 

несет чертеж и дополнительно предоставляет 

ряд средств по работе с размерами аннотаций, 

которые не доступны при работе с чертежами. 

Это позволяет отправлять модель в технологиче-

ские подразделения на согласование намного раньше, чем будет выпущен чертеж, и при этом 

отправлять не только геометрию модели, но и размеры с допусками и аннотации с требовани-

ями. Помимо этого, размеры и аннотации, созданные в модуле ТУ, могут быть использованы 

для подготовки к производству, в частности для написания программ ЧПУ и анализа размер-

ных цепочек. 

В следующих разделах на примерах будут рассмотрены основы работы в модуле ТУ по 

образмериванию и управлению трехмерными моделями.

РАЗМЕРЫ АННОТАЦИИ В 3D
Аннотирование 3D моделей производится как с помощью инструментов модуля ТУ, так и с 

помощью инструментов модуля Моделирование, который содержит ряд функций, позволяю-

щих конвертировать размеры эскизов и конструктивных элементов в размеры ТУ. Рассмотрим 

простановку размеров и нанесение некоторых типов аннотаций на 3D модель.

• Откройте модель pmi1.prt из папки ch9.

• Нанесем несколько PMI размеров на геометрию модели. В главном меню выберите пункт 

меню Начало > Технические условия (ТУ) (Start > PMI). Убедитесь в том, что инстру-

ментальная панель ТУ активна. Если её нет среди отображенных панелей, то включите ее, 

нажав правую кнопку мыши на любой другой инструментальной панели и выбрав пункт ТУ 

(PMI).

Основное отличие между нанесением размеров в пространстве модели от образмерива-

ния чертежных видов заключается в необходимости указывать плоскости расположения раз-

меров.

• На инструментальной панели ТУ нажмите кнопку создания Контекстного размера 

Рисунок 9.27. 3D модель с PMI
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(Inferred Dimension). Контекстный размер пред-

ставляет собой режим создания размера, при 

котором система  в зависимости от выбираемой 

геометрии будет подбирать наиболее подходящий 

тип размера из числа доступных. При необходи-

мости выбора конкретного типа размерной линии 

выберите его из выпадающего списка кнопки Кон-

текстный размер или воспользовавшись разде-

лом главного меню Тех. условия > Размер (PMI 

> Dimensions).  

• Включив режим привязки к центру окружности, вы-

берите два круглых ребра на модели и расположи-

те размер (рис. 9.28). 

Обратите внимание, что размер был расположен 

на плоскости, выбираемой по умолчанию, – парал-

лельно плоскости XY текущего вида. Это не всегда является оптимальным, особенно если об-

размеривание производится при активном виде модели Изометрия (Isometric) или Трех-

мерный (Trimetric). Плоскость расположения можно как задавать во время создания нового 

размера, так и редактируя существующий размер.

• Двойным щелчком на размерной линии войдите в ре-

жим редактирования и на панели выбора разверните 

выпадающий список кнопки  Плоскость аннотации 

(Annotation Plane) (рис. 9.29). 

Данный список предлагает следующие варианты пло-

скости расположения размеров и аннотаций:

Плоскости XY/XZ/YZ – будут использоваться соответ-

ствующие плоскости рабочей системы координат. Поэтому 

при необходимости нанесения размеров, лежащих в пло-

скостях, отличных от текущей рабочей системы координат, 

необходимо её переориентировать или создать дополни-

тельную.

Вид модели по плоскости аннотации (Model View 

Based Annotation Plane) – будет использоваться пло-

скость XY текущего активного вида.

Последняя заданная пользователем плоскость (Last User Defined Plane) – использу-

ется плоскость, которую определил пользователь для предыдущего проставления размера. 

Плоскость аннотация, задаваемая пользователем (User Defined Annotation Plane) 

– позволяет задать плоскость на основе выбранных направлений осей или на основе суще-

ствующих плоских объектов.

Рисунок 9.28. Простановка размера.

Рисунок 9.29. Задание плоскости 

расположения
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• В выпадающем списке выберите расположение на плоскости YZ рабочей системы коорди-

нат. Размер будет перемещен на выбранную плоскость. 

Привязка размеров к плоскостям важна не только с точки зрения читаемости, но и с  точ-

ки зрения создания чертежных видов. При проецировании на чертежные виды размеры так-

же будут переноситься, поэтому важно, чтобы они лежали на плоскостях, параллельных пло-

скости чертежного вида, иначе будет происходить искажение. Наиболее оптимально распо-

лагать размеры и аннотации, выбрав режим Вид модели по плоскости аннотации и акти-

вировав один из стандартных или пользовательских видов. 

Помимо плоскости расположения, размеры имеют ряд настроек, которые доступны в ди-

алоговом окне определения размера во время создания или редактирования. Оно содержит 

следующие параметры для настройки:

Значение (Values) – задает вид отображения значения размера и допусков, а также ко-

личество отображаемых знаков после запятой.

Текст (Text) – позволяет задать дополнительный текст до или после размера (а также над 

и под значения размера).

Ссылки (References) – задает связанные ассоциированные геометрические объекты. Это 

позволяет наглядно отображать те элементы модели, к которым относится данный размер или 

аннотация. Все связанные объекты будут автоматом подсвечиваться при выборе соответству-

ющего размера или аннотации.

Настройки (Settings) – открывает окно настройки стиля отображения размерной линии и 

значения размера. 

Направление (Direction) – задает направление измерения.

Большинство этих параметров совпадает с параметрами аналогичных типов размеров в 

модуле Черчение. Исключением является параметр Ссылки.  

Рисунок 9.30. Задание ассоциированной геометрии.



247

NX Глава 9. Чертежи и PMI

• На инструментальной панели ТУ раскройте выпадающий список типов размеров и выберите 

Размер диаметра (Diameter Dimension). Выбрав в качестве плоскости расположения 

размера плоскость XY рабочей системы координат, укажите грань одного из отверстий. За-

тем нажмите на панели создания размера кнопку ссылки, укажите грань второго отверстия 

и нажмите кнопку ОК (в виде зеленой галочки). Этим действием мы создали ассоциацию 

между размерной линией и второй гранью (рис. 9.30). 

• Завершите построение размера, поместив его возле модели, и закройте окно. Теперь при 

выборе данного размера будут подсвечиваться связанные ассоциированные грани.  Это 

даёт возможность сократить количество проставляемых размеров на одинаковые элементы – 

достаточно будет образмерить один из них, а остальные сделать ассоциативно связанными 

геометрическими элементами.

Рисунок 9.31. Привязка объектов ТУ к видам

Рисунок 9.32. Изменение привязки
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• Используя разные типы размеров, проставьте ещё несколько размерных линий на разных 

плоскостях расположения. Затем в Навигаторе модели разверните узел Виды модели 

(Model Views). 

Обратите внимание, что тот вид модели, который был текущим в момент создания раз-

меров, сейчас содержит в себе проставленные размеры. В нашем случае это Трехмерный 

(Trimetric) вид. Таким образом, размеры и аннотации привязываются к видам, то есть они яв-

ляются видозависимыми (рис. 9.31). 

• Двойным щелчком на любом другом виде сделайте его рабочим, и все нанесённые размеры 

исчезнут из графической области. Сделайте опять рабочим Трехмерный вид.

В Навигаторе модели есть также узел PMI, который содержит все проставленные разме-

ры и аннотации без привязки к видам. Вы можете управлять привязкой размеров и аннота-

ций к видам. 

• Выберите размеры диаметра и радиуса отверстий и нажмите правую кнопку мыши для ото-

бражения контекстного меню (также можно выбрать эти размеры в Навигаторе модели и 

отобразить контекстное меню там). 

• В контекстом меню выберите пункт Отобразить > в видах (Display > in Views). Откро-

ется диалоговое окно с именами видов модели, где необходимо выбрать, на каких видах 

должны отображаться выбранные размеры (рис. 9.32). 

• Выключите отображение размеров на виде Трехмерный (TRF-TRI) и включите отображение 

на виде Снизу (BOTTOM), поставив галочки у соответствующих имен видов, после чего на-

жмите ОК. Выбранные размеры будут погашены в текущем виде и перенесены в другой вид. 

• Сделайте вид СНИЗУ рабочим и убедитесь, что размеры были перенесены. Вторая команда 

Рисунок 9.33. Конвертация размеров эскиза
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контекстного меню Отобразить > Во всех 

видах (Display > in all Views) продублиру-

ет выбранные размеры во всех видах модели.

Видозависимость размеров и аннотаций по-

зволяет сделать модель более читаемой и раз-

делить проставляемые объекты на группы по ка-

кому-либо признаку. 

Помимо инструментария прямой простанов-

ки размеров на модель, можно воспользоваться 

функцией конвертации размеров эскизов и раз-

меров конструктивных элементов. В режиме ре-

дактирования эскиза нажатием правой кнопки 

меню на проставленном размере в контекстном 

меню выберите пункт Отобразить как ТУ (Display as PMI). Размеры, маркированные дан-

ным способом, будут отображены в модельном пространстве, и с ними можно будет работать 

как с размерами ТУ (рис. 9.33).

Конвертация размеров конструктивных элементов производится в два этапа. Сначала не-

обходимо выбрать исходный элемент модели, воспользовавшись фильтром по типу со зна-

чением Элемент (Feature), и затем, нажав правую кнопку мыши, выбрать пункт Показать 

размеры (Show Dimensions) (рис. 9.34). Будут отображены размеры, которые задавались 

в диалоге создания данного конструктивного элемента. И следующим этапом необходимо 

выбрать нужные размеры и в контекстном меню правой кнопки мыши выбрать пункт Отобра-

зить как ТУ.

Рассмотрим другие типы аннотирующих объектов, которые можно проставить на 3D мо-

дель:

• Выберите грань тела, указанную на рисунке, ис-

пользуя соответствующий фильтр выбора или на-

жав Shift+G для изменения приоритетности выбо-

ра в пользу граней,  и нажмите F8 для ориентации 

вида параллельно выбранной грани. 

• В Навигаторе модели выберите узел Виды 

модели (Model Views) и, нажав правую кнопку 

мыши, выберите пункт меню Добавить вид (Add 

View). Введите имя вида и нажмите Enter. Создан-

ный вид станет текущим, и создаваемые элементы 

аннотаций будут привязываться к нему (рис. 9.35).

• На инструментальной панели ТУ вызовите команду 

Символ обозначения базы (Datum Feature 

Symbol). Нажмите левую кнопку мыши на верхней 

Рисунок 9.34. Конвертация размеров элемента

Рисунок 9.35. Содание нового вида
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грани модели, показанной на рис. 9.36, и протащите курсов мыши влево и затем отпустите 

кнопку мыши.

Пока позиционирование символа базы ещё не закончено, необходимо щелчком мыши указать 

расположение буквы базы, но до этого следует задать параметры символа в диалоге. Обратите 

внимание, что, в отличие от простановки размерных линий, на панели выбора нет кнопки опреде-

ления плоскости расположения символа. Вместо неё в диалоге создания символа базы есть опция 

Плоскость (Plane) в разделе Ориентация (Orientation). Это характерно и для некоторых других 

объектов аннотирования. Так как мы создали отдельный вид, плоскость XY которого подходит для 

Рисунок 9.36. Создание символа базы

Рисунок 9.37. Создание символа допуска формы
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расположения символа, то выберите значение Вид модели (Model View). В разделе Выноска 

(Leader) выбором значения опции Тип (Type) можно определить вид создаваемого символа. Так 

же как и в случае с простановкой размера, вы можете указать ассоциированную геометрию  в 

соответствующем разделе диалога. И в разделе Идентификатор базы (Datum Identifier) можно 

изменить букву базы, предложенную по умолчанию. Буквы увеличиваются инкрементально в за-

висимости от проставленных баз на модели. При необходимости настроить типы линий и шрифтов 

воспользуйтесь кнопкой Стиль(Style) в разделе диалога Настройки (Settings).

• После задания необходимых параметров щелчком мыши разместите символ базы.

• Далее  на той же инструментальной панели вызовите команду Допуски формы и распо-

ложения (Feature Control Symbol). Простановка такого типа символа аналогична про-

становке символа базы. Нажмите кнопку мыши на грани и, не отпуская её, протащите вверх 

(рис 9.37). Обратите внимание на маркер, который загорается на выносной линии символа, 

когда эта линия становится перпендикулярной выбранной грани.

• В диалоговом окне все основные параметры, отвечающие за вид и расположение символа, 

полностью аналогичны диалогу символа базы. При необходимости измените их, а в выпада-

ющем списке Характеристика (Characteristic) выберите нужный тип допуска. 

Рисунок 9.38. Создание символа шероховатости
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• Впишите значение в соответствующее поле раздела Допуск (Tolerance), в разделе Пер-

вичная ссылочная база (Primary Datum Reference) выберите букву базы. Таким обра-

зом вы формируете вид и содержание символа допуска формы. После этого щелчком мыши 

в графической области разместите полученный символ. 

• Попробуйте создать ещё один аналогичный символ, но в этот раз не выбирайте геометрию, 

а подведите предварительное изображение символа к существующему. Перемещение курсо-

ра мыши вдоль краев существующего символа активирует режим связывания символов. Если 

сейчас щелкнуть правой кнопкой мыши, то два символа будут связаны. 

Такой режим связывания или стыковки характерен для большинства типов размеров и объ-

ектов аннотаций.  Поставим ещё один часто применяемый символ – символ шероховатости 

поверхности. 

• На инструментальной панели ТУ нажмите кнопку Шероховатость поверхности (Surface 

Finish) и, так же как и с предыдущими символами, нажав кнопку на целевой грани, прове-

дите курсор мыши в сторону до образования выносной стрелки. Далее  в диалоге команды 

определите ассоциированные геометрические объекты и в разделе Атрибуты (Attributes) 

укажите основные параметры создаваемого символа. А именно Стандарт (Standard) 

и  Удаление материала (Material Removal). После этого в поле Легенда (Legend) 

появится изображение выбранного символа. Забейте необходимые значения параметров 

шероховатости, после чего щелчком мыши разместите символ в пространстве (рис. 9.38).

Рисунок 9.39. Создание текстовой аннотации
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Таким образом с помощью инструментов нанесе-

ния размеров, шероховатостей и допусков формы 

можно аннотировать любую 3D модель, аналогично 

тому, как это делается на чертежных видах. 

Есть ряд команд построения вспомогательной гео-

метрии для тех случаев, когда необходимо привя-

зывать размер или указывать допуск, используя не-

геометрические объекты, в частности оси отверстий. 

Для таких случаев воспользуйтесь командами  Осе-

вая линия (Centermark) и 3D осевая линия (3D 

Centerline) для нанесения вспомогательных линий на 

модель. Ещё одна команда ТУ область (PMI Region) 

также служит для построения вспомогательной геоме-

трии в тех случаях, когда надо разбить одну сплош-

ную грань на несколько частей. Это бывает необходи-

мо, в частности, для указания разных зон обработки 

на одной части детали (рис. 9.40).

Ещё один тип аннотаций, который необходимо 

рассмотреть, – это аннотации для нанесения различного рода надписей и замечаний. В функ-

ционале модуля ТУ есть несколько общих и специализированных команд для создания заме-

чаний. Все специализированные замечания собраны в разделе главного меню Тех.условия 

> Специальные (PMI > Specialized) и являются вариациями аннотации типа Замечание 

(Note). 

• Нажмите кнопку команды Замечание на инструментальной панели ТУ и, нажав левую 

кнопку мыши на грани, к которой должно быть привязано замечание, проведите курсор 

мыши в сторону от геометрии модели и отпустите кнопку. Далее в разделе Ввод текста 

(Text Input) введите необходимый текст. При вводе текста вы можете использовать инстру-

менты форматирования и вставлять специальные символы,  открыв одноименные подразде-

лы диалога.  Также вы можете импортировать текст из файла, воспользовавшись командой 

Вставить текст из файла (Inset Text from File).

• Разверните раздел диалога Выноска (Leader). Этот раздел отвечает за задание параме-

тров стрелок и выносных линий. Данный тип аннотаций позволяет создать несколько вынос-

ных линий со стрелками в рамках одного замечания. Для этого выберите в списке строчку 

со значением Новый (New) в колонке Id и укажите щелчком мыши в графической области 

точку, куда надо поместить ещё одну выносную линию. Альтернативно вы можете нажать в 

графической области левую кнопку мыши и выбрать  в контекстном меню пункт Добавить 

новую выноску (Add New Leader), затем укажите точку привязки новой выноски (рис. 

9.39).

• Разместите аннотацию в пространстве и завершите построение.

Рисунок 9.40. Вспомогательные элементы 

ТУ.
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Возможность назначать ассоциированную геометрию для текстовых аннотаций позволя-

ет при написании технических требований ссылаться на целевую геометрию. Например, при 

указании в технических требованиях особых условий обработки какой-то части детали мож-

но привязывать текст данного требования к граням, формирующим эту часть детали. Тогда 

другие участники разработки, в частности специалисты технологических служб, при  работе 

с 3D моделью, выбирая текст требования, могут сразу видеть на модели, к каким геометриче-

ским объектам оно относится.

При использовании аннотации типа Замечание для написания технических требований 

рекомендуется создавать её без выносной линии и на отдельном виде. Это даёт возможность 

быстро наследовать текст аннотации на чертеже.

АННОТИРОВАНИЕ СЕЧЕНИЙ МОДЕЛЕЙ
Для полного описания геометрического представления детали часто необходимо ставить 

размеры и допуски формы на элементы, расположенные внутри внешнего контура модели. 

В случае с чертежами для этих целей используют разрезы и сечения. Модуль ТУ предлагает 

инструменты для создания аналогов чертежных разрезов и сечений в пространстве модели. В 

версии NX7.5 предлагаются две команды, которые создают вид сечения модели без измене-

ния геометрии самой модели. Рассмотрим обе команды:

• Откройте модель pmi2.prt из папки ch9. Данная модель представляет собой сборку из не-

скольких компонентов. Создадим сечение одной из моделей  в контексте сборки и проставим 

размеры на сечении.

• Нажмите кнопку команды Вид сечения (Section View) на инструментальной панели ТУ. 

Рисунок 9.41. Создание выреза в виде
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Логика работы этой команды очень по-

хожа на команду Вытягивание (Extrude) 

в модуле Моделирование с опцией логи-

ческого вычитания из существующих тел. 

В качестве исходных данных укажите ком-

понент, который должен быть рассечен, в 

разделе Объекты в сечении (Objects to 

Section). В общем случае это может быть 

не один компонент. Далее в разделе Ин-

струмент (Cutter) необходимо задать 

кривую или эскиз, которые будут форми-

ровать тело вытягивания. Это тело будет 

использоваться для фиктивного вычитания из геометрии выбранных компонентов. То есть вы-

читание производится только в контексте создаваемого вида, но сама геометрия компонен-

тов при этом сохраняется. 

• Нажмите кнопку создания эскиза и, расположив его на плоскости XY рабочей системы ко-

ординат, нарисуйте прямоугольник, выходящий за границы выбранного тела. Затем нажмите 

кнопку Завершить эскиз (Finish Sketch) (рис. 9.41). 

• Далее в разделе Ограничения (Limits) задайте размеры тела вытягивания так, чтобы оно 

начиналось от плоскости эскиза и с запасом выходило из рассекаемого компонента.

• Кнопкой Сторона матер. (Material side) вы можете управлять, какая из частей рассекае-

мого компонента будет оставлена, а какая будет обрезана.

Рисунок 9.43. Создание сечения вида

Рисунок 9.42. Привязка к линиям пересечения
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• В разделе Настройки (Settings) задайте цвет линий сечения и при необходимости включи-

те опцию Штриховка (Crosshatch), задав её параметры. 

• В поле Имя вида (View Name) поменяйте имя создаваемого вида на более подходящее, 

после этого завершите построение сечения, нажав ОК в диалоге.

Построенное тело будет «вычтено» из выбранного компонента, и результат будет помещен 

в новый вид модели с названием, заданным в диалоге, который станет рабочим. 

• Двойным щелчком на имени другого вида сделайте его рабочим и убедитесь, что сечение ак-

тивно только на одном виде.  

• На инструментальной панели ТУ вызовите команду создания контекстного размера и соз-

дайте любой размер, например угловой между линиями сечения модели, выбрав подходя-

щую плоскость расположения. 

• Для углового размера на (рис. 9.42) плоскостью расположения является плоскость XZ рабо-

чей системы координат. Несмотря на то что сечение является фиктивным,  все размеры и ан-

нотации могут оперировать линиями сечения.

• Двойным щелчком на виде Трехмерный сделайте его рабочим и запустите вторую команду 

создания сечения Облегченный вид сечения (Lightweight Section View) на инструмен-

тальной панели ТУ (рис. 9.43).

Эта команда, в отличие от первой, строит сечение на основе плоскости, а не тела вытяги-

вания. Выберите рассекаемое тело, задайте имя сечения в разделе диалога Имя и спозици-

онируйте плоскость сечения. Это можно делать как с помощью маркеров в графической об-

ласти, вращая и перемещая маркеры манипулятора, так и с помощью элементов управления 

в разделах Плоскость сечения (Section Plane) и Смещение (Offset). 

• После позиционирования плоскости задайте в оставшихся разделах диалога настройки ото-

бражения линий пересечения и штриховки и завершите построение, нажав кнопку ОК в диа-

логе.

Аналогично предыдущей команде, выбранный компонент будет рассечен, и результат бу-

дет отображен в новом виде. Попробуйте нанести размеры и аннотации, используя составля-

ющие линии пересечения. Так же как и после работы команды Вид сечения, линия пересече-

ния состоит из выбираемых кривых, которые можно использовать для привязки.

Вы всегда можете переопределить тело или плоскость сечения, а также набор компонен-

тов, подлежащих рассечению. Для этого необходимо сделать вид сечения рабочим, а потом 

нажать на нем левую кнопку мыши и выбрать пункт меню Изменить сечение (Edit Section 

View) или Изменить облегченный вид сечения (Edit Lightweight Section View).

При выборе между использованием команды Вид сечения или Облегченный вид сече-

ния предпочтение стоит отдавать второй команде. Это обусловлено тем, что первая коман-

да позволяет строить более сложные сечения, задаваемые эскизом, что существенно повы-

шает размер модели. Поэтому если желаемое сечение можно построить при помощи плоско-
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сти, рассекая один или несколько компонент, то следует использовать команду Облегчен-

ный вид сечения. 

Все виды сечения, созданные в пространстве модели при проецировании на чертеж, бу-

дут создавать виды с разрезами.  На практике такие «наследованные» сечения оказываются 

более удобными, по сравнению с теми, что создаются непосредственно в модуле Черчение.  

Они позволяют намного более гибко управлять тем, какие компоненты подлежат рассечению, 

а какие должны оставаться неизменными. Дополнительно использование команды Вид сече-

ния дает возможность наглядно задавать произвольные линии сечения, чем это возможно на 

проекционных видах. Но следует иметь в виду, что при использовании на чертежах сечений, 

наследованных из модели, вся работа по наименованию видов и расположению изображе-

ния линии сечения остается за пользователем.  

НАСЛЕДОВАНИЕ НА ЧЕРТЕЖАХ
Как уже говорилось, все объекты аннотаций, размеры и сечения могут быть перенесены 

на чертежные виды, что позволяет избежать дополнительной работы, связанной с повторным 

оформлением модели.

• Откройте файл pmi03.prt из папки ch9.

• Модель содержит несколько модельных видов с размерами и аннотациями разных типов, 

а также несколько видов сечения. Двойным щелчком на виде «Сечение 2» сделайте его ра-

бочим и просмотрите сделанное сечение модели с нанесенными размерами и аннотациями 

(рис. 9.44).

• Создайте новый чертеж. Выберите в главном меню Файл > Новый (File > New), в от-

крывшемся диалоге перейдите на вкладку Чертеж (Drawing)  и выберите шаблон чертежа 

размера А1 или А0. Задайте имя чертежа и убедитесь в том, что в разделе Деталь для 

создания чертежа (Part to create a drawing of) введено имя открытой модели, после 

чего нажмите ОК.

Рисунок 9.44. Модель с аннотированными видами и сечениями
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• Запустится приложение Черчение, и активируется команда создания базового вида. Если 

этого не произошло (это управляется опцией в Настройках по умолчанию), то нажмите 

кнопку Базовый вид (Base View) на инструментальной панели Чертеж (Drawing).

• В диалоге создания вида выберите ВИД СПЕРЕДИ в выпадающем списке Использовать 

вид модели (Model View to Use). Затем, не размещая вид на листе, нажмите правую 

кнопку мыши и в контекстном меню выберите пункт Стиль вида (View Style) (рис. 9.45).  

• В открывшемся диалоговом окне перейдите на вкладку Наследовать ТУ (Inherit PMI). 

Раздел вкладки Наследовать ТУ содержит следующие опции для переноса объектов анно-

таций и размеров из модели на чертежные виды (рис. 9.46):

Нет (None) – это значение опции по умолчанию, при котором никакого наследования не 

производится. Если выбрать это значение опции для уже созданного вида, то вид перестанет 

быть актуальным и после обновления все наследованные объекты будет убраны с вида.

Из вида модели (From Model View) – при выборе этого значения на чертежный вид будут 

перенесены объекты ТУ, привязанные к виду модели, с которого создается вид.

Выровнять по чертежу – Только вид (Alig-

ned to Drawing – View Only ) – при этом зна-

чении наследоваться будут только те объекты ТУ, 

которые принадлежат виду модели, с которого 

создается чертежный вид и плоскости располо-

жения которых параллельны листу чертежа.

Выровнять по чертежу – Вся деталь 

(Aligned to Drawing – Entire Part) – эта опция 

аналогична предыдущей, но учитываются все 

объекты ТУ в модели, а не только привязанные 

к виду модели.

Опция Наследовать ТУ на чертеж (Inherit 

Рисунок 9.45. Создание чертежного вида

Рисунок 9.46. Режимы наследования размеров
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PMI onto Drawing), которая становится активной при выборе одной из последних двух оп-

ций, наследует объекты ТУ на чертежный лист, а не в чертежный вид. 

Кнопка Типы ТУ (PMI Types) позволяет задать фильтрацию по типам объектов ТУ, опреде-

ляющую, какие типы могут быть наследованы, а какие – нет.

• Для нашего примера подходит опция Из вида модели. Включите её и закройте диалог сти-

ля вида, нажав кнопку ОК. Расположите вид на листе и щелчком левой кнопки мыши завер-

шите команду. Будут спроецированы вид модели и все объекты ТУ, связанные с ним.

• Отмените создание проекционного вида и заново нажмите кнопку создания Базового 

вида.

• В диалоге выберите модельный вид  «Сечение 2» и аналогично процессу создания первого 

вида зайдите в стиль вида и включите 

наследование объектов ТУ с модель-

ного вида. Затем расположите вид и 

завершите команду. 

Будет спроецирована геометрия моде-

ли, и будет создан разрез на том месте, 

где было создано сечение модели. Однако 

на вид было спроецировано полное пред-

ставление модели, хотя необходимо ото-

бразить только ту часть, на которой изо-

бражен разрез (рис. 9.47).

• Для создания завершенного вида с 

разрезом нажмите правую кнопку 

мыши на границе вида и выберите 

пункт контекстного меню Граница Рисунок 9.48. Задание новых границ вида

Рисунок 9.47. Изменение границ вида
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вида (View Boundary), в открывшемся диалоге выберите имя вида, границу которого не-

обходимо изменить, а в выпадающем списке выберите режим задания границы  Вручную 

прямоугольником(Manual Rectangle). После этого на листе чертежа прямоугольником 

выделите область, на которой изображен разрез, после чего закройте диалог (рис. 9.48).  

• Двойным щелчком на главной осевой линии войдите в режим редактирования и, раскрыв в 

диалоге раздел Настройки (Settings), включите опцию Набор отдельных расширений 

(Set Extension Individually) и измените длину оси, используя появившийся маркер.

ПОИСК ПО ТУ
Поиск по объектам ТУ, помимо своей прямой функции, служит для группировки и упорядо-

чивания множества размеров и аннотаций, нанесенных на модель. Большое количество объ-

ектов ТУ, нанесенных на сложную модель, будет сложно читать, если они не будут упорядоче-

ны и сгруппированы.  Одно из средств для упорядочивания, которое было рассмотрено выше, 

– это видозависимость объектов ТУ, которая позволяет разбить множество аннотирующих 

объектов на группы по какому-либо признаку. Инструмент поиска по объектам ТУ позволяет 

формировать группы по заданному критерию. 

• Откройте заново файл pmi04.prt из предыдущего примера и на инструментальной панели ТУ 

запустите команду ТУ Поиск (PMI Search).

• В открывшемся диалоге выберите тип объекта ТУ для поиска, выбрав значение Размеры 

(Dimension) в выпадающем списке ТУ Тип (PMI Type), и для детализации поиска нажми-

те кнопку Детали размера (Dimension Details). В диалоге Подробности размера 

(Dimension Details) задайте граничные условия, для поиска выбрав критерии, которым 

должны удовлетворять ТУ выбранного типа (рис. 9.49). В нашем примере поиск будет вестись 

Рисунок 9.49. Поиск по параметрам объекта ТУ
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по всем линейным размерам, нижний допуск 

которого меньше величины –0.2.  

• Закройте окно задания критериев и в диа-

логе поиска ТУ нажмите кнопку Выполнить 

поиск (Execute Search). В список Соответ-

ствие ТУ (Matching PMI) будут выведены 

результаты поиска. 

• В разделе Настройки (Settings) введите 

имя вида, нажмите кнопку Сохранить как 

вид модели (Save as Model View). В ре-

зультате будет создан вид, на который будут 

вынесены все найденные объекты ТУ.

Таким образом с помощью инструмента поис-

ка можно отсортировать  объекты ТУ и разнести 

их по типам, избежав ручной выборки.

Еще один инструмент поиска объектов ТУ ос-

новывается на ассоциированных связях размеров и аннотаций. Во время простановки  объ-

ектов ТУ, как это было показано в первом примере, имеется возможность задавать ассоци-

ированную геометрию, которая потом подсвечивается при выборе соответствующего ТУ. На 

самом деле эта связь двухсторонняя, и можно совершать обратную операцию – опрашивать 

геометрический объект на предмет ассоциированных с ним объектов ТУ. 

• Двойным щелчком на виде СПЕРЕДИ сделайте его рабочим. 

• Включите режим выбора граней, выбрав соответствующий пункт в выпадающем списке филь-

тра по типу на панели выбора, и выберите одну из цилиндрических граней. 

• Нажмите на выбранной грани левую кнопку мыши и в контекстном меню выберите пункт По-

иск ТУ, связанных с геометрией (Find PMI Associated to Geometry) (рис. 9.50). 

•  Появится диалог, в котором можно задать дополнительную геометрию для поиска, или на-

жать ОК. 

Результат поиска будет отображен в новом виде, который станет рабочим. Обратите вни-

мание, что этот вид является перезаписываемым, то есть новый поиск перезапишет резуль-

таты предыдущего. Поэтому для сохранения результатов поиска вид необходимо переимено-

вать.

Рисунок 9.50. Поиск по ассоциированной гео-

метрии
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РАБОТА С ШАБЛОНАМИ
Тема шаблонов достаточно популярна при работе с САПР высшего уровня. Шаблоны по-

могают гармонизировать знания и опыт, оформить их в виде определенной части конструк-

ции изделия и повторно использовать в различных проектах. Понятие шаблона пользователь-

ского элемента, или элемента, определяемого пользователем (Used Defined Feature), уже дав-

но прижилось среди пользователей САПР. В общем случае элемент, определяемый пользова-

телем, представляет собой сгруппированный последовательный набор команд системы, вы-

полняющих определенные действия над задаваемыми входными данными. Такие объекты по-

зволяют создать типовые элементы геометрии детали, которые могут при вставке в дерево по-

строения адаптироваться в зависимости от задаваемых контекстных параметров. 

Обычно шаблоны элементов работают в пределах дерева построения одной детали, то 

есть представляют собой часть этого дерева. Когда речь идёт о шаблоне всей детали или ша-

блоне сборок, то тут уже элемент, задаваемый пользователем, не позволяет полноценно реа-

лизовать такие объекты. Конечно, всегда можно взять существующую модель, пересохранить 

её под другим именем и,  изменяя контекстные геометрические ссылки и значения числовых 

переменных, пытаться перестроить эту модель. Как правило, это достаточно трудоёмкий про-

цесс, тем более если модель создавалась другим пользователем – приходится разбираться в 

дереве построения, зависимостях и логике. Было бы намного удобней, если бы у моделей был 

понятный интерфейс, где были бы вынесены все необходимые параметры, что избавило бы от 

необходимости разбираться в дереве построения модели. 

Для этих целей в NX5 была представлена Студия разработки шаблонов (Product 

Template Studio - PTS). Назначение PTS - создавать шаблоны деталей и сборок на базе су-

ществующих параметрических моделей. При создании PTS ставилась цель создать простой и 

надежный инструмент, который обеспечит функционал создания шаблонов для опытных поль-

зователей системы NX. Не секрет, что часто когда на предприятиях ставится вопрос о созда-

нии «умных» шаблонов или заготовок для типовых узлов конструкции, то, как правило, поми-

мо опытных пользователей системы САПР, привлекают ещё и программистов, которые с по-

мощью программного кода реализуют более сложную логику работы шаблонов, чем это до-

ступно стандартными командами системы.  В случае с PTS упор делался именно на исключе-

ние необходимости прибегать к написанию какого-либо программного кода и на реализа-

цию логики шаблона средствами PTS. 

Для создания шаблона с помощью PTS необходима только законченная параметризован-

ная модель детали или сборки и понимание того, как эта модель должна работать. Естествен-

но, для того что шаблон был рабочим в пределах предполагаемой области его применения, 

необходимо удостовериться, что дерево построения модели отрабатывает заложенную в него 

логику на всех допустимых значениях ключевых параметров – как геометрических, так и чис-

ленных. PTS на основе дерева построения модели и заданных  ключевых параметров созда-

ет диалоговый интерфейс, с помощью которого пользователи взаимодействуют с шаблоном. 

Данная глава на примерах показывает подходы к созданию шаблонов в приложении PTS.
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ПРИЛОЖЕНИЕ PTS
PTS реализована в виде отдельного приложения, которое устанавливается вместе с NX. 

Для запуска PTS в меню Пуск (Start) зайдите в программную группу UGS NX 7.5 и в разде-

ле Инструменты NX выберите Студия создания шаблонов. После инициализации необхо-

димых библиотек будет открыто основное окно приложения. Окно состоит из главного меню, 

двух инструментальных панелей и нескольких функциональных окон (рис. 10.1). 

 Вертикальная инструментальная панель содержит графические блоки пользовательского 

интерфейса, с помощью которых строится диалог работы с шаблоном.

Горизонтальная панель содержит набор команд общего назначения, которые активизиру-

ются в зависимости от текущего контекста.

Верхнее левое окно работает в двух режимах – оно может отображать графическую схе-

му шаблонов и связи между ними, а в режиме редактирования шаблона оно показывает его 

содержимое. Каждый шаблон в этом окне отображается в виде диалога с пиктограммой, ото-

бражающей геометрическое представление этого шаблона. Для перехода в режим редакти-

рования необходимо нажать кнопку «развернуть» или дважды щёлкнуть левой кнопкой мыши 

на заголовке диалога.

Нижнее левое окно состоит из нескольких вкладок, которые активизируются в режиме ре-

дактирования шаблона:

Рисунок 10.1 Вид главного окна приложения PTS
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Информация – вкладка отображает динамическую информацию во время работы над 

шаблоном. Как правило, сюда выводятся информационные и предупреждающие сообщения, 

касающиеся того или иного элемента шаблона.

Атрибуты – на этой вкладке пользователь задет свойства элементов интерфейса шабло-

на, определяющих их поведение. Содержимое этой вкладки зависит от того, какой элемент 

интерфейса выбран.

Зависимости – позволяет задать условия видимости и активности выбранного элемента 

интерфейса.

Требования – эта вкладка позволяет задать логические проверки числовым параметрам 

шаблонов. А также на этой вкладке можно определить набор геометрических проверок мо-

дели, создаваемой шаблоном.

Инициализация – здесь пользователь определяет поведение шаблона в целом, которое 

реализуется при его использовании в сессии NX.

Правые верхнее и нижнее окно являются зависимыми и управляются четырьмя вкладками, 

расположенными над правым верхним окном. Первая вкладка Проводник шаблонов отве-

чает за отображение структуры и последовательности текущих открытых шаблонов в сессии 

PTS. Вторая вкладка является Файловым проводником ,  она позволяет производить нави-

гацию по файловой системе или папкам системы Teamcenter для поиска и добавления файлов 

моделей при формировании структуры связанных шаблонов. Третья вкладка – Проводник 

модели, является одной из основных рабочих областей при создании и редактировании ша-

блона. Она отображает упрощённое представление геометрии модели и предоставляет до-

ступ к дереву построения со всеми операциями и их параметрами. Последняя вкладка – Про-

водник диалогов, на который отображается получаемый диалоговый интерфейс, на основе 

тех ключевых параметров, которые были выбраны на предыдущей вкладке.

Рассмотрим общий алгоритм создания шаблона модели в PTS:

- В сессии NX создается параметризованная 3D модель и сохраняется на локальный  

 диск или в PDM систему.

- Полученная модель открывается в PTS в режиме редактирования шаблона.

- Из дерева построения модели на вкладке Проводник шаблона выбираются управля-

ющие параметры – числовые переменные операций, ссылочная геометрия, эскизы.

- Каждому выбранному параметру система ставит в соответствие элемент диалогового  

 интерфейса.

- Пользователь задаёт атрибуты элементам диалогового интерфейса, определяющие их 

поведение, а также задаёт ограничения числовым переменным.

- Полученный диалоговый интерфейс сохраняется в файл модели.

При этом необходимо понимать, что шаблоном может быть только хорошо параметризо-

ванная модель. Исходная 3D модель должна зависеть от выбранных управляющих параме-

тров, и при этом логика модели должна отрабатываться на всех возможных значениях этих 

параметров. Поэтому имеет смысл перед созданием шаблона из модели проверить, как мо-

дель себя ведёт при различных входных параметрах, при их крайних значениях и различных 
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сочетаниях. Такого рода проверка повысит стабильность работы шаблона и снизит количе-

ство случаев, когда получаемая модель на основе шаблона будет выходить за рамки предпо-

лагаемого поведения.

СОЗДАНИЕ ПРОСТОГО ШАБЛОНА
 Давайте создадим простой шаблон модели, содержащий диалоговый интерфейс для ра-

боты с деревом построения модели. На данном этапе это будет простой шаблон, без расши-

ренной функциональности, но этого будет достаточно, чтобы понять принцип работы студии.

• Запустите NX7.5 и из папки ch10 откройте файл Piston.prt.

• Осмотрите открывшуюся модель (рис. 10.2). Она имеет достаточно большое дерево по-

строения, и очевидно, что для её редактирования, не будучи автором этой модели, пона-

добится некоторое время, чтобы разобраться в логике построения. Если открыть окно вы-

ражений Инструменты > Выражения (Tools > Expressions), то мы увидим, что в модели 

есть некоторый набор именованных параметров, созданный, вероятно, для управления 

построением модели. Естественно, при практической работе с PTS необходимо понимать 

логику построенной модели и назначения параметров. Поэтому автору модели, как пра-

вило, намного проще создать шаблон. В данном примере тоже будем исходить из того, 

что мы знаем логику построения и назначения всех управляющих параметров. Закройте 

модель в NX и запустите PTS. Так как PTS работает с файлом модели, то не рекомендует-

Рисунок 10.2 Модель поршня для создания шаблона
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ся одновременная работа с шаблоном в PTS, в то время когда сама модель открыта в NX. 

• В PTS с помощью команды Файл > Открыть (File  > Open) или первой кнопки в горизон-

тальной инструментальной панели откройте файл Piston.prt.

• После того как модель будет загружена (рис. 10.3),  перейдите в режим редактирования 

шаблона. Для этого в левом верхнем окне дважды щёлкните мышью на заголовке диало-

га с изображением шаблона или воспользуйтесь командой меню диалога для развора-

Рисунок 10.3 Модель поршня в PTS

Рисунок 10.4 Режим редактирования шаблона
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чивания окна.

• Окно шаблона перейдёт в режим редактирования, и откроется его содержимое на дан-

ный момент (рис. 10.4).

• Так как пока шаблон практически ничего не содержит, кроме небольшого текстового эле-

мента, то и на вкладке Проводник диалогов мы видим лишь заготовку под интерфейс 

шаблона.

• Дайте шаблону какое-нибудь осмысленное имя. Для этого в левом верхнем окне выдели-

те строчку с именем шаблона и в нижнем окне 

на вкладке Атрибуты в поле Наименование 

впишете своё название (рис. 10.5).

• В левом верхнем меню, щёлкнув правой 

кнопкой мыши на текстовой метке с названием 

comp_label, удалите этот элемент интерфейса, 

который нам пока не понадобится (рис. 10.6).

• Из вертикаль-

ной инструментальной панели мышкой перетащите элемент 

интерфейса «Группа» на строчку с названием шаблона. По-

сле того как вы отпустите кнопку мыши, в левом верхнем 

меню появится дочерняя строчка, обозначающая элемент, 

а в правом верхнем на вкладке Проводник диалогов по-

явится изображение этого элемента (рис. 10.7).

• Выбрав в левом верхнем меню вставленный элемент, дайте 

ему какое-нибудь осмысленное имя на вкладке Атрибуты нижнего левого окна.

• Добавьте ещё один элемент «Группа» аналогичным способом. При этом обратите вни-

мание на получаемое положение элемента. Начните перетаскивать элемент на строчку, 

отображающую предыдущую группу, но пока не отпускайте кнопку мыши. Обратите вни-

мание, что когда курсор мыши наведён на существующую строчку, она выделяется крас-

ной рамкой. При этом если подвести курсор мыши к нижнему краю строчки, то красная 

рамка утолщается внизу(рис. 10.8), аналогично она утолщается сверху, когда курсор 

Рисунок 10.5 Задание атрибутов

Рисунок 10.6 Удаление эле-

мента

Рисунок 10.7 Добавление группы
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приближается к верхнему краю строки, и имеет одинаковую 

толщину линий, когда курсор около середины. Этим регулиру-

ется позиция вставляемого элемента по отношению к уже су-

ществующему. Если вы отпустите кнопку мыши при перетаски-

вании, когда нижняя или верхняя линия имеет утолщение, то 

соответственно новый элемент будет добавлен ниже или выше 

существующего. Если вы хотите, чтобы элемент стал дочерним 

существующему, то необходимо добиться равномерной толщины красной рамки. 

• В нашем случае мы хотим сделать элемент дочерним, то есть создать подгруппу элемен-

тов в рамках существующей группы. Поэтому перетащите элемент «Группа» на строчку 

уже вставленной группы и, добившись равномерной толщины красной рамки, отпустите 

кнопку мыши. В атрибутах добавленной подгруппы измените её имя (рис. 10.9).

• Откройте вкладку Навигатор модели в правом верхнем окне и в дереве построения 

модели найдите и разверните элемент RECTANGULAR_GROOVE75. Этот конструктив-

ный элемент формирует один из пазов на цилиндрической грани модели. Перетащи-

те параметр oil_control_groove_position, находящийся под элементом RECTANGULAR_

GROOVE75, в левое верхнее окно. При этом необходимо поместить перетаскиваемый 

элемент в подгруппу, вставленную на предыдущем шаге (рис. 10.10).

Рисунок 10.8 Управление 

иерархией

Рисунок 10.9 Создание дочерней группы

Рисунок 10.10 Добавление управляющих параметров
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• Сделайте то же самое для параметров oil_control_groove_th и oil_control_groove_diam.

• В правом верхнем окне откройте вкладку Проводник диалогов. Если все было сделано 

правильно на предыдущих шагах, то диалог шаблона должен выглядеть как на рис. 10.11.

• Поочерёдно выбирая в левом верхнем окне строчки параметров в подгруппе, в нижнем 

левом окне на вкладке Атрибуты дайте осмысленные имена каждому элементу диалого-

вого интерфейса (рис. 10.12).

• Сохраните шаблон. Для этого в меню приложения выберите пункт Файл > Опублико-

вать или нажмите вторую кнопку 

с изображением дискеты на го-

ризонтальной инструментальной 

панели.

• Выйдите из приложения PTS и за-

пустите NX7.5.

• Откройте файл Piston.prt и пере-

Рисунок 10.11 Диалоговый интерфейс шаблона

Рисунок 10.12 Назначение атрибутов

Рисунок 10.13 Проверка шаблона
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йдите в Навигатор сборки.     

Обратите внимание, что в колон-

ке Информация навигатора по-

явился значок, говорящий о том, 

что модель является шаблоном. 

Нажмите правой кнопкой на  

строке модели и в открывшем-

ся контекстном меню выберите 

пункт Редактировать изменя-

емый компонент (рис. 10.13).

• В открывшемся диалоговом окне дважды щёлкните правой кнопкой мыши на названии 

шаблона. Откроется диалоговый интерфейс шаблона. Попробуйте изменять параметры 

в диалоге и посмотреть, как перестраивается геометрия модели. При этом пока шаблон 

не контролирует вводимые значения, поэтому при вводе слишком больших величин пара-

метров логика шаблона может быть нарушена  (рис. 10.14).

• Закройте модель.

Созданный шаблон достаточно простой и управляет только одним элементом управления, 

не контролируя входных параметров. Но при этом шаблон предоставляет простой интерфейс 

управления параметрами и избавляет от необходимости искать и редактировать параметры в 

дереве построения модели. Наличие шаблона не отменяет возможности проводить редактирова-

ние модели через дерево. При этом если будут изменены параметры в дереве построения, то и со-

ответствующие значения в диалоге шаблона тоже будут обновлены. Готовый шаблон этого при-

мера вы можете найти в папке ch10/Step1.

УПРАВЛЕНИЕ ПАРАМЕТРАМИ
Давайте модифицируем созданный шаблон, так чтобы можно было контролировать вводи-

мые значения.

• Запустите PTS и откройте созданный шаблон.

• Двойным щелчком на заголовке диалогового окна с изображением модели шаблона от-

кройте его в режиме редактирования.

• В левом верхнем окне выберите параметр, управляющий положением кольца, и в ниж-

нем окне выберите вкладку Атрибуты.

• Сейчас этот параметр просто вводится пользователем и никак не контролируется. По-

меняем тип элемента интерфейса для ввода этого элемента. Для этого в выпадающем 

списке Стиль отображения вместо значения Ввод выберем значение Масштаб . В 

правом верхнем окне на вкладке Проводник диалогов соответствующий элемент ин-

терфейса поменяется своё представление (рис. 10.15).

Рисунок 10.14 Работа шаблона
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• На той же вкладке нижнего левого окна измените настройки изменённого элемента 

управления. Необходимо задать крайние значения параметра, которые можно будет 

вводить через данный элемент управления. Для этого задайте значения 5 и 15 в поля 

Минимальное и Максимальное значения соответственно. Поле Приращение за-

даёт величину инкремента параметра при минимальном перемещении ползунка. Число 

знаков отвечает за количество отображаемых знаков после запятой в текущем значе-

Рисунок 10.15 Изменение типа ввода параметров

Рисунок 10.16 Задание свойств элементу интерфейса
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нии параметра. Для обновления заготовки диалога шаблона после изменения параме-

тров необходимо нажимать клавишу Enter на клавиатуре (рис. 10.16).

• Включите опцию Динамическое обновление. Она определяет, будет ли модель пере-

страиваться каждый раз при изменении вводимого параметра до того, как пользователь 

нажмет кнопку ОК или Применить в диалоге шаблона. Это имеет смысл, когда пользо-

вателю необходимо отслеживать текущее состояние модели по мере подбора необхо-

димых параметров. С другой стороны, надо иметь в виду, что если изменение параме-

тра приводит к длительному перестроению модели, то включение этой опции существен-

но затормозит работу интерфейса шаблона. 

• Теперь давайте поменяем тип ввода для параметра ширины паза. Выберем его в левом 

верхнем окне и на вкладке Атрибуты изменим Стиль отображения на Выбор из спи-

ска. В текстовом поле Значения вбейте возможные значении параметра – 1.5, 2, 2.5. 

Рядом с этим полем есть две опции Возврат индекса и Возврат значения индекса. 

Первая опция означает то, что в зависимости от выбора пользователя параметру будет 

присвоено значение, равное порядковому номеру элемента выпадающего списка. Вто-

рая опция заставит передавать из выпадающего списка само выбранное значение. Пер-

вый  вариант удобен, когда параметру необходимо назначить числовое значение, в то 

время как пользователю желательно в списке видеть какие-либо осмысленные, возмож-

но текстовые, обозначения.  В нашем случае необходимо передавать само значение из 

списка, поэтому выберем вторую опцию. Также включим опцию Динамическое обнов-

ление (рис. 10.17).

• Добавьте ещё два элемента типа «Группа» из вертикальной инструментальной панели 

Рисунок 10.17 Создание выпадающего списка
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на тот же уровень, что и группа «Масло». В атрибутах каждой группы задайте им имена 

(рис. 10.18).

• В верхнюю и нижнюю группы перетащите параметры элементов RECTANGULAR_

GROOVE77 и RECTANGULAR_GROOVE78 соответственно, аналогично тому, как это 

делалось для первой группы. Важно правильно отслеживать иерархию добавляемых 

элементов, чтобы соответствующие блоки интерфейса попадали в правильное место 

(рис. 10.19).

• Переключитесь на вкладку Проводник диалогов в правом верхнем окне. Переиме-

Рисунок 10.18 Добавление групп

Рисунок 10.19 Наполнение параметрами
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нуйте и смените тип для элементов на двух добавленных группах по аналогии с первой 

группой (рис. 10.20).

• Сохраните шаблон и выйдите из приложения PTS. Запустите NX7.5 и, открыв шаблон, 

проверьте, как он теперь работает.

Готовый шаблон этого примера вы можете найти в папке ch10/Step2.

РАБОТА С ЭСКИЗАМИ
До сих пор при построении шаблонов мы использовали только параметры конструктивных 

элементов, входящих в дерево построения. В общем случае набор объектов, которые могут 

быть использованы для создания интерфейса, не ограничивается параметрами. Вы также мо-

жете использовать именованные параметры из заданных в модели выражений, WAVE связи и 

эскизы. В следующем примере добавим в шаблон возможность управлять геометрией моде-

ли через эскизы.

• Запустите PTS и откройте шаблон, созданный в предыдущих примерах.

• Переведите шаблон в режим редактирования и в верхнем правом окне перейдите на вкладку 

Проводник модели.

• Добавьте в интерфейс диалога ещё один элемент типа «Группа» в самый верх окна. В эту 

Рисунок 10.20 Задание свойств элементов
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группу перетащите из дерева построения модели эскизы SKETCH1, SKETCH2 и SKETCH4. 

Обратите внимание, что каждый эскиз имеет набор параметров, которые основаны на раз-

мерах в этом эскизе. Вы также можете их использовать для построения интерфейса, но в дан-

ном примере ограничимся только самими эскизам. Под каждый эскиз, помещённый в группу, 

будет создан элемент интерфейса в заготовке диалога шаблона. На вкладке Атрибуты за-

дайте имена новым элементам интерфейса (рис. 10.21).

• Сохраните шаблон и выйдите из PTS.

• Запустите NX7.5, откройте шаблон и протестируйте интерфейс.

Готовый шаблон этого примера вы можете найти в папке ch10/Step3.

КОНТРОЛЬ ШАБЛОНА 
PTS позволяет не только создавать интерфейс для управления параметрами геометриче-

ских построений, но и даёт возможность проконтролировать получаемый результат. У вас 

есть возможность контролировать как саму геометрию, полученную в результате ввода дан-

ных через интерфейс, так и оценивать некие характеристики, которые важны с конструктив-

ной точки зрения для данной модели. Первый тип проверок представляет собой набор проце-

дур Checkmate, который задаётся на вкладке 

Требования при выборе заголовка шабло-

на в верхнем левом окне (рис. 10.22).   

Вам необходимо выбрать те проверки, 

которые вы хотите осуществить после при-

менения шаблона, а также задать необходи-

мые параметры. Текстовое поле Описание 

Рисунок 10.21 Работа с эскизами

Рисунок 10.22 Контроль геометрии шаблона
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позволяет задать текст сообщения, который будет видеть пользователь по окончании работы 

соответствующей проверки. Выпадающий список Уровень ошибки задаёт критичность дан-

ной проверки, в случае если результат будет отрицательным. 

Другой тип проверок задаётся на основе измерений геометрии, которые были сохране-

ны в дереве построения модели. В следующем примере установим проверку по предельному 

весу для шаблона модели, созданной в предыдущих примерах.

• Запустите PTS и откройте созданный шаблон.

• Добавьте ещё один элемент типа «Группа» в интерфейс диалога. Так как сейчас диалог со-

держит уже достаточно много элементов интерфейса, то есть смысл свернуть уже наполнен-

ные группы, чтобы сам диалог принял более компактный вид. Для этого необходимо в левом 

верхнем окне, выделив наполненные группы, созданные в предыдущих примерах, на вкладке 

Атрибуты выключить опцию Расширенный (рис. 10.23).

• Дайте название новой группе и в верхнем правом окне переключитесь на вкладку Прово-

дник модели. В дереве построения модели было создано ассоциативное измерение, один 

из результатов которого представляет собой интересующую нас массу. Найдите в дереве 

Рисунок 10.23 Добавление группы

Рисунок 10.25 Задание свойств контрольного параметра
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построения элемент BODY_MEASUREMENT79 и разверните его. Выделив параметр p783, 

перетащите его в созданную группу в верхнем левом окне (рис. 10.24). Если вам необходи-

мо определить, за что отвечает конкретный параметр, входящий в элемент измерения, то, за-

держав курсор мыши над интересующим параметром, вы получите всплывающую подсказку.

• Выделите в левом верхнем окне параметр массы и на вкладке Атрибуты дайте название 

элементу интерфейса, а также задайте Стиль отображения как Текст только для чтения 

(рис. 10.25).

• Полученный элемент интерфейса позволяет в реальном времени видеть получаемую массу 

модели. Добавим теперь ограни-

чение на этот параметр, чтобы 

шаблон сам отслеживал соответ-

ствие текущей массе заданным 

границам.

• Снова выделите в левом верхнем 

окне параметр массы и на вкладке 

Требования в поле Имя тре-

бования  задайте любое имя для 

создаваемого требования. Поле 

Тип сообщения позволяет задать 

критичность сообщения, выдава-

емогое пользователю. Оставим 

его пока без изменения. Далее 

необходимо выбрать тип проверки. 

Возможны три варианта –  одно-

стороннее условие, диапазон или двухстороннее условие и набор значений. В данном 

случае выберем Односторонне условное выражение и в параметрах условия укажем, 

Рисунок 10.24 Добавление контрольного параметра

Рисунок 10.26 Создание требования
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что измеряемая масса должна быть меньше 340 граммов. В текстовом поле Информация 

о требовании введите текст, который будет отображаться пользователю, в случае если 

требование будет нарушено (рис. 10.26). 

• При построении шаблонов с более сложной логикой вы можете задавать условия, не вписы-

вая явно величину значения параметров, а использовать параметры из выражений модели 

или параметров конструктивных элементов. Для этого надо просто перетащить из дерева 

построения модели интересующий вас параметр в текстовое поле условия.

• С вертикальной инструментальной панели выделите и перетащите под параметр массы 

элемент типа «Кнопка». Выделив 

его, задайте ему имя на вкладке 

Атрибуты и в выпадающем спи-

ске Действие кнопки выберите 

пункт Показать информацию 

проверки (рис. 10.27).

• Сохраните шаблон и выйдите из 

PTS.

• Запустите NX7.5 и откройте файл 

шаблона.

• Войдите в режим редактирования 

шаблона и измените параметры 

построения модели. После этого нажмите кнопку проверки. Появится информационное со-

общение, показывающее, соответствует ли выбранный параметр заданному требованию 

(рис. 10.28).

Измеряемая масса будет обновляться при изменении параметров, только если в свойствах 

Рисунок 10.27 Добавление кнопки действия

Рисунок 10.28 Проверка шаблона
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этих параметров была включена опция Динамическое обновление. Иначе необходимо на-

жать кнопку Применить, чтобы модель перестроилась и новое значение массы было отобра-

жено в диалоге. Готовый шаблон этого примера вы можете найти в папке ch10/Step4.

ШАБЛОН ЧЕРТЕЖА И РАСЧЁТНОЙ МОДЕЛИ 
Использование шаблонов деталей позволяет существенно повысить повторное использо-

вание наработок в новых проектах. Обычно созданные 3D модели на основе шаблонов ис-

пользуются на последующих этапах проектирования – по ним делают чертежи, их использу-

ют для расчётов и написания программ для станков с ЧПУ. Приложение PTS с версии NX7.0  

позволяет, помимо создания шаблона самой модели, сделать связанные шаблоны чертежей 

и расчётных моделей. Это даёт возможность дополнительно сократить время проектирования 

и подготовки детали для производства. Надо иметь в виду, что сама PTS не создаёт ни чертёж, 

ни расчётную модель – для этого необходимо воспользоваться модулями Черчение и Рас-

ширенная симуляция системы NX7.5. Задача PTS - создать шаблоны-заготовки на основе 

существующего чертежа и расчётной модели, которые будут ассоциированы с шаблоном 3D 

Рисунок 10.29 Чертёж поршня
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модели. После того как пользователь адаптирует шаблон 3D модели, введя необходимые па-

раметры, ему остается переключиться в шаблон чертежа и внести по мере необходимости 

коррективы в получившийся чертёж, аналогично в расчётной модели провести обновление 

заложенного в шаблоне расчёта и оценить полученный результат. Учитывая, что 3D модель, 

создаваемая шаблоном, в целом подобна исходной 3D модели, с которой изначально созда-

вался чертёж, то, как правило, шаблон чертежа более чем на 90% адаптируется под новую 

перестроенную модель. То же самое можно сказать и о расчётной модели. Так как получае-

мые из шаблона модели подобны, то в большинстве случаев сохранённый расчёт в шаблоне 

расчётной модели применим к изменённой геометрии модели. 

В следующем примере мы свяжем шаблон поршня с расчётной моделью и шаблоном черте-

жа. Для этого предварительно на основе созданного в предыдущих примерах шаблона порш-

ня были подготовлены модель чертежа и расчётная модель, представляющая собой файл си-

муляции и модель конечноэлементной сетки. 

• Запустите NX7.5 и из папки ch10/Step5 откройте файл Piston_dwg1.prt . Откроется чер-

тёж, созданный на основе модели поршня. На данном этапе никаких действий в самом чер-

теже производить не требуется, так как он соответствует текущему состоянию 3D модели. 

Все, что нам необходимо сделать - это связать шаблон 3D модели поршня с чертежом. Это 

мы сделаем в последующих шагах (рис. 10.29).

• Из той же папки откройте файл Piston_sim1.sim. Запустится приложение Расширенная си-

Рисунок 10.30 Расчётная модель поршня
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муляция, и будет загружена расчётная модель поршня (рис. 10.30).   Модель уже была по-

считана – расчёту соответствует объект Mechanical_01 в Навигаторе симуляции. То есть 

на основе геометрии исходной 3D модели была создана конечноэлементная сетка (файл 

Piston_fem1.fem), заданы граничные условия и приложена нагрузка. После чего был произ-

ведён расчёт. Результаты расчёта можно просмотреть, открыв двойным щелчком мышки узел 

Results в Навигаторе симуляции (рис. 10.30). Наша задача - сделать из расчётной мо-

дели шаблон, связанный с шаблоном исход-

ной 3D модели, так чтобы пользователь после 

вставки шаблона в сборку и его адаптации 

мог произвести повторный расчёт, используя 

логику, заложенную в расчётную модель. 

• Закройте все модели и выйдите из NX7.5.

• Запустите PTS, но пока не открывайте ника-

ких шаблонов.

• Для работы с расчетными моделями необхо-

димо произвести некоторые предварительные 

настройки. В главном меню PTS выберите 

пункт Файл > Свойства и в открывшимся 

диалоговом окне настроек выберите вкладку CAE. В поле Папка для результатов укажите 

путь до папки ch10/Step5/post_template_files. Опция Суффикс модели симуляции за-

дает, как PTS будет определять расчетную модель, 

созданную в модуле Расширенная симуляция, 

на основе имени 3D модели. Её оставляем неиз-

менной, так как по умолчанию расчетные модели 

именуются как имя 3D модели с добавлением 

суффикса _sim (рис. 10.31).

• В папке post_templates_files содержатся на-

стройки постпроцессинга – отображения ре-

зультатов расчета. Эти настройки получаются 

из модуля Расширенная симуляция, который 

позволяет сохранить настроенное представление 

результатов в виде набора файлов. Прописав 

путь к файлом постпроцессинга, мы указали PTS, 

откуда брать настройки для отображения резуль-

татов расчёта. Дополнительно необходимо ука-

зать эти же настройки для сессии NX, когда поль-

зователь будет использовать созданный шаблон. 

Для этого необходимо задать значение пере-

менной окружения UGII_CAE_POST_TEMPLATE_

Рисунок 10.31 Настройка файлов постпроцес-

синга

Рисунок 10.32 Создание системной переменной
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USER_DIR. Это можно сделать несколькими способами, но для примера сделаем это через 

системные переменные. Задайте эту переменную как системную. Для этого на ярлыке Мой 

компьютер щелкните правой кнопкой мыши и в контекстном меню выберите Свойства, в 

открывшемся диалоге выберите вкладку Дополнительно. Нажмите кнопку Переменные 

среды  и в открывшемся диалоге нажмите кнопку Создать. Введите имя переменной и как 

значение введите путь до папки ch10/Step5/post_template_files (рис. 10.32). После этого 

нажмите ОК три раза. 

• В приложении PTS откройте из папки ch10/

Step5/Start шаблон Piston.prt. Основное отличие 

этого шаблона от того, что мы создавали в пре-

дыдущих примерах, - в том, что на основе этой 

модели в приложении Расширенная симуля-

ция была создана конечноэлементная сетка и 

произведён расчёт. 

• Сначала добавим к шаблону модели заготов-

ку-шаблон чертежа, который уже также был создан в приложении Черчение. В Навига-

торе шаблонов выберите верхний узел – имя модели шаблона, и, нажав правую кнопку 

мыши, выберете в контекстном меню Добавить чертеж (рис. 10.33).

• В открывшемся диалоге выберите файл Piston_

dwg1.prt . Чертеж будет добавлен в дерево 

шаблона. Обратите внимание, что там уже при-

сутствует расчетная модель Piston_sim1 . Вставка 

расчётной модели произошла автоматически 

во время открытия шаблона модели, так как PTS 

обнаружила модель с суффиксом _sim – как и 

было задано в настройках.

• Пока расчётная модель ещё не является ша-

блоном. Чтобы её превратить в шаблон, необ-

ходимо добавить к ней соответствующий интер-

Рисунок 10.33 Добавление чертежа

Рисунок 10.34 Добавление шаблона расчётной 

модели

Рисунок 10.35 Заготовка шаблона расчётной модели
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фейс. Для этого выберите в Навигаторе шаблонов, строку соответствующую расчётной 

модели, и, нажав правую кнопку мыши в контекстном меню выберите пункт Добавить 

интерфейс шаблона (рис. 10.34). 

• В левом верхнем окне к шаблону 3D модели будет добавлен шаблон расчётной модели. В 

правом верхнем окне на вкладке Навигатор шаблонов появится соответствующая строка 

(рис. 10.35).

• Дальнейшая работа по построению шаблона расчётной модели практически полностью 

идентична процессу создания шаблона 3D модели. Единственное отличие - в том, что в слу-

чае с расчётной моделью оперировать надо не с геометрическими объектами, а с объекта-

ми, из которых формируется расчёт. Переключаем шаблон расчётной модели в режим ре-

дактирования, щёлкнув дважды левой кнопкой мыши по заголовку его диалога, и в правом 

верхнем окне активируем вкладку Навигатор модели (рис. 10.36).

• Выделив в левом верхнем окне корневую строчку шаблона, на вкладке Атрибуты в нижнем 

левом окне переименовываем шаблон. Удаляем объект comp_label типа Метка из шаблона, 

Рисунок 10.36 Редактирование шаблона

Рисунок 10.37 Добавление групп
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так как он нам не нужен.

• Добавим в интерфейс шаблона две группы, которые назовём Нагрузки и Результаты 

(рис. 10.37).

• При работе с расчетными моделями Навигатор модели отображает не дерево построе-

ния, как в случае с 3D моделями, а объекты, задающие условия расчета. Вы можете строить 

интерфейс шаблона, не используя параметры конечноэлементной сетки, материала модели, 

величин и направления задаваемых нагрузок и блока запуска расчета и просмотра резуль-

татов.   Разверните узел Нагрузки. В этом узле содержатся граничные условия и приложен-

ные нагрузки, заданные в модуле Расширенная симуляция. Перетащите объект Pressure1 

в левое верхнее окно в группу Нагрузки. Затем, выделив его на вкладке Атрибуты, в ниж-

нем левом окне задайте имя, тип ввода и единицы измерения величины нагрузки. В зависи-

мости от типа нагрузок, заданных для модели, выпадающий список Единицы измерения 

ввода будет заполнен подходящими единицами измерения (рис. 10.38).

• В Навигаторе модели разверните узел Решения и перетащите единственный объект под 

ним Mechanical_01 в левое верхнее окно в группу результаты. После этого в правом верх-

нем окне переключитесь в Навигатор диалогов для просмотра полученного интерфейса 

(рис. 10.39). Обратите внимание, что объект, задающий давление в расчетной модели, 

Рисунок 10.38 Наполнение групп

Рисунок 10.39 Элемент запуска решателя
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создал элемент интерфейса, позволяющий менять величину давления. То есть пользователь 

может не только применить расчетную схему к перестроенному шаблону, но и варьировать 

параметрами расчета.

• Выделив в левом верхнем окне вставленный объект, перейдите на вкладку Атрибуты левого 

нижнего окна и, выбрав Конструктивное решение: Просмотр результатов, активируйте 

три файла настроек постпроцессинга результатов расчета (рис. 10.40). Эти файлы были взя-

ты из той папки, которую мы изначально про-

писали в настройках. Обратите внимание, что 

они были созданы на основе расчета и пост-

процессинга другой модели, но тем не менее 

вы можете их использовать для данной моде-

ли. Если вы не видите этих файлов настроек в 

PTS или в NX7.5 при работе с шаблоном, про-

верьте, нет ли пробелов в пути к папке, где ле-

жат файлы с шаблонами.

• Сохраните шаблоны и выйдите из приложения 

PTS.

• Запустите NX7.5, создайте новую модель 

сборки, но пока не вставляйте в неё каких-ли-

бо компонентов.

• Сначала мы настроим библиотеку повторного 

Рисунок 10.40 Назначение шаблонов постпроцессинга

Рисунок 10.41 Создание библиотеки
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использования, чтобы вставлять наш шаблон 

из неё. Для этого активируйте навигатор 

Библиотеки повторного использова-

ния, нажав в нем на правую кнопку мыши, 

выберите в контекстном меню Добавить 

библиотеку. Затем в открывшемся диало-

говом окне укажите путь к папке, где был со-

хранен шаблон поршня (рис. 10.41).

• Выделите новую библиотеку, в выпа-

дающем меню фильтрации выберите режим 

отображения только моделей с шаблонами 

PTS. Затем, выделив шаблон поршня, пере-

тащите его в графическую зону (рис. 10.42). 

При вставке шаблона NX создает его копию 

и присваивает имя согласно маске. Чтобы её из-

менить, в главном меню выберите пункт Файл > Утилиты > Настройки по умолчанию, 

раскройте  раздел Базовый модуль > Библиотека повторного использования и на 

вкладке Задание имени детали определите маску имени модели, которая будет исполь-

зоваться при генерации нового имени. Так как к нашему шаблону были привязаны шаблоны 

чертежа и расчета, то для них также будут созданы копии, которые вы можете увидеть в числе 

загруженных в сессию моделей, выбрав пункт Окно в главном меню. 

• В Шаблоне проводника, который автоматически будет открыт после вставки шаблона (или 

откройте его вручную, перейдя в режим редактирования шаблона)  активируйте Расчетную 

модель. Активация займет некоторое время, так как NX обновляет конечноэлементую сетку 

каждый раз, когда происходим изменение исходной геометрии. В открывшемся диалговом ин-

Рисунок 10.42 Вставка шаблона

Рисунок 10.43 Проверка шаблона
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терфейсе шаблона расчетной модели задайте давление и запустите решатель. После оконча-

ния расчётов включите режим отображения результатов и, переключаясь между тремя задан-

ными настройками постпроцессинга, просмотрите полученные результаты (рис. 10.43).

Работа с шаблоном чертежа не требует каких-либо дополнительных действий по сравне-

нию с обычным чертежом 3D модели. Все, что вам надо сделать, – после изменения параме-

тров шаблона 3D модели переключиться в чертёж и обновить виды.

УПРАВЛЕНИЕ ЭЛЕМЕНТАМИ МОДЕЛИ
Часто бывает необходимо управлять не только геометрическими размерами элементов мо-

дели, но и самим наличием этих элементов в модели. PTS не предоставляет специального бло-

ка контроля состоянием элементов, но эта задача решается в системе NX7.5 с применением 

стандратного механизма подавления конструктивных элементов в дереве построения модели. 

Пользователю остается только в шаблон модели добавить блок  интерфейса, управляющий 

выражением, от которого зависит подавление конструктивных элементов. Давайте создадим 

два представления модели поршня, которым будем управлять через интерфейс шаблона. 

• Запустите NX7.5 и в папке ch10/Step6 откройте файл Piston.prt.

• Эта модель уже является шаблоном, но содержит более детальную геометрию. Такая детали-

зация важна для создания конструкторской документации, но часто она бывает лишней для 

ряда задач, например для проведения прочностного расчёта.

• Создадим выражение, от которого будут зависеть состояния нескольких геометрических эле-

ментов модели. Для этого выберите в главном меню пункт Изменить > Элементы > По-

Рисунок 10.44 Подавление элементов модели
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давление по выражению. В 

появившемся диалоговом окне в 

выпадающем списке Опция вы-

ражения выберите значение 

Создать совместно исполь-

зуемый. Эта опция определяет, 

будет ли создано индивидуальная 

переменная для контроля состоя-

ния каждого геометрического эле-

мента или будет одна переменная 

на группу. Для наших целей мы 

создадим одну совместно используемую переменную, которая будет управлять состоянием 

подавления всех геометрических элементов скругления в модели (рис. 10.44). 

• Удерживая нажатой клавишу Ctrl на клавиатуре, выберите в Навигаторе модели все эле-

менты типа Скругление ребра (рис. 10.44).

• После окончания выбора нажмите кнопку Применить в диалоговом окне. После этого в том 

же диалоге нажмите кнопку Показать выражения и в открывшемся списке определите имя 

созданной совместной переменной (рис. 10.45).

• Закройте диалог команды подавления и в главном меню выберите пункт Инструменты > Вы-

ражение. В списке доступных выражений найдите переменную подавления элементов и, вы-

делив её, дайте ей какое-либо осмысленное имя. После этого поменяйте значение этой пере-

менной с 1 на 0 и, нажав кнопку Применить, посмотрите, как это отразится на геометрии 

модели (рис. 10.46). 

• Если все было сделано верно, то при изменении значения переменной модель должна активи-

ровать и деактивировать все геометрические элементы типа «Скругление ребра».

Рисунок 10.45 Переменные подавления

Рисунок 10.46 Создание управляющей переменной
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• Сохраните модель и выйдите из NX7.5.

• Запустите приложение PTS и откройте сохранённую модель.

• Войдите в режим редактирования шаблона и в правом верхнем окне переключитесь на вклад-

ку Проводник модели.

• Добавьте в диалог шаблона новый элемент интерфейса типа Группа и перетащите в него из 

дерева построения переменную, созданную для подавления скруглений в модели. На вкладке 

Аттрибуты задайте ей стиль отображения как Выбор из списка, а в список значений вне-

сите две строки – «Упрощенная модель» и «Детальная модель». При этом необходимо вклю-

чить опцию возврата индекса выбранного элемента. Как это будет работать? Пользователь, 

выбирая одно из значений выпадающего списка, будет присваивать переменной или ноль, или 

единицу. В зависимости от значения все связанные с этой переменной геометрические эле-

менты будут подавляться или активироваться. Включите опцию динамического обновления, со-

храните шаблон и выйдите из PTS (рис. 10.47).

• Запустите NX7.5, откройте шаблон модели, проверьте, как она меняется в зависимости от вы-

бранного состояния.

УПРАВЛЕНИЕ СОСТОЯНИЕМ ИНТЕРФЕЙСА
Вы можете котролировать, какие части диалогового интерфейса шаблона будут доступны 

или видимы пользователю в зависимости от каких-либо его действий. Это позволяет создать 

более «умные» диалоги, которые не загромождены лишними элементами и активируют их по 

мере необходимости. Всегда имеет смысл избавлять пользователя от необходимости думать 

над вводом каких-то исходных данных, которые не применимы в данном контексте. В следую-

щем примере мы уже знакомым способом деактивируем одну из прямоугольных проточек на 

Рисунок 10.47 Создание элемента управления
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поршне и как следствие уберём из диалога элементы управления, отвечающие за неё. 

• Запустите NX7.5 и из папки Step5 откройте файл Piston.prt.

• Сейчас в модели поршня присутствуют три прямоугольные проточки. Дадим пользователю 

возможность в интерфейсе шаблона задавать, сколько проточек будет в модели, и в зависи-

мости от его выбора будет управлять самим интерфейсом. 

• Выбрав пункт меню 

Изменить > Элемен-

ты > Подавление по 

выражению создайте 

переменную, управ-

ляющую состоянием 

подавления элемента 

Прямоугольная про-

точка (рис. 10.48).

• Затем, выбрав пункт 

меню Инструменты > 

Выражение, откройте 

диалог со списком вы-

ражений и, найдя там 

созданную перемен-

ную, измените её имя 

на более осмысленное. 

Далее создайте новую 

Рисунок 10.48 Подавление элемента

Рисунок 10.49 Управляющая переменная и логическое условие
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переменную rings со значением 3. Эта переменная будет определять количество проточек. 

Для простоты пока ограничимся выбором между двумя и тремя проточками. Теперь нам необ-

ходимо связать эту переменную с переменной, управляющей подавлением одной из прото-

чек. Так как переменная подавления должна иметь значение либо 1, либо 0, нам необходимо 

задать условие, как на рис. 10.49.

• Если пользователь присваивает переменной rings значение 3, то согласно условному выра-

жению переменная подавления принимает значение 1 и проточка в модели появляется, а при 

других значениях она будет подавлена.

• Попробуйте сначала в диалоге Выражения отработать изменение переменной rings и, убе-

дившись, что это изменение влияет на геометрическую модель, выйдите из диалога, сохрани-

те модель и закройте NX7.5.

• Запустите приложение PTS и загрузите в него сохранённую модель.

• Перейдите в режим редактирования шаблона и в правом верхнем окне переключитесь в 

Проводник модели.

• Разверните группу Выражения и найдите там переменную rings. Перетащите её в левое 

верхнее окно, поместив в первую группу, так чтобы она была на том  же уровне иерархии, 

что и элементы группы, содержащие параметры каждого кольца. Затем, выделив вставлен-

ный элемент, измените имя, заданное системой, на более понятное пользователю, на вклад-

ке Атрибуты поменяйте стиль отображения на Выбор из списка, в поле Значения вве-

дите 2 и 3, установите опцию Возврат значения индекса. И включите опцию Динами-

ческое обновление, которая в данном случае необходима, так как этот элемент управле-

ния будет управлять не только перестроением геометрии модели, но и элементами интерфей-

Рисунок 10.50 Создание элемента управления
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са диалогового окна. В противном случае пользователь шаблона может столкнуться с непра-

вильным поведением модели, когда геометрический элемент будет деактивирован, но при 

этом останется возможность изменять его параметры (рис. 10.50).

• Переключитесь на вкладку Проводник диалогов в верхнем правом окне и посмотрите на 

получившийся интерфейс. Так как мы в атрибутах переменной rings задали возвращение зна-

чения индекса, то шаблон будет присваивать этой переменной именно те значения, что видит 

пользователь в списке. На данный момент интерфейс шаблона уже будет управлять количе-

ством проточек в 3D модели. Нам теперь необходимо настроить поведение соответствующих 

элементов интерфейса шаблона.

• Переключитесь обратно в Проводник модели. В дереве построения модели элемент по-

строения RECTANGULAR_GROOVE38 соответствует той самой проточке, которая подавляет-

ся в зависимости от выбора пользователя. Когда мы создавали шаблон, то мы выбрали пара-

метры этого элемента в качестве  управляющих и добавили их в группу с названием Нижнее 

компрессионное кольцо (UIGroup7). Выделите эту группу в левом верхнем окне и в ниж-

нем левом окне перейдите на вкладку Зависимости. Активируйте опцию Управление ви-

димостью по и в выпадающем списке выберите значение Подавленному элементу. За-

тем вам необходимо указать, состояние какого элемента необходимо отслеживать. Для этого 

из дерева построения модели перетащите элемент RECTANGULAR_GROOVE38 в пустое тек-

стовое поле опции  управления видимостью. Убедитесь, что в последнем выпадающем списке 

выбрано значение =восстановленный (рис. 10.51).

• Сейчас шаблон практически готов, остаётся только его сохранить. Но давайте ещё немно-

го расширим его логику работу и заодно деактивируем возможность редактирования формы 

модели, если пользователь выбрал отображение двух колец вместо трех. 

• Для управления формой 3D модели мы создали группу в диалоге интерфейса, куда помести-

Рисунок 10.51 Назначение аттрибутов
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ли кнопки редактирования эскизов, образующих модель. В левом верхнем окне разверни-

те эту группу и выделите один из эскизов. В нижнем левом окне перейдите на вкладку Зави-

симости.  Обратите внимание, что в отличие от элемента типа «Группа» для этого элемента 

интерфейса вы можете управлять не только его видимостью, но и активностью. Под активно-

стью понимается состояние элемента интерфейса, при котором его видно, но пользователь 

не имеет возможности с ним работать.

•  Включите опцию Управление активностью по и в выпадающем списке на этот раз вы-

берите строчку Значению выражения. Мы могли бы, так же как и в предыдущем случае, 

управлять активностью по состоянию подавленного элемента, но сейчас воспользуемся дру-

гим методом. Будет управлять активностью в зависимости от значения переменной, которую 

мы создали для подавления проточки. В Проводнике модели, развернув группу Выраже-

ния, найдите эту переменную и перетащите её в текстовое поле опции управления активно-

стью. В последнем выпадающем списке есть несколько вариантов задания условного выра-

жения. Для нашего случая выберем самый простейший способ – проверку на неравенство 

нулю переменной (рис. 10.52).

• Повторите предыдущий шаг для оставшихся двух эскизов. Сохраните шаблон и закройте PTS.

• Запустите NX7.5, откройте шаблон и активируйте диалог интерфейса. В выпадающем спи-

ске, определяющем количество колец (проточек), выберите значение 2. Если шаблон был по-

строен правильно, то переменной rings будет присвоено такое же значение, как следствие 

этого - переменная подавления проточки получит нулевое значение согласно заложенно-

му условию. Проточка будет подавлена в геометрии модели, и эта одна из групп элементов 

управления параметрами проточки будет скрыта. А эскизы, связанные со значением пере-

менной подавления, останутся видимыми, но будут деактивированными (рис. 10.53).

Таким образом, управляя активностью и видимостью элементов через значение перемен-

Рисунок 10.52 Управление видимостью
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ных и состояние элементов построения моделей, вы можете значительно повысить функцио-

нальность шаблона. Особенно актуально это в тех случаях, когда вам надо сочетать в рам-

ках одного шаблона несколько геометрических моделей, которые имеет значительные раз-

личия между собой. 

ВИЗУАЛЬНЫЕ ПРАВИЛА
До сих пор мы разрабатывали логику шаблонов, пользуясь атрибутами и поведением раз-

личных элементов управления. С выходом версии NX7.5 в приложении PTS был представлен 

дополнительный логический механизм работы с моделями, который существенно расширил 

возможности работы с различными объектами моделей из диалогового интерфейса шаблона. 

Этот механизм, названный Визуальными правилами (Visual Rules), позволяет вам создать 

Рисунок 10.53 Проверка шаблона

Рисунок 10.54. Запуск визуальных правил при изменении переменной 
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алгоритм какого-либо действия, используя гра-

фические блоки и соединения, а затем приме-

нять это действие при наступлении какого-либо 

события. Наверное, при работе с предыдущими 

примерами вы уже замечали опцию Запустить 

визуальное правило при изменении значе-

ния – это один из способов запуска описанно-

го вами действия при изменении пользователем 

какой-либо переменной (рис. 10.54). 

Ещё один способ заложен в атрибутах эле-

мента управления типа «Кнопка» из вертикаль-

ной инструментальной панели. То есть у вас есть 

возможность запускать предопределённое дей-

ствие как в качестве реакции на действия поль-

зователя по вводу данных, так и давать возможность самому пользователю вызвать действие 

нажатием на кнопку (рис. 10.55).  Если вы попытаетесь сейчас активировать опцию вызова 

визуального правила или назначить вызов правила на кнопки, то в списке выбора доступных 

правил ничего не будет, так как в текущем шаблоне пока нет ни одного созданного правила. 

Для создания действия или визуального правила необходимо в горизонтальной инстру-

ментальной панели нажать кнопку Добавить правило и в появившемся диалоге задать имя 

создаваемому действию. После этого в верхнем 

левом окне откроется вкладка редактора визуаль-

ных правил (рис. 10.56). В левой части окна вы ви-

дите группы операций, разделённых по функцио-

нальному признаку. Каждый член группы - это блок 

алгоритма, выполняющий какое-либо действие. 

Первая группа «Выборка» содержит функции 

по опросу текущей модели детали или сборки и 

выбору объектов заданного типа. В общем случае 

результатом функции из этой группы является на-

бор найденных объектов заданного типа.

Следующая группа «Фильтр» отвечает за функ-

ции фильтрации объектов по какому-либо при-

знаку. В большинстве случаев вам необходимо 

сочетать функции по фильтрации с функциями по 

выборке, так как для этой группы необходимо пре-

доставить некий набор объектов. Результатом ра-

боты функций фильтраций является подмножество 

объектов, удовлетворяющих заданному условию.

Третья группа «Создать» самая простая. Она 

Рисунок 10.55 Запуск визуальны правил по на-

жатию кнопки 

Рисунок 10.56 Создание визуальных правил
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содержит функции создания условия и цикличности в алгоритме создаваемого действия.

Следующая группа «Действия» отвечает за выполнение каких-либо действий над объек-

тами, переданными на вход. 

И последняя группа «Результат» содержит две функции вывода информации на основе 

данных из предыдущих операций.

Создание действия или визуального правило заключается в графическом определении 

блоков алгоритма из вышеописанных функций и заданию связей между ними. Связи опре-

деляют прохождение потока данных по мере работы алгоритма. На рис. 10.56 изображено 

простейшее визуальное правило, которое при выполнении на первом шаге получает массив 

всех компонентов, входящих в сборку (предполагается, что текущий шаблон является сбор-

кой), затем на втором шаге в полученном массиве делается выборка по имени модели. И на 

третьем шаге на все компоненты, имеющие имя model3, назначается атрибут с именем Test и 

значением, равным 33.

Вы не ограничены в количестве функциональных блоков из одной группы, используемых 

при составлении алгоритма. Поэтому ваши визуальные правила могут содержать несколь-

ко операций выборки и фильтрации. То есть вы можете делать выборку объектов в пределах 

набора объектов, выбранных предыдущей операцией, детализировать фильтрацию объек-

тов путем последовательного применения функций фильтров или производить несколько дей-

ствий над одними и теми же объектами. Как уже было сказано выше, определяя связи, вы за-

даете путь прохождения информации от блока к блоку, и в общем случае алгоритмы быва-

ют нелинейными. Поэтому у вас есть возможность создавать несколько связей, выходящих из 

одного блока, то есть отправлять результат работы функции текущего блока сразу несколь-

ким другим нижестоящим функциям. Давайте рассмотрим пример использования визуальных 

правил на основе уже созданного шаблона, а затем создадим свое правило для нашего ша-

блона поршня. 

• Запустите приложение PTS и откройте файл chopper.prt в папке ch10/chopper, 

• Откроется модель сборки миксера с двумя определенными шаблонами. Один шаблон опре-

делен для верхнего узла сборки, а второй находится в одной из подсборок, содержащих 

Рисунок 10.57 Сборка миксера
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компоненты корпуса миксера (рис. 10.57). 

• Двойным щелчком на заголовке окна шаблона сборки миксера переведите его в режим ре-

дактирования. В правом верхнем окне переключитесь на вкладку с отображением интер-

фейса шаблона, выбрав в левом верхнем окне корневой узел структуры шаблона, в нижнем 

окне выберите вкладку Инициализация (рис. 10.58). Шаблон имеет достаточно простой 

интерфейс, который содержит три функциональные кнопки, вызывающие заданные в шабло-

не визуальные правила, которые выполняют определённый алгоритм действий. Визуальные 

правила, заданные в шаблоне, отображаются на вкладках в верхнем левом окне.  

• Дополнительно к двум описанным выше способам вызова визуальных правил на вкладке 

Инициализация вы можете найти две опции, включение которых позволяет привязать 

выполнение визуальных правил к открытию и закрытию диалогового интерфейса шаблона. 

В контексте нашего примера такого поведения не требуется, но при практическом исполь-

зовании PTS вы часто будете сталкиваться с необходимостью обращаться к этим опциям. 

Обратите внимание, что в списках доступных визуальных правил для назначения на событие 

открытия или закрытия диалогового окна присутствуют всего три правила, в то время как 

в верхнем левом окне присутствуют четыре определённых в шаблоне правила. Не хватает 

правила body_mass. Это говорит о том, что это правило является дочерним к какому-либо 

другому правилу. Механизм визуальных правил позволяет пользователю создавать дочерние 

правила, которые будут вызываться другим или несколькими другими правилами. Это дает 

возможность разбить сложные правила на более простые.  

• В левом верхнем окне выберите поочередно три элемента интерфейса типа «Кнопка» и по-

Рисунок 10.58 Шаблон сборки с визуальными правилами
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смотрите, к каким визуальным правилам они 

привязаны (рис. 10.59).

• Перейдите на вкладку визуального правила 

body_mass (рис. 10.60). Это правило полу-

чает на  первом шаге компонент сборки, 

затем на втором шаге делает выборку тел из 

компонента, далее на третьем шаге делает 

выборку свойств массы полученных тел и на 

последнем шаге извлекает значение конкрет-

ного атрибута массы. Как уже говорилось, 

это правило является дочерним. Поэтому 

родительское правило передает ему на вход 

компонент, а на выходе принимает значение 

массы. 

• Откройте вкладку с правилом cal_mass (рис. 

10.61). Правило выбирает все компоненты 

сборки на первом шаге и на втором в цикле 

передает каждый компонент в дочернее пра-

вило body_mass. Дочернее правило возвра-

щает значение массы компонента, которое 

передается на следующий шаг. На третьем 

шаге происходит суммирование всех при-

шедших на вход значений, и окончательная 

сумма масс компонентов сборки выводится в 

информационное окно на последнем шаге.

• Правило show_steel производит выборку всех 

компонентов сборки и с помощью функции 

фильтрации выделяет те из них, которые 

имеют атрибут с именем material и значением 

steel. Далее из этих компонентов производит-

ся две последовательные выборки – сначала 

выбираются все элементы моделей компо-

нентов, а затем из этого множества выбира-

ются все грани, которые на последнем этапе 

алгоритма передаются действию подсветки. 

Таким образом правило подсвечивает все ком-

поненты сборки, имеющие заданный атрибут с 

определённым значением.

• И последнее правило WebEx – самое простое. Оно состоит из одного действия, которое вы-

водит отчет по сборке в предопределенном формате. Эта функция создает отчет в формате 

Рисунок 10.59 Привязка визуальных правил к 

кнопкам 

Рисунок 10.60 Визуальное правило body_mass 
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HTML, используя шаблон форматирования, 

задаваемый в поле Файл шаблона,  и 

сохраняет его в файл, заданный в поле Вы-

ходной файл. Для корректной работы этого 

визуального правила вам необходимо от-

редактировать путь к файлу шаблона отчета, 

который находится в той же папке, что и фай-

лы моделей. После этого сохраните шаблон.

• Сверните шаблон сборки миксера и раз-

верните шаблон корпуса. Здесь есть три 

визуальных правила, два из которых являются 

дочерними. Основное правило congif_bowl 

вызывается при изменении значения пере-

менной bowl_type, которая управляется вы-

падающим списком в интерфейсе шаблона. 

В зависимости от значения переменной на 

втором шаге вызывается одно из дочерних 

правил. Результатом работы каждого дочер-

него правила является вставка одного ком-

понента сборки и удаление другого – то есть 

замена компонента в составе сборки. Таким 

образом, мы через выпадающий список вы-

бираем, какой из компонентов будет входить в 

сборку.

• Выйдите из PTS и, запустив NX7.5, откройте сборку миксера.

• Войдите в режим редактирования изменяемого компонента и исследуйте, как работают ша-

блоны сборки миксера и подсборки корпуса.

Теперь мы создадим визуальное правило для нашего шаблона поршня, который мы созда-

вали и совершенствовали в прошлых примерах. Наше правило будет подсвечивать прямоу-

гольную проточку при изменении её положения.

• Закройте NX7.5 и, запустив приложение PTS, 

откройте  файл Piston.prt.

• Переведите шаблон в режим редактирования 

и в горизонтальной инструментальной пане-

ли нажмите кнопку Добавить правило. В 

появившемся окне задайте имя правила и на-

жмите ОК. Опция Активизированный из 

визуального правила определяет, будет 

ли создаваемое правило дочерним к какому-

Рисунок 10.61 Визуальное правило cal_mass 

Рисунок 10.62 Создание нового визуального 

правила
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либо другому правилу. В данном случае в этом нет необходимости, поэтому эту опцию мы 

оставим выключенной (рис. 10.62).

• Проточке, которую мы хотим подсвечивать, при изменении её позиции соответствует элемент 

дерева построения RECTANGULAR_GROOVE(78). Все, что нам необходимо, - это с помощью 

функций визуальных правил «добраться» до граней проточки и подсветить их. А затем привязать 

вызов созданного визуального правила к переменным, которые её модифицируют из диалогово-

го интерфейса шаблона. «Добраться» до граней мы можем двумя способами. Первый способ вы 

могли видеть в визуальном правиле по подсветке компонентов с заданным атрибутом в пре-

дыдущем примере. То есть, применяя функции выборки и фильтрации, получить набор граней, 

соответствующих элементу с заданным именем. Есть второй, более простой способ, который в 

данном случае имеет смысл использовать. Переключите правое верхнее окно в режим отобра-

жения дерева построения модели и перетащите элемент  RECTANGULAR_GROOVE(78) в окно 

редактирования визуальных правил. Система сама создаст операцию выборки, получающую 

необходимый нам элемент модели (рис. 10.63). 

• Далее нам необходимо получить все грани 

элемента полученной операции выборки. Это 

можно сделать, добавив ещё одну операцию 

выборки. Для этого из левой части окна ре-

дактирования визуального правила, раскрыв 

группу Выборка, выделите и перетащите в 

поле редактирования функцию Элемент. В 

выпадающем списке блока функции устано-

вите тип выбираемых элементов Грани (рис. 

10.64). Добавленный блок-функция будет при-

нимать элемент построения проточки из первой 

функции выборки и выбирать все грани этого 

элемента. 

Рисунок 10.63 Получение геометрического элемента

Рисунок 10.64 Выборка граней 
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• Теперь осталось определить действие, кото-

рое мы хотим осуществить, и соединить все 

блоки алгоритма в цепочку. Из группы Дей-

ствие выберите и перетащите функцию Под-

светить в поле редактирования шаблона. 

Затем соедините все блоки друг за другом в 

порядке их добавления. Начните с блока На-

чало. Для создания соединения выберите ма-

ленький прямоугольный маркер на середине 

нижнего края блока функции и, нажав левую 

кнопку мыши, перетащите его на другой блок, 

с которым вы хотите установить связь. Затем 

отпустите кнопку мыши (рис. 10.65).

• Вернитесь обратно на вкладку создания 

интерфейса шаблона и, выделив по очереди 

параметры, отвечающие за управление про-

точкой, включите опцию Запустить визуальное правило при изменении значения, а 

в списке Визуальные правила выберите только что созданное правило (рис. 10.66). 

• Сохраните шаблон и выйдите из PTS. 

• Запустите NX7.5 и загрузите шаблон. Активируйте диалоговый интерфейс шаблона и поме-

няйте параметры управления проточки. Если все было сделано правильно, то при каждом из-

менении будет производиться запуск визуального правила, и грани проточки будут подсве-

чиваться (рис. 10.67).  

В данной главе мы рассмотрели базовые возможности создания шаблонов моделей в при-

ложении PTS. Этого хватит, чтобы создавать шаблоны с достаточно сложной логикой, но функ-

Рисунок 10.65 Построение связей 

Рисунок 10.66 Привязка визуального правила к переменной
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ционал PTS этим не ограничивается. Помимо описанных возможностей, с помощью PTS вы мо-

жете создавать группы шаблонов, связанные между собой, передавать параметры, введен-

ные пользователем между шаблонами, управлять внешними геометрическими связями, вызы-

вать из шаблонов программный код, написанный на языках Visual Basic или Java, и многое 

другое. С этими возможностями вы можете подробней ознакомиться, открыв раздел докумен-

тации системы NX7.5, посвящённый PTS.

Рисунок 10.67 Тестирование шаблона
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ВИЗУАЛЬНЫЕ ОТЧЕТЫ
Визуальные отчеты появились в версии NX7 и с тех пор находят все большее применение 

в процессах разработки и анализа разрабатываемого изделия. Механизм визуальных от-

четов решает задачу быстрого предоставления необходимой информации об изделии непо-

средственно на трёхмерном макете самого изделия. Не секрет, что разработка любого из-

делия сопровождается большими объемами сопутствующих данных, и достаточно большая 

часть этих данных так или иначе касается конкретных узлов, сборок и деталей, входящих в со-

став изделия. Это могут быть данные о весе, состоянии готовности, статусе, актуальности и о 

многом другом, что обычно представляется в виде текстовой информации в PDM системе или 

в электронных таблицах. Недостаток такого представления информации – в том, что в CAD 

системе пользователь видит трехмерный макет изделия, а для получения сопутствующей ин-

формации он вынужден обращаться к другим источникам, которые не всегда удобны с точки 

зрения получения быстрого ответа на интересующий вопрос. Хорошо, когда изделие неболь-

шое и разрабатывается одним-двумя исполнителями. В ином случае даже получение ответа 

на простые вопросы о текущем состоянии разработки по каким-то критериям требует значи-

тельных трудозатрат. 

Механизм визуальных отчетов предлагает альтернативное представление сопутствую-

щей информации. Они отображают информацию не в отдельном представлении, а непосред-

ственно на моделях компонентов состава разрабатываемого изделия. Это даёт наглядную 

привязку информации к объектам и избавляет от необходимости переключаться между не-

сколькими источниками данных.

Визуальный отчет  представляет собой набор определенных логических операций над 

атрибутами объектов и описание области действия этих операций. Отчет отображается в 

виде цветовой раскраски и графических тэгов, которые формируются на основании обра-

ботки каждого компонента состава изделия логическими операциями, заданными в отчете.

• Запустите NX7.5 и откройте файл сборки impeller_

assy.prt из папки ch11/hd3d.

• На панели ресурсов откройте вкладку Инструмент 

HD3D (HD3D Tools) и двойным щелчком мышки на 

кнопке Визуальный отчет (Visual Reporting) за-

пустите одноименный инструмент. Будет открыта па-

нель просмотра и создания отчетов (рис. 11.1). 

• В системе для примера уже есть несколько предо-

пределенных отчетов, которые можно использовать 

как основу для создания своих отчетов. В выпадаю-

щем списке Имя отчета (Report Name) выберите 

один из примеров отчетов, который называется Со-

стояние позиционирования (Positron Status), 

и нажмите кнопку Активировать (Activate). 

Рисунок 11.1. Запуск панели управления 

визуальными отчетами
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После обработки компонентов сборки отчет будет представлен на компонентах сборки. 

Данный отчет проверил состояние позиционирования компонента и в зависимости от резуль-

тата отнес его к одной из групп – Фиксировано (Fixed), Частично ограниченный (Partially 

Constrained) и Неограниченный (Unconstrained) (групп может быть больше в этом отчете). 

Каждой группе назначается определённый цвет, которым раскрашиваются все входящие в 

группу компоненты. Дополнительно на компонентах отображается графический тэг, который 

отображает дополнительную информацию и заодно является точкой для отображения кон-

текстного меню по щелчку правой кнопки мыши. Для смены вида отображения отчета вос-

пользуйтесь выпадающим списком Стиль отчета (Reporting Style) (рис. 11.2).

При работе со сборками, содержащими большое количество компонентов, или при плот-

ной компоновке можно воспользоваться режимом полупрозрачности для более четкого ото-

бражения интересующих объектов. Режим полупрозрачности включается с помощью кнопки 

Полупрозрачность (See-Thru) на инструментальной панели Вид (View). Когда режим акти-

вирован, все не выбранные в данный момент объекты делаются полупрозрачными, что обе-

спечивает контрастность выбранных объектов на фоне всего остального. Использование дан-

ного режима визуализации для отображения визуальных отчетов существенно облегчает про-

смотр результатов. 

• Включите режим полупрозрачности и, выбирая в панели управления визуального отчета 

группы и компоненты, посмотрите, как визуализируются компоненты. Полупрозрачность мо-

жет быть отображена в трех стилях, которые управляются с помощью кнопки меню Стиль 

полупрозрачности (See-Thru Style) (рис. 11.3). 

Визуальный отчет будет отображаться до тех пор, пока не будет выключен с помощью кноп-

ки Деактивировать (Deactivate) в панели управления отчетом или пока не будет выключена 

сама панель. Если после генерации отчета будут произведены какие-то изменения в сборке 

или её компонентах, то отчет можно обновить с помощью кнопки  Обновить (Refresh).

• Не выключая отображения отчета, переключитесь на вкладку Навигатор сбор-

Рисунок 11.2. Отображения визуального отчета
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ки (Assembly Navigator). Обратите внимание на колонки Групповой отчет (Report 

Group) и Свойство отчета (Report Property). Эти колонки видны только при активном ви-

зуальном отчете и показывают цвет группы результатов, присвоенных компоненту сборки 

(первая колонка), и значение атрибута, использованного для отчета (вторая колонка) (рис. 

11.4).   

Теперь давайте создадим свой отчет с нуля и обработаем им компоненты текущей сборки. 

Создадим отчет, который будет показывать тип компонента – стандартный, покупной или из-

готавливаемый. В каждой детали, входящей в сборку, определен атрибут с именем ТИП ИЗ-

ДЕЛИЯ, который имеет соответствующее 

значение. 

• На панели управления визуальными 

отчетами нажмите кнопку Деактивиро-

вать, чтобы выключить текущий отчет, и за-

тем нажмите кнопку Определить новый 

отчет (Define New Report), в открывшем-

ся диалоге задайте свойства отчета.

• В поле Имя отчета (Report Name) 

задайте наименование отчета, под которым 

он будет отображаться в выпадающем спи-

ске доступных отчетов. В поле Описание 

(Description) введите описание отчета, поясняющее его назначение.

Следующим шагом в разделе Свойство отчета (Report Property) в первом выпадающем 

списке необходимо задать  критерий, по которому будет формироваться отчет. Критериями 

могут быть:

Свойство компонента сборки (Component Property) –  это свойства вхождения детали 

в состав сборки. По своей сути, это те свойства, которые отображаются в колонках Навига-

Рисунок 11.3. Режим полупрозрачности

Рисунок 11.4. Отображение результатов в Навигато-

ре сборки 
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тора сборки. Во втором выпадающем списке необходимо указать, какое именно свойство 

будет критерием.

Атрибут детали (Part Attribute) – атрибут, который задается в свойствах детали (не в 

контексте сборки). При выборе этого типа во втором списке необходимо вписать имя атри-

бута.

Свойства изделия в системе PDM Teamcenter (Teamcenter Property) – этот пункт досту-

пен, только когда NX работает под управлением PDM системы Teamcenter. Он позволяет ис-

пользовать в качестве критерия свойства изделия, его ревизии или набора данных.

Принадлежность компонента группе (Component Group) – критерием будет являться 

принадлежность компонента какой-либо из предопределенных групп.

Попадание компонента в заданный диапазон (Match Scope) – этот критерий опре-

деляет, попадает ли компонент в отчет, определяемый в разделе Границы отчета (Report 

Scope). То есть при использовании этого критерия компоненты будет разделены на те, кото-

рые входят в область действия отчета, и те, которые в него не входят.

В нашем примере мы будем проверять значение атрибута детали ТИП ИЗДЕЛИЯ, и в зави-

симости от его значения соответствующий компонент сборки будет относиться к той или иной 

группе.

• В разделе Свойство отчета в первом выпадающем списке выберите значение Атрибут 

детали (Part Attribute). В следующем выпадающем списке (который пока пуст) введите имя 

атрибута – ТИП ИЗДЕЛИЯ, в последнем выпадающем списке выберите тип атрибута Стро-

ка/Цепочка (String).

Границы отчета (Report Scope), то есть область его действия, пока не будем задавать. 

Следовательно, будет применяться ко всем компонентам сборки. 

В разделе Результаты (Results) выпадающий список Стандартный стиль отчета (Default 

Reporting Style) задает тип представления результатов по умолчанию, который потом можно 

переключать. Опция Метод группировки (Grouping Method) определяет, как будут груп-

пироваться компоненты в зависимости от выбранного критерия построения отчета. Значение 

Автоматически (Automatic) означает, что группы будут формироваться по усмотрению си-

стемы и свойства отображения каждой группы также будут задаваться системой. В зависи-

мости от выбранного критерия может быть реализован разный алгоритм группировки в этом 

режиме. В случае данного примера автоматическое формирование групп будет означать, 

что группы будут создаваться на базе совпадения значения выбранного атрибута детали. 

Режим Полуавтоматически (Semi-Automatic) определяет автоматическое формирование 

групп, но их свойства отображения задаются пользователем. И последний режим Вручную 

(Manual) предполагает определение пользователем правил группировки и задание свойств 

отображения групп.

Опция Создать группу для несогласованных объектов (Create a Group for Unmatched 

Objects) определяет, будут ли в отчете учитываться те компоненты сборки, которые не попа-

дают под выбранный критерий для формирования отчета. Если эта опция включена, то все 

компоненты, не вошедшие в отчет, будут собраны в отдельную группу. 
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• Сохраните отчет, нажав кнопку Сохранить отчет (Save Report) в верхней части диалога, 

введите имя файла для сохранения, а затем нажмите ОК и выйдите из режима редактирова-

ния отчета. После чего нажмите кнопку Активировать, чтобы применить текущий отчет к за-

груженной сборке, или, не выходя из диалога редактирования, нажмите кнопку Применить 

(рис. 11.5).

В результате компоненты сборки будут разбиты на три группы, отображённые в разде-

ле Результаты (Results) панели управления визуальными отчетами. Каждой группе присвоен 

свой цвет, и этим цветом покрашены все компоненты в этой группе. 

• Наведите курсор мыши на каком-нибудь из графических тэгов, отображённых на компонен-

тах. Появится всплывающая подсказ-

ка, отображающая имя компонен-

та и значение критерия, по которому 

этот компонент был причислен к дан-

ной группе. Нажмите правую кнопку 

мыши на графическом тэге для ото-

бражения контекстного меню. Дан-

ное меню содержит несколько ко-

манд для управления компонентом, к 

которому привязан тэг (рис. 11.6).

В панели управления отчетом выбе-

рите одну из групп и нажмите на ней 

правой кнопкой мыши. Среди доступ-

ных команд управления группой есть 

две команды, представляющие инте-

рес, – это Создать группу компонент 

(Create Component Group) и Изме-

нить стиль группы (Edit Group Style). Рисунок 11.6. Контекстное меню тэгов 

Рисунок 11.5. Создание визуального отчета
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Первая команда создаёт в Навигаторе 

сборки именованную группу компонен-

тов, соответствующую группе, сформи-

рованной на основе отчета. Это позволя-

ет разбить сборку на части, базируясь на 

каком-либо критерии. Например, если в 

атрибутах детали или в соответствующем 

изделии есть какой-то признак принадлеж-

ности данного компонента конкретной си-

стеме, то с помощью визуального отчета 

можно быстро разбить сборку на группы, представляющие системы изделия (рис. 11.7).

Вторая команда позволяет изменять заданное системой представление всех входящих 

компонентов.  С помощью этой команды можно оптимизировать отображение сборки так, 

чтобы выделить интересующую группу компонентов. В диалоге задания стиля группы, помимо 

задания цвета, можно выбрать в выпадающем списке значение Отменить выделение (De-

emphasize), которое задает режим обесцвечивания и полупрозрачности (рис. 11.8).

Раздел отображения результатов в панели управления отчетами располагает дополнитель-

ными средствами работы с результатом в контекстном меню, отображаемом по щелчку пра-

вой кнопки мыши на свободном месте в списке групп. Первые два пункта меню дублируют ко-

манды обновления и деактивации текущего отчета. Cледующие две – позволяют экспортиро-

вать результаты отчета в браузер или электронную таблицу. Настроить отображение столб-

цов в списке результатов можно, выбрав пункт меню Столбцы (Columns). И последний пункт 

меню Отправить в окно (Send to Window) выведет результаты отчета в отдельном окне вне 

панели управления отчетом (рис. 11.9).

• Для пользования расширенными средствами просмотра визуального отчета включите ин-

струментальную панель Режим визуального отчета (Explore Visual Report). Для этого 

Рисунок 11.8. Изменение отображения группы

Рисунок 11.7. Создание группы компонент



311

NX Глава 11. Визуализация

нажмите правую кнопку мыши на любой ин-

струментальной панели и в контекстном меню 

выберите нужную панель. 

• Перейдите в Навигатор сборки и нажмите 

кнопку Изучить отчет (Explore Report) на 

появившейся панели. Это включит режим про-

смотра текущего отчета (рис. 11.10).

Выбирая в выпадающем списке группы, полу-

ченные на основании отчета, вы можете выде-

лять входящие компоненты на фоне остального 

состава сборки.

Для отображения компонентов определенной 

группы, входящих в какую-то подсборку, необ-

ходимо в Навигаторе сборке выделить интере-

сующую  подсборку и, выбрав группу в выпада-

ющем списке на инструментальной панели Из-

учить отчет, нажать кнопку Отчет по сборке 

(Report Down Assembly), расположенную справа от списка. Будут отображены только те 

компоненты, которые входят в подсборку и принадлежат группе, остальные члены этой группы 

будут погашены. Таким образом можно детализировать отчет, продвигаясь от начала сборки 

до её нижних уровней. Оставшиеся три кнопки инструментальной панели:

Добавить режим (Add Mode) –  включает режим добавления новых объектов отчета к су-

ществующему отображаемому набору.

Сброс отчета по деталям (Reset Report Parts) – очищает список текущих отображаемых 

результатов отчета.

Раскрыть для отчета (Expand to Reported) – раскрывает свернутые подсборки в Нави-

гаторе сборки, если в них содержатся компоненты, отображенные в данный момент в отчете.

Рисунок 11.10. Режим изучения отчетов 

Рисунок 11.9. Свойства списка групп
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Отредактируем наш отчет, поменяв метод группировки компонентом с автоматического на 

получавтоматический. 

• Выключите режим изучения отчета, нажав на кнопку Изучить отчет.

• Переключитесь обратно на панель управления визуальными отчетами и нажмите на кнопку 

Изменить (Edit) для редактирования отчета.

• В разделе Результаты поменяйте метод группировки на полуавтоматический. Далее необ-

ходимо задать стиль отображения каждой группы. Так как отчет уже был применен к текущей 

сборке, то в разделе Группа, задаваемая пользователем (User Defined Group) уже 

будут добавлены три строки, соответствующие доступным группам. Если бы отчет не был при-

менен, то эти группы надо было бы создать вручную с помощью кнопки Добавить группу 

(Add Group) (рис. 11.11).

Каждая группа представлена строчкой, состоящей из полей:

Имя (Name) – имя группы, задаваемое вручную или автоматически, в зависимости от 

включения опции в начале строки. 

Значение (Value) – значение атрибута, по которому производится назначение компонен-

та данной группе. Данное поле видоизменяется в зависимости от того, что было выбрано в ка-

честве критерия отчета. Так, например, если бы вместо атрибута детали был выбран вес ком-

понента, то это поле могло бы принимать как значение величины веса, так и диапазон вели-

чин. Если бы критерием было состояние позиционирования компонента в сборке, как в при-

мере отчета, рассмотренного ранее, то это поле представляло бы список возможных состоя-

ний позиционирования.  

Стиль отображения (Display Style) – определяет режим отображения, а именно цвет или 

Рисунок 11.11. Полуавтоматическое формирование групп
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полупрозрачность. Цвет может задаваться или использоваться исходный цвет компонента, то 

есть компонент не будет менять свое отображение.

• Поменяйте стиль отображения для групп и, сохранив отчет, примените его к загруженной 

сборке.

Создадим ещё один отчет и на этот раз задействуем опцию заданий области действия от-

чета. До сих пор отчет применялся ко всем компонентам сборки, что не всегда удобно. Ино-

гда требуется сделать отчет только по определенной категории компонентов, не обрабаты-

вая весь состав сборки. Создадим отчет, который будет показывать состояние позициониро-

вания стандартных изделий.

• Нажмите кнопку Определить новый отчет и присвойте ему имя.

• Так как позиционирование является свойством компонента сборки, то в разделе Свойство 

отчета (Component Property) выберите в первом выпадающем списке значение Свой-

ство компонента (Component Property), а во втором выпадающем списке выберите зна-

чение Положение (Position) (рис. 11.12).

• Если оставить отчет в таком виде, то он будет применен ко всем компонентам сборки. Чтобы 

задать область действия, раскройте раздел диалога Границы отчета (Report Scope). 

Здесь необходимо сформировать одно или несколько правил, по которому будет опреде-

ляться, входит ли конкретный компонент в область отчета или нет. Правила формируются в 

виде логических условий, которые необходимо задавать, выбирая и вписывая значения выпа-

дающих списков каждой строчки.

• В первом выпадающем списке необходимо выбрать атрибут, который будет использован для 

создания логического условия.  Так как в данной сборке тип детали определяется атрибутом 

на уровне модели, то выберите значение Атрибут детали (Part Attribute). 

• Во втором списке необходимо вписать имя атрибута, который содержит необходимую ин-

формацию о типе, и в третьем списке следует указать тип этого атрибута. 

Рисунок 11.12. Отчет по позиционированию группы компонент
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• В четвертом списке выберите логическое условие, для нашего примера подойдет значение 

Содержит (Contains).

• В последнем списке необходимо вписать значение «СТАНДАРТНОЕ». 

Так мы явно зададим значение атрибута. При необходимости можно оставить задание зна-

чения на усмотрение пользователя отчета. Для этого надо в этом выпадающем списке выбрать 

значение Заданный  пользователем (User Specified) вместо ввода конкретного значения. 

Тогда во время работы отчета пользователю предложено будет вписать это значение (рис. 

11.13). Такой отчет будет более гибким с точки зрения возможностей – его можно будет при-

менять к любым типам деталей, но существует риск того, что пользователь введет неправиль-

ное значение – и тогда желаемая логика не будет реализована. 

Следует отметить, что содержимое каждого списка не является постоянным для любых 

атрибутов. То есть если в качестве определяющего критерия в первом списке будет выбран 

не атрибут детали, а, например, какое-либо свойство компонента, то остальные списки будут 

наполнены значениями, применимыми к данному свойству. 

При выполнении отчета созданное логическое правило будет запрашивать у компонен-

та сборки атрибут с именем «ТИП ИЗДЕЛИЯ», и если в значении этого атрибута (и если этот 

атрибут присутствует в детали) встречается строка «СТАНДАРТНОЕ», то компонент будет пе-

редаваться на обработку по критерию отчета. Иначе он будет игнорироваться.

• В разделе результате оставьте опцию Метод группировки со значением Автоматиче-

ски. Сохраните отчет и примените его. Просмотрите полученный результат.

С помощью комбинаций различных логических условий можно задавать достаточно ком-

плексные схемы выборки объектов. Возможности визуальных отчетов многократно увеличи-

ваются, когда разработка изделия ведется под управлением PDM системы. В этом случае, 

помимо стандартных атрибутивных данных, для формирования отчетов можно использовать 

данные процессов управления данных, привязанные к компонентам состава изделия. Так, на-

пример, можно в качестве критерия визуального отчета использовать статус компонента и 

получить наглядный отчёт по изделию, где будет видно, какие компоненты уже выпущены, ка-

кие в разработке и какие находятся в состоянии утверждения. Ещё один пример отчета на 

основе данных PDM системы – это отчет по последним изменениям за какой-то срок, который 

Рисунок 11.13. Задание значения пользователем
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может наглядно на трехмерном макете изделия отобразить, что изменилось за какой-то вре-

менной срок.

ПРОВЕРКА МОДЕЛЕЙ
Помимо отображения результатов  отчета по компонентам состава сборки, механизм ви-

зуальных отчетов используется для отображения результатов проверки моделей средствами 

Помощника проверки (Checkmate). Данный инструмент решает задачу проверки соответ-

ствия моделей заданному набору критериев. В 

комплекте системы NX7.5 идёт пакет из более 

800 типовых критериев проверки, которые мож-

но использовать для проверки моделей. Рассмо-

трим работу инструмента проверки в сочетании 

с визуальными отчетами на примере:

• Запустите NX75 и откройте сборку impeller.

prt из папки ch11/hd3d. 

• Если активен какой-либо визуальный отчет, то деак-

тивируйте его и выключите панель управления визуальны-

ми отчетами.

• На панели ресурсов  выберите вкладку Инструмент 

HD3D и нажмите  двойным щелчком мыши кнопку По-

мощник проверки моделей (Check-mate).

Откроется панель управления помощника проверки, 

состоящая из трех разделов:

Результаты (Results) – отображает результаты по-

следней проверки и обеспечивает навигацию по компо-

нентам сборки для просмотра результатов.

Управление (Controls) – содержит кнопки управле-

ния процессом проверки.

Настройки (Settings) –  отвечает за задание набо-

ра проверок, а также за фильтрацию визуального ото-

бражения результатов в графической области.

Для того чтобы запустить процесс проверки, необхо-

димо определить, какого рода проверки должны быть 

проведены.

• В разделе Настройки нажмите кнопку Назначить 

проверки (Set Up Tests). Откроется диалоговое окно 

задания исходных данных для проверки. 

На первой вкладке Детали (Parts) задаётся список 
Рисунок 11.15. Панель управления 

средством проверки

Рисунок 11.14. Запуск средства проверки
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объектов, подлежащих проверке (рис. 11.16). 

Это может быть Текущая деталь (Current Part), 

Все загруженные детали (All Loaded Parts) и 

Все детали в папке (All Parts in Directory). В 

последнем случае необходимо указать папку, 

где лежат модели, подлежащие проверке. Опция 

Загрузить компоненты (Load Components) 

определяет, будут ли подгружаться компоненты, 

если проверяемая деталь является сборкой, и 

если да, то сколько уровней должно быть загру-

жено. Оставшиеся две опции определяют, про-

верять ли только модели, для которых есть до-

ступ на запись, и проверять ли только модели с 

правами владения текущего пользователя. Эти 

опции позволяют проверять большие сборки, в 

которых присутствуют модели разных пользо-

вателей, и отсеивать те, которые не могут быть 

перезаписаны, если будут найдены ошибки и их 

надо будет исправить.

• Выберите на первой вкладке опцию Текущая деталь и в выпадающем списке Загрузить 

компоненты выберите значение Все уровни (All Levels) или выберите опцию Все загру-

женные компоненты. В обоих случаях это будет одинаковый набор объектов, если в сес-

сии NX не загружено других данных, кроме сборки примера, и если эта сборка является ра-

бочей деталью. Затем переключитесь на вкладку Проверка (Tests).

На вкладке Проверка (рис. 11.17) представлены все доступные на данный момент про-

верки (тесты), сгруппированные по категориям. В зависимости от целей в общем случае поль-

зователь производит выбор необхо-

димых проверок, добавляя их в спи-

сок Выбранные проверки (Chosen 

Tests), формируя тем самым набор, 

которым будет проверяться каждая 

модель, заданная на вкладке Дета-

ли. 

• Разверните категорию Моде-

лирование (Modeling ) и добавь-

те несколько проверок из раздела 

Проверить геометрию (Examine 

Geometry), выделяя их в верхнем 

списке и нажимая кнопку со стрелкой. 

При желании ознакомиться с описани-

Рисунок 11.16. Выбор объектов проверки 

Рисунок 11.17. Задание набора проверок 
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ем проверки необходимо нажать на кнопку с изо-

бражением книги. Выберите следующие проверки: 

Тела – Непрерывность (Bodies Consistency), 

Тела – Пересечение граней (Bodies – Face-

Face Intersection), Объекты – Крошечность 

(Objects - Tiny), Ребра – Гладкость (Edges - 

Smoothness).

• Если была добавлена неправильная проверка, 

то воспользуйтесь кнопкой Удалить из списка 

(Remove from List) справа от нижнего списка.

• Некоторые проверки предполагают задание 

параметров. Выберите проверку Объекты – 

Крошечность в нижнем списке и нажмите кноп-

ку Настройки (Customize). Эта проверка про-

веряет модель на предмет наличия крошечных тел 

и поверхностей, образовавшихся в результате не-

точных операций построения модели. В открыв-

шемся диалоговом окне вы можете задать минимальный размер объекта, меньше которого 

этот объект будет считаться крошечным. Для этого поменяйте значение по умолчанию в поле 

Пороговый допуск расстояния (Distance Threshold Tolerance). Затем закройте этот 

диалог и переключитесь на вкладку Опции выполнения.

Рассмотрим опции на этой вкладке (рис. 11.18):

Остановка при ошибке (Stop on Error) – останавливает процесс проверки, если была 

обнаружена ошибка. Если опция выключена, то проверка будет выполняться до конца с вы-

водом итогового отчета. В противном случае при первой найденной ошибке проверка будет 

прекращаться.

Остановка при предупреждении (Stop on Warning) – аналогично предыдущему, но в 

этом случае остановка будет происходить при нахождении нарушения категории «Предупре-

ждение».

Сохранить деталь после проверки (Save Part After Checking) – определяет, будет ли 

модель перезаписана после проверки. Позволяет запрещать или разрешать запись, а также 

перезаписывать модель, в случае если проверка была пройдена.

Создавать флаг проверки (Generate Check Flag) – определяет, будет ли создавать флаг 

проверки или нет. Флаг проверки представляет собой запись в файле модели о проведенной 

проверке и её результате.  Смысл такого флага – в том, что если модель была проверена не-

которое время назад и с тех пор не менялась, то нет необходимости заново её проверять. 

Это позволяет существенно сэкономить время, затрачиваемое на проверку большого коли-

чества моделей. Эта опция доступна, только если разрешена перезапись проверяемого объ-

екта предыдущей опцией.

Не проверять, если флаг проверки актуален (Skip checking if Check Flag is up-date) 

Рисунок 11.18. Задание настроек проверки 
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– определяет, будет ли проверяться модель, в которой был обнаружен флаг о пройденной 

проверке и с тех пор модель не изменилась. 

Считать предупреждения допустимыми (Treat Warning as Pass) – если эта опция ак-

тивна, то при записи флага проверки в модель все результаты категории «Предупреждение» 

будут рассматриваться как успешные.

Считывать флаг проверки без загрузки детали (Read Flag without part loading) – 

проверяет флаг проверки у модели, не загружая её в память. Это касается тех моделей, кото-

рые являются компонентами проверяемых моделей и которые не загружены в сессии. 

 Генерация внешнего файла журнала (Generate an External Log file) – определяет, 

создается ли файл отчета, и выпадающий список определяет, создается ли он  для каждой 

проверяемой модели или один файл для всей сессии.

Параметры отображения результатов (Display Results Options) – определяет, отобра-

жаются ли результаты проверки в виде визуального отчета, и дополнительно можно указать, 

что результаты должны отображаться, только если результат проверки негативен. 

Автоматическое обновление результатов при изменении рабочей детали 

(Automatically Update Results when Work Part is Changed) – включает автоматическое 

обновление результатов проверки при изменении рабочей модели.

• На рассмотренной вкладке отключите опции остановки по ошибке и предупреждению, отка-

житесь от сохранения моделей после проверки, включите опцию автоматического обновле-

ния результатов и убедитесь, что опция отображения параметров установлена  в значение 

Всегда отображать (Always Display). Затем закройте диалог настройки проверок, на-

жав кнопку Закрыть (Close).

• На панели управления помощника проверки, в разделе Управление нажмите кнопку Вы-

полнить проверку (Execute Check-Mate Tests).

Рисунок 11.19. Результаты проверки
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После окончания проверки будет наполнен список в разделе Результаты, а на изображе-

нии моделей в графической области появятся графические тэги с изображением результатов. 

Результаты в списке по умолчанию группируются по моделям (рис. 11.19). 

• Переключите режим группировки с помощью выпадающего списка Уровень фильтра 

(Filter Level) в разделе Настройки.  Вы можете выбрать значение Проверка (Test) для 

группировки по назначенным проверкам или Объект (Object) для группировки по геоме-

трическим объектам.

• Для фильтрации отображаемых результатов по типу воспользуйтесь соответствующими оп-

циями в разделе Настройки.

• На инструментальной панели Вид (View) активируйте режим полупрозрачности для более 

четкого представления графических данных. В этом режиме, выбирая модели в списке Ре-

зультаты, исследуйте полученные ре-

зультаты (рис. 11.20).

• Воспользуйтесь контекстным меню по 

правой кнопке мыши на имени моде-

ли для манипуляций с моделью. Коман-

да Удалить результаты в этом меню 

позволяет очистить информацию о про-

верке для данной детали.

• В графической области наведите кур-

сор мыши на какой-нибудь тэг до появ-

ления всплывающей подсказки с инфор-
Рисунок 11.21. Дополнительная информация на гра-

фических тэгах

Рисунок 11.20. Просмотр результатов в режиме полупрозрачности 
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мацией о результатах теста. Двойным щелчком по графическому тэгу откройте окно с рас-

ширенной информацией, а нажатие правой кнопки мыши на тэги вызовет контекстное меню 

управления моделью (рис. 11.21).

Механизм проверки с использованием визуальных отчетов может применяться не только к 

моделям деталий и сборок, но также к чертежам и объектам аннотаций моделей в 3D (PMI).  

Набор доступных проверок, поставляемых с системой NX, постоянно расширяется, и специ-

фичный их текущий набор закрывает большую часть задач «электронного нормокнотроля». 

При отсутствии подходящих проверок для какой-либо задачи их можно разработать, исполь-

зуя встроенный язык Knowledge Fusion.

 ИЗОБРАЖЕНИЯ И  АНИМАЦИЯ
Иногда для задач презентации проекта возникает необходимость создания высококаче-

ственных изображений и анимации. Система NX предлагает ряд средств для создания сцен 

визуализации и рендеринга, как статического, так и динамического. Рассмотрим создание 

статического изображения и анимации на примере сборки:

• Откройте файл gearbox.prt из папки ch11/visual.

• Включите инструментальные панели управления визуализацией. Для этого нажмите правую 

кнопку мыши на любой инструментальной панели, в выпадающем меню выберите пункты Ви-

зуализация формы (Visualize Shape) и Визуализация (Visualization).

Создадим статическое изображение загруженной сборки. Для этого можно использовать 

настройки по умолчанию, но в данном примере проведем некоторые предварительные на-

стройки. Чтобы изображение было более натуральным, необходимо как минимум задать 

свойства материалов объектам сборки и освещение. По умолчанию никаких материалов объ-

ектам  не присвоено, поэтому при создании изображения будет учитываться только их теку-

щий цвет. Назначим материалы на основные крупные компоненты.

• Включите режим визуализации Студия (Studio) – нажмите в пустом месте графической об-

ласти среднюю кнопку мыши до появления радиального меню и затем выберите левую верх-

нюю кнопку.  

Этот режим позволяет динамически отображать текстуру материала на моделях, а в дру-

гих режимах отображения вид моделей с учётом материалов будет доступен только при гене-

рации статического изображения.

В NX есть два набора материалов для задач рендеринга – Библиотека материалов 

(Material Library) и Системные материалы (System Materials). Первый набор представля-

ет собой библиотеку материалов в формате LWA от различных поставщиков. Второй набор 

содержит системные материалы, которые поставляются вместе с NX. При использовании ма-

териала из того или иного источника он сначала копируется в рабочую часть и затем приме-

няется к выбранному объекту. Доступ к материалам, как библиотечным, так и сохраненным в 

детали, осуществляется через панель ресурсов. 
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• Для активации библиотек материалов и назначения их на геометрические объекты на ин-

струментальной панели Визуализация формы  нажмите кнопку Материалы/Текстуры 

(Materials/Textures) или выберите пункт главного меню Вид > Визуализация > Мате-

риалы текстуры (View > Visualization > Materials/Textures). Будет включен режим на-

значения материалов, и в панели ресурсов появится вкладка Библиотеки материалов. 

Также в панели ресурсов появится вкладка Материалы в детали (Materials in Part), ко-

торая пока не содержит никаких материалов. Вкладка Системные материалы отображается 

по умолчанию при создании или открытии модели в сессии, если она не доступна, то включи-

те её отображение, воспользовавшись пунктом меню Настройки > Палитры (Preferences > 

Pallets). Способ назначения материалов на объект отличается в зависимости от того, что ис-

пользуется как источник материалов. 

• Сначала назначим материал из Библиотеки материалов. Для этого разверните какой-нибудь 

раздел библиотеки, например Metal > Steel и далее, установив в фильтре выбора значение 

Твердое тело (Solid Body),  выберите в графической области какой-нибудь компонент, а 

затем в раскрытом списке библиотеки выберите желаемый материал (рис. 11.23). 

Материал будет скопирован в деталь и назначен на выбранный объект. Если активен ре-

жим отображения Студия, то изображение объекта будет изменено с учетом текстурных 

свойств материала. Пока это лишь предварительный просмотр, он не соответствует полно-

стью тому, что получается при генерации статического изображения, когда производится де-

тальный расчет отображения каждой точки геометрического объекта с учетом свойств мате-

риала и источников света.

• Теперь назначим материал из набора Системные материалы. Переключитесь в пане-

ли ресурсов на соответствующую вкладку и, выбрав на одной из категорий материал, пред-

ставленный виде изображения сферы с текстурой материала, выделите его курсором мыши 

и перетащите на объект назначения. Как только объект назначения будет подсвечен, можно 

отпустить кнопку мыши. Материал будет скопирован в деталь и назначен (рис. 11.24).

Рисунок 11.22. Включение режима работы с материалами 
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• Повторите назначение материалов на другие компоненты из любого набора материалов и 

затем переключитесь на вкладку Материалы в детали. 

Здесь собраны все материалы, которые применялись к объектам и были скопированы в 

модель. В том числе и те, которые не используются в данный момент. Для определения, ка-

кими объектами пользуется тот или иной материал, выберите интересующий материал и на-

жмите кнопку Показать использование (Show Usage). Если материал используется, то со-

ответствующие компоненты будут подсвечены, иначе в строке-подсказке появится сообщение 

о том, что материал не используется. В таком случае можно его удалить из модели, нажав на 

нем правую кнопку мыши и выбрав пункт меню Удалить (Delete).

Вы можете изменить свойства материала, скопированного в модель. Для этого выберите 

материал и нажмите кнопку Запуск редактора материалов (Launch Material Editor). Ре-

дактор позволяет менять оптические свойства материала и параметры текстуры. Обратите 

Рисунок 11.23. Назначение материала из Библиотеки материалов.

Рисунок 11.24. Назначение материалов из системной библиотеки.



323

NX Глава 11. Визуализация

внимание, что некоторые параметры в диалоге редактора сопровождаются значком фотоап-

парата. Это означает, что изменение этого параметра не влияет на отображение объектов в 

режиме реального времени и будет учитываться только при генерации статического изобра-

жения (рис. 11.26).

• После выбора и назначения материалов включите диалог настройки основных источников 

света, нажав кнопку Базовые источники света (Base Lights) на инструментальной па-

нели Визуализация.  Перемещая ползунки управления яркостью, отрегулируйте освещен-

ность модели (рис. 11.27).

Для дополнительных настроек освещенности воспользуйтесь диалогом Дополнительные 

источники света (Advanced Lights), нажав одноименною кнопку на инструментальной па-

нели Визуализация формы или воспользовавшись пунктом главного меню Вид > Визуали-

зация > Дополнительные источники света. В диалоге представлены две группы источников 

света активных – Вкл (On) и неактивных – Выкл (Off). Перемещая источники света из одной 

Рисунок 11.26. Изменение свойств материала

Рисунок 11.25. Определение применяемости материала
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группы в другую с помощью кнопок-стрелок, вы можете создать свой набор источников света 

и настроить для каждого из них Цвет (Color) и Интенсивность (Intensity) в следующем раз-

деле диалога (рис. 11.28).

• После задания источников света на инструментальной 

панели Визуализация нажмите кнопку Высококаче-

ственное изображение (High Quality Image), что-

бы вызвать диалог создания статического изображения. 

В выпадающем списке Метод (Method) выберите ме-

тод рендеринга. Описание каждого метода вы можете 

найти в документации к системе NX . В данном примере 

оставим значение по умолчанию и перейдём к настрой-

ке получаемого изображения (рис. 11.29).

• Нажмите кнопку Настройки изображения (Image 

Preferences) и в открывшемся диалоге задайте Фор-

мат (Format) изображения, в выпадающем списке 

Отобразить (Display) выберите цветовую схему, в 

поле Размер изображения (Image Size) выберите 

желаемый размер. Если будет выбран размер, задавае-

мый пользователем, то задайте Качество печати (Plot 

Quality) и размеры получаемого изображения. 

Надо иметь в виду, что сочетание высокого качества и 

больших размеров может привести к достаточно длитель-

ной операции создания изображения и большому размеру 

полученного файла. Например, файл изображения разме-

ра А0 с высоким уровнем качества может достигать 400 

Мб и более. Поэтому используйте минимально необходи-

Рисунок 11.27. Настройка стандартных источников света

Рисунок 11.28. Настройка дополни-

тельных источников света 
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мые сочетания качества и размера изображения.

• Закройте диалог настройки и нажмите кнопку 

Начало закраски (Start Shade). Будет запу-

щен процесс генерации изображения на основе 

заданных настроек материалов и освещенности. 

После окончания процесса генерации в диалоге 

активируются кнопки Сохранить (Save) и От-

рисовать (Plot), которые позволяют сохранить 

или напечатать полученное изображение (рис. 

11.30). 

• Сохраните полученное изображение в файл и 

закройте диалог.

Мы рассмотрели только основные настрой-

ки генерации статического изображения, которых 

должно быть достаточно для создания графических 

представлений изделий. Теперь давайте создадим 

анимацию, показывающую облет изделия по за-

данной траектории. 

Для создания анимации необходимо наличие 

3D модели изделия и кривых линий, представля-

ющих собой траекторию передвижения камеры. В 

общем случае создание анимации состоит из сле-

дующих шагов:

• выбор объектов (кривых в данном случае), 

представляющих траекторию движения ка-

меры;

• указание точек, которые будут являться ме-

стами расположения ключевых кадров. За-

дание параметров для каждого ключевого  

кадра, в том числе вектора направления вида камеры;

• задание параметров анимации;

• рендеринг.

• Воспользуемся той же моделью сборки. Откройте диалог настройки слоев с помощью пункта 

главного меню Формат > Настройки слоя (Format > Layers Settings) и сделайте слой 

22 видимым и выбираемым. На этом слое лежит траектория, по которой будет совершать об-

лет камера, направленная на изделие.

• С помощью команды Вставить > База/Точка > Набор точек (Insert > Datum/Point > 

Point Set) откройте диалог создания набора точек. Нам необходимо создать некоторое ко-

личество точек на траектории, к которым будут привязываться кадры анимации. Укажите 

Рисунок 11.29. Панель генерации изображе-

ния 

Рисунок 11.30. Результат рендеринга 
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сплайн траектории в качестве Геометри базы (Base Geometry), в выпадающем списке 

Точки кривой по (Curve Poibts by) выберите значение Равная длина дуг (Equal Arc 

Length) и укажите Число точек (Number of Points) равным 10 (рис. 11.31). 

Количество точек определяет количество ключевых кадров, которыми можно будет управ-

лять на этапе создания анимации, все остальные кадры будут генерироваться автоматически 

между этими ключевыми кадрами. Поэтому в общем случае количество и положение точек на 

траектории может существенно отличаться.

• На инструментальной панели Визуализация нажмите кнопку  Высококачественная ани-

мация (Animate).

Откроется диалог задания анимации (рис. 11.32).  Данный диалог позволяет задать после-

довательности движения камеры по траектории сгенерировать итоговый файл. Задать траек-

тории можно двумя способами – с помощью кривых или с помощью аппроксимации точек по-

ложения камеры. Рассмотрим опции диалога:

Имя (Name) – определяет имя траектории с набором кадров. Траектория может задавать-

ся двумя способами. Первый способ определяется значением Задать кривые траектории 

(Define Trajectory Curves)   опции  Создание траектории (Create Trajectory) и заключа-

ется в том, что траектория задается набором соединённых кривых, вдоль которых размеча-

ются точки. На эти точки затем привязываются ключевые кадры, которые определяют параме-

тры анимации. Второе значение опции – Задать кадры (Define Key Frames) – определяет 

второй способ задания траектории. При использовании этого способа траектория задается 

на основе аппроксимации точек расположения камеры, которые также будут являться ключе-

выми кадрами. То есть в первом случае для задания траектории необходимо иметь кривые и 

желательно нанесённые на них точки (их можно будет сделать и потом), и появляется возмож-

ность точно управлять положением камеры и вектором её взора. А при использовании второ-

го способа исходной геометрии не требуется, и точки будут задаваться путем операций нави-

Рисунок 11.31. Задание точек для кадров
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гации в геометрической области и фиксации её пози-

ции в качестве ключевых кадров. Очевидно, что вто-

рой способ более простой, но менее точный.

Назначение кнопок диалога:

Доб/Копир. (Add/Copy) – создают или копируют 

траекторию в текущий набор анимации.

Удалить (Delete) – удаляет выбранную траекто-

рию из набора.

Переопределить (Redefine) – позволяет пере-

задать кривые, задающие траектории, или  переза-

дать позиции камеры в зависимости от значения оп-

ции Создание траектории.

Информация (Information) – отображает инфор-

мационное окно с описанием параметров ключевых 

кадров.

Кадры (Key Frames) – запускает редактор ключе-

вых кадров для текущего режима задания траектории.

Параметры (Parameters) – задает параметры 

создаваемого файла анимации.

Просмотр анимации (Preview Animation) – за-

пускает предварительный просмотр анимации в окне 

NX. Этот просмотр формируется на основе текуще-

го представления геометрии, то есть без рендеринга 

и просчета отображения текстуры материала и осве-

щённости. 

Генерация анимации (Generate Animation) – запускает процесс генерации анимации 

на основе заданной траектории.

Объединение анимации (Merge Animations) – запускает инструмент объединения соз-

данных анимационных роликов.

• В появившемся диалоге задания параметров анимации, в поле Имя (Name) введите имя для 

траектории движения камеры, которую вы собираетесь создать. Не нажимая Enter, нажмите 

кнопку Доб./Копир(Add/Copy).

• Появится диалог, которому необходимо указать кривые, определяющие траекторию движе-

ния. Если бы кривых было несколько, то необходимо было бы указать их последовательно. 

Но так как в нашем случае траектория представлена в виде одного сплайна, выберите его в 

графической области и нажмите кнопку ОК в диалоге (рис. 11.33).

• В диалоге задания анимации нажмите кнопку Кадры (Key Frames) для запуска диалога ре-

дактирования ключевых кадров.

Диалог редактирования состоит из следующих опций (рис. 11.34):

Рисунок 11.32 Диалог задания анима-

ции. 
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Имя (Name) – задаёт имя ключевого кадра. Не яв-

ляется обязательной; если имя не задано, то система 

автоматически его сгенерирует.

Шаги (Steps) – определяет, сколько кадров нахо-

дится между предыдущим ключевым кадром и созда-

ваемым. Этим параметром можно регулировать ско-

рость движения камеры по траектории. Чем больше 

кадров между двумя точками на траектории, тем мед-

ленней будет движение.

Паузы(Pauses) – определяет, на сколько кадров 

камера задержится на текущей позиции, прежде чем 

продолжить движение.

Ориентация (Orientation) – задает направление 

взора камеры. Значение Касательное (Tangential) 

определяет, что в данном ключевом кадре направле-

ние взора будет по касательной к траектории в точ-

ке положения камеры.   Значение Взгляд на точку 

(Look At Point) – определяет, что в данном ключевом 

кадре взор камеры будет направлен в заданную точ-

ку, которую надо будет указать.

Угол свертывания (Roll Angle) – задает поворо-

та камеры вокруг касательной прямой в точке траек-

тории, соответствующей данному  ключевому кадру. 

Тело для задания взгляда (Select Body Only 

Look At Point) – если эта опция активна, то при зада-

нии точки взора камеры можно выбирать только твер-

дые тела.

Кнопки Добавить (Add) / Удалить (Delete)/ Из-

менить (Edit) – соответственно добавляют, удаляют и 

редактируют ключевые кадры на траектории.

Отобразить точки (Redisplay Points) – показы-

вает точки, к которым привязаны ключевые кадры.

Установить камеру (Set Up Camera) – задает на-

чальное положении камеры для первого кадра.

Обратное направление вектора вверх (Reverse 

up_vector) – инвертирует направление вектора вер-

тикали.

Алгоритм создания ключевого кадра выглядит так:

•  задаются значения в полях Имя, Шаги, Пау-

зы и Угол свертывания (все параметры опцио-

нальны);

Рисунок 11.33. Добавление траектории 

движения камеры

Рисунок 11.34. Определение кадра
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•  выбирается направление вектора взора камеры в данном кадре значением опции Ори-

ентация в сочетании с опцией Тело для задания взгляда;

•  далее следует нажать кнопку Добавить;

•  указать точку в графической области, которая будет соответствовать данному кадру;

•  если ориентация взора камеры была определена как Взгляд на точку, то сразу после 

указания точки на траектории необходимо указать точку, на которую должна смотреть 

камера или твердое тело, если включена соответствующая опция;

• нажать кнопку Применить для создания кадра.

Здесь необходимо строго придерживаться данного алгоритма, иначе параметры кадра бу-

дут заданы неверно. Особое внимание надо обратить на задание точки и последующего ука-

зания точки, на которую должна смотреть камера. Если не включена опция использования 

твердых тел для задания направления взора камеры, то необходимо указывать точку непо-

средственно на видимой части какого-либо объекта (при этом никакого режима геометриче-

ских привязок нет), а не в пустом пространстве.

• В диалоге задания кадров выберите значение опции Ориентация равным Взгляд на точ-

ку, включите опцию Тело для задания взгляда и, нажав кнопку Добавить, укажите вто-

рую точку (первая точка автоматом была связана с нулевым кадром). Обратите внимание, 

что при выборе точки не подсвечиваются, поэтому надо просто навести перекрестье курсора 

на точку и щелкнуть левой кнопкой мыши. Затем сразу же укажите курсором мыши на тело, 

которое должно быть в фокусе камеры, и ещё раз щёлкните левой кнопкой мыши. Текущий 

фокус камеры будет временно изменен, чтобы отобразить, как будет выглядеть выбранный 

объект в анимации (рис. 11.35). 

• После этого нажмите кнопку Применить в диалоговом окне. Фокус камеры вернется в ис-

ходное состояние, будет создан с кадр параметрами,заданными в диалоговом окне, и при-

вязан ко второй точке.

• Соблюдая аналогичную последовательность действий, добавьте ключевые кадры к остав-

Рисунок 11.35. Задание параметров ключевого кадра
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шимся точкам. Попробуйте для некоторых точек варьировать параметры Шаги, Паузы и 

Угол свертывания.

При необходимости модифицировать созданный кадр необходимо нажать на кнопку Из-

менить в диалоге и указать точку, кадр которой подлежит редактированию. Когда фокус ка-

меры переместится в позицию кадра, то можно перезадать точку или тело взгляда и изменить 

параметры кадра в диалоге, после чего необходимо нажать кнопку Применить.

Также рекомендуется после задания всех точек воспользоваться кнопкой Отобразить 

точки, для того чтобы убедиться, что все точки были задействованы.

• После того как все ключевые кадры будет привязаны к точкам траектории, нажмите ОК в ди-

алоге редактирования кадров и вернитесь в диалог задания анимации.

• Нажмите кнопку Просмотр анимации (Preview Animation) для предварительного про-

смотра получаемой анимации. Если какие-то  части анимации не соответствуют ожиданиям, 

то необходимо вернуться в диалог редактирования ключевых кадров и отредактировать их 

(рис. 11.36).

• После окончательного редактирования ключевых кадров на диалоге задания анимации на-

жмите кнопку Параметры (Parameters). Откроется диалог задания параметров выходно-

го файла.

Этот диалог содержит следующие опции (рис. 11.37):

Имя файла анимации (Animation File Name) – нажмите кнопку, чтобы задать имя и рас-

положение получаемого файла;

Тип (Type) – формат файла анимации. По умолчанию стоит Mpeg-1, и если необходимо 

получить анимацию более высокого качества, то следует выбрать значение Mpeg-2;

Размер (Size) – метод задания размера кадров;

Разр. Гориз. (Hres) – разрешение кадра по горизонтали (эта и следующая опция доступ-

на, только если размер задается пользователем);

Рисунок 11.36. Предварительный просмотр анимации
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Vres – разрешение кадра по вертикали;

Коэффициент сжатия (Aspect Ratio) – соотноше-

ние сторон;

Частота кадров (Frame ratе) – задает количе-

ство кадров в секунду; 

Качество изображения (Image Quality) – опре-

деляет количество точек на дюйм;

Обновить выражения (Update Expressions) – 

эта опция позволяет передавать значение текущего 

кадра в выражения модели во время генерации ани-

мации. Это дает возможность в зависимости от номе-

ра кадра изменять какие-то параметры моделей. Что-

бы эта опция работала, необходимо в выражениях за-

ранее создать переменную с именем Frame Number, 

куда и будет передаваться текущий номер кадра при 

генерации анимации;

Использовать аппаратный рендеринг (Use 

Hardware Rendering) – определяет, будет ли ис-

пользоваться графический процессор видеокарты при генерации анимации или только про-

граммный механизм NX. При наличии мощной видеокарты и необходимости создавать ани-

мационные ролики высокого качества имеет смысл эту опцию активировать.

• Задайте в диалоге определения параметров имя и расположение файла анимации, осталь-

ные опции оставьте по умолчанию и, нажав кнопку Применить, выйдите из диалога.

• В диалоге задания анимации нажмите кнопку Генерация анимации (Generate 

Animation), чтобы запустить процесс расчета анимации. По окончании расчета откройте и 

просмотрите полученный файл анимации. 

Рисунок 11.37.  Параметры анимации
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